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Kata Sambutan

Menuju masyarakat informasi berbasis pengetahuan merupakan tujuan yang hendak dicapai
oleh bangsa Indonesia, khususnya dalam menciptakan dan meningkatkan kemandirian bangsa.
Untuk itu berbagai kegiatan dan aktivitas dalam mencapai tujuan tersebut perlu dilakukan secara
bertahap dan berkesinambungan.

Terkait dengan upaya tersebut, Kementerian Negara Riset dan Teknologi (KNRT) dalam
hal ini Keasdepan Pengembangan dan Pemanfaatan Teknologi Informasi merasa terpanggil untuk
ikut berpartisipasi, mendukung dan mendorong kegiatan tersebut guna terciptanya kemandirian
bangsa, sesuai dengan tugas, fungsi dan tanggung jawabnya. Untuk itu semangat Indonesia, Go
Open Source! (IGOS) dengan berbagai manfaatnya berkeinginan turut serta untuk membesarkan
program Buku Sekolah Elektronik (BSE) yang telah dicanangkan oleh Departemen Pendidikan
Nasional Republik Indonesia. IGOS bertujuan antara lain: memperkecil kesenjangan teknologi
informasi dengan memanfaatkan OSS diseluruh lapisan masyarakat, meningkatkan kreativitas
dalam mengembangkan dan memanfaatkan teknologi informasi, memberi peluang bagi para
pengembang untuk menumbuhkan industri perangkat lunak dalam negeri dengan biaya rendah
serta memperkecil biaya dan menghemat devisa dalam pengadaan/pembelian perangkat lunak.

Salah satu wujud nyata untuk mensukseskan program BSE adalah melakukan kerjasama
dengan para narasumber dan penulis buku Teknologi Informasi dan Komunikasi (TIK), khususnya
berbasis Open source untuk menerbitkan buku pelajaran TIK bagi siswa/siswi Sekolah Menengah
Pertama/ Madrasah Tsanawiah (SMP/MTs) dan pendidikan lain yang sederajat. Secara umum,
kontribusi yang kami berikan sangat kecil dan bahkan mungkin hanya menjangkau sebagian kecil
masyarakat Indonesia, sehingga dapat dikatakan masih sangat jauh dari kesempurnaan. Namun
demikian, kami berharap dengan awal yang kecil ini selanjutnya akan memberikan dampak luas di
masa yang akan datang bagi bangsa dan negara Indonesia.

Lebih lanjut, terbitan ini diharapkan dapat dimanfaatkan bagi para siswa/siswi (SMP/MTs),
dengan demikian, pengenalan, penggunaan dan pemanfaatan open source dapat berlangsung
sejak dini, dan sekaligus dapat menumbuhkembangkan kreativitas dalam menciptakan piranti lunak
berbasis Open Source.

April 2009

Kemal Prihatman
Asisten Deputi Pengembangan dan Pemanfaatan Teknologi Informasi

Kementerian Negara Riset dan Teknologi Republik Indonesia

- Kata Sambutan



Kata Sambutan

Buku merupakan salah satu sarana penting dalam upaya meningkatkan mutu pendidikan. Salah satu
permasalahan perbukuan dalam era otonomi daerah dewasa ini adalah ketersediaan buku yang memenuhi
standar nasional pendidikan dengan harga murah yang dapat dijangkau oleh masyarakat luas. Untuk mengatasi
hal tersebut, Departemen Pendidikan Nasional telah membeli 407 hak cipta buku teks pelajaran dari penulis/
penerbit.

Buku-buku teks pelajaran SD, SMP, SMP dan SMK yang telah dinilai dan dinyatakan memenuhi
syarat kelayakan untuk digunakan di dalam proses pembelajaran oleh Badan Standar Nasional Pendidikan
(BSNP) ini ditetapkan melalui Peraturan Menteri Pendidikan Nasional Nomor 34 Tahun 2008.

Buku-buku yang hak ciptanya telah dimiliki oleh Departemen Pendidikan Nasional tersebut kemudian
dialihformatkan oleh Pustekkom menjadi buku elektronik (e-book) yang penyebarluasannya dilakukan melalui
media web BSE yang beralamat di bse.depdiknas.go.id dan cakram digital (CD/DVD). Seluruh buku telah
diunggah (upload) ke web BSE dan saat ini buku-buku tersebut dapat diunduh (download), digandakan,
dicetak, dialih-mediakan, atau difotokopi secara bebas oleh masyarakat. Namun untuk penggandaan yang
bersifat komersial, maka harga penjualannya harus memenuhi Harga Eceran Tertinggi (HET) yang telah
ditetapkan oleh Pemerintah. Dengan melalui Jardiknas diharapkan buku-buku teks pelajaran murah ini mudah
diakses oleh siswa dan guru di seluruh Indonesia maupun Sekolah Indonesia yang berada di luar negeri.

Dari tahun ke tahun jumlah buku teks pelajaran tersebut akan ditambah sehingga kebutuhan
masyarakat terhadap buku murah dapat terpenuhi. Disamping menyediakan buku murah sendiri,
Departemen Pendidikan Nasional menyambut baik dukungan dan sumbangan buku-buku teks pelajaran
lain dari lembaga atau mitra kerja.

Salah satu mitra yang telah memberikan perhatian pada upaya untuk menyediakan buku teks pelajaran
adalah Kementerian Negara Riset dan Teknologi yang pada tahun 2009 ini telah bersedia menghibahkan
hak cipta 3 (tiga) buah buku teks pelajaran Teknologi Informasi dan Komunikasi (TIK) berbasis Open
Source untuk SMP kelas VI, VIII dan IX kepada Departemen Pendidikan Nasional. Buku-buku tersebut
akan diunggah dan disebarluaskan melalui web BSE sehingga masyarakat nantinya dapat mengunduh,
menggandakan, mencetak, mengalihmediakan, atau memfotokopinya kapan saja dan dimana saja.

Untuk itu kami menyampaikan penghargaan yang setinggi-tingginya kepada Kementerian Negara
Riset dan Teknologi yang telah berkenan menyerahkan buku teks pelajaran TIK tersebut kepada Departemen
Pendidikan Nasional untuk digunakan secara luas oleh para siswa dan guru di seluruh Indonesia.

Kami berharap semua pihak dapat mendukung kebijakan ini. Kepada para siswa kami ucapkan selamat
belajar dan manfaatkanlah serta terapkanlah buku ini dengan sebaik-baiknya. Kita menyadari bahwa buku ini
masih perlu ditingkatkan mutunya. Oleh karena itu, sumbang saran dan kritik sangat kami harapkan.

April 2009

Kepala Pusat Teknologi Informasi dan Komunikasi Pendidikan

iv Kata Sambutan .



Kata Pengantar

Buku pelajaran TIK (Teknologi Informasi dan Komunikasi) untuk SMP/MTs berbasis FOSS (Free/
Open Source Software) ini disusun berdasarkan kurikulum pendidikan nasional KTSP (Kurikulum
Tingkat Satuan Pendidikan). Penerbitan buku ini diharapkan dapat melengkapi koleksi buku-buku
sekolah elektronik yang telah diterbitkan Departemen Pendidikan Nasional dan didistribusikan
melalui web http://bse.depdiknas.go.id.

Perangkat lunak atau program komputer yang digunakan sebagai bahan pembelajaran di buku
ini berlisensi bebas atau merdeka, lisensi yang menjadi ciri khas perangkat lunak FOSS. Para
guru dan siswa dapat memperoleh semua program yang digunakan dalam buku ini tanpa harus
membayar lisensi kepada pembuatnya. Perangkat lunak FOSS seperti sistem operasi Linux dan
aplikasi OpenOffice dapat diperoleh dengan cara men-download dari Internet, meng-copy CD yang
disertakan dalam buku atau majalah, atau membeli dari penyedia CD/DVD lainnya.

Buku yang diterbitkan oleh Kementerian Negara Riset dan Teknologi ini disusun oleh para pengajar
dan penulis yang telah lama berkecimpung di dunia pendidikan maupun dunia kepenulisan buku-
buku TIK. Sebagian besar materi yang terdapat di buku ini telah digunakan di laboratorium komputer
pada beberapa SMP yang dikelola oleh Divisi Pendidikan Sekolah LP3T-NF (Lembaga Pendidikan
dan Pengembangan Profesi Terpadu — Nurul Fikri).

Rangkaian buku TIK untuk SMP/MTs berbasis FOSS ini terdiri atas 3 judul sesuai dengan kelas dan
semester. Buku kelas VIl semester | membahas pengenalan teknologi informasi dan komunikasi
dan operasi dasar komputer, sementara semester || membahas perangkat keras dan perangkat
lunak. Buku kelas VIl semester | membahas penggunaan perangkat lunak pengolah kata, sementara
semester || membahas pengolah angka atau lembar kerja (spreadsheet). Buku kelas IX semester |
dan Il membahas pemanfaatan internet.

Kami ucapkan terima kasih kepada semua pihak yang telah membantu penyusunan dan penerbitan
buku ini. Kami menunggu kritik dan saran Anda demi penyempurnaan buku ini dan buku-buku lain
yang akan kami susun untuk mencerdaskan generasi muda bangsa Indonesia. Kritik dan saran
dapat dikirim melalui email ke alamat penulis-buku@nurulfikri.com.

April 2009

Penyusun

- Kata Pengantar



Petunjuk Penggunaan Buku

Buku ini terdiri atas empat bab pelajaran yang terbagi atas dua semester. Tiap semester
terdiri atas dua bab pelajaran. Tiap bab pelajaran terdiri atas beberapa subbab yang merupakan
penjabaran kompetensi-kompetensi dasar yang terdapat di dalam Standar Isi.

Untuk memudahkan kamu mempelajari isi buku ini, mari kita cermati bagian-bagian yang
terdapat dalam buku ini. Terdapat 8 bagian penting, antara lain :

1. Halaman Judul

Adalah halaman berisi judul bab, bagian ini merupakan pengantar untuk memasuki materi
pembelajaran. Pada bagian ini terdapat target pembelajaran yang dapat kamu capai setelah
mempelajari bab ini secara tuntas

PERANGKAT LUNAK
PENGOLAH KATA

2. Peta Konsep

Bagian ini menggambarkan kaitan beberapa konsep yang kamu pelajari pada bab ini sehingga
kamu mendapatkan pemahaman yang utuh

Peta Konsep

PERANGKAT LUNAK PENGOLAH
KATA OPENOFFICE.ORG WRITER

) i) ) ()

a Detrscican Fungss | (‘= Demust, Fungsian | (= Mengenatbeypoara ) [ Menggunakan menu
dan mouse

= Cantoh program MRCHTHTECAM dan kon uriuk
ata meny, loolbar dan = Menggunakan mesTibuat dan men-
= Merjatankan dan kon beyboard dan mouse ‘gedil pada dokumen
mengenal jendeia = Menjalankan = Mermformat feks
OpenOifice.org sederhana ‘dokumen
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3. Kata Kunci
Bagian ini berisi daftar kata-kata penting yang harus kamu pahami pada bab ini

Kata Kunci

4. Tips

Bagian ini merupakan petunjuk cara cepat untuk mengeksekusi sebuah perintah sehingga kamu
terbiasa bekerja dengan cepat

Kenali dan pahamilah
bagian komponen-
komponen dari jendela
kerja OpenOffice.org
Writer

5. Praktikum

Bagian ini berisi kegiatan-kegiatan yang kamu lakukan untuk lebih memahami isi materi pelajaran.
Kegiatan ini dapat kamu lakukan sendiri atau bekerja kelompok dengan bimbingan guru

B Praktikum

A. Membuka program OpenOffice.org Writer:
1. Membuka dan menu Applications
2. Membuka dengan menu shoricut di desklop

B. Mengenal menu dan toolbar:

. Sebutian ada DErapa Macam KOMPONEn pada OpenOmes.arg Wiker?

Manakah menu yang berfungs! untuk memformat feks?

Manatan menu yang berfungs! untuk menylsipkan gambar atau simbol te dalam gokumen?

. Tunjukkan komponen yang memillkl fungsl untuk mengguiung lembar kerja dokumen?

. Pada posisl manakah juaul gokumen diletakkan?

. Lakukan bagaimana cara menutup lembar kerfa tanpa keluar dan program OpenOmce.org
Writer?

7. Lawukaniah bagaimana cara menutup lembar kerja dan keluar darl program OpenOfice org

Writer?

o N L
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6.

7.

Rangkuman

Bagian ini berisi kegiatan-kegiatan yang kamu lakukan untuk lebih memahami isi materi pelajaran.
Kegiatan ini dapat kamu lakukan sendiri atau bekerja kelompok dengan bimbingan guru

. 1. OpenOffice.cry Writer Menpakan salah 538 Program perangiial lunak yang berfungsl sebagal

© BpERAE! pEngOlan ALK Aan DErsital Freée Somware, Defgund untul membudt dokumen, Drosur,
miakalah maupun Lertas ucapan

" 2. Jendela OpenOfice.org Willer terdin alas dua belas komponen, antara kain yaltu: btk bar, meny
Bar, loodar Sanddy, formating foaibar, drawing fooibar Gan Stafus Aar. P43 koempanen menu
bar, 0 dalamnya lerdapat menu-menu yang dibelompokkan bergasarkan Tungsl pedntahnya

. JIka3 URa menguil salah eaty menu, akan muncul [endeld armp-aomT.

| 3. mon adalan smbol dar shoricul yang berfungsl unbut mempercepat sudtu perintan yang akan
dialankan ¥y @plif calam membuat dan memodiagl suaiy dotumen di program apldcag!
CpenCffice ory Writer. Ikon-Kon lersebud teretak of dalam bagian menu foolbar sfandar,
Farmarmng fooiar 4N Srawing loamar.

(]

Glossarium

Bagian ini berisi definisi istilah-istilah penting atau istilah asing yang terdapat pada bab yang
bersangkutan. Jika kamu menemukan istilah yang tidak kamu mengerti kamu dapat mencari
referensinya di sini

Dkt IMI'I'W 3t ke QDM KOMpUleT

Orop Down  [kotak plihan masukkan perintah berbentul sepertl daftar

Cownioad mengambil Sie atau program dan infemet ke komputer
Free Software  |perangkat nak yang bersifal gratis dan tidak ber kesens|

Iken menu penntah yang o wakil dengan simbol bengamibar
Input data yang akan diolah dengan komputer
Mouse pad  |alas lempat mouse digeratian
Shorcut  [perintan dengan singkat
Software perangkat lunak yang o inetal ke dalam Komputer
Toolbar
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8. Evaluasi

Bagian ini berisi soal-soal latihan dan tugas-tugas untuk mengukur keberhasilanmu setelah

mempelajari kompetensi-kompetensi pada bab tersebut

Evaluasi %,

A.Berilah tanda silang (X) pada jawaban yang paling tepat.
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PERANGKAT LUNAK
PENGOLAH KATA

Welcome to

OpenOffice.org

Create a new document

iﬁ Presentation Ty Drawing
@) - : L2y -

E Open a document..,

=
Text Document EEI‘ Spreadshest

(g | Dawbase [* )| Templates.,

ebagai paket Office yang semakin populer,
S OpenOffice.org menawarkan sejumlah

kelebihan, baik dari sisi lisensi ataupun
teknis. Apa saja kelebihan OpenOffice.org dibanding
Microsoft Office? Sebagai paket Office yang semakin
populer, OpenOffice.org menawarkan sejumlah
kelebihan, baik dari sisi lisensi ataupun teknis. Apa
saja kelebihan OpenOffice.org dibanding Microsoft
Office?

Boleh dikatakan, hampir tidak ada pengguna
komputer aktif yang tidak mengenal paket office
Microsoft Office. Sebagian pengguna komputer
bahkan tidak bisa bekerja produktif tanpa produk
tersebut. Sudah bertahun-tahun lamanya, Microsoft
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Dari sisi fitur, harus diakui OpenOffice.org belum bisa dibandingkan dengan
Microsoft Office. Namun, sebagian besar pengguna toh hanya membutuhkan sebagian
kecil fungsionalitas, yang sudah dipenuhi dengan baik oleh OpenOffice.org. OpenOffice.
org datang dengan semua komponen Office yang dibutuhkan untuk bekerja sehari-hari.

Selain itu, ooo juga datang dengan berbagai fitur lain, yang bahkan belum bisa

disediakan oleh Microsoft Office. Kita akan membahas sepuluh diantaranya :

1.

2
3
4
5.
6
7
8
9

10.

Ketersediaan source code
Berjalan pada banyak platform

Kompatibel dengan Microsoft Office dan format office lainnya

. Format OpenDocument yang terbuka dan fleksibel

Ekspor ke PDF dan format lain dengan mudah

. Macro dalam berbagai bahasa pemrograman
. Akses database yang luas dan transparan
. Wizard untuk konversi dokumen MS Office

. Sangat customizeable

User interface yang konsisten antar komponen

Arsitektur program OpenOffice.org dan sistem komponennya dikembangkan

dengan sangat baik. Salah satu akibatnya, user interface Writer, Calc, Impress dan
komponen lain sangatlah konsisten. Kita bahkan bisa membangun macro untuk
memanggil komponen tertentu dari OpenOffice.org.

Bisa kita lihat, Openoffice.org bukanlah proyek main-main. OpenOffice.org

sangatlah layak untuk digunakan dan diandalkan untuk membantu Anda tetap produktif.
Jangan terus tergantung pada Microsoft Office. Ketergantungan itu tidak akan pernah
selesai apabila kita tidak berusaha keras melepaskan diri.

http://iddonk.wordpress.com/2008/07/29/10-kelebihan-openofficeorg/
Tanggal : Kamis, 12 Februari 2009 | 08:58 WIB
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Peta Konsep

PERANGKAT LUNAK PENGOLAH
KATA OPENOFFICE.ORG WRITER

| [ | |
Sekilas Program Mengenal Menu, Menggunakan Menggunakan
Pengolah Kata Toolbar dan lkon keyboard dan mouse Menu dan lkon

m Definisi dan Fungsi
m Contoh program
pengolah kata

m Definisi, Fungsi dan
macam-macam
menu, toolbar dan

m Mengenal keyboard
dan mouse
m Menggunakan

m Menggunakan menu
dan ikon untuk
membuat dan men-

m Menjalankan dan ikon keyboard dan mouse gedit pada dokumen
mengenal jendela m Menjalankan perintah m Memformat teks
OpenOffice.org sederhana dokumen

writer

software aplikasinya adalah pengolah kata. Saat ini sangat banyak aplikasi pengolah kata
yang bisa kita temui, mulai dari yang paling sederhana yaitu wordpad, yang paling populer
yaitu Microsoft Word dan yang gratis yaitu OpenOffice.org Writer, Abiword, dan lain-lain.

Tentu kamu masih ingat pelajaran TIK kelas VII tentang software Aplikasi. Salah satu contoh

Bisa jadi, aplikasi pengolah kata adalah aplikasi yang paling kita butuhkan dan yang paling
banyak kamu gunakan di komputermu, selain aplikasi permainan tentunya. Karena aplikasi pengolah
kata dapat membantu untuk membuat naskah dalam bentuk dokumen seperti membuat laporan,
karya tulis, surat-surat, brosur dan sebagainya.

Kata Kunci

aplikasi, shortkey, ketik, format, dokumen, ikon, tombol, program, naskah, klik, menu bar, drag drop

Teknologi Informasi dan Komunikasi B
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A. Mengenal Perangkat Lunak Pengolah Kata

Software pengolah kata yang kita bahas ini menggunakan perangkat lunak
OpenOffice.org Writer yang dijalankan dengan sistem operasi Linux. Perangkat lunak ini
merupakan program satu paket saat kamu menginstal Linux di komputer sendiri. Karena
sistem operasi Linux sudah menyiapkan beberapa paket dalam penginstalan termasuk
aplikasi yang digunakan untuk perkantoran dan multimedia di dalam satu kaset piringan
(Compact Disc).

1. Sekilas tentang Program Pengolah Kata

OpenOffice.org Writer merupakan bagian program dari aplikasi perkantoran
OpenOffice.org. Selain tugas utamanya untuk membuat naskah dalam bentuk
dokumen, OpenOffice.org Writer juga dapat menyisipkan gambar, membuat tabel
dan melakukan perhitungan sederhana.

Kamu pasti bertanya, kenapa menggunakan OpenOffice.org Writer kalau yang
paling populer adalah Microsoft Word? Ada beberapa keuntungan menggunakan
OpenOffice.org Writer dibandingkan dengan aplikasi yang sejenis, yaitu:

a. Free Software, aplikasi gratis yang bisa didapat dari mengkopi, download atau dari
manapun, tanpa diharuskan membayar lisensi. Dan bebas pula untuk diinstal ke
beberapa komputer dan dikopikan kemanapun dan yang paling penting didukung
oleh komunitas di seluruh dunia.

b. Format dokumen yang digunakan menggunakan Open Document Format (.odt)
sehingga dapat dibuka oleh pengolah kata yang lain, seperti AbiWord, StarWtiter,
dan sebagainya.

c. File dokumen yang digunakan tidak rentan sebagai pembawa virus.
d. Dapat membuka file yang dibuat dengan Microsoft Word dengan baik.
e. Dapat menyimpan file dengan format Microsoff Word, sehingga dapat dibuka
dengan baik juga oleh Microsoft Word.
f. Tersedia untuk sistem operasi Linux, Windows, Mac, dan Solaris.
g. Tersedia versi portable (tanpa harus diinstal ke komputer).
2. Mengenal OpenOffice.org Writer
OpenOffice.org Writer dapat berjalan di tempat sistem operasi yang berbeda,
yaitu sistem operasi Linux, Windows, Mac, dan Solaris. Namun begitu, pada keempat
sistem operasi tersebut memiliki langkah-langkah untuk memulainya yang sedikit

berbeda. Dalam buku ini, kita menggunakan sistem operasi Linux dengan distro
Ubuntu.

Teknologi Informasi dan Komunikasi N
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Untuk pengguna di sistem operasi Linux, menu yang digunakan untuk
menjalankan program pengolah kata OpenOffice.org Writer adalah sebagai berikut:

a. Klik tombol Application.
b. Pilih Office.

c. Klik OpenOffice.org Writer.

Places System i}.@
q

u Accessories

L'.n Games b

& Graphics >

@ Internet ¥
V¥ office

ﬁ Sound & Video

@ Add/Remove. ..

fo Evolution Mail and Calendar

» 9 Fax address book

s _
nuL.as Inance anagemen
8 GnuCash F Management

e HPLIP Fax Utility
e . )
s CpenOffice.org Calc

 OpenOffice.org Impress

Gambar 1.1
Menjalankan
OpenOffice.org Writer

Sumber: Dok. Penulis

| OpenOffice org Writer

'JI 0 o .‘u}'

Project Management

Perhatikan bahwa sebenarnya penulisan OpenOffice selalu diakhiri dengan
akhiran .org, namun demi kepraktisan, maka terkadang akhiran tersebut tidak

dituliskan.

OBZHOffice.org 2.3

Gambar 1.2.
Logo OpenOffice.org
!tj ubuntu | versi2a.

Sumber: Dok. Penulis
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Berdasarkan Gambar 1.3. tersebut, komponen-komponen yang ada pada
jendela program aplikasi pengolah kata OpenOffice.org Writer terdiri dari 11 (sebelas)
bagian, yaitu:

URtHEd 1 - Openoice.org Writer e E

F e Edit View Insert Format Table Tools Window Help x
J EEIEETTY % -ﬁ o ae- B
| | J [Default ~ | [Times New Roman vz [~ & 4 . . . E u

I:Z,' IR AR

B
1
N

Gambar 1.3. - - \

Jendela aplikasi [ ;5 \
OpenOffice.org Writer - il : ]

Sumber: Dok, Penulis |11 |43 /M@ VI 2 BH-©-< -F-0-%- 5 @ 8

[Page 1/1 | Default | English (Usa)  [INsRT [sTD | | | [GFRM e—e—o |

[saIE]

Jendela aplikasi pengolah kata OpenOffice.org Writer ditunjukkan pada gambar
1.3. Lembar kerja OpenOffice.org Writer disebut juga dengan Document.

NOMOR | NAMA KOMPONEN
1 Title Bar
Menu Bar

Kontrol Jendela

Toolbar standar

Formatting toolbar
Horizontal Ruler
Vertikal Ruler

Scroll Bar Horizontal
Scroll Bar Vertikal
Drawing toolbar
Status Bar

Text Boundaries

O | [N | |W|IN

—_
o

—
—_—

—_
o

~ Untuk SMP / MTs Kelas VIl

Teknologi Informasi dan Komunikasi N



a. Title Bar

Y 1.inologi Informasi dan Komunikasi

Berfungsi sebagaijudul dan informasi nama file yang sedang aktif atau sedang
dijalankan. Terletak pada posisi paling atas pada jendela dokumen OpenOffice.org
Writer.

! Gambar 1.4. Title Bar
Sumber: Dok. Penulis

Uit =0penoimceson Whter

. Kontrol Jendela

— IF' 'T' Qambar 1.5. Kontrol
= jendela

Sumber: Dok. Penulis

Tiga fungsi pada kontrol ini, yaitu:
1. Minimize windows, berfungsi untuk memperkecil tampilan OpenOffice.org
Writer.

2. Maximize dan Unmaximize windows, berfungsi untuk mengembalikan ukuran
tampilan pada OpenOffice.org Writer dan untuk memperbesar tampilan jendela
kerja program aplikasi OpenOffice.org Writer.

3. Close windows, berfungsi untuk menutup jendela program aplikasi OpenOffice.
org Writer

Untuk dapat mengakhiri jendela program aplikasi OpenOffice.org Writer, ada
2 (dua) cara penggunaannya:

1. Cara pertama, digunakan untuk menutup lembar kerja tanpa mengakhiri atau
keluar dari program OpenOffice.org Writer, yaitu:

Klik menu File, kemudian pilih dan klik Close.

2. Carakedua, digunakan untuk menutup lembar kerja dan mengakhiri atau keluar
dari program OpenOffice.org Writer, yaitu:

Klik menu File, kemudian pilih dan klik Exit, atau

Klik tanda silang ( X ) pada komponen kontrol jendela i'

Kenali dan pahamilah
bagian komponen-
komponen dari jendela
kerja OpenOffice.org
Writer

Untuk SMP / MTs Kelas VIIl



raktikum

A. Praktikum membuka program OpenOffice.org Writer:

1. Membuka dari menu Applications.

2. Membuka dengan menu shortcut di desktop.

. Praktikum mengenal menu dan toolbar:

2

Sebutkan ada berapa macam komponen pada OpenOffice.org Writer!

Manakah menu yang berfungsi untuk memformat teks?

Manakah menu yang berfungsi untuk menyisipkan gambar atau simbol ke dalam dokumen?
Tunjukkan komponen yang memiliki fungsi untuk menggulung lembar kerja dokumen!

Pada posisi manakah judul dokumen diletakkan?

Lakukan bagaimana cara menutup lembar kerja tanpa keluar dari program OpenOffice.org
Writer!

. Lakukanlah bagaimana cara menutup lembar kerja dan keluar dari program OpenOffice.org
Writer!

B. Menu, Toolbar dan lkon pada program
OpenOffice.org Writer

Komponen-komponen yang sebelumnya sudah disebutkan di atas, merupakan
bagian yang terdiri atas menu, toolbar dan ikon-ikon di dalamnya. Pada subbab ini,
akan dijelaskan lebih lanjut tentang bagian komponen tersebut.

1. Menu pada OpenOffice.org Writer

Menu merupakan bagian yang tidak dapat terpisahkan dan berfungsi untuk
mengaktifkan dan menjalankan perintah-perintah atau instruksi dalam pembuatan
dokumen di program aplikasi OpenOffice.org Writer.

Gambar 1.6.

MenuBar File Edit Wiew Insert Format Table Tools Window Help

Sumber: Dok. Penulis

Menu Bar berisi pilihan menu-menu yang berfungsi sebagai perintah untuk
mengolah dokumen lembar kerja di OpenOffice.org Writer. Menu Bar terletak pada
bagian atas, di bawah judul dokumen. Menu utama atau disebut dengan Menu Bar
terbagi menjadi beberapa kelompok menu-menu, yaitu:

. Teknologi Informasi dan Komunikasi
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a. Menu File, jika menu ini dipilih maka akan memunculkan Drop-Down menu
yang disebut sub menu, di antaranya: New, Open, Save, Close, Print, Exit dan
sebagainya. Menu ini berhubungan dengan pengaturan dokumen, seperti
membuat dokumen baru, membuka, menyimpan dan mencetak.

b. Menu Edit, berfungsi dalam proses peng-editan atau perubahan tulisan. Di
dalamnya sub menu Cut, Copy, Paste, Undo, Redo, Select All, dan sebagainya.
Seperti menyalin, memindahkan dan memilih teks atau kalimat pada dokumen.

c. Menu View, menu ini berfungsi untuk mengatur tampilan lembar kerja dan di
dalamnya terdapat sub menu PrintLayout, Web Layout, Toolbars, Zoom dan
sebagainya. Seperti mengubah ukuran lembar kerja, bentuk tampilan dokumen,
meng-aktifkan dan me-non-aktifkan menu toolbar.

d. Menu Insert, berfungsi untuk menyisipkan objek tertentu ke dalam lembar kerja.
Di dalamnya terdapat sub menu Manual Breaks, Row, Column, Picture, Table,
Object dan sebagainya.

e. Menu Format, berfungsi untuk mengaturformatdarilembarkerja seperti formatteks,
lebar baris dan kolom, ukuran kertas, paragraf, perataan teks dan sebagainya.

f. Menu Table, berfungsi untuk membuat, mengatur dan menyunting tabel.

g. Menu Tools, berfungsi untuk mengubah dan mengatur berbagai macam aturan
pada lembar kerja, seperti bahasa, pemeriksaan ejaan, jumlah kata, mail merge,
dan sebagainya.

h. Menu Window, berisi menu-menu yang digunakan untuk mengatur dan memilih
jendela kerja aplikasi OpenOffice.org Writer yang aktif.

i. Menu Help adalah menubantuanyang berisifasilitas petunjuk bantuan penggunaan
OpenOffice.org Writer.

2. Menu pada OpenOffice.org Writer

Toolbar berisi berbagai macam tombol berbentuk ikon gambar-gambar yang
dikelompokkan berdasarkan fungsinya. Misalnya proses membuka file dokumen yang
sudah disimpan, yang diaktifkan dengan menu File > Open dan dapat digantikan
dengan mengklik tombol Open (tombol yang memiliki ikon bergambar folder file).

Untuk mengaktifkan dan menyembunyikan menu toolbar, kamu bisa
mengaturnya melalui menu View - Toolbars, kemudian beri atau hilangkan tanda cek
list (v).

a. Standard Toolbar (Toolbar Standar)

» Gambar 1.7.
Menu toolbar standar

Sumber: Dok. Penulis

8808 1 IRA vE P IR R 1=  |

-
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Toolbar standar adalah sekumpulan ikon-ikon atau gambar sebagai jalan
pintas yang berfungsi dalam melakukan perintah-perintah pengaturan dokumen,
seperti menyimpan, membuka, mencetak, menyalin teks dan sebagainya.

Berikut nama ikon-ikon yang sering digunakan pada menu toolbar standar:

NAMA IKON FUNGSI

New Membuat lembar kerja baru
Open Membuka dokumen yang pernah disimpan
Save Menyimpan lembar kerja dalam bentuk
dokumen file
Print Mencetak lembar kerja
Page Preview |Menampilkan dokumen yang aktif sebelum
dicetak
Cut Memindahkan suatu objek pada penyimpanan
sementara
Copy Menggandakan suatu objek pada lembar kerja
OpenOffice.org Writer
Paste Menampilkan hasil Copy atau Cut
Undo Membatalkan penyuntingan dokumen paling
akhir
Redo Mengembalikan kembali tindakan penyuntingan
terakhir
Table Membuat tabel
Zoom Mengubah ukuran tampilan lembar kerja
OpenOffice.org Writer

b. Formatting Toolbar (Toolbar Pemformatan)

Menu Fo?r?)r:tz:;;:} E [Default | v| [TimesNewRoman  [v|[12 |v| & 4 é |E| i}
Sumber: Dok. Penulis
Pada formatting toolbar, terdapat ikon-ikon yang sering kita gunakan.
Ikon tersebut berguna untuk mengatur dan memodifikasi penulisan pada
dokumen. Dengan ini kita dapat memodifikasi teks dengan cepat.

Berikut nama ikon yang sering digunakan dalam penyuntingan teks pada
dokumen OpenOffice.org Writer:

40 . Teknologi Informasi dan Komunikasi .
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NAMA IKON FUNGSI

Style and Memilih style yang akan digunakan
Formatting
Font Name Memilih jenis huruf yang akan digunakan
Font Size Memilih ukuran huruf
Bold Mencetak tebal huruf, angka atau kalimat
Italic Memberikan efek miring pada huruf, angka atau
kalimat yang dimaksudkan
Underline Memberikan garis bawah pada huruf, angka
atau kalimat
Align Left Membuat tulisan rata Kiri
Centered Membuat tulisan rata tengah
Align Right Membuat tulisan rata kanan
Justified Membuat tulisan rata kiri dan rata kanan pada
lembar kerja
Numbering Memberikan dan mengatur bentuk daftar item
berstruktur di dalam teks, berupa huruf dan
angka
Bullets Memberikan dan mengatur bentuk daftar item
berstrukstur di dalam teks, berupa simbol-
simbol tertentu.
Font Color Mengatur pewarnaan huruf atau angka di
lembar kerja
Background Color |Memberikan efek pewarnaan pada bagian latar
belakang teks ata objek tertentu

c. Drawing toolbar (Toolbar Menggambar)

/meVI®r-Q-o-0-D-v D

Gambar 1.9.
Menu drawing toolbar
Sumber: Dok. Penulis

Pembuatan dokumen yang disertai dengan gambar, warna, teks artistik
dan simbol objek, akan membuat menarik isi dan tampilan dari sebuah dokumen.
Drawing toolbar berfungsi untuk membuat atau menyisipkan gambar, simbol,

objek, teks artistik dan sebagainya pada lembar kerja dokumen.

Teknologi Informasi dan Komunikasi
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Berikut nama ikon-ikon yang sering digunakan dalam menyuntingan gambar
pada lembar kerja OpenOffice.org Writer:

NAMA IKON FUNGSI

Line Membuat garis lurus
Rectangle Membuat objek berbentuk kotak
Ellipse Membuat objek berbentuk lingkaran
Freeform Line |Membuat garis bebas atau tidak beraturan
Text Membuat teks pada area tertentu
Callaouts Menyisipkan objek awan

Basic Shapes |Menyisipkan objek ataugambardasarpadalembar
kerja, berupa bentuk persegi dan lingkaran
Symbol Shapes |Menyisipkan simbol pada lembar kerja

Block Arrows |Menyisipkan objek berupa arah dan bentuk
panah
Fontwork gallery |[Membuat teks yang diberi efek grafis tertentu

d. Status Bar

Gambar 1.10. - R
Mot ey 118 Default | Engish(USA)  [100% [INSRT (STD [* |

Sumber: Dok. Penulis

Status bar adalah kotak yang terletak paling bawah dari program aplikasi
OpenOffice.org Writer dan berfungsi untuk menampilkan informasi halaman,
gaya halaman, bahasa, ukuran tampilan, bahasa, dan sebagainya. Lihat gambar
1.10.

e. Scroll Bar

Scroll bar adalah bagian dari OpenOffice.org Writer yang berfungsi untuk
menggeser halaman yang sedang aktif. Ada dua buah scrollbar, yaitu scrollbar
horizontal untuk menggeser halaman ke arah kanan atau kiri, scrollbar vertikal
untuk menggeser halaman ke arah atas atau bawah.

3. Shortkey pada OpenOffice.org Writer

Shortkey atau kunci kombinasi pada keyboard berfungsi supaya kamu
bisa menggunakan menu bar dan toolbar yang ada tanpa harus memakai mouse.
Sehingga kamu akan terbiasa menggunakan keyboard untuk menggunakan fungsi-
fungsi tersebut.

Berikut shortcut pada keyboard yang sering digunakan untuk penulisan di
program aplikasi OpenOffice.org Writer:

12 . Teknologi Informasi dan Komunikasi .
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Tabel 1.1 fungsi pada Menu File

KOMBINASI FUNGSI

Ctrl+N Membuat dokumen baru menggunakan
OpenOffice.org Writer
Ctri+O Memilih jenis huruf yang akan digunakan
Ctrl+S Menyimpan dokumen (Save)
Ctrl+Shift+S Menyimpan dokumen (Save as...)
Ctrl+P Mencetak dokumen
Alt+F+X Keluar dari program OpenOffice Writer

Tabel 1.2 fungsi pada Menu Edit

KOMBINASI FUNGSI

Ctrl+Z Perintah Undo, membatalkan perintah terakhir
yang kamu lakukan

Ctrl+Y Perintah Restore/Redo, mengulang perintah
pembatalan yang baru saja dilakukan

Ctri+X Perintah untuk memindahkan paragraf atau
teks

Ctrl+C Perintah untuk membuat penggandaan atau
duplikat paragraf atau teks

Ctrl+V Meletakkan hasil pemindahan paragraf atau
teks dari perintah copy atau cut

Ctrl+A Mensortir atau memblok semua paragraf atau
teks dalam satu lembar kerja pada OpenOffice.
org Writer yang aktif

Tabel 1.3 fungsi pada Menu View

KOMBINASI FUNGSI

Alt+V+T+... Mengaktifkan dan menonaktifkan menu-menu
toolbar yang dipilih
Ctrl+Shift+J Perintah untuk tampilan layar lembar kerja
menjadi full screen
Alt+V+Z Untuk memperbesar atau memperkecil tampilan
layar lembar kerja dokumen

Tabel 1.4 fungsi pada Menu Insert

KOMBINASI FUNGSI

Alt+1+P Menyisipkan  berupa simbol-simbol atau
karakter khusus
Ctrl+F12 Menyisipkan tabel
Alt+l+U+F Menyisipkan gambar-gambar dari disk

Teknologi Informasi dan Komunikasi
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Tabel 1.5 fungsi pada Menu Format

KOMBINASI

FUNGSI

Alt+O+H Menampilkan format karakter.

Alt+O+A Menampilkan format paragraf

Alt+0+B Menampilkan fornat Bullets and Numbering.
Alt+O+C+... Mengubah huruf menjadi besar atau kecil

(Change Case).

Tabel 1.6 fungsi pada Menu Tabel

KOMBINASI

Ctrl+F12

FUNGSI
Menyisipkan tabel.

F2

Menampilkan  kotak dialog perhitungan
matematika.

Tabel 1.7 fungsi pada Menu Tool

KOMBINASI FUNGSI
F7 Memeriksa format kalimat sesuai dengan
bahasa yang benar.
Alt+T+C Menampilkan kotak dialog Customize.
Alt+T+O Menampilkan kotak dialog Options.

Tabel 1.8 fungsi pada Menu Windows

KOMBINASI

Alt+W+N

FUNGSI
Membuka jendela baru OpenOffice.org Writer.

Ctrl+W

Menutup jendela windows yang aktif.

Tabel 1.9 fungsi pada Menu Help

KOMBINASI |

F1

FUNGSI

Kotak dialog bantuan tentang penggunaan
OpenOffice.org Writer.

Gunakan kombinasi
dan fungsi pada
keyboard untuk
memformat teks
pada dokumen.
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raktilum

Praktikum operasi dasar OpenOffice.org Writer

1. Jalankan program aplikasi OpenOffice.org Writer

Perhatikan masing-masing bagian pada komponen OpenOffice.org Writer
Di submenu manakah ikon printer terletak?

Tunjukkan ikon-ikon yang terdapat pada toolbar standard!

Ketiklah naskah di dalam lembar kerja OpenOffice.org Writer!

Buatlah tabel dengan jumlah kolom 3 dan jumlah baris 4!

Berikanlah warna latarbelakang pada tabel tersebut.

© N o o kA e D

Kerjakan cara menyimpan dokumen pada OpenOffice.org Writer dengan menggunakan
shortkey?

©

Masukanlah gambar dari komputer kamu ke dalam dokumen kamu.

10. Apa yang kamu harus lakukan jika memerlukan bantuan tentang cara menggunakan
OpenOffice.org Writer?

11. Kerjakan cara pemindahan teks atau dokumen dari halaman satu ke halaman dua!

12. Tutuplah dokumen dan program OpenOffice.org Writer dengan menggunakan shortkey.

C. Menggunakan keyboard dan mouse

Keyboard dan mouse merupakan bagian dari perangkat komputer yang berfungsi
sebagai alat untuk memasukkan data ke dalam komputer (teks, angka) dan memilih
atau mensortir menu atau ikon tertentu.

1. Menggunakan tombol pada keyboard

Keyboard atau papan ketik adalah peralatan untuk memasukkan data dengan
cara mengetik. Keyboard terdiri atas tombol huruf, tombol angka dan tombol simbol
atau karakteristik khusus. Pada keyboard juga terdapat lampu indikator.

Tombol pada keyboard dikelompokkan ke dalam empat kelompok, yaitu
kelompok kanan, kelompok kiri, kelompok tengah dan kelompok atas. Pada keyboard
terdapat tombol-tombol huruf dari A sampai Z, tombol angka (numerik) 0 sampai 9,
tombol karakter khusus seperti @? > <#$ % * & * () ~? | , tombol fungsi seperti F1
sampai F12, dan tombol-tombol lainnya.

Y 1.inologi Informasi dan Komunikasi &5
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Kelompok Lampu

Kelompok atas tengah indikator
| F1 F2 ||F2 | Fs F6 F1o |[F11 |[F12 [ S || Ga=e
Gambar 1.11. j GE G 7 R E=)
Papan ketik atau Keyboard ’ﬁﬁﬁﬁﬁﬁﬁl& LElElEEEE ﬁfﬁrﬁ =)
Sumber: http://seoconsultans.com/ = e If—lf—“’_]f_lf_lﬂ’_W_V_Lf__][' hm!g""}j!?ﬁl .

windows ﬁ[_][_][_][_]ﬁﬂ[_}[_][_l[_] ==

E TEELETTELETEIE Hr’=‘L
Gl | [ Ea) =

Kelompok kiri Kelompok kanan

Ketika kita mengetik, kalimat atau teks yang kita ketik akan ditampilkan di layar
monitor. Kita juga dapat menghapus atau menambahkan kata dengan bebas, tanpa

harus menggunakan penghapus.

2. Menggunakan Mouse

Mouse juga dikenal dengan istilah tetikus, mungkin karena bentuknya yang
mirip tikus. Mouse ini berfungsi sebagai alat penunjuk, untuk memilih menu atau
ikon pada saat menjalankan sebuah program komputer. Pada saat ini hampir
semua sistem operasi komputer sudah berbasis grafis, sehinggga tidak perlu lagi

mengetikkan perintah seperti pada komputer dengan modus teks.

Sensor Gerak
Penggulung

Gambar 1.12.
Mouse

Sumber: http://qiezzy.wordpress.
com

Sensor Gerak v .

Mouse memiliki dua tombol tekan yaitu tombol kiri dan tombol kanan, ada juga
mouse memiliki tiga tombol yang berada di tengah dan disebut dengan tombol scroll
dan berfungsi sebagai tombol putar yang dapat diputar ke arah depan dan belakang.
Supaya mouse dapat digunakan dengan lebih baik, diperlukan pad. Pad adalah alas

tempat mouse digerak-gerakan.

Teknologi Informasi dan Komunikasi N

' Untuk SMP / MTs Kelas VIl



Sekarang ada beberapa hal yang kita pelajari tentang tombol ini:

a. Klik : berarti menekan tombol kiri mouse satu kali.
b. Klik ganda : berarti menekan tombol kiri mouse dua kali dengan cepat.
c. Drag : klik tombol kiri mouse dan ditahan, kemudian
digeser.
d. Klik kanan : berarti mengaktifkan menu baru pada teks yang Gunakan fungsi
keyboard dan mouse
dipilih. serta kombinasinya

dalam pengetikan
dan 'mengedit teks
dokumen penulisan.

D. Menggunakan Menu dan lkon pada
OpenOffice.org Writer

. Menggunakan menu dan ikon untuk membuat dokumen baru
Kita dapat membuka dan membuat dokumen baru yang akan kita tulis di

program aplikasi OpenOffice.org Writer. Pada program pengolah kata OpenOffice.
org Writer menyediakan ada tiga cara, yaitu:
a. Menggunakan Menu Bar pada jendela drop-down menu File:

m Klik menu File.

m Pilih New.

m Kilik pilihan Text Document.

b. Menggunakan shortcut, yaitu:
Ctrl+ N

c. Menggunakan ikon New bergambar pada menu toolbar standar. !] >

|| Edt view Tools Window Help

U TextDocument  Cirh
[ Open.. Clk0 |[g| Spreadshest ]
Recent Documents  + [ Presentation
Wizards v @ Drawing

[a] HTVL Document
ML Form Document
[ Mester Document

) Labals

i) Business Cards

X Close

Ci+s

e As. ClritShift+S

@ Document as E-mall...

Templates v| ] Templates and Documents

Propertes..
& it CteP Gambar 1.13.

;rimer Settings. . Menu membuka

i : dokumen baru
] Exit CtikQ Sumber: Dok. Penulis
[
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2.

Gambar 1.14.

Tombol Cut, Copy, dan
Paste pada toolbar
standar

Sumber: Dok. Penulis

Menggunakan menu dan ikon untuk mengedit dokumen
o =0 -

Untuk menyalin suatu teks tertentu atau perintah Copy, yaitu lakukan seleksi
terhadap teks yang akan disalin tersebut. Kemudian lakukan salah satu langkah di
bawah ini:

a. Memilih menu Edit > Copy.
b. Menekan kombinasi pada keyboard, Ctrl + C.
c. Mengklik tombol Copy pada menu toolbar standar. @

Untuk memotong suatu teks tertentu pada dokumen atau perintah Cut, yaitu
lakukan seleksi terhadap teks yang akan disalin tersebut. Kemudian lakukan salah
satu langkah di bawah ini:

a. Memilih menu Edit > Cut.
b. Menekan kombinasi pada keyboard, Ctrl + X.
c. Mengklik tombol Cut pada menu toolbar standar.

Sedangkan untuk menempelkan suatu teks yang dipilih dari perintah cut dan
copy, lakukan dengan perintah Paste. Dengan cara meletakkan kursor pada posisi
di mana teks tersebut akan ditempelkan dan lakukan salah satu langkah di bawah
ini:

a. Memilih menu Edit > Paste.
b. Menekan kombinasi pada keyboard, Ctrl + V.

c. Mengklik tombol Paste pada menu toolbar standar. ﬁ =

Selain proses penempelan biasa, OpenOffice.org Writer juga menyediakan
proses penempelan khusus yang disebut dengan Paste Special, yaitu dengan cara
meletakkan kursor pada posisi di mana teks tersebut akan ditempelkan dan lakukan
salah satu langkah di bawah ini:

a. Memilih menu Edit > Paste Special.
b. Menekan kombinasi pada keyboard, Ctrl + Shift + V.

c. Mengklik tombol segitiga kecil tepat berada di sebelah kanan tombol Paste pada
menu toolbar standar. ﬁ -

. Menggunakan menu dan ikon untuk membatalkan dan mengulang perintah

Jika karena ada suatu ketidaksengajaan kamu salah melakukan penyuntingan
dalam membuat penulisan dokumen menjadi lebih buruk, kamu dapat melakukan
pembatalan penyuntingan teks dokumen yang telah dilakukan.
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Untuk membatalkan tindakan tersebut yang kamu lakukan adalah dengan
cara:

a. Memilih menu Edit > Undo.
b. Menekan kombinasi pada keyboard, Ctrl + Z.
c. Mengklik tombol ikon pada menu toolbar standar. 4-‘.’ Z

Sedangkan jika pembatalan penyuntingan dokumen tersebut kamu batalkan,
maka kamu dapat mengulangi kembali tindakan terakhir tersebut dengan melakukan
beberapa cara, yaitu di antaranya dengan:

a. Memilih menu Edit > Redo.
b. Menekan kombinasi pada keyboard, Ctrl +Y.
c. Mengklik tombol ikon pada menu toolbar standar. (3 -

4. Menggunakan menu dan ikon untuk menyimpan dokumen
Untuk proses penyimpanan dokumen pada program aplikasi OpenOffice.org
Writer tersebut, kamu dapat melakukannya dengan menu atau ikon. Langkah-langkah
penggunaanya adalah sebagai berikut:
a. Memilih menu File > Save.
b. Menggunakan tombol kombinasi pada keyboard, Ctrl + S.
c. Mengklik tombol ikon disket pada menu toolbar standar. E]

5. Menggunakan menu dan ikon untuk format karakter

Format karakter digunakan untuk menentukan bentuk dari teks yang akan
ditampilkan dalam dokumen. Format yang dapat diatur seperti: jenis font, efek font,
letak teks, warna latar belakang dan hyperlink. Proses format karakter pada program
aplikasi OpenOffice.org Writer melalui kotak dialog karakter yaitu mengaktifkan menu
Format > Character.

6. Menggunakan menu dan ikon untuk mengatur perataan paragraf

Posisi teks atau suatu paragraf dalam dokumen dapat kita atur sesuai keingian.
Posisi ini berfungsi Perataan paragraf ada empat, yaitu: rata kiri, rata tengah, rata
kanan dan rata kiri-kanan.

Untuk mengatur perataan paragraf, yaitu dengan cara lakukan seleksi terhadap
teks atau paragraf yang akan di format tersebut. Kemudian lakukuan salah satu
langkah di bawah ini:

a. Memilih menu Format > Paragraph > Alignment.

b. Mengklik tombol ikon pada menu formatting toolbar.

EEEE

Untuk mempercepat
waktu pengeditan
teks atau terjadi
kesalahan adalam
penulisan, kamu
bisa menggunakan
semua ikon-ikon
yang ada pada
menu Toolbar
standar.

Gambar 1.15.
Ikon alignment
Sumber: Dok. Penulis
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7. Menggunakan menu dan ikon untuk membuat nomor urut

Daftar angka adalah suatu bentuk daftar dari item dan setiap item pada daftar
tersebut diberi berupa angka atau huruf terstruktur. Proses pembuatan daftar angka
ini pada dokumen program aplikasi OpenOffice.org Writer memiliki beberapa cara,

yaitu:

a. Memilih menu Format > Bullets and Numbering.

b. Menggunakan tombol kombinasi pada keyboard, Alt+O+B.

c. Mengklik tombol ikon pada menu formatting toolbar.

Gambar 1.16.
Ikon bullets dan numbering =

Sumber: Dok. Penulis

Praktikum

Sejarah Komputer

Psds tshun 1642, Blaize Pazcal vang pads waktu itu berumur 18 tshun berhasil
meznzmukan pascaling atzu kalkulator roda numerik. Alst ini digunskan untuk membantu
avahnva menghitung pajak.

Seziring dengan perkembanzan ilmu matematiks dan slsktronilka, pads tshun 1821
szorang profzsor matsmatibs Ingeeis bemama Charles Babbage mensmuksn mesin
panehituns vang dibarinama Differsnss Engins. hMeasin ini mempakan eikal bakal muneulnyva
Lomputsr dan merupsksn  kalbulstor otomstis wvang pertsms Lsli muncul Barkat
pensmuannys ini, Charles Babbage kamudisn diksnsl ssbagsi Bapak komputsr dunia.

Pada tshun 1937 manusis tzslah berhasil menciptakan komputar slsktronik.
Selanjuinva, padas tshun 19448, Dr. John Mauchly dan J. Presper Eckert barhasil merskit
Lomputer zlzktronik digital. Komputer ini beratnva mencapai 30 ton dan tardiri dari 18.000
tabung vakum. Komputar ini dikenal szbagai komputer senerasi partama.

Padatshun 1971, sejslan denesn ditemukan chip, ukuran bomputer menjadi semskin

Lacil, dan pada tshun ini puls muncul PC {psrsonal compuisr). PC adslsh Lomputer vang
biaza kita punakan setisp hari, 4i rumah, kantor dan szkolah.

B = % i e

A. Praktikum menyiapkan program OpenOffice.org Writer

1. Jalankan program aplikasi OpenOffice.org Writer!

2. Buatlah lembar dokumen yang baru!

Teknologi Informasi dan Komunikasi N
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B. Praktikum mengetik naskah:

1. Ketiklah teks dokumen di bawah ini.

2. Simpan dokumen tersebut dengan nama file: latihan1.

Sejarah Komputer

Pada tahun 1642, Blaise Pascal yang pada waktu itu berumur 18 tahun berhasil
menemukan pascaline atau kalkulator roda numerik. Alat ini digunakan untuk membantu
ayahnya menghitung pajak.

Seiring dengan perkembangan ilmu matematika dan elektronika, pada tahun
1821 seorang profesor matematika Inggris bernama Charles Babbage menemukan
mesin penghitung yang diberi nama Difference Engine. Mesin ini merupakan cikal bakal
munculnya komputer dan merupakan kalkulator otomatis yang pertama kali muncul. Berkat
penemuannya ini, Charles Babbage kemudian dikenal sebagai Bapak komputer dunia.

Pada tahun 1937 manusia telah berhasil menciptakan komputer elektronik.
Selanjutnya, pada tahun 1946, Dr. John Mauchly dan J. Presper Eckert berhasil merakit
komputer elektronik digital. Komputer ini beratnya mencapai 30 ton dan terdiri dari 18.000
tabung vakum. Komputer ini dikenal sebagai komputer generasi pertama.

Padatahun 1971, sejalan dengan ditemukan chip, ukuran komputer menjadi semakin
kecil, dan pada tahun ini pula muncul PC (personal computer). PC adalah komputer yang
biasa kita gunakan setiap hari, di rumah, kantor dan sekolah.

*hkkk
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. OpenOffice.org Writer merupakan salah satu program perangkat lunak yang berfungsi sebagai

aplikasi pengolah kata dan bersifat Free Software, berguna untuk membuat dokumen, brosur,
makalah maupun kertas ucapan.

Jendela OpenOffice.org Writer terdiri atas dua belas komponen, antara lain yaitu: title bar, menu
bar, toolbar standar, formatting toolbar, drawing toolbar dan status bar. Pada komponen menu
bar, di dalamnya terdapat menu-menu yang dikelompokkan berdasarkan fungsi perintahnya.
Jika kita mengklik salah satu menu, akan muncul jendela drop-down.

Ikon adalah simbol dari shortcut yang berfungsi untuk mempercepat suatu perintah yang akan
dijalankan atau dipilih dalam membuat dan memodifikasi suatu dokumen di program aplikasi
OpenOffice.org Writer. lkon-ikon tersebut terletak di dalam bagian menu toolbar standar,
formatting toolbar dan drawing toolbar.

. Keyboard dan mouse merupakan dua contoh bagian dari hardware berupa alat input. Keyboard

berfungsi untuk memasukkan angka, huruf, simbol dan karakteristik tertentu yang ditampilkan
pada layar monitor komputer. Sedangkan mouse berfungsi untuk memilih menu-menu dalam
menjalankan perintah-perintah tertentu sesuai keinginan berupa simbol atau ikon pada jendela
OpenOffice.org Writer.

Dalam memodifikasi atau meng-edit suatu teks dan paragraf tertentu dalam dokumen OpenOffice.
org Writer, diperlukan tool-tool perintah pada menu formatting toolbar. Sehingga teks atau
paragraf tersebut dari yang penulisannya biasa-biasa saja kemudian akan menjadi lebih menarik
dan lebih rapih struktur tulisannya.

. Teknologi Informasi dan Komunikasi NN
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ISTILAH |

~Glosarium

KETERANGAN

Disket penyimpan data ke dalam komputer
Drop Down kotak pilihan masukkan perintah berbentuk seperti daftar
Download mengambil file atau program dari internet ke komputer

Free Software

perangkat lunak yang bersifat gratis dan tidak ber lesensi

Ikon menu perintah yang di wakili dengan simbol bergambar
Input data yang akan diolah dengan komputer
Mouse pad alas tempat mouse digerakkan
Shortcut perintah dengan singkat
Software perangkat lunak yang di instal ke dalam komputer
Toolbar sebuah simbol atau ikon-ikon yang dikelompokkan berdasarkan fungsinya
Tombol bagian alat untuk mengaktifkan dan me-non-aktifkan dari perintah tertentu
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

ZQ‘ Teknologi Informasi dan Komunikasi

Termasuk program pengolahan
OpenOffice.org Writer itu ....

a. pengolah angka

b. pengolah data

c. pengolah gambar

d. pengolah kata

OpenOffice.org Writer dapat dijalankan pada
dua sistem operasi, yaitu ....

a. Linux dan windows

b. Linux dan mac

c. windows dan apple

d. mac dan apple

Program OpenOffice.org Writer,
dalam menu ....

a. games

b. graphics

c. internet

d. office

terdapat

Lembar kerja OpenOffice.org Writer disebut
dengan ....

a. blank database

b. blank page

c. text documents

d. spreadsheet

Bagian yang berisi nama dokumen yang
sedang aktif atau yang digunakan bernama

. kontrol jendela
title bar
formatting toolbar
toolbar standar

e e oo

Untuk SMP / MTs Kelas VIII

apakah 6.

. Fungsi menu ikon ini

10. Apa fungsi ikon ini

Drawing toolbar berfungsi untuk ....
a. menyisipkan tabel

b. menyisipkan gambar

c. format teks atau paragraf

d. format halaman

. Untuk menebalkan huruf atau angka pada

dokumen, menggunakan simbol format ....
a. A

b. B

c.C

d. |

=

adalah untuk

. menyimpan dokumen

. menghapus dokumen
mengganti nama dokumen
. membuka dokumen

Qa0 oo

. Perintah untuk menduplikat suatu teks atau

paragraf yang dipilih, dapat menggunakan
shortcut pada keyboard berupa ....
a.Ctrl+C

b. Ctrl + P

c. Ctrl+V

d. Ctrl + X

a. rata kanan

b. rata kiri

c. rata kanan dan rata Kiri
d. rata tengah



B.Lengkapilah jawaban dengan tepat.

1.

o

Menu toolbar pada OpenOffice.org Writer yang utama dan aktif terdiri atas tiga
komponenyaitu....,.... dan....

. OpenOffice.org Writer merupakan program paket perangkat lunak dari program perkantoran .

Menu maximize berfungsi untuk . . . .
Jelaskan fungsi scrollbar pada OpenOffice.org Writer . . . .

Menu toolbar yang digunakan untuk menampilkan toolbar tersembunyi terdapat pada submenu

. Bagaimana cara memasukkan gambar ke dalam dokumen OpenOffice.org Writer?
. Jelaskan perbedaan antara menu Bullets dan menu Numbering!

6
7
8.
9

Apa yang dimaksud dengan funngsi kombinasi pada keyboard?

. Ctrl + V memiliki fungsi untuk . . . .

10. Menu insert memiliki fungsi untuk . . . .

C.Jawablah pertanyaan di bawah ini dengan tepat.

1.

Jelaskan langkah-langkah menjalankan program OpenOffice.org Writer!

. Apa definisi dari toolbar?
. Jelaskan apa yang dimaksud dengan document!

2
3
4.
5

Sebutkan dan jelaskan fungsi dari menu-menu OpenOffice.org Writer, minimal 57

. Ada berapa cara untuk menutup jendela dari program OpenOffice.org Writer? Jelaskan!

D. Soal praktik.

1.

2
3.
4

| Teknologi Informasi dan Komunikasi

Jalankan program OpenOffice.org Writer!

. Buatlah lembar dokumen yang baru!

Ketiklah teks dokumen di halaman berikut ini!

. Simpan dokumen tersebut dengan nama file: latihan3!

/f‘ 25

Untuk SMP / MTs Kelas VIl \/N



Blogger

Blog berasal dari kata Weblog, yang intinya merupakan sebuah halaman web yang berisi
catatan pemilik web. Catatan-catatan ini memiliki keterangan waktu. Biasanya terdiri atas tanggal,
bulan, dan tahun.

Sejarah munculnya weblog dirintis oleh PyraLab dengan membuat Blogger. Merupakan
situs internet yang berisi catatan pribadi serta topik-topik yang dibuat pemiliknya. Tahun demi tahun
berganti situs Weblog pun bermunculan dan mulai memikat penggemarnya. Muncullah WordPress,
Multiply, Blogspot/Blogger, Blogdrive, Live Journal My Opera, FaceBook, dan lain sebagainya.

Weblog tersebut amat popular digunakan karena fasilitas serta kemudahan yang ditawarkan
oleh blog gratis tersebut. Disebut blog gratis karena user/pengguna cukup melakukan pendaftaran
pada situs resmi blog tersebut, yang selanjutnya user akan dapat langsung menggunakan blog
tersebut. Ada pula versi berbayar, yang berarti kamu harus memiliki webhosting dan domain sendiri.
Dalam versi berbayar, kamu harus melakukan penginstalan software blog tersebut pada webhosting
yang kamu miliki. Contoh blog tersebut misalnya Wordpress.

Blogger merupakan situs blog milik Google, pada awalnya dimiliki oleh Pyralab, baru pada
bulan Februari 2003 diakuisisi oleh Google. Sedangkan blog Multiply merupakan penyedia layanan
blog yang juga merupakan situs social networking seperti Friendster dan FaceBook. Bebicara
masalah social network, blog juga dapat membangun jaringan sosial. Jaringan sosial dibangun
dengan koneksi dari teman kita ke teman dari teman kita, dan memiliki kaitan yang luas hanya
berdasarkan profil pengguna situs tersebut. Artinya, semakin banyak dan berbobot tulisan kamu
atau setidaknya menarik, maka orang akan banyak berkunjung dan membangun jaringan sosial
untuk blog kamu.
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Membuat Dokumen

Sederhana

Untitled 1 - OpenOffice org Writer:

File Edit View Insert Format Table Tools Window Help

o Data ielalui peralatan fnput untuk diproses olsh
peralatan gloss Falings poria nfomasl Akan diamplkan pads peraialan otipu loanwm Jmpan
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erkembangan teknologi informasi dan

komunikasi sekarang ini sangat cepat. Hal ini

ditandai dengan munculnya alat-alat teknologi
yang dibuat oleh manusia. Alat teknologi ini sangat
membantu aktifitas manusia sehari-hari sehingga lebih
efisien, cepat dan akurat.

Selain teknologi pada perangkat keras, kita
juga mengenal perangkat lunak atau software.
Aplikasi perangkat lunak yang sering kita gunakan
sehari-hari untuk membuat dokumen, brosur atau
undangan merupakan bagian perangkat lunak yang
disebut dengan perangkat lunak aplikasi. OpenOffice.
org Writer merupakan aplikasi perangkat lunak untuk
mengelolah dokumen dan bersifat gratis.

Jika kamu pernah membuat dokumen atau
surat undangan dengan menggunakan Microsoft
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Peta Konsep

MEMBUAT DOKUMEN
SEDERHANA

Dokumen Mﬁ rrIIformat Memformfat Mengguna- Menyimpan | Mencetak
baru alaman paragra kan Header dokumen | dokumen
dokumen dokumen dan Footer

= Membuat m Ukuran kertas m Bentuk m Menambakan m Save
dokumen baru m Batas kertas paragraf header m Save As
m Membuka m Posisi halaman m Mengatur m Menambakan m Menyimpan
dokumen lama paragraf footer dengan
dengan mouse password
m Indentasi
m Jarak spasi

yang ada di dalam program aplikasi pengolah angka OpenOffice.org Writer. Selain itu juga

kamu sudah mengerti tentang fungsi dari masing-masing ikon yang terdapat dalam menu
komponen tersebut. Dalam menggunakan alat keyboard dan mouse, kita juga sudah dibahas.
Diharapkan pada bab tersebut, kamu dapat memahami cara penggunaan menu-menu yang ada di
OpenOffice.org Writer dengan mudah.

P ada bab sebelumnya, kita sudah mempelajari dan membahas tentang komponen-komponen

Untuk selanjutnya di bab 2 ini, kamu akan mempelajari cara penggunaan dari fungsi utama
ikon-ikon tersebut. Di mulai dari menjalan program OpenOffice.org Writer, membuat dokumen baru,
format dokumen sampai dengan menyimpan dokumen.

format, dokumen, ikon, tombol, program, naskah, klik, menu, paragraf, spasi, pengolah kata
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A. Membuat Dokumen Baru

Pengelolaan dokumen pada OpenOffice.org Writer merupakan hal mendasar yang
harus dikuasai secara baik, karena hampir setiap pekerjaan yang kita lakukan dengan

OpenOffice.org Writer akan melibatkan hal tersebut..

1. Membuat dokumen baru

Pada dokumen yang kamu aktifkan, akan terlihat titik sisi sebagai tempat
untuk mengetik naskah di atas lembar dokumen. Pembuatan dokumen baru pada
OpenOffice.org Writer dapat dilakukan dengan dua cara, yaitu:

Cara 1: Menggunakan task panel pada menu bar, dengan langkah-langkah

sebagai berikut:

1. Klik menu File.

2. Klik New.

3. Pilih Text Document (Ctrl + N).

2| Edit View Tools Window Help

Hew s
Open... Ctri+0

Recent Documents

0
)

Wizards '

Document as E-mall...
Templates v

B TextDocument  CiriN
o] Spreadshest
Presentation

[ Drawing

[8] HTML Document
XML Form Document
[} Master Document

Labels
Business Cards

Templates and Documents

Properties...

& Print.. CikF
Printer Settings..

# Exit Ctri+Q

Cara 2: Menggunakan menu ikon Text Document pada toolbar standar.

Eile

Text Document
Spreadsheet
Fresentation
Drawing

Edit Wiew Tools MWindow Help

Master Docume

HTML Document
KML Form Document

nt

Labels
Business Cards

| 0 0! | O (60 (@) | () ) @ fa

Templates and Documents

Gambar 2.1.
Task panel pada menu

Sumber: Dok. Penulis

Gambar 2.2.
lkon New Documents

Sumber: Dok. Penulis
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Gunakan fungsi
Ctrl+N atau Ctrl+O
pada keyboard untuk
membuat dokumen
baru atau membuka
dokumen yang
tersimpan di dalam
disk.

Gambar 2.3. | P e
Kotak dialog Open | 1 zesony

Sumber: Dok. Penulis

Gambar 2.4.

Ikon Open pada menu toolbar ![ T E @ g @ HB@&?@ E%Ef

1. Membuka dokumen lama

Dokumen yang telah kamu simpan dalam disk atau media penyimpanan
lainnya, dapat ditampilkan atau diaktifkan kembali oleh program OpenOffice.org
Writer dilayar monitor dengan cara sebagai berikut:

Cara 1: Menggunakan task panel pada menu bar:

1. Klik menu File

2. Klik Open ( Ctrl + O ) sampai kotak dialog Open muncul.

= BRen =l

B

Places Mame v Moditied | —
lo Search & Desktop Thursday
@) Recently Used | Documents 03/08/2009
_ | Dokumen 12/28/2008
i Desktop | Examples 04/27/2008
£ File System [ Music 03/01/2009
. 156 GB Media | Pictures 03/14/2009
.51 GB Media | Public 02/16/2009
£ DATA I Templates 02/16/2009
| Documents | Videos 02/16/2009
| Music

| Pictures

| videos

Add Remove Allfiles

Version:

Cara Il : Menggunakan ikon pada menu toolbar standard

standar
Sumber: Dok. Penulis

SPraktikum

A. Praktikum menyiapkan program:

1. Nyalakan sistem komputermu!

2. Jalankan program aplikasi OpenOffice.org Writer!

3. Siapkan halaman berukuran A4!

B. Praktikum menyiapkan dokumen:

1. Buatlah dokumen baru!

2. Ketiklah naskah di halaman berikut ini!

3. Simpan dokumen tersebut dengan nama file: Latihan2a_Namal!

: % Teknologi Informasi dan Komunikasi N
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Tahukah siapa pendiri Linux itu ?

Kenal Linus Torvalds kan? Linus dilahirkan di Helsinki, Finlandia pada
tanggal 28 Desember 1969. Orang yang disebut sebagai Bapak Linux(LINus UniX)
ini, sudah mengenal bahasa pemrograman pada umurnya yang ke 10. Saat itu ia
sering mengutak-atik komputer kakeknya, Commodore VIC-20. Karena hobinya
dalam dunia komputing, 1988 Linus diterima di Univerity of Helsinki dan pada tahun
1990, Linus memulai kelas pemrograman C pertamanya.

Linus lebih cenderung untuk menggunakan sistem operasi UNIX seperti
yang dipakai komputer milik universitasnya. Akhirnya ia mengganti sistem operasi
openSource Minix yang berbasiskan UNIX. Adapun Minix ini merupakan sistem
UNIX kecil yang dikembangkan oleh Andrew S. Tanenbaum, seorang professor yang
menggeluti penelitian masalah OS dari Vrije Universiteit, Belanda. Adapun Minix ini
digunakan untuk keperluan pengajaran dan pendidikan.

Namun Linus merasa bahwa Minix masih memiliki banyak kelemahan. Dan
mulai saat itu, di usianya yang ke-23, Linus mulai mengutak-atik kernel Minix. Dan
ia mulai mengembangkan sistem yang kompatibel dengan IBM PC. Pada bulan
Agustus 1991, lahirlah Linux 0.01 hasil oprekan Linus, dan pada tanggal 5 Oktober
1991, secara resmi Linus mengumumkan Linux 0.02 yang hanya dapat menjalankan
BASH dan gcc compiler.

Sampai saat ini, Linux dibangun oleh berbagai macam komunitas dan jangan
heran apabila banyak sekali distro-distro Linux yang beredar. Mulai dari yang berbayar
sampai yang gratis, dari untuk pemula sampai tingkat lanjut, dan biasanya dengan
banyaknya distro Linux yang beredar akan membuat orang awam bingung untuk
memilih distro. Bayangkan, ada beratus-ratus distro yang tercipta atau bahkan beribu-
ribu. Namun perlahan tapi pasti, diantara distro-distro Linux ini ada yang menyamai
(atau bahkan) melebihi kemampuan dari Sistem Operasi keluarga raksasa (Microsoft)
dan dengan semakin mudahnya dan semakin lengkapnya dukungan Linux pada
hardware, besar kemungkinan Linux akan menjadi alternatif (atau bahkan sistem
operasi utama di dunia).

Teknologi Informasi dan Komunikasi
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B. Mengatur format halaman

Pengaturan formatlembar kertas kerja sangat penting dibutuhkan untuk kerapihan
dalam penulisan dokumen. Sehingga maksud dari isi dokumen tersebut terlihat jelas
dari susunan format dokumennya. Untuk format halaman terdiri atas ukuran kertas,
batas kertas dan posisi kertas.

1. Ukuran kertas

Kamu dapat memilih ukuran kertas dengan menggunakan menu Format >
Page. Dengan mengaktifkan menu tersebut, akan muncul kotak dialog Page Style.
Pilihlah ke tab (halaman) Page seperti terlihat pada gambar 2.5.

Pada kondisi awal, jenis kertas yang ditampilkan adalah Letter, dengan besar
ukuran lebar 21,59 cm dan ukuran panjang 27,94 cm. Untuk mengganti jenis kertas
tersebut, pilihlah salah satu pilihan yang disediakan oleh drop down format dengan
gambar kecil panah ke bawah. Kamu juga bisa memasukkan nilai ukuran kertas
tersebut pada kotak teks Width dan Height, jika jenis pilihan kertas tidak tersedia.

B Ty1er DBTATITT I —

|Organizer |Pagl!| Background | Header | Footer| Borders| Columns| Footnote |

Paper format

Eormat Letter o

Width 21.59cm :
Height 27 94cm :

Orientation @® Portrait

() Landscape Paper tray |[From printer settings] 3 |
Margins Layout settings
Left [2.00cm : ‘ Page layout Right and left ¢ ]
[ — P |
Right [2.00cm = Format 1,23, .. 3

Top [2.00cm : [ ] Register-true
Bottom [2.00em : Reference Style

Gambar 2.5.
Kotak dialog page style

Sumber: Dok. Penulis

Ok || Cancel || Help || Eeset
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2. Batas kertas

Batas kertas dokumen penulisan atau Margin, adalah besar ukuran ruang
kosong untuk menulis dengan kata lain adalah jarak antara batas area cetak kertas
dengan tepi kertas. Ruang tersebut dapat digunakan untuk menampilkan gambar,
nomor halaman, header dan footer, catatan kaki dan lain sebagainya. Margin
ditampilkan dengan bingkai garis berwarna tidak terang atau pudar yang mengelilingi
batas area cetak.

A

v

Batas teks area

Untuk menentukan batas penulisan kertas, masukkan nilai ukuran margin yang
diinginkan pada kotak teks Left, Right, Top dan Bottom di kotak dialog gambar 2.5.
Apabila kamu tidak menginginkan bingkai margin pada kertas tersebut, kamu dapat
menyembunyikannya dengan menggunakan menu View > Text Boundaries.

3. Orientasi kertas

Orientasi kertas yaitu format tampilan posisi lembar
kertas kerja penulisan. Pada gambar 2.7. layout orientasi
ini ditampilkan dua macam vyaitu Portrait (bentuk tegak)
dan Landscape (bentuk datar).

Portrait

Landscape

Gambar 2.6.

Garis yang
menunjukkan
margin

Sumber: Dok. Penulis

Gambar 2.7.
Jenis Orientasi Kertas

Sumber: Dok. Penulis

Jika kamu ingin
mengetik berupa
artikel berbentuk
koran, disarankan
untuk mengatur
format paragraph
dari awal dan posisi
kertas menggunakan
portrait.
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2 Praktikum

A. Praktikum menyiapkan program:

1. Nyalakan komputer.
2. Jalankan program aplikasi OpenOffice.org Writer

B. Praktikum menyiapkan dokumen:

1. Buatlah dokumen baru di bawah ini
2. Atur format kertas dengan jenis kertas A4 dan orientasi kertas portrait.

3. Simpan dokumen dengan nama file: Latihan2b_Nama.

SEJARAH LINUX

Kernel Linux pada mulanya ditulis sebagai hobi oleh pelajar Universitas Finland
Linus Torvalds yang belajar di Universitas Helsinki, untuk membuat kernel seperti Minix yang bebas
dan dapat di rubah. (Minix adalah projek pelajaran menyerupai UNIX yang dibuat Prof. Tanenbaum
untuk menjadi mudah dan bukan untuk kegunaan perniagaan.) Versi 0.01 dikeluarkan ke Internet
pada bulan September 1991, Versi 0.02 pada 5 Oktober 1991.

Sejarah sistem pengoperasian berdasarkan Linux berkaitan erat dengan projek GNU,
projek program ini terkenal dipimpin oleh Richard Stallman. Projek GNU bermula pada 1983 untuk
membuat sistem pengoperasian seperti Unix kompiler lengkap, aplikasi utiliti, utiliti pembangunan dan
seterusnya dibuat sepenuhnya dengan Program Gratis. Pada 1991, apabila versi pertama rancangan
Linux ditulis, projek GNU project telah menghasilkan hampir kesemua komponen sistem ini kecuali
kernel. Torvalds dan pembangun kernel seperti Linux menyesuaikan kernel mereka supaya dapat
berfungsi dengan komponen GNU, dan seterusnya mengeluarkan Sistem Pengoperasian yang
cukup berfungsi. Oleh itu, Linux melengkapkan ruang terakhir dalam rancangan GNU.

Walaupun kernel Linux dilisensikan di bawah GNU General Public License, ia bukan
sebesar dari projek GNU. Tux, seekor Penguin, merupakan logo dan maskot bagi Linux. Linux
adalah label perdagangan (SN: 1916230) yang dimiliki oleh Linus Torvalds. Linux terdaftar sebagai
"Program sistem operasi komputer bagi pengguna komputer dan operator”. Label perdagangan ini
diletak setelah berlaku pada saat kejadian di mana seorang pemalsu bernama William R Della Croce
Jr bermula dari mengirimkan surat kepada para distributor Linux yang mengklaim label perdagangan
Linux adalah pemiliknya, serta meminta royalti sebanyak 10% dari mereka. Para pengguna Linux
mulai mendukung agar label perdagangan ini diberikan kepada Linus Torvalds. Perlisensian label
dagang Linux sekarang ini, dikendalikan oleh Linux Mark Institute.

Terdapat banyak distribusi Linux (lebih dikenali sebagai Distro), yang dibuat oleh
individu, grup, dan lembaga lain. Masing-masing mungkin disertakan dengan program sistem
operasi dan program aplikasi tambahan, di samping menyertakan suatu program yang memasang
keseluruhan sistem dalam komputer baru tersebut.

34 . Teknologi Informasi dan Komunikasi .
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C. Format Paragraf

Paragraf atau alinea, berisi sekumpulan teks atau kalimat yang mempunyai satu
pemikiran tertentu. Tampilan yang kamu buat akan terlihat lebih baik dan menarik, apabila
melakukan pengaturan paragraf secara baik.

1. Mengenal bentuk paragraf

Pada program aplikasi pengolah kata OpenOffice.org Writer, menu paragraf
dapat kamu aktifkan dengan memilih menu Format > Paragraph. Di dalam kotak
dialog Paragraph disediakan delapan jendela untuk memformat tampilan paragraf
dalam penulisan dokumen dengan fungsinya sendiri.

Salah satunya adalah menu tab pada Drop Caps yang berfungsi untuk
mengubah format huruf awal pada kalimat pertama di dalam suatu teks atau paragraf
menjadi ukuran yang lebih besar dengan karakteristik yang lebih mencolok. Perhatikan
gambar 2.8 di bawah ini.

|'- =} Paragrapi =

| Indents & Spacing | Alignment | Text Flow | Mumbering | Tabs |Drop Caps| Borders | Background |

Settings
& Display drop caps d

] Whole word

Mumber of characters: |1 :

S
Space to text |m
Contents
Text d |
Character Style |[None] & |

2. Mengatur paragraf dengan mouse

Kursor pada mouse atauttitik sisip adalah awal tempat kita melakukan pengetikan.
Cara untuk memformat paragraf dari dokumen OpenOffice.org Writer dengan
menggunakan mouse adalah pertama dengan memilih paragraf dan meletakkan
kursor di awal teks sambil menekan dan tahan tombol kiri mouse. Kamu geser kursor
tersebut sampai dengan akhir teks masih dalam satu paragraf, kemudian pilih dan klik
menu format paragraf dengan cara Format > Paragraph.

Gambar 2.8.
Kotak dialog
paragraph

ok || cancel || mep || Reset || Sumber: Dok. Penulis

Y 1.inologi Informasi dan Komunikasi
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3. Membuat indentasi

Indentasi berfungsi untuk mengatur jarak antara sisi teks pada paragraf

dengan sisi batas penulisan teks. Beberapa pengaturan yang ada pada menu tab
Indents & Spacing dari menu Paragraph yaitu:

a. Before text, berfungsi untuk mengatur jarak antara sisi kiri paragraf dengan batas
margin Kiri.

b. After text, berfungsi untuk mengatur jarak antara sisi kanan paragraf dengan
batas margin kanan.

c. First line, digunakan untuk pengaturan seberapa jauh baris pertama paragraf
akan menjorok lebih ke dalam atau ke luar dibandingkan dengan baris kedua,
dan seterusnya.

4. Mengatur jarak spasi

Gambar 2.9.

Menu kotak dialog
Paragrph pada
halaman Indents &
Spacing

Sumber: Dok. Penulis

Spasi baris adalah pengaturan jarak antara paragraf baris pertama dan baris
berikutnya. Pada OpenOffice.org Writer memiliki 7 macam spasi. Spasi atau jarak
antar baris pada umumnya memiliki nilai sebesar 1, 1.5 dan 2. Perhatikan gambar
2.9 di bawah ini pada kotak Line spacing.

|ra Paragrapn =

[Indents & Spacing | Alignment | Text Flow | Numbering | Tabs | Drop Caps | Borders | Background |

Indent

Before text |

After text |

Eirst line proserm (3] | e—————

[ ] Autornatic I
R— I

Abgve paragraph |

Below paragraph |@
Line spacing

‘Slngle S RET El

Register-true
[ | Activate

SPraktikum

A. Praktikum menyiapkan program:

1. Nyalakan sistem komputer mu.

2. Jalanka

n program aplikasi OpenOffice.org Writer.

3. Siapkan halaman berukuran A4 dan orientasi kertas portrait.

B. Praktikum menyiapkan dokumen:

1. Buatlah
2. Ketiklah
3. Simpan

dokumen baru.
naskah di halaman berikut!

dokumen dengan nama file: Latihan2c_Nama
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Puisi Persahabatan
Karya Kahlil Gibran

Dan jika berkata, berkatalah kepada aku tentang kebenaran persahabatan?

Sahabat adalah kebutuhan jiwa, yang mesti terpenuhi.

Dialah ladang hati, yang kau taburi dengan kasih dan kau panen dengan penuh rasa terima
kasih.

Dan dia pulalah naungan dan pendianganmu.

Karena kau menghampirinya saat hatilapa dan mencarinya saat jiwa butuh kedamaian.
Bila dia bicara, mengungkapkan pikirannya, kau tiada takut membisikkan kata “tidak”
di kalbumu sendiri, pun tiada kau menyembunyikan kata “ya”.

Dan bilamana ia diam, hatimu tiada ‘kan henti mencoba merangkum bahasa hatinya; karena
tanpa ungkapan kata, dalam rangkuman persahabatan, segala pikiran, hasrat, dan keinginan
terlahirkan bersama dengan sukacita yang utuh, pun tiada terkirakan.

Di kala berpisah dengan sahabat, janganlah berduka cita; Karena yang paling
kaukasihi dalam dirinya, mungkin lebih cemerlang dalam ketiadaannya, bagai sebuah
gunung bagi seorang pendaki, nampak lebih agung daripada tanah ngarai dataran.

Dan tiada maksud lain dari persahabatan kecuali saling memperkaya ruh kejiwaan. Karena
kasih yang masih menyisakan pamrih, di luar jangkauan misterinya, bukanlah kasih, tetapi
sebuah jala yang ditebarkan: hanya menangkap yang tiada diharapkan.

Dan persembahkanlah yang terindah bagi sahabatmu.

Jika dia harus tahu musim surutmu, biarlah dia mengenal pula musim pasangmu.
Gerangan apa sahabat itu hingga kau senantiasa mencarinya,

untuk sekadar bersama dalam membunuh waktu?

Carilah ia untuk bersama menghidupkan sang waktu!

Karena dialah yang bisa mengisi kekuranganmu, bukan mengisi kekosonganmu.

Dan dalam manisnya persahabatan, biarkanlah ada tawa ria berbagi kebahagiaan.

Karena dalam titik-titik kecil embun pagi, hati manusia menemukan fajar jati dan gairah segar
kehidupan.

Sumber: http://toppuisi.blogspot.com/2007/12/persahabatan_22.html
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D. Menggunakan Header dan Footer

Header adalah area di dalam margin atas yang dapat diberi teks atau gambar.
Dan Footer merupakan area di dalam margin bawah yang dapat diberi teks atau
gambar. Fungsi header atau footer ini biasanya untuk menampilkan nomor halaman,
judul dokumen, penulis dokumen dan lain sebagainya.

1. Menambahkan header

Header adalah elemen yang letaknya berada di atas dari lembar halaman
dokumen. Untuk menyisipkan header ke dalam dokumen kamu adalah dengan cara
memilih menu Insert > Header > Default.

2. Menambahkan footer

Footer adalah elemen yang letaknya berada di bawah dari lembar halaman
dokumen. Untuk menyisipkan footer ke dalam dokumen kamu adalah dengan cara
memilih menu Insert > Footer > Default.

Manual Break...

Fields *
3 Special Character...

Formatting Mark v

Section...
[ ] Hyperlink

Footer *
Footnote, ..

Caption...
= Bookmark. ..
Cross-reference. ..
] MNote. .

Script...

Gambar 2.10. Indexes and Tables »
Menu Header dan Footer

Sumber: Dok. Penulis Enyelope...
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DEPARTEMEN PENDIDIKAN NASIONAL
PROVINSI DKIJTAKARTA

SMP MUTIARA BANGSA
JAKARTA
Jalan, Rava Bogor Km. 31, Jakarta Timme 13270
Teleppn. : (021) 809 01234

SURA UGAS
Nomes; 234 Bddkn SHENE-JKT 112009

Bapale SMP hlntiare Seneva Jekets Timur, danezn il manuessken banade namanama dlbawah,
ol

hiic) :303134278

Sshaest Kansdinatr Penitis Demssan Bandidiben den Bromasi Bsnarimess Mineid Beon Tl
Bilsiaran 20092010 vane dilsksanshan nada -

Hagi -Kamiz 54 Mingmy

Toeml 265,429 Mgt 2009

Wk 20700 - salazsi

Damikian sniat twess il dibuat vatek: ailshssnaban densan sabalbchalnys sags nepphrase
tepesune igvah, Samoass kasnkesnsn. manveraikit saboa, min

A. Praktikum menyiapkan program:

1. Nyalakan sistem komputer mu.
2. Jalankan program aplikasi OpenOffice.org Writer.

B. Praktikum menyiapkan dokumen:

1. Buatlah dokumen baru.
2. Siapkan halaman berukuran Letter dan orientasi kertas portrait

C. Praktikum membuat kop surat:

1. Aktifkan perintah untuk menyisipkan header, Insert > Header >
Default

2. Buatlah naskah dibawah ini didalam kotak header.
3. Kemudian letakkan kursor diluar kotak header dan dobel klik

o DEPARTEMEN PENDIDIKAN NASIONAL
m PROVINSI DKI JAKARTA
N\
(@) &= SMPNUSANTARA JAKARTA
) == 4

Jalan. Raya Bogor Km. 24, Jakarta Timur
Telepon.: (021) 82442119
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D. Praktikum membuat naskah surat:

1. Letakkan kursor dibawah kotak header pada dokumen yang dibuka.
2. Ketik dan aturlah naskah dokumen surat di bawah ini ....
3. Simpan dokumen dengan nama file: Latihan2d_Nama

SURATTUGAS
Nomor: 234 /Pddkn/SMP ST JKT/111/2009

Assalamualaikum wr. wb.

Kepala SMP NUSANTARA Jakarta Timur, dengan ini menugaskan kepada nama-
nama di bawah ini:

Nama Lengkap :Agus Sucipto, S.Pd.
NIP : 303 134 278

Sebagai Koordinator Panitia Pameran Pendidikan dan Promosi Penerimaan Murid
Baru Tahun Pelajaran 2009/2010 yang dilaksanakan pada:

Hari : Kamis s/d Minggu
Tanggal : 26 s.d. 29 Maret 2009
Waktu : 07.00 - selesai

Demikian surat tugas ini dibuat untuk dilaksanakan dengan sebaik-baiknya serta
penuh rasa tanggung jawab. Semoga kesuksesan menyertai kita semua. Amin

Wassalamu’alaikum wr. wb.

Jakarta, 2 Maret 2009
Kepala Sekolah,

Ir. Muh. Rifai, S.Pd
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E. Menyimpan Dokumen

Setelah teks penulisan dokumen selesai diketik, maka dilakukan penyimpanan
dengan memberi nama file dokumen. Penyimpanan dapat kamu lakukan ke dalam
berbagai media penyimpanan yang didukung oleh komputer yang menjalankan
OpenOffice. Writer, misalnya hard disk, disket atau Flashdisk.

. Save

Untuk proses penyimpanan dokumen pada program aplikasi OpenOffice.org
Writer tersebut kamu dapat melakukannya dengan beberapa cara, yaitu:

1. Memilih menu File > Save. [ Hew .

i3 open... Ctri+C
Fecent Documents 3

2. Menggunakan tombol kombinasi pada keyboard,
Ctrl + S.

3. Mengklik tombol ikon disket pada menu toolbar

standar. E]

Wizards 3

M Close

[Z] save Ctri+5S

Save As... Ctri+Shift+S
Save All

[] Reload

Wersions. ..

[#] Export...
Export as PDF ..
Send 3

2

Froperties ...
Digital Signatures. ..
Templates

Freview in Web Browser

. Save As

Fage FPreview
BErint...
Frinter Settings. ..

Ztri+F

Gambar 2.11.
Menu menyimpan
dokumen

& Wl

Exit L+

Sumber: Dok. penulis

Apabila sebuah dokumen pernah disimpan sebelumnya, maka penyimpan

berikutnya hanya dilakukan terhadap perubahan yang terjadi tanpa meminta
nama dokumen sebelumnya. Namun untuk proses penyimpan dilakukan dengan
penggantian nama dokumen yang baru dari nama dokumen sebelumnya, kamu dapat

melakukannya dengan cara:

1. Memilih menu File > Save As.

2. Menggunakan tombol kombinasi pada keyboard, Ctrl + Shift + S.
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3. Menyimpan dengan password

Gambar 2.12.

Kotak dialog proteksi file
dokumen

Sumber: Dok. Penulis

Untuk keamanan file dokumen yang kamu buat, OpenOffice.org Writer telah
memiliki fasilitas tambahan pada kotak dialog Save. Caranya adalah sebelum kamu
menekan tombol Save, beri tanda cek list ( V ) pada kotak Save with password,
kemudian masukkan nama file dokumen lalu tekan tombol Save.

Save = e

Hame II ‘
Save in folder §=-imam

~ Browse for other folders
Create Foidar
Places — | name v | Modified ||
le search Deskto Thursday

'S - p Y

) Recently Used | Documents : 03/08/2009

5% imam | Dokumen ‘12/28/2008

s Desktop L Examples 04/27/2008

£ File System | music $03/01/2009

£ 156 GB Media | Pictures - 03/14/2008

£ 5.1 GB Media L Public - 02/16/2008

£ pATA L Tempiates $02/16/2009

| Documents [=] | L] Videos +02/16/2008 |||

Add Remove: ODF Text Document (.odt) |
[> File type
Edit filter setting

[] Save with password

F. Mencetak Dokumen

Setelah teks dokumen yang kamu ketik sudah selesai dan format dokumen sudah
sesuai dengan keinginanmu, dokumen tersebut dapat dicetak ke media pencetakan

yaitu printer. Sebelum kamu melakukan pencetakan

Digital Signatures...
Templates

[ Mew v
(L Open... Ctri0 dengan printer, pastikan program aplikasi printer sudah
Recent Documents  » terinstal di dalam komputermu.
Wizards v
X Close Ada beberapa langkah untuk melakukan pencetakan
[=] save Ctri+S dokumen melalui printer, yaitu:
Save As... Cti+Shift+5
Save Al 1. Memilih menu File > Print.
[] Reload i i
irkianace 2. Menggunakan LBI ol kombinasi pada keyboard,
= ge— Ctrl + P.
Export as PDF... 3. Mengklik tombol ikon disket pada menu toolbar
il ' standar.
[5] Properties...

Preview in Weh Browser

Gambar 2.13. ]
Menu mencetak [

Page Preview

Brint... Ctri+P

dokumen 4% Printer Settings...

Sumber: Dok. Penulis

&

Exit Ctri+Q
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1. Untuk membuat dokumen baru menggunakan program OpenOffice.org Writer sangatlah mudah.
Dengan memilih ikon bergambar kertas pada menu foolbar standar, lembar kerja kosong akan
ditampilkan.

2. Pengaturan format lembar kerja sangatlah penting dalam membuat suatu dokumen, misalnya
membuat surat kerja atau surat undangan. Pengaturan format halaman ini dapat kamu lakukan
di menu File > Page. Semua format halaman dan paragraf ada di dalam.

3. Header dan Footer bisa kita masukkan untuk menandakan suatu label dari halaman ke halaman.
Label tersebut bisa berubah tanggal, nomor halaman, gambar ataupun nama judul halaman.

4. Tahap terakhir adalah penyimpanan dokumen. Dokumen yang kamu ketik bisa disimpan dengan
dua cara, yaitu dengan menggunakan perintah Save atau Save As. Kamu juga bisa memberikan
password atau kata kunci pada dokumen, sehingga jika ada orang lain yang ingin menggunakan
komputer kamu, tidak dapat membuka file dokumen yang tersimpan di dalamnya.
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> Glosarium

ISTILAH ‘ KETERANGAN

Drop Down | kotak pilihan masukkan perintah berbentuk seperti daftar.

Default kondisi awal.

Hang sistem tidak bereaksi atau macet.

Ikon menu perintah yang diwakili dengan simbol bergambar.
Margin batas-batas teks terhadap format penulisan.

proses rekonstruksi file yang hilang atau tak dapat dibaca lagi atau file hilang

Recovery kalau dihapus dengan tidak disengaja.

Shortcut perintah dengan singkat menggunakan keyboard.

Toolbar sebuah simbol atau ikon-ikon yang dikelompokkan berdasarkan fungsinya.

Tombol bagian alat untuk mengaktifkan dan me-non-aktifkan dari perintah tertentu.
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

. Apa yang dimaksud dari

Fungsi dari Save As .... adalah untuk ....
a. membuka file dokumen

b. menyimpan file lama

c. mengganti dan menyimpan file baru
d. menghapus file dokumen

Untuk menyimpan file dokumen OpenOffice.
org Wiriter harus menggunakan ekstensi
dokumen berupa ....

a. *.mdb

b. *.ods

c. *.odt

d. *.doc

. Menu Open terdapat dalam satu kelompok

toolbar apa ....
a. file

b. format

c. table

d. view

type *.odt di
OpenOffice.org Writer?

a. OfficeData Teks

b. OpenDocument Text

c. OpenData Text

d. OfficeDocuments Text

Apa nama sub menu yang digunakan untuk
membuka lembar kerja dokumen yang baru?
a. Close

b. New

c. Open

d. Save

6.

10.

Ada berapa macam format spasi
disediakan di OpenOffice.org Writer?
a. 4

b. 5

c. 6

d.7

yang

Untuk membuka dokumen yang tersimpan
di dalam disk, kombinasi keyboard yang
digunakan adalah ....

a. Ctrl+ N

b. Ctrl + O

c. Ctrl +S

d. Alt+F

=

Fungsi menu ikon ini adalah untuk
menyimpan dokumen

menghapus dokumen

mengganti nama dokumen

membuka dokumen

Qo o o

Kombinasi perintah pada keyboard yang
berfungsi untuk mencetak dokumen adalah

a.Ctrl+ C
b. Ctrl + P
c. Ctrl +V
d. Ctrl + X

Spasi yang memiliki fungsi untuk mengatur
jarak antara sisi kiri paragraf dengan batas
margin kiri disebut dengan ....

a. after text

b. before text

c. firstline

d. end line
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B.Lengkapilah jawaban dengan tepat.

Sebutkan tahapan pengelolaan dokumen . . . .

—

© © ® N o a bk w2

Untuk membuka file dokumen data menggunakan menu shortcut berupa ....
Jelaskan fungsi dari Save As . . ..

Bagaimana cara merubah ukuran dan posisi kertas . . ..

Apa yang dimaksud dengan perintah Before Text dalam fungsi menu indentasi teks . . ..

Sebutkan perbedaan antara menu header dan footer . . ..
Disebut apakah posisi kertas berbentuk datar?

Apa yang dimaksud dengan portrait?

Ctrl + S berfungsi untuk . . ..

Untuk mencetak dokumen, kita dapat menggunakan menu ikon yang bergambar . . ..

C.Jawablah pertanyaan di bawah ini dengan tepat.

o M DN~

Jelaskan langkah-langkah memformat halaman dokumen?
Jelaskan menu-menu yang ada di dalam kotak dialog paragraph?
Apa yang dimaksud dengan File Recovery?

Bagaimana cara menggunakan menu header dan footer?

Apa yang dimaksud dengan jarak spasi pada teks!
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BERKREASI

DENGAN

OPENOFFICE WRITER

B OFEHTA ESPL

oster merupakan bagian dari dunia periklanan
Pyang sangat penting. Sampai hari ini poster

masih digunakan untuk memasarkan suatu
produk baik berupa barang maupun jasa.

Koran sekolah merupakan media belajar
menulis yang cukup berarti bagi siswa. Berawal dari
membuat tulisan di mading sekolah, kemudian koran
sekolah, itu semua merupakan kawah candradimuka
bagi siswa untuk meningkatkan kemampuannya
menulis.

Pada suatu unit usaha seperti kafe, kantin atau
koperasi sekolah Daftar Menu merupakan bagian
yang penting karena merupakan informasi bagi
pembelitentang apa saja yang dijual. Harga makanan
tentunya merupakan salah satu pertimbangan
penting bagi pembeli.
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Peta Konsep

MEMBUAT DOKUMEN
KREATIF

Poster Artikel Koran Daftar Menu

C Insert-Picture m Format kolom m Gambar bentuk

m Textbox m Dropcaps m Bullets dan Number-

m Fontwork m Gambar ilustrasi ing

m Border dan m Penomoran halaman m Tabulasi
Background

apakah itu sebuah pengumuman, himbauan atau undangan. Secara teknis mungkin kita

menganggapnya mudah tinggal tulis saja pada selembar kertas, kemudian tempel gambar
dan pasang di sepanjang jalan. Masalahnya apakah pesan yang ingin disampaikan dalam poster
itu sampai atau tidak kepada targetnya. Inilah yang jadi alasan bahwa membuat poster itu mudah
tapi susah.

Tujuan pembuatan poster adalah menyampaikan pesan kepada khalayak tentang sesuatu,

Artikel biasanya digunakan untuk menyampaikan ide, gagasan, atau fakta untuk meyakinkan,
mendidik atau menawarkan cara pemecahan masalah bahkan untuk menghibur pembacanya.
Sedangkan Daftar Menu makanan di kantin sekolah, kafe atau restoran digunakan untuk

memberikan informasi kepada pembeli tentang menu makanan apa saja yang dijual dan berapa
harganya. Tampilan yang segar dan menarik akan menggoda pembacanya untuk memilih menu
tersebut.

Ketiga karya di atas merupakan perangkat publikasi. Sebagai alat penyampai informasi agar
efektif dan sampai pada sasaran maka harus memenuhi syarat minimal pesan yang terkandung
di dalamnya mudah dipahami, dan menarik orang lain untuk membacanya kemudian melakukan
kegiatan yang merupakan tujuan karya tersebut dibuat.

Kata Kunci

background, border, dropcap, fontwork, gallery, insert picture, menu, poster, shading, tab stop
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A. Membuat Poster

Poster adalah kertas berisi informasi kepada khalayak, biasanya ditempel di tempat
umum seperti di pinggir jalan, di pohon-pohon, di halte, stasiun kereta tergantung siapa
sasarannya. Bisa juga ditempel di sekolah atau kampus. Jumlahnya tergantung berapa
besar sasaran yang ditargetkan untuk dicapai.

Berikut adalah contoh poster.

Perhatikan poster di atas, komponen apa sajakah yang terdapat di dalamnya?
Secara umum sebuah poster terdiri atas:

m Gambar.
m Teks artistik.

m Textbox (teks dalam kotak).

m Latar (background). ua k i
m Bingkai (border). S @i Eai

Hal-hal apa saja yang dibutuhkan untuk

membuat poster? Pertama adalah menyiapkan Il@ll[j‘@l

konsep dan menuangkannya ke dalam kata-kata.
MINGGU, 22 FEBRUARI 2009

Ini butuh kreativitas, tidak ada aturan yang baku BASKET INDOOR SENAYAN

untuk membuat istilah atau slogan-slogan. Yang @

kedua adalah materi desain bisa berupa gambar . ’ Gambar 3.1
atau foto-foto. Berikutnya adalah layout atau tata & i Hub.021sssaez7 |  CONtoh poster
letak dalam penyusunan obyek dalam poster. Rebut Piala Bergilir Gubernur Sumber: Dokumen

penulis

Ada berbagai jenis layout yang bisa dipilih
untuk mendesain poster:
m Gambar dan judul berukuran besar, tetapi lebih menonjolkan gambar.
m Gambar berukuran besar, judul hanya sebagai pendukung.
m Judul berukuran besar, gambar hanya sebagai pendukung.
m Gambar dan judul tidak penting, lebih mengedepankan informasi yang akan
disampaikan.
Poster biasanya dibuat dengan program-program pembuat desain, akan tetapi
dibuat dengan software pengolah kata seperti OpenOffice.org Writer pun tak kalah
indahnya, karena program ini juga menyediakan fasilitas-fasiltas yang dibutuhkan seperti

pembuatan teks artistik, penyisipan gambar, berbagai warna latar, bingkai yang menarik
dan sebagainya.
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Mari kita pelajari teknik pembuatan komponen-komponen poster seperti di
bawah ini.

1. Menyisipkan Obyek Gambar

Gambar merupakan bagian yang penting dalam sebuah poster. Gambar dapat
memudahkan untuk memahami isi poster, memperindah tampilan sehingga menarik
minat target . Oleh karenanya gambar haruslah sesuai dengan tujuan poster itu
dibuat, tidak sembarang gambar dapat ditempel dalam sebuah poster.

Gambar yang sempurna harus dibuat dengan software khusus pembuat
gambar. Software OpenOffice.org Writer bukanlah pembuat gambar, akan tetapi
dalam dokumen yang dibuat dengan OpenOffice.org Writer dapat disisipkan gambar
yang dibuat dengan software lain.

a. Insert - Picture

Gambar atau dalam bahasa komputer sering dikenal dengan istilah picture
adalah gambar yang dibuat dengan software lain (bukan OpenOffice.org Draw). File
gambar umumnya berformat jpeg, gif, png, bmp (bitmap) yang dapat disisipkan ke
dalam program pengolah kata. Kamu bisa mendapatkan file gambar-gambar tersebut
dengan cara membeli CD gambar yang banyak tersedia di toko atau membuat sendiri
jika bisa atau yang paling mudah adalah dengan cara browsing di internet.

Info
Cara mendapatkan gambar dari internet:

1. Aktifkan program browser misalnya Mozilla Firefox.
Akses situs pencari misalnya www.google.co.id.

Pilih fitur image.

Ketikkan nama gambar yang dicari.

Jika gambar sudah ditemukan klik kanan pada gambar.
Pilih Save Image As.

N o o ks~ b

Simpan ke folder yang sudah kita siapkan.

Bagaimana cara menyisipkannya ke dalam poster? Pastikan bahwa kamu
sudah memiliki file gambarnya baik tersimpan di dalam harddisk atau media
penyimpan lain seperti CD atau flashdisk. Kemudian ikuti langkah berikut:
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1). Aktifkan menu Insert — Picture — From File.

2).Carilah gambar yang akan disisipkan pada folder penyimpanan dengan cara:

m Cari nama folder penyimpanan pada Places.
m Pilih nama file pada kolom Name.

untuk memunculkan
tampilan gambar ceklis pada Preview.

m Agar tidak salah pilih,

E&D

Break...
Fields

3 Special Character...
Formatting Mark

>

Section...
[1 Hyperlink
Header »
Footer »
Footnote,..
;;-BJ Caption...
<1 Bookmark...
5| Cross-reference...
[ Note...
Script...
Indexes and Tables »
Envelope...
[] Frame...
[ Table...  ctrl+F12
‘/Hmuler...
Picture  { ‘m From File...
Sound >~ »
Object »
7] Floating Frame
& File...
3).Klik Open untuk membukanya.
Nama file | places i = Z:jjmn B} Basketjpg
o
(@[ G | Open
b. Memodifikasi Gambar
Gambar yang disipkan terkadang ukurannya tidak sesuai dengan

kebutuhan, untuk itu gambar perlu diedit seperti mengubah ukuran maupun
mengatur posisinya di dalam naskah. Berikut adalah cara mengatur gambar di

dalam dokumen:

Gambar 3.2.
Perintah menyisipkan
gambar

Sumber: Dokumen
penulis

Gambar 3.3.
Menyisipkan gambar

Sumber: Dokumen
penulis
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1). Format — Picture

Klik tombol kanan
pada mouse,
kemudian pilih Picture
adalah cara cepat
untuk menampilkan
menu Format —
Picture.

Gambar 3.4.
Format — Picture

Sumber: Dokumen penulis

Klik pada gambar, kemudian aktifkan menu Format — Picture.

Insert | Format | Table

Default Formatting Ctri+Shift+Space

Character...

AED
S
Lul

Paragraph...

Bullets and MNumbering...
Page...

Change Case

Asian phonetic guide. ..

LIMAs..

[] styles and Formatting
AutoFormat

E1!

Anchor
Wrap

|2 Alignment
Arrange
Elip

Group

Object
Frame...

&

Picture...

2). Type

Klik pada tab Type untuk mengubah ukuran gambar.

|—< [Type | OpYhns | Wrap | Hyperlink | Picture | Crop | Borders | Background | Macro |

Anchor

(iTd page =
@ To paragraph

(1 To character

) As character

Tab Type
Untuk mengubah lebar gz —
gambar Width ( 1.36" ‘;}
[] Relative
Untuk mengubah tinggi Height T
gambar [ Relative
Menjaga rasio gambar ’—
Position
Horizontal Center 8 by

Gambar 3.5.
Mengatur ukuran gambar

Sumber: Dokumen penulis

[] Mirrer on even pages
Wertical Top

] Follow text flow

Paragraph area |

000" [I] to

+

0.00"

o Margin o

oK ancel Help Reset

Klik tombol OK jika pengaturan sudah selesai.
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Cara cepat mengubah gambar dapat dilakukan dengan drag gambar pada

ke empat titik-titik point di seputar gambar.

Untuk mengubah tinggi

gambar

.
7 N
7N\~
XN e
(D
X &

Untuk mengubah gambar
secara proporsional

Gambar 3.6.

Mengubah ukuran

Untuk mengubah lebar
gambar

gambar secara cepat
Sumber: Dokumen

penulis

Gambar 3.7.
Berbagai hasil
perubahan ukuran
gambar

(a) mengubah secara
vertical,

(b) mengubah secara
proporsional

(c) mengubah secara

(a) horisontal
Sumber: Dokumen
penulis

3). Wrapping.
Mengatur posisi gambar disekeliling teks atau disebut juga dengan istilah
wrapping, klik tab Wrap pada jendela Picture.
- Gambar 3.8
Type  opaT yperlink | Picture | Crop | Borders | Background | Macro | ambar 3.6. i
Untuk mengatur St Mengatur Wrapping
posisi gambar di 0 gambar
seputar te ks Tme Before parallel Sumber: Dokumen
- B - penulis
Through Optimal
Untuk mengatur __ o
jarak gambar e poe [ O Eirst paragraph
dengan teks e EE ; ;
T ‘m O g.o?tuur
Bottom [0.00" [2]

‘ oK H Cancel || Help || Reset |

Klik tombol kanan
mouse pada gambar,
kemudian pilih Wrap
adalah cara cepat
untuk menampilkan
pilihan Wrapping .
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Berikut ini adalah berbagai contoh wrapping

Sebanyak 10 tim

' . bola  basket di

= Kabupaten  Aceh

J Barat, Sabtu (14/5]

ikut memeriahkan

. turnamen  bola

basket 3 on 3

piala Dandenpom

s M ZMeulaboh

berlangsung  di  Madenpem Kecamatan

Meureubo. Pertandingan dalam rangka

memeriahkan HUT ke-62 POM AD dibuka

Dandenpom  Mayer CPM M Hasanudin.

Hasanudin kepada Serambi menjelaskan,

turnamen digelar selama tiga hari yang

dikuti peserta-peserta terbaik di Kabupaten
Aceh Barat.

(a)

Sebanyal 10 tim bola basket di Kabupaten

Aceh Barat, Sabtu (14/6) ikut memeriahkan

turnamen  bola basket 3 on 3 piala

Dandenpom IM 2/Meulabeh berlangsung di

Madenpom Kecamatan Meureubo.

Pertandingan

dalam  rangka

memeriahkan

HUT ke-62

POM AD

[ ] dibuka

Dandenpom

Mayor CPM M

Hasanudin.

Hasanudin kepada Serambi menjelaskan,

turnamen digelar selama tiga hari yang

dikuti peserta-peserta terbaik di Kabupaten
Aceh Barat.

(b)

Sebanyak 10 tim bela basket di Kabupaten
Aceh Barat, Sabtu (14/) ikut memeriahkan

turname

Sebanyak 10 tim bola basket di Kabupaten Dandenp|

Gambar 39_ Aceh Barat, Sabtu (14/%) ikut memeriahkan Madenp

. turnamen  bola sket 3 on 3 piala :

Berbagal ContOh Dandenpom IM h berlangsung di Pertandi

Wrapping Page Wrap Madenpom n Meureubo. HUT ke
. Pertandin, ka memeriahkan Mavyor
(b) Optlmal Page Wrap HUT ke-62 Dandenpom I-cepada

(C) |n Background (d) Mayer CP . Hasanudin dizelars

kepada Ser meglelaskan, turnamen g
Through Wl‘ap digelar selama tRga hari Vang dikuti peserta- peserta terba

Sumber: Dokumen penu[is peserta terbaik di Kabupaten Aceh Barat.

(c) (d)

1). Memindahkan gambar.

Arahkan mouse di sekitar gambar sehingga pointer mouse berubah
bentuknya menjadi gambar tangan. Drag (klik dan geser) ke arah posisi
gambar akan ditempatkan. Sebelum dipindahkan sebaiknya gambar diubah
dulu wrapping-nya agar lebih mudah dalam penempatan.

Gambar 3.10.
Cara memindahkan

gambar
Sumber: Dokumen penulis

2).Menghapus gambar.

Klik pada gambar, aktifkan menu Edit — Delete. Dapat juga dengan
menekan tombol delete pada keyboard.
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2. Menambahkan Text
Text adalah kotak berisi teks. Apa keuntungan menggunakan text? Text bisa
ditempatkan di mana saja sesuai keinginan layaknya sebuah gambar. Memang text
ini adalah teks dalam kotak yang berformat gambar. Biasanya teks ini digunakan

untuk membuat teks dalam poster, bagan atau bentuk-bentuk lain yang
sejenis. Icon Text terdapat pada Toolbar Drawing.

i

Karena formatnya yang seperti gambar maka kotak teks ini

Gambar 3.11.
Icon text

Sumber: Dokumen
penulis

mempunyai sifat-sitat seperti gambar, demikian pula cara penempatannya diantara

teks dalam suatu paragraf.
Bagaimana cara membuatnya?

1). Membuat Text
1. Klik ikon Text, sehingga pointer mouse berubah menjadi tanda +.

2. Buatlah kotak, lalu ketik teks di dalamnya.

Teks

2).Format Text
1. Blok teks dalam kotak.

%

SRR

2. Gunakan ikon-ikon pada Toolbar Formatting.

Rata kiri
| Rata tengah

Rata kanan
Rata kanan Kiri

| Cetak tebal,miring dan garis bawah |

| Jenis huruf ||Ukuran huruf|

ST [T B R Eed o ol e e ) o) e e e e o i S EOEIONGE 5 3| ET

|Nimbus Roman Mog L | w | |11 | w |

Gambar 3.12.
lkon-ikon untuk
format teks

Sumber: Dokumen
penulis
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3).Posisi dan Ukuran Kotak Teks

1

. Klik pada kotak teks.

2. Klik tombol mouse kanan.
3. Pilih Position and Size.
4. Pilih tab Position and Size.

Gambar 3.13.
Menampilkan perintah

mengatu

Sumber: Dokumen penulis

Gambar 3.14.
Memutar kotak teks

Sumber: Dokumen
penulis

5

Gambar 3.15.
Kotak teks dengan
sudut putar 45°
Sumber: Dokumen
penulis

i
eks
& Lne...
& Area...

Text

I Position and Size...

Description...
MName...

Arrange
Alignment
Wrap
Anchor
L Caption...

Group

& Cut
[& Copy

r kotak teks

Tab Position and Size I—

Untuk mengubah lebar
kotak teks

Untuk mengubah tinggi
kotak teks

Menjaga rasio kotak
teks

. Pilin tab Rotation

Position and 5ize
‘ atatian| Slant & Corner Radius |
Size Anchor
it  7opage
heght  Cge ) | @ Toparsureph
7 Keep ratio () To character
() As character
Protect
[ Position [ Size
Position
Herizontal  [From left 5] by Pper |3 to  |Paragrapharea ¢ |
[] Mirror on even pages
Vertical [Fromtop ¢ | by 003 [i] to [Margin 2]
[ Follow text flow
| oK H Cancel H Help || Reset ‘

Untuk memutar
kotak teks

@ Poshonandisiee
| Position and Size |Rotation| Slant & Comer Radius |
Pivot point
Default settings
Position X e 74"4(“
Position ¥ o2er 3] &

Rotation angle

untuk mengubah
kemiringan kotak teks

Ketik angka pada Angle| |

Teknologi Informasi dan Komunikasi

Untuk SMP / MTs Kelas VIII

0.00 degrees |3

i

(‘ K s

S e

~

(s T
aK | | Cancel ‘ ‘ Help ‘ ‘ Reset




3. Menggunakan Fontwork

Fontwork adalah teks artistik, seperi halnya WordArt pada Microsoft
Word. Fontwork biasanya digunakan untuk membuat kreasi dokumen seperti

logo, kop surat, undangan, poster dan lain-lain.
Bagaimana membuatnya?
a. Membuat Fontwork

1).Klik ikon Fontwork Gallery pada toolbar drawing.

—
37114 =

Fontwork

Gambar 3.16.
lkon Fontwork

Sumber: Dokumen penulis

2).Pilih jenis style fontwork, lalu klik OK.

FBNEWOTICGallETy

select a Fontwork style:

S T
N N
U W e ™
foyo o Tt/ Forowt

[ oK [[ cancel J [ Help |

Gambar 3.17.
Fontwork gallery

Sumber: Dokumen penulis

3). Akan muncul teks Fontwork berukuran besar.

] Fontwork " o

1y . O
Gambar 3.18.
Teks fontwork

Sumber: Dokumen penulis

A
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4).Dobel klik pada teks Fontwork.

5).Hapus teks fontwork yang berukuran kecil, lalu ganti dengan teks yang akan
ditulis.

o DPS-LP3TNF m

o]

-\

Gambar 3.19.
Mengganti teks fontwork

Sumber: Dokumen penulis

RN

6). Klik mouse di luar area fontwork.

[m] [m]
s Ly
Gambar 3.20. \
Teks artistik
[m] [m]

Sumber: Data pribadi

b. Format Fontwork

Pada saat membuat fontwork, biasanya otomatis Toolbar Fontwork akan
ditampilkan. Toolbar ini berisi ikon-ikon untuk mengatur tampilan Fontwork.
Caranya? Klik saja pada Fontwork yang akan diformat, kemudian:

1).Pilih Fontwork Shape untuk mengubah bentuk teks dan Fontwork Gallery
untuk mengganti style fontwork.

Fontwork Shape
_
Fontwork Gallery [A] ?r-** -AA = AV
CELELS
ATEAAY

Gambar3.21. %P QAU
Mengubah bentuk fontwork & w ¢ 5 © ©

Sumber: Dokumen penulis @
Arch Up (Pour)
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Contoh Fontwork Shape

oA
L

Gambar 3.22.
Berbagai contoh
bentuk Fontwork

Sumber: Dokumen
penulis

2). Pilih Fontwork Alignment untuk mengatur perataan fontwork.

Fontwork Alignment

v -Aa = - AV-
= Left align
Center
= Right Align
= Word Justify
= Stretch Justify
Gambar 3.23.

Mengubah perataan fontwork
Sumber: Dokumen penulis

Contoh Fontwork Alignment

DR LS
e, Baral

L

AR,

all

DRSSLRNG
LW,

Al

DR LRSI
Jawa, Baral

Gambar 3.24.
Berbagai jenis
perataan pada
Fontwork

Sumber: Dokumen
penulis
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3). Pilih Pilih Fontwork Character Spacing untuk mengatur jarak antar huruf dalam
fontwork.

Fontwork Character Spacing

- AY -
—

v A3

@ Fontwork Cha| =]
e Very Tight

Tight

Normal

Loose

Gambar 3.25.

‘ery Loose
Mengatur karakter fontwork Suston

Sumber: Dokumen penulis Kepaharagentare

4).Menambahkan Border dan Background.

Border adalah garis yang membingkai suatu obyek baik berupa gambar

maupun paragraf. Sedangkan background adalah warna latar suatu obyek
atau paragraf.

Bagaimana cara menambahkannya pada halaman yang kita buat?
a. Border

1). Aktifkan menu Format — Paragraph sehingga jendela menu paragraf
ditampilkan.

2).Pilih tab Border.

Paragrapn =

Background

- [ ings cing_ | Alignment | TextFlow | Numbering | Tabs | Drop @/:‘\Es\anrders\)—| Tab Border
Line Arrangement Tre

roner .
Line Style User-defined - R —E
Bottom @
W Synchronize
Gambar 3.26. Color
Jendela Format — Shadow Style
0.02 B
Paragraph Position e -
Sumber: Dokumen penulis 2 Merge vith next paragraph
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3).Line Arrangement.

Pilih bagian paragraf yang akan diberi border pada:

mi=ip(uiy

Gambar 3.27.
Memilih jenis pengaturan border
Sumber: Dokumen penulis

Keterangan:

- 1: set no border

- 2: set all four border

- 3: set left and right border only

- 4: set top and bottom border only
- 5: set left border only

4).Line Style

Untuk memilih jenis border.
5). Color

Untuk memilih warna border.
6). Shadow Style Position

Untuk menambahkan bayangan.

m elelal

Gambar 3.28.
Berbagai jenis pengaturan bayangan
Sumber: Dokumen penulis

Keterangan:

- 1: no shadow

- 2: cast shadow to bottom right
- 3: cast shadow to top right

- 4: cast shadow to bottom left

- 5: cast shadow to top left

Teknologi Informasi dan Komunikasi
Untuk SMP / MTs Kelas VIII




b. Background
1). Format — Paragraph.

Aktifkan menu Format — Paragraph.

2).Tab Background.
Pilih Tab Background.

Paragrapn

Background Color |7

Gambar 3.29.
Memilih background

Sumber: Dokumen penulis | N il

[ ok [ cancel |[ Help |[ Beset

3). Background Color.

Pilih warna background di sini.

Contoh Background Color

-
=]
[
}"
lGambar 3.30. ‘ﬁ}-
Berbagai contoh warna =
background

Sumber: Dokumen penulis (a) (b) (C) (d)

4).0K.
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1. Gallery

Gallery merupakan kumpulan gambar yang siap pakai pada OpenOffice.org
Writer. Gambar-gambar yang tersimpan dalam gallery dapat disisipkan sebagai
obyek gambar maupun background halaman dokumen.

Bagaimana membuatnya?

a. lkon Gallery

Klik ikon Gallery untuk mengaktifkan menu Gallery, sehingga ditampilkan
jendela Gallery seperti berikut:

- ice-light ( i i back/ice-light.jpg)

Gambar 3.31.
Menu Gallery

TEEEEENEE Sumber: Dokumen

penulis

b. Menyisipkan sebagai obyek gambar

Klik tombol mouse kanan pada gambar yang dipilih kemudian klik /nsert -

Copy.
| New Therne... | EE EE Backgrounds - ice-li
® Backgrounds
® Bullets il
® Homepage BE I
® My Theme Insert | Copy
* Ak Link Gambar 3.32
® Sounds ﬁ Rl
& Ubuntu Background » Mengcopy gambar

dari gallery

Sumber: Dokumen
penulis

c. Menyisipkan sebagai background

@ EE EE Backgrounds - ice-light (/usr/lib/o

Backgrounds

Bullets " 3

Homepage Insert » | Copy

S T Preview Lk

Rulers = _—

Sounds — Background » | Page Gambar 3.33.
Ubuntu : : Paragraph [ Mengcopy gambar

untuk background

Sumber: Dokumen
penulis

Cara menyisipkan gambar ke dalam dokumen sebagai background, klik
tombol mouse kanan pada gambar yang dipilih kemudian klik Insert — Background
— Page untuk memberikan warna latar pada halaman.

Klik Insert — Background — Paragraph untuk memberi warna latar pada
paragraf.

Untuk SMP / MTs Kelas VIII
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Praktikum

A. Praktikum menyiapkan dokumen

Buka dokumen OpenOffice.org Writer dengan perintah Application — Office — OpenOffice.org

Word Processor

Page styler Default

1. Ubah ukuran kertas dengan perintah

Paper format

|0rganizer ‘Page‘ Background | Header | Footer| Borders | Columns| Footnote

Format — Page. Pilih ukuran kertas A4

Height 11.69" :
Qrientation @ Portrait

() Landscape

Margins

outer 0.59" H
Top 059"

Bottomn .78 S

Inner )

Format
Width 8.27" :

dan orientasi Portrait.

2. OK.
Paper tray |[Frum printer settings] 1¢ |
Layout settings
Format
[] Register-true
Reference Style
oK H Cancel H Help H Reset

B. Praktikum menyisipkan gambar

%

-,
B inel
=

1.
2.

Klik menu Insert — Picture — From File.

Pilih gambar basket.jpg (boleh diganti dengan gambar lain
yang tersedia di komputermu.

Ubahlah ukuran gambar sehingga tampak serasi ditempatkan
pada lembar poster.

Pindahkan posisi gambar ke ujung kanan atas halaman.
Ambil pula gambar piala.jpg.

Ubah ukurannya dan pindahkan posisinya seperti berikut.
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C. Praktikum menambahkan teks artistik

1. Klik ikon Fontwork Gallery.
% Buatlah teks Basket Ball.

2.
BaSk@t @a“ 3. Pilih Fontwork Shape yang sesuai.
4.

Ubah ukuran fontwork sehingga tampak lebih menonjol di
dalam halaman poster, karena fokus poster ini ada pada kata
tersebut.

>,
=

D. Praktikum menambahkan teks

1. Buat teks COMPETITION, caranya:

L]
Rﬁ@%@é}. B @“ Tambahkan warna background.

"Q“‘t Dv‘" m Gandakan (copy) kotak teks berisi huruf C beberapa kali

COMPETITION sejumlah 10 kali.

——————————— m Ganti huruf C dengan tiap-tiap huruf pada kata

MINGGU, 22 FEBRUART 2009

BASKET INDOOR SENAYAN COMPETITION_
=}

Rebut Piala Bergilir Gubernur

m Buat dengan ikon Text huruf C dengan size agak besar.
%_ m Tambahkan border.

Susun seperti contoh sehingga tampak serasi.

Info Hub. 0218854627

2. Buat teks Minggu, 22 Februari 2009.

3. Buat teks Basket Indoor Senayan.

4. Buat teks Rebut Piala Bergilir Gubernur.
5. Buat teks Info Hub (021)8854627.

Y 1.inologi Informasi dan Komunikasi &
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E. Praktikum menambahkan background

1. KIlik ikon Gallery.

% 2. Pilih warna background sesuai selera.

ﬁﬁ@“ﬁ(h&. B@N\ 3. Sisipkan sebagai background.
TWINGL Dot

COMPIEEITION

MINGGU, 22 FEBRUARI 2009
BASKET INDOOR SENAYAN

Info Hub. 0218854627

Rebut Piala Bergilir Gubernur

F. Praktikum menambahkan border

1. Klik menu Format — Page.

2. Pilin tab Border.

Ragkei @ i“ 3. Pilih jenis border dan warna yang sesuai.

COMPETITION

MINGGU, 22 FEBRUARI 2009
BASKET INDOOR SENAYAN

Info Hub. 0218854627

Rebut Piala Bergilir Gubernur

G. Praktikum menyimpan dan mencetak poster
1. Klik menu File — Save.
2. Ketik nama file POSTER_NAMA_KELASMU.
3. Siapkan kertas berukuran A4 pada printermu.
4. Klik menu File — Print.
5. OK.
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B. Membuat Artikel

Artikel adalah tulisan berupa fakta (bukan fiksi) tentang suatu masalah atau
kejadian secara lengkap yang panjangnya tidak ditentukan, biasanya untuk dimuat di
koran, majalah atau tabloid. Biasanya tulisannya relatif panjang dan berkolom-kolom.
Ada tambahan gambar untuk ilustrasi dan tulisan artistik. Ada teks berukuran lebih
besar di awal paragraf.

Artikel ini biasanya digunakan untuk menyampaikan ide, gagasan, atau fakta
untuk meyakinkan, mendidik atau menawarkan cara pemecahan masalah bahkan untuk
menghibur pembacanya.

rmameas

Surabl yang Blkin Ketagihan

_____ e Gambar 3.34.
: Contoh artikel

Sumber: blog.
raditya.net

= am.

b i

Bagaimana membuatnya? Berikut adalah cara pembuatan secara teknisnya.
1. Membuat Teks Berkolom

Koran maupun majalah selalu menggunakan format teks berkolom. Hal ini
tentu disebabkan lebar halaman koran yang cukup besar mengharuskan naskah
ditampilkan dalam tampilan berkolom-kolom.

Cara membuat kolom:
a. Aktitkan menu Format - Column.

Farmat | Table Tools Window Help
Default Formatting Ctrl+shift+Space

&0 Character...
&7 Paragraph...

Page... Gambar 3.35.
A ey Mengaktifkan menu
p=1] |€||gu wase »
Columns... untuk membuat
Sections... kolom

[ Styles and Formatting F11 Sumbgr: Dokumen
AutoFormat . penulis

Untuk SMP / MTs Kelas VIII
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oK
Help
Width and spacing - i
Column - T 2 3 - .
: = = % 7 Current Sectio|{
@ e B O EE B H
o =8 @
Gambar 3.36. & Autowidth
|

Jendela menu untuk {(_Separatorline>
mengatur kolom | e [——— 0@ o]

Sumber: Dokumen penulis Height oo [3]

Position |Top

1). Setting.

Banyaknya kolom dapat diatur pada Setting. Kita dapat memilih dari
setting kolom yang sudah tersedia atau dengan mengatur sendiri dengan jalan
mengatur nilai pada Column. Ceklis pada “Evenly distribute contens to all
columns” jika menginginkan lebar kolomnya sama.

2). Width and Spacing.

Apabila kita menginginkan lebar kolom tidak sama, maka hilangkan
ceklis pada “Evenly distribute contens to all columns” lalu masukkan nilai lebar
kolom1, kolom 2, kolom 3 dan seterusnya pada Width. Jarak antar kolom
dapat diatur dengan mengisi nilai pada Spacing.

3). Separator Lines.

Untuk menambahkan garis batas antar kolom, pilih salah satu ketebalan
garis pada Line. Untuk menghilangkan garis pembatas ini kita dapat memilih
None. Height adalah tinggi garis pembatas, nilai 100% menunjukkan bahwa
tinggi garis sampai di batas atas kolom. Sebaliknya nilai kurang dari 100%
artinya tinggi garis batas tidak sampai batas atas kolom.

at demensia bagi perokok
is barn-baru ini membulktik

il @mlk [ Height 100% |

Gambar 3.37. litian kami | fongsi 1

Atribut kolom Mjukkan g Spacing 0.20” |
) . |biarkan kesulitan
Sumber: Dokumen penulis :
z lain | perubahan
d. OK.
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2. Menambahkan Dropcaps

Dropcaps adalah huruf kapital berukuran besar yang terdapat di awal paragraf.
Dropcaps ini biasa digunakan pada tulisan artikel di koran atau majalah. Fungsinya
sebagai salah satu cara untuk menarik perhatian pembaca.

cialFasi sy

I o R T TR Ty S I RN EUNCIN U T NSRS o S|
dle PClUbUL SCUAINILYA THULAL Salldl GHL GUdll Delbdbed. Pdsdllyd G b 3.38
kenikmatan semu vang dilusap perokok aktif ternyata biza ambar 3.39.

Contoh Dropcaps

Sumber: Dokumen
penulis

_ berbuah penyakit demensia bagi perokok pasif. Sekelompok tim
dari Amerika dan Inggris baru-baru ini membuktikan hal tersebut.

Cara membuat Dropcaps:

a. Aktitkan menu Format — Paragraph

Pastikan posisi kursor pada paragraf yang akan diberi drop caps, kemudian
aktitkan menu Format — Paragraph.

b. Aktifkan tab Dropcaps

2 Paragraph =

| Background |
| Indents & Spacing | Alignment | Text Flow | Numbering | Tab&|Drop Caps DBorders |
Settings.

W Display drop caps P
] Whole word
—
Clies D I
Contents
Text P |

Character Style |5Drop Caps i

Gambar 3.39.
Menu Dropcaps

Sumber: Dokumen
penulis

QK || Cancel H Help H Reset |

c. Display dropcaps

Tambahkan ceklis di sini untuk mengaktifkan dropcaps. Hilangkan kembali
ceklisnya untuk tidak menampilkan dropcaps, karena biasanya drop caps hanya
ditampilkan pada paragraf pertama.

d. Number of characters

Ketikkan angka di sini untuk membuat banyaknya huruf yang dijadikan drop
caps, dihitung dari huruf pertama pada paragraf yang bersangkutan.

c. Lines

Tinggi dropcaps dinyatakan dalam banyaknya baris. Ketikkan angka di sini
untuk mengatur tinggi huruf.
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Gambar 3.41.
Mengaktifkan modus gambar

Sumber: Dokumen penulis

Gambar 3.42.

Modus gambar default(a),
grayscale(b), Black/White(c) w w ‘
dan Watermark(c)

Sumber: Dokumen penulis

d. Space to text

Jarak antara dropcaps dengan teks paragraf dapat diatur dengan
mengetikkan angka di sini.

e. OK

. Menambahkan Gambar llustrasi

Gambar ilustrasi adalah gambar yang ditambahkan pada artikel sebagai
gambaran untuk mempermudah pemahaman atau dapat juga ditampilkan sebagai
fakta untuk memperkuat isi artikel.

Sebenarnya menyisipkan gambar dalam dokumen sudah kita bahas di depan,
di sini bahasan kita lebih kepada efek dan mode gambar. Perintah mengatur efek
dan mode gambar terdapat pada toolbar picture. Toolbar picture akan otomatis
ditampilkan jika gambar dalam keadaan terpilih (di-klik)

Gambar 3.40.
Toolbar Picture

Sumber: Dokumen pribadi

@ | pra ) Bl Qpow 3] g

a. Transparancy
Adalah fasilitas untuk mengatur tebal tipisnya gambar dalam satuan persen.
Semakin besar persentase transparansinya makin tipis gambarnya.
b. Graphics mode

Merupakan beberapa modus gambar seperti grayscale, black and white
dan watermark. Jika ingin mengembalikan ke warna asal gambar, pilih default.

Teknologi Informasi dan Komunikasi
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c. Filter

Berupa efek tambahan pada gambar agar gambar tampak lebih artistik
layaknya filter yang digunakan pada program-program desain.

9] Bl Phx 3 & B

4. Nomor Halaman

Pada pembuatan buletin atau buku yang lebar halamannya relatif kecil,
penomoran halaman dapat dengan mudah dilakukan dengan OpenOffice Writer.
Nomor halaman hampir selalu ada di setiap halaman, dapat diletakkan di bagian atas
atau di bagian bawah.

a. Header

Header adalah bagian dari naskah yang posisinya di bagian paling atas
halaman dan selalu ditampilkan di setiap halaman. Biasanya header ini digunakan
untuk menuliskan judul bab, edisi sebuah media publikasi berupa tanggal.

Untuk mengaktifkan header dalam sebuah dokumen, aktifkan menu Format
— Page. Kemudian pilih tab Header. Ceklis pada Header on, akan ditampilkan
kotak teks tempat mengetikan teks header.

=) Page Style: Default =
|Organizer | Page | Background [Header| Footer | Borders | Columns | Footnote |
Header

& Header on

M Same content left/right

Left margin |0‘00“ :

Right margin |0.00" :

Spacing |[]‘2[]“ :

[ Use dynamic spacing

s -

W AutoFit height

More...
oK ‘ ‘ Cancel ‘ ‘ Help ‘ ‘ Reset ‘
:: INFO SEHAT :: Edisi I, 03/04/09

Gambar 3.43.
Filter gambar

Sumber: Dokumen
penulis

Gambar 3.44.
Berbagai mode filter
Invert (a), Solarization
(b), Carcoal Sketch(c),
Relief(d), Mosaic(e)
Sumber: www.
geocities,com

Gambar 3.45.
Menu untuk
mengaktifkan
Header

Sumber: Dokumen
penulis

Gambar 3.46.
Contoh teks pada
header

Sumber: Dokumen
penulis
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Gambar 3.47.

Menu untuk mengaktifkan
Footer

Sumber: Dokumen penulis

Gambar 3.48.
Contoh teks pada footer

Sumber: Dokumen penulis

Jika posisi nomor
halaman ganjil dan
genap berbeda maka
yang harus disiasati
adalah hilangkan ceklis
pada Same content
left/right. Kemudian
aktifkan Insert — Field
— Page Number pada
halaman ganijil dan
halaman genap.

b. Footer

Footer adalah bagian dari naskah yang posisinya di bagian paling bawah
halaman dan selalu ditampilkan di setiap halaman. Biasanya footer ini digunakan
untuk menuliskan sumber atau nomor halaman.

Untuk mengaktifkan footer dalam sebuah dokumen, aktifkan menu Format
— Page. Kemudian pilih tab Footer. Ceklis pada Footer on, akan ditampilkan
kotak teks tempat mengetikan teks footer.

Page style: Default Bl

[ Organizer | Page | Background | Header |[Footer| Borders | Columns | Footnate

Footer

& Same content left/right

Left margin
Right margin |m
Spacing 0.20" :
[] Use dynamic spacing

& AutoFit height

.....

oK || Cancel || Help || Reset

Media Pelajar Menulis ij

c¢. Menambahkan nomor halaman

Jika nomor halaman ditambahkan pada footer, maka klik mouse pada footer.
Posisikan kursor di bagian kanan atau kiri. Aktifkan menu Insert — Field — Page
Number.

Teknologi Informasi dan Komunikasi
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raktikum

}: INFO SEHAT :: Edisi, 130409

Perolok Pasif Bisa Terkena Demensia

ara perokok sebatkitra nmlal sadar din dan berkaca Pasalnya

kenkmatan semm wang dilusap perokok akbf temyrata bisa

berbiah penyrakt derensia bagl perckok pasif. Selkelongpol tm
dari Amerika dan Inggris baru-bam imi membuktikan hal tersebut.

“Hasil peneltian | zangzuan fangzsi bahasa,
Jeami mundirmya  kemampuan  berfikir

mernmnkkan abstrak, kemltan merawat diri
meambiarkan sendiri, pembahan perlaln, emosi
orang lan | rang labil, dan hilaznya

terpapar  asap | pengenalan wakta dan tempat.
wlkok hisa David  menanbahlan,  ia

mengakibatkan penyakit demensia,
merisak otak, menszangm fungsi
Jeoguitif, dan menggangg
imgzatan”, kata ketna Tim Peneliti
dari Cambrdge Universiby Davd
Llewllym sepert dilmtip Reurers
Demensia merapakan
Jompulan  gejala Minds  yang
disebabkan berbazal latar belakans
penyakit. Biasanya diandai
denzan hilangnya mermod jangka
pendek dan zangzuan global fungsi

bersama bmuwra mereldi sampel
atr Ilmr 5000 orang wang tidak
merokok wang berusia di atas 50
talom Merela masih menenmlkan
nkotin dalam  air bur  (ootmin)
setelah 25 jarmn pasca ferpapar asap
rokok.

Penelitian vang
dipublikasikan  dalam  Bwnsh
Medieal  Jouwrmal 1w juga
menyebutlkan resiko perokolk pasif
terserang dermensia mencapal 44%

metal Tetmasuk  diantaranya

Media Pelgjar Menulis i

A. Praktikum menyiapkan dokumen

1. Aktifkan program Openoffice.org writer.

2. Siapkan halaman berukuran A4.

B. Praktikum membuat kolom

1. Ketikkan semua naskah tanpa format kolom.
2. Blok teks mulai paragraf ke dua sampai paragraf terakhir.
3. Format menjadi dua kolom yang sama lebar.

4. Atur jarak antar kolom atau spacing 0,20".

5. Tambahkan garis antar kolom dengan width 0.05 pt, height 100%.

Teknologi Informasi dan Komunikasi
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C. Praktikum menambahkan dropcaps

1. KIlik kursor pada paragraf pertama.

2. Aktifkan Dropcaps dengan ketentuan Number of character 1, lines 3, Space to
text 0.10”.

D. Praktikum menambahkan gambar

1. Insert — Picture — From File.
2. Pilih gambar yang kamu miliki yang sesuai dengan tema artikel.

3. Letakkan gambar seperti contoh dengan wrapping Optimal, beri filter
Solarization.

Sisipkan sebuah gambar lagi yang sesuai tema.
Berikan wrapping in background.

Ubah modus gambar menjadi watermark.

N o o A

Copy gambar sebanyak empat kali, kemudian letakkan dibalik naskah.

E. Praktikum menambahkan header

1. Aktifkan Header.
2. Ketikkan pada header:: INFO SEHAT::.
3. Tekan tombol tab sehingga posisi kursor ada di kanan, ketik Edisi.

4. Sisipkan tanggal dengan Insert — Field — Date.

F. Praktikum menambahkan footer

1. Aktifkan Footer.
2. Ketikkan Media Pelajar Menulis.
3. Tekan tombol tab sehingga posisi kursor ada di kanan.

4. Sisipkan nomor halaman dengan perintah Insert — Field — Page Number.

G. Praktikum menyimpan dan mencetak

1. Simpan dengan nama ARTIKEL_NAMA_KELASMU.
2. Cetak dengan perintah File - Print.

Teknologi Informasi dan Komunikasi N
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C. Membuat Daftar Menu

Daftar menu adalah informasi tentang segala sesuatu yang dijual pada sebuah
restoran atau kantin. Daftar menu biasanya berisi daftar nama makanan atau minuman,
berikut harganya. Selain itu untuk menarik perhatian biasanya ditambahkan gambar-
gambar yang menarik. Berikut ini adalah contoh Daftar menu .

K afe Sekolah
Sehat, Bersit dan Jujur

||. ?)Pr’

Gambar 3 .49.
3 DB R A Contoh Daftar Menu
* Terul Fp. S000
* Lan Fp. G000 Sumber: Dokum en
el e pribadi
3. Hel JFp. 3500
4. Th LFp. 2500
S Eapio. ~Fp. 2500
& Cappu _Fp. <000
Bagaimana cara membuatnya? lkuti langkah teknik pembuatan menu berikut
ini.
1. Membuat logo dengan Shape
Pada daftar menu di restoran umumnya menggunakan logo. Shape adalah
gambar bentuk dasar yang nantinya akan dijadikan sebagai pembuat logo.
OpenOffice Writer menyediakan berbagai gambar bentuk yang dalam Toolbar
Drawing.
a. Toolbar Drawing
Gambar 3.50.
Toolbar Formatting
Sumber: Dokumen
penulis

Teknologi Informasi dan Komunikasi & ’
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Tabel 3.1. Daftar fungsi ikon pada Toolbar Drawing

1

Select

Memilih gambar

2 Line Membuat gambar garis

3 Rectangle Membuat gambar persegi
panjang

4 Ellipse Membuat gambar lingkaran

5 Freeform line Membuat gambar garis bebas

6 Text Membuat teks dalam kotak

7 Callout Membuat teks percakapan

8 Basic Shape Membuat gambar bentuk dasar

9 Symbol Shape Membuat gambar simbol

10 Block Arrows Membuat gambar tanda panah

11 Flowchart Membuat gambar diagram alur

12 Callout Membuat teks percakapan

13 Star Membuat gambar bintang

14 Point Membuat titik-titik untuk mengedit
gambar

15 Fontwork Gallery |Membuat teks artistik

16 From File Menyisipkan gambar

17 Extrusion on/off Menambahkan efek 3D pada

gambar

b. Membuat gambar Shape

1. Garis

Membuat gambar garis ada ada dua cara, untuk garis lurus gunakan

ikon line dengan cara klik pada ikon line sehingga bentuk kursor menjadi

lalu drag ke arah yang diinginkan. Untuk membuat garis bebas, gunakan ikon

freeform dengan cara klik ikon freeform sehingga bentuk kursor menjadi
kemudian drag mengikuti bentuk gambar yang diinginkan.

Gambar 3.51.
Contoh gambar garis lurus dan
garis bebas

(76 . Teknologi Informasi dan Komunikasi
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2. Bentuk lain

Gambar bentuk selain garis, cara membuatnya kurang lebih sama. Kilik
padaikon bentuk yang diinginkan sehingga bentuk pointer menjadi % kemudian
drag mouse ke arah kanan bawah sehingga bentuk gambar sempurna, lalu

lepaskan tombol mouse.

c. Memodifikasi gambar

1. Garis dan Warna Gambar

Garis dan warna gambar bentuk dapat ditambahkan, diubah atau
Caranya klik pada gambar, kemudian pilih ikon-ikon yang
dibutuhkan pada Toolbar Drawing Object Properties.

dihilangkan.

otB»a $+

13 ] [0.00"

[3] W Black | ¢ | @)J |Co|or

& |||:| Blue 8

jenis garis | | tebal garis | [warna garis| | jenis warna || warna isi

2. Memutar gambar

Gambar shape dapat diputar bebas (rotate) atau dibalik (flip). Caranya
klik pada gambar, klik ikon rotate pada Toolbar Drawing Object Properties. Pada

Gambar dengan
warna isi dengan
garis tebal

gambar akan muncul titik-titik ubah yang dapat diputar ke segala arah.

Titik-titik ubah untuk

Drag titik ini ke kiri sehingga

posisi gambar terbalik

I
1

I
I

E e

Gambar 3.52.
Contoh berbagai
gambar bentuk

Sumber: Dokumen
penulis

Gambar 3.53.
Toolbar Drawing
Objeft Properties

Sumber: Dokumen
penulis

Gambar 3.54.
Mengubah warna
dan garis gambar

Sumber: Dokumen
penulis

Gambar 3.55.
Cara memutar
gambar

Sumber: Dokumen
penulis

Gambar 3.56.
Membalik gambar

Sumber: Dokumen
penulis

Untuk SMP / MTs Kelas VIIl
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3. Mengatur posisi

Jika gambar posisinya bertumpuk dengan gambar lain maka dapat diatur
dengan cara klik mouse kanan pada gambar, pilih arrange kemudian klik:

e Bring to front, memindahkan gambar ke bagian paling depan.

e Bring forward, memindahkan ke depan gambar lain satu langkah.

e Send backward, memindahkan ke belakang gambar lain satu langkah.
e Send to back, memindahkan gambar ke bagian paling belakang.

e To background, menggunakan gambar sebagai background.

Gambar persegi pindah ke depan
gambar lain satu langkah
Gambar 3.57.

Mengatur posisi gambar ..

Sumber: Dokumen penulis L. .
P “ Gambar persegi pindah bagian
paling depan

4. Mengubah bentuk

Setiap gambar shape mempunyai titik ubah untuk mengubah gambar.
Caranya dengan men-drag titik tersebut ke arah yang diinginkan. Berikut
adalah contoh bagaimana cara mengubah gambar shape.

Gambar 3.58. ) ’ ’ ’
Mengubah bentuk gambar _
Sumber: Dokumen penulis | Titik untuk mengubah gambar | ' :

2. Bullets dan Numbering

Bullet adalah penomoran menggunakan lambang, sedangkan numbering
adalah penomoran menggunakan angka atau abjad. Cara membuatnya aktifkan
perintah Format — Bullets and Numbering.

a. Bullets

Pilih tab Bullets untuk memilih jenis nomor bullets. Pilih salah satu jenis
bullets yang tersedia, kemudian klik OK.

% Teknologi Informasi dan Komunikasi N
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BUNEts BndINUmbenng

° * [ ]
° * [ ]
° * [ ]

> > x

> > 3

> > 3

e Baso sapi
e Mieayam
e Nasigoreng
e Mie goreng
e Buburayam

Gambar 3.59.
Memilih bullets

Sumber: Dokumen
penulis

Jika ingin mengganti jenis bullets, pilih tab Option untuk mengganti. Klik

tanda

... pada Character, sehingga ditampilkan jendela bermacam-macam

karakter yang dapat dijadikan sebagai bullets. Pilih salah satu, OK

Format
vel

Gambar 3.60.
Memilih karakter

Klik di sini untuk memilih

karakter bullets

bullets
Sumber: Dokumen

[Bullets | Numbering type | Outline | Graphics | Position [options|
Numbering Bulet 3 —
—
—
Character Styl Bullets 15 B—
]
—
Character =
—
—
—
Alllevels - —
[] Consecu tive numi bering

Special Characters

Eont DejaVu Sans Subset _ ' oK

Jelel=¥Ti[s[ Jole[«]-T-[o] E [ cumca |
Y ERE ule ] N EAREA i‘E
AlATAlAlATAlE|CIEJE]ElE]T]T]T]1 —
plR{O|O|O|O|O|x|@|Uu|U|lOjU|Y]|r|BR
alalalalal|da|ee|c|leje|ale|i|T]1]1
Slajo|la|loa|a|o|+|e|lUfla|O|O|¥ |b]|Y
AlalAla|Aa|la|cle|Cle|C]|clC|le|D]|d
DlafEfefE|e|E|e|R|e|F|e[G[a]G[8 R |igomousn

b. Numbering

Pilih tab Numbering Type,
Kemudian klik OK.

kemudian pilih

penulis

Gambar 3.61.
Berbagai karakter bullets
Sumber: Dokumen penulis

salah satu jenis penomoran.

BHNEEE AN NUTDErNG:
[BulieE [Numbering type [ Yutiine | Graphics | Position | Options |
Selection
1) i, (1) [l
2) 28 (2) Il
3) B (3) Il
A) @) (a) i.
B) b) (b) ii.
C) c) (c) iii.
0

s wN e

Martabak
Pisang coklat
Kue keju
Donat
Bakpao

Gambar 3.62.
Berbagai jenis penomoran

Sumber: Dokumen penulis
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c. Outline

Gambar 3.63.
Penomoran bertingkat

Sumber: Dokumen penulis

Gambar 3.64.
QOutline number

Sumber: Dokumen penulis

Outline number adalah cara penomoran bertingkat, artinya di dalam
nomor ada nomor atau di dalam bab ada sub bab. Pada penomoran bertingkat

mengenal level-level (tingkat).

Hardware

1.1. Input

1.1.1.Mouse
1.1.2.Keyboard

1.2. Proses
1.3.0utput

L]

Software

Cara membuatnya aktifkan tab outline, pilih salah satu jenis penomoran

outline. OK.

BHITErS BN umbEnng)

Selection

[Bullets | Numbering type |Outline| Graphics | Position | Options |

o
dbodly
a)

1.

a)

1
1% T

i

p1S1 851 W]

d. Properti Bullets dan Numbering

Gambar 3.65.
Toolbar Bullet and Numbering

Sumber: Dokumen penulis

Pada saat membuat penomoran otomatis toolbar Bullets and Numbering
akan ditampilkan. Ikon-ikon di dalamnya akan sangat membantu. Misalnya
untuk me-nonaktifkan bullet atau nomor, turun ke level di bawahnya atau
naik ke level di atasnya, menukar dengan teks sebelumnya karena salah

pengurutan dan sebagainya.

Mematikan
number,

Turun
satu level

[ ova1]
Level 3

Level 2

—_

12

. Jus buah
= Jeruk
= Alpukat
= Mangga

3. Softdrink
4. Teh manis

. Es kelapa muda

Tukar dengan
nomor diatasnya

Mengulang dari
nomor awal

Turun satu

T

Pindah ke atas

=l
2ii)

Le@*\;‘xE

Mengaktifkan
bullet —
Mengaktifkan| Naik satu
number level

80
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3. Tabs

Tabs adalah titik-titik tempat berhenti. Tabs bisa diatur posisinya sehingga
dapat mempercepat kerja pada saat mengetik. Selain cepat juga rapi. Tabs
digunakan untuk membuat tampilan seperti tabel tanpa border (bingkai).

No Nama Kelas Nilai TIK
1. Alfania VI 90
2. Satriyo VIiI 95
3. Kanya VI 80
4. Nuray VI 85

a. Membuat tabs

Jarak antar tabs dapat diatur dengan mengaktitkan menu Format —
Paragraph. Aktifkan menu Tabs. Ketikkan angka pada Position. Pilihlah jenis
perataan dengan klik pada Type. Ada empat pilihan yaitu Left, Right, Centered
dan Decimal. Fill character adalah menambahkan karakter tertentu pada
ruang kosong antar tab stop. Pilih salah satu jenisnya dengan klik pada Fill
Character. Klik tombol New. Buatlah tabs berikutnya, klik kembali tombol New
untuk memasukkan setting yang sudah kita buat. Jika sudah selesai semua,
akhiri dengan klik OK.

Berikut contoh pemakaian Fill character “.......

Martabak ...............cccceeee. Rp. 3500
Pisang Coklat...........cccccceeeiieenn. Rp. 3000

(=5 Paragraph )

[ Background

W ez |
sgent | Text Flow | Numberw@mp&ps | Borders |

e
: o)
e :
) Centered i .
ool i
Character
< Fill character )
\L_-Fﬂ'gns/

() Character

< oK ‘N Cancel || Help || Reset ‘
o

Gambar 3.66.
Menentukan tabs

Sumber: Dokumen
penulis
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b. Menggunakan tabs

Setelah selesai pengaturan jarak antar tabs, teks dapat langsung
diketik. Caranya gunakan bantuan tombol tab pada keyboard untuk pindah
dari satu posisi tab ke posisi berikutnya. Untuk pindah ke baris berikutnya
gunakan tombol Enter pada keyboard, karena dengan demikian setting yang
sudah kita buat pada paragraf sebelumnya tidak hilang.

Menghapus setting tab yang sudah dibuat dapat dilakukan dengan
mengaktifkan menu Format — Paragraph — Tabs. Klik pada setting posisi
yang sudah dibuat, kemudia klik tombol Delete All. OK.

raktikum

X
K afe Sekolah
Sehe, Borsih dan Jujur
W BFACE
1. IdLs reskuk.......... . w00
2. Yewnpr O klee Bk )
S Euskep Bk
4. Iennc ¢ 1500
FoEskpst. pteu]
B Bunmt b Fp. G000
! ?}PH
MAEAFAR
o Bskrarwpio CFp. 000
SO0
j=lu us]
Fp. 2000
« Eubur srsm. . Fp. G000
@ LOPTLL A
1 E:Ealpauda.ns Fp. 4000
2. JuzEush
a Jaruk S0
= Lhnnpmes.... [=1u 0 5]
= Alpukse... =] o u]
& derswberr . .Fp. TOX
S faledrmbko B, 3500
4. Thillsne....... 2500
5. Eapi . 2500
G Cappue M Fp. <4000
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A. Praktikum menyiapkan dokumen

1. Aktifkan program pengolah kata.

2. Siapkan dokumen dengan ukuran kertas A4.

B. Praktikum membuat logo

1. Buatlah logo kafe, snack, makanan dan minuman menggunakan gambar-gambar bentuk
(shape).

2. Group masing-masing gambar logo agar tidak terpisah.

3. Atur jarak antar kolom atau spacing 0,20

4. Tambahkan garis antar kolom dengan width 0.05 pt, height 100%.

C. Praktikum membuat tabulasi

1. Buatlah tabulasi pada titik 3” dengan type Left dan Fill Character .......
2. Buat lagi tabulasi pada titik 3.5” dengan type Left tanpa Fill Character.

D. Praktikum membuat penomoran

1. Buatlah penomoran dengan jenis Number untuk mengetik daftar menu Snack.
2. Buatlah penomoran dengan jenis Bullets untuk mengetik daftar menu Makanan.

3. Buatlah penomoran dengan jenis Outline untuk mengetik daftar menu Minuman

E. Praktikum menyimpan dan mencetak

1. Simpan dokumen dengan nama MENU_NAMA_KELASMU.
2. Cetak menu dengan perintah File — Print.

Y 1.inologi Informasi dan Komunikasi
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. Banyak karya dapat dibuat dengan OpenOffice Writer diantaranya adalah poster,
artikel dengan kolom koran dan daftar menu. Untuk membuat karya tersebut
dibutuhkan kemampuan untuk mengoperasikan OpenOffice Writer dengan baik dan
memaksimalkan penggunaan fasilitas-fasilitas yang telah disediakan.

. Pembuatan poster membutuhkan gambar yang dapat dibuat dengan perintah Insert
— Picture, teks yang dibuat dengan ikon Text, teks artisik dengan Fontwork dan
background dengan Gallery.

. Artikel dibuat dengan format kolom, dilengkapi dengan dropcaps dan gambar
ilustrasi. Pada pembuatan buletin, memerlukan penambahan nomor halaman.
Nomor halaman dibuat dengan header atau footer.

Pembuatan daftar menu makanan membutuhkan logo yang dapat dibuat dengan
shape. Tabs dan bullets and numbering dibutuhkan untuk membuat daftar harga
makanan.

. Dengan membuat tiga karya ini diharapkan dapat menggunakan fasilitas-fasilitas
yang tersedia pada OpenOffice Writer dengan demikian dapat dijadikan sebagai
bahan untuk membuat karya-karya lain yang cara pembuatannya kurang lebih sama
seperti kartu nama, kartu ucapan, booklet dan sebagainya. .

Teknologi Informasi dan Komunikasi
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ISTILAH KETERANGAN

Karya tulis berupa fakta atau suatu kejadian di media yang fungsinya untuk

Artikel . . .
menyampaiakn informasi, ide atau gagasan.
Angle Sudut putar untuk mengatur arah sebuah obyek gambar
Browsing Mencari informasi di internet
Black/white |mode warna hitam putih pada gambar

Corner radius

Sudut ketumpulan obyek gambar berbentuk persegi panjang

Diippliety Menampilkan huruf kapital berukuran besar di awal paragraf
dropcaps
Menekan tombol kiri pada mouse dan menggesernya untuk memindahkan obyek
Drag
gambair.
Footer on Mengaktifkan footer
Galle Kumpulan gambar-gambar yang disediakan Openoffice writer yang dapat
Y disisipkan ke dalam dokumen baik sebagai gambar maupun gambar latar
Grayscale |Mode warna abu-abu pada gambar
Header on |Mengaktifkan header
Preview Menampilkan gambar
Setting Pengaturan
Slogan Kata-kata singkat untuk memotivasi
Software Perangkat lunak (program)
Watermark |Mode gambar dalam tampilan transparan
Width .and Mengatur lebar dan jarak antar kolom
spacing

Teknologi Informasi dan Komunikasi
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

86

Sebuah poster selalu membutuhkan gambar
untuk menarik minat pembacanya. Untuk
memasukkan menyisipkan gambar ke dalam
dokumen menggunakan perintah ....

a. Insert - Picture

b. Insert - Image

c. Insert - Symbol

d. Insert - Diagram

Berikut ini adalah format file gambar yang
dapat disisipkan ke dalam dokumen ....

a. pdf, png, odt

b. odt, ods, odp

c. bmp, jpg, gif
d. jpg, ods, odt

Meletakkan gambar dengan wrapping optimal,
dapat dilakukan dengan perintah Format —
Picture — Wrap, kemudian pilih ikon berikut

1= |

d.

Kotak teks yang mempunyai ujung tumpul

seperti berikut ini ALFA

mengatur ....

a. angle

b. corner radius
c. height

d. width

dibuat dengan

Pembuatan teks artistik pada Openoffice

. Teknologi Informasi dan Komunikasi
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10.

Writer menggunakan ikon
pada foolbar drawing.

a. Fontwork

b. Gallery

c. Callout

d. Flowchart

.... yang terdapat

Style Fontwork dapat diubah-ubah, pilihannya
terdapat pada jendela ....

a. Fontwork Shape

b. Fontwork Gallery

c. Character Spacing

d. Alignment

. Artikel dengan format kolom dapat dibuat

dengan mengaktitkan menu .... - Column
a. Insert

b. Edit

c. Format

d. View

Line Separator merupakan pilihan untuk ....
pada pembuatan kolom

a. mengatur jumlah kolom

b. mengatur lebar kolom

c. mengatur jarak antar kolom

d. menambahkan garis batas antar kolom

Dropcaps selalu diletakkan di awal ....
a. baris

b. paragraf

c. kalimat

d. halaman

Gambar di bawah ini menngunakan mode

a. default

b. grayscale

c. black/white
d. watermark




B.Lengkapi pernyataan berikut ini.

1.

Untuk menjaga rasio ukuran gambar pada saat mengubah ukurannya, klik pilihan . . . . pada
menu Format — Picture - Size.

. Huruf kapital berukuran besar yang terdapat di awal paragraf pada artikel disebut dengan

Untuk memindahkan posisi gambar di bagian paling depan diantara gambar yang lain
menggunakan perintah . . . .

Penomoran bertingkat disebut dengan . . . .

Teks atau gambar yang ada di bagian atas setiap halaman dalam dokumen disebut dengan

C.Jawablah pertanyaan berikut ini dengan singkat dan tepat.

-_—

w0 DN
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. Jelaskan komponen-komponen pada sebuah poster.

Sebutkan langkah-langkah membuat teks dengan format kolom.
Jelaskan perbedaan penomoran dengan bullets, number dan outline.

Apakah perbedaan memindahkan gambar dengan perintah Send backward dengan Send to
back?

Jelaskan fungsi fabs.

" g7
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GRAFIK

ada sebuah lembaga seperti

kantor, perusahaan dan berbagai jenis

organisasi tidak terlepas dengan yang
namanya administrasi. Administrasi adalah kegiatan
mengelola informasi secara sistematis dengan tujuan
untuk memudahkan pencarian kembali. Administrasi
biasanya identik dengan surat menyurat, pengarsipan
dan sebagainya.

sekolah,

Dalam sebuah lembaga atau organisasi
pasti melakukan kegiatan-kegiatan. Kegiatan
perlu perencanaan, oleh karenanya dibuatlah
yang namanya proposal. Penyusunan proposal
memerlukan format khusus, agar tampak sistematis
biasanya ditampilkan dalam tabulasi, khususnya
yang menyangkut perhitungan anggaran ataupun
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MEMBUAT
LAPORAN

Tabel Grafik

m Membuat data
m Membuat grafik
m Modifikasi grafik

m Insert Table

m Modifikasi tabel

m Perhitungan dalam
tabel

menyusun rencana kegiatan dan laporan keuangan pada laporan kegiatan. Grafik digunakan

untuk menganalisis perkembangan suatu hasil kegiatan dengan tampilan visual yang menarik
dan mudah dibaca. Menginformasikan hasil suatu kegiatan atau mengundang untuk menghadiri
sebuah kegiatan sekaligus kepada orang banyak, membutuhkan sebuah surat yang formatnya sama
dengan alamat tujuan yang berbeda. Untuk itu digunakan fasilitas bernama mailmerge. Semua ini
tersedia dalam program pengolah kata OpenOffice.org Writer.

Tabel digunakan sebagai bentuk untuk menyajikan perhitungan dalam proposal, jadwal untuk

w \
)V \}\‘

/)

baris, kolom, merge cell, split cell, sel, chart, data range, axis, legend, grid, data label
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Tabel terdiri atas baris dan kolom. Tabel dibuat untuk mengelompokkan data
berdasarkan jenisnya dalam tampilan baris dan kolom. Dengan demikian data jadi lebih
mudah dibaca dan dimengerti.

Bagian tabel yang tersusun vertikal disebut kolom dan yang tersusun horisontal
disebut dengan baris. Kolom diberi nama dari yang paling kiri kolom A, B, C, D dan
seterusnya, baris dinamai dari yang paling atas dengan nama baris 1, 2, 3,4 dan
Sedangkan satu kotak yang merupakan perpotongan antara baris dan
kolom disebut dengan sel. Sel dinamai sesuai dengan perpotongan nama kolom dan

seterusnya.

A. Membuat Tabel

barisnya misalnya A1, B5, C3 dan seterusnya.

Berikut contoh tabel.

kolom

No Nama D Tanggal lahir
1 Alfania Dita Jalan Anggrek | 22 Juni 1992
2 Adi Nugroho Jalan Melati 18 Juni 1994
3 Aisya Putri Jalan Mawar 25 Mei 1995
4 Hakim Ananda | Jalan Anggrek 15 April 1991

Bagaimana cara membuatnya?

1. Menyisipkan tabel
a. Menggunakan Menu

Pertama tentukan jumlah kolom dan baris yang dibutuhkan, lalu aktifkan

menu Table — Insert — Table.

v Table... Ctrl+F12

Protect Cells
Merge Table

Split

v Rows...

i Columns...

: Format...
Autofit

Convert
&, Sort,

fo Formula

Heading rows repeat

Number Format.

W Table Boundaries

3

3

F2

Bf Table Properties...

Gambar 4.1.
Contoh tabel

Sumber:
Dokumen penulis

Gambar 4.2.
Perintah membuat
tabel

Sumber: Dokumen
penulis
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Gambar 4.3.
Menyisipkan tabel
Sumber: Ddokumen penulis

Ketikkan nama tabel pada Name. Ketikkan jumlah kolom pada Column dan
jumlah baris pada Row. Heading untuk menambahkan judul kolom pada baris
pertama. Ceklis pada Repeat Heading untuk mengulang judul pada halaman
selanjutnya jika tabel terpisah halaman. Border untuk menambahkan garis

bingkai pada tabel. Tabel AutoFormat adalah tabel dengan desain yang sudah
siap pakai.

Insertiable

Mame Table1 | | ok

Size

g — | cancel |
Rows E@
Optiens
| Heading
Repeat heading
The first |:|§| rows
] Don't split takble
& Border

b. Menggunakan ikon

Cara cepat membuat tabel adalah menggunakan ikon Table. KIlik ikon
Table pada Toolbar Standard. Akan ditampilkan kotak-kotak sel di bawah ikon
table. Klik dan drag tombol mouse ke kanan untuk menentukan jumlah kolom,
lalu lanjutkan ke bawah untuk menentukan jumlah baris.

lkon Table [——[] ~

Membuat tabel dengan ikon

—

Gambar 4.4.

Sumber: Dokumen penulis
P 4%5

Gambar 4.5.
Tabel dengan 4

kolom 5 baris

Sumber: Dokumen
penulis
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2. Mengubah lebar kolom dan tinggi baris

Tabel yang ditampilkan memang sesuai dengan jumlah kolom dan baris yang
diminta tetapi lebar kolom dan tinggi barisnya belum tentu sesuai dengan kebutuhan.
Untuk itu perlu diubah.
a. Lebar kolom Cara cepat

. . . mengubah lebar
Klik mouse pada tabel yang akan diubah lebar kolomnya. Aktifkan menu kolom adalah

Table — Autofit — Column Width. Ketikkan angka kolom ke berapa yang akan g‘etnggeier E;”S
atas antar om.
diubah pada Column. Ketikkan angka lebar kolom pada Width. OK.

Column Width

| Cancel | Gambar 4.6.

Width E Mengubah lebar
| kolom
Help |
Sumber: Dokumen
k. 4 penulis

b. Tinggi baris

Klik mouse pada tabel yang akan diubah tinggi barisnya. Aktifkan menu
Table — Autofit — Row Height. Ketikkan angka kolom ke berapa yang akan diubah

pada Height. Ketikkan angka tinggi baris pada Height. OK. Cara cepat
mengubah tinggi
baris adalah dengan
_ menggeser garis

How Height £.3|| batas antar baris.
Height
:Eg [ o< |
pISDII
| cancel | Gambar4.7.
i Fit to size Mengubah tinggi
E baris
| Hel P | Sumber: Dokumen
b J penulis

3. Toolbar Table

Pada saat pembuatan tabel Openoffice Writer melengkapi fasilitas untuk
mengedit tabel dengan Toolbar Table. Toolbar ini sangat membantu untuk mengedit
tabel secara cepat.

Y 1.inologi Informasi dan Komunikasi
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Gambar 4.8.
Toolbar Table

Sumber: Dokumen penulis

Ol T

Tabel 4.1. Ikon-ikon pada Toolbar Table dan Fungsinya

1 Table Membuat tabel

2 Top Isi sel di atas

3 Center (vertical) |lIsi sel rata tengah secara vertikal

4 Bottom Isi sel di bawah

5 Insert-Row Menyisipkan baris

6 Insert-Column | Menyisipkan kolom

7 Delete Row Menghapus baris

8 Delete-Column |Menghapus kolom

9 Autoformat Membuat tabel dengan desain siap
pakai

10 Table Properties |Perangkat untuk melengkapi tabel

11 Sort Mengurutkan isi tabel

12 Sum Menjumlahkan isi tabel

13 Optimize Mengubah lebar kolom dan tinggi
baris sesuai isi sel

14 Split Cell Membagi sel

15 Merge Cell Menggabung sel

16 Background Color |Mewarnai sel-sel pada tabel

17 Border Menambahkan garis bingkai pada
tabel

18 Line Color Mewarnai garis bingkai pada tabel

19 Line Style Memilih jenis garis bingkai pada
tabel

. Teknologi Informasi dan Komunikasi
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4. Menyisipkan baris dan kolom

Jika pada pembuatan tabel jumlah baris kurang atau perlu menyisipkan satu
baris ditengah-tengah, kamu dapat menambahkan dengan menempatkan posisi
kursor pada baris akan disisipkan baris baru . Aktifkan menu Table — Insert — Row .

Ketikkan banyaknya baris pada Number, kemudian pilihlah posisinya apakah

Insert Rows

Insert

Number

Paosition
") Before

@ After

) —=x

akan disisipkan before untuk sebelum atau after untuk sesudah posisi kursor.

No Nama Alamat Tanggal Lahir
1 Alfania Dita Jalan Anggrek 22 Juni 1992
2 Adi Nugroho Jalan Melati 18 Juni 1994
3 Aisya Puri Jalan Mawar 25 Mei 1995
4 Hakim Ananda | Jalan ANggrek 15 Oktober 1991

Jika pada pembuatan tabel jumlah kolom kurang atau perlu menyisipkan
satu kolom ditengah-tengah, kamu dapat menambahkan dengan menempatkan
posisi kursor pada kolom yang akan disisipkan kolom baru . Aktifkan menu Table

— Insert — Column .

Insert Colamns

Insert

Mumber

Position

[ 3

Help

OK

Gambar 4.9.
Menyisipkan baris

Sumber: Dokumen
penulis

Cara cepat
menyisipkan baris
adalah dengan klk
ikon Insert Row pada
toolbar Table .

Gambar 4.10.
Menyisipkan satu
baris baru

Sumber: Dokumen
penulis

Gambar 4.11.
Menyisipkan kolom

Sumber: Dokumen
penulis
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Gambar 4.12.
Menyisipkan satu
kolom baru

Sumber: Dokumen
penulis

Gambar 4.13.
Menghapus baris ke
dua

Sumber: Dokumen
penulis

Gambar 4.14.
Menghapus kolom
ke tiga

Sumber: Dokumen
penulis

Gambar 4.15.
Menggabung kolom

Sumber: Dokumen penulis

Tanggal Lahir

22 Juni 1992

18 Juni 1994

25 Mei 1995

No Nama Alamat

1 | Alfania Dita Jalan Anggrek
2 | Adi Nugroho Jalan Melati

3 | Aisya Puri Jalan Mawar
4 |Hakim Ananda |Jalan Anggrek

15 Oktober 1991

5. Menghapus baris dan kolom

Baris yang sudah tidak digunakan lagi dapat dihapus dengan mengaktifkan

menu Table — Delete — Row.

No Nama Alamat Tanggal Lahir
1 Alfania Dita Jalan Anggrek 22 Juni 1992
3 Aisya Puri Jalan Mawar 25 Mei 1995
4 Hakim Ananda Jalan ANggrek 15 Oktober 1991

Kolom yang sudah tidak digunakan lagi dapat dihapus dengan mengaktitkan

menu Table — Delete — Column.

No Nama Tanggal Lahir
1 Alfania Dita 22 Juni 1992
2 Adi Nugroho 18 Juni 1994
3 Aisya Puri 25 Mei 1995
4 Hakim Ananda 15 Oktober 1991

6. Menggabung dan membagi sel dalam tabel

Untuk membuat tabel dengan format tertentu kadang perlu menggabung
dua sel atau lebih. Caranya blok sel yang akan digabung, kemudian aktifkan menu
Table — Merge Cell. Atau dapat juga denga klik ikon Merge Cell pada toolbar Table.

| Sel yang telah digabung |——

Dalam keadaan tertentu terkadang juga harus membagi sebuah sel menjadi
lebih dari satu baik secara vertikal maupun horisontal. Caranya klik mouse pada sel
yang akan dibagi, kemudian aktifkan menu Table — Split Cell. Atau dapat juga klik

ikon Split Cell pada toolbar Table.
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Split
Split cell into Elz \LI
Direction Gambar 416.
[ Harizentaly Menu untuk membagi
[ Into equal proportions Sel
W S Sumber: Dokumen
e penulis
Gambar 4.17.
Membagi sel secara
| vertikal(a) dan
horisontal(b)
Sumber: Dokumen
a)' b)' penulis
7. Arah teks dalam tabel
pd & n)_>> b %_’|
)
° 3 3 =8
o 2 )
1 Alfania Dita Jalan Anggrek 22 Juni 1992 $‘aab'2|'°:; r:;;g-arah
2 Adi Nugroho Jalan Melati 18 Juni 1994 teks vertikal
3 Aisya Puri Jalan Mawar 25 Mei 1995 Sumber: Dokumen
4 Hakim Ananda Jalan Anggrek 15 Oktober 1991 | penulis

Ingin posisi teks seperti pada judul kolom tabel di atas? Blok baris judul,
kemudian klik ikon Table Properties. Aktifkan tab Text Flow, pada Text direction pilih

Right to Left (Vertical).

8. Perataan isi sel dalam tabel

able rormat
4‘ Columns | Borders | Background |
Text Flow
[ Break Page Column
Before After
with Page Style [ 12| Page number o B
& Allow table to split across pages and columns
& Allow row to break across pages and columns
] Keep with next paragraph
@ Fepeat isading
The first rows
Text direction [Right-to-left (vertical) & Gambar 4.18.
Alignrment Mengubah arah teks
Sl e e ~ Sumber: Dokumen
ok (o] [ ) [ ]| PENUNS

Setelah format tabel siap berikutnya adalah mengisi tabel. Format teks dalam
sel sama dengan yang berlaku pada teks sebagaimana biasa. Gunakan ikon-ikon
pada foolbar formatting untuk mengubah format teks.

Teknologi Informasi dan Komunikasi
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Gambar 4.19.
Toolbar Formatting

Sumber: Dokumen penulis

Gambar 4.20.

lkon Perataan secara
horisontal

Sumber: Dokumen penulis

Gambar 4.21.

Times Mew Faman

v||12 v| B /7 U

Sedangkan untuk perataan teks secara horisontal juga dapat memanfaatkan
ikon-ikon pada toolbar formatting.

(i} —=|=

|Center| | Right |

Contoh perataan sel

i NAMA

i ALAMAT

TELEPDNI TANGGALLAHIR ]

secara horisontal
Rata kiri(a), tengah(b),
kanan(c), kanan kiri(d)
Sumber: Dokumen
penulis

a).

b). c). d).

Untuk mengatur perataan teks secara vertikal dapat dilakukan dengan bantuan
ikon-ikon yang tersedia pada toolbar Table.

Gambar 4.22.
Ikon perataan secara _
vertikal | =1

Sumber: Dokumen penulis

Gambar 4.23. |INAMA
Contoh perataan sel
secara vertikal

AT ANAT

TELETON

Rata atas(a), tengah(b)
dan bawah(c)
Sumber: Dokumen penulis
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9. Border dan Background

Untuk memperbaiki tabel agar tampak lebih baik tampilannya, maka dapat
ditambahkan border dan background. Secara lengkap perintah mengatur border dan
background ini terdapat pada menu Table — Table Properties. Pilih tab Border untuk

mengubah garis

Jabletrormat

[Table | Text Flow | Columns [Borders| Background |

Line arrangement
Default

CCEEE

User-defined

Line
Style
- None -
0.05 pt
0.50 pt
1.00 pt

—— 250 pt
—— .00 pt
.00 pt

110

Color
Il Black 18

Spacing to contents

it por T3

W Synchronize

Right
Top

Bottom

Shadow styie
Position

gooE =

Distange

[zl

0.07"
B,

Bl Gray

Properties

W Merge adjacent line styles

|Cance\ H Help || Reset |

Pilih tab Background untuk menambahkan warna pada background.

Jabletrormat

|Tabla | Text Flow | Columns | Borders |Background|

AS [color

o] Far

|cell 1

Background color

i EEEE B
/AN N

[ ]
]
[ |
[ |
[ |

[*

IINEEEEN
INEEEEN

No Fill

oK

H Cancel H Help H Reset |

Cara cepat untuk mengatur border dan background adalah menggunakan

ikon-ikon pada toolbar Tabel:

Pertama blok bagian tabel yang akan diberi efek warna atau ditambahkan
border. Klik ikon Border, untuk memilih jenis border. Klik ikon Border Style untuk
memilih jenis garis dan klik ikon Border Color untuk memilih warna garis. Kilik ikon

Background untuk memberi warna background.

Gambar 4.24.
Menu Border
tabel

Sumber: Dokumen
penulis

Gambar 4.25.
Menu Background
tabel

Sumber: Dokumen
penulis

Teknologi Informasi dan Komunikasi
Untuk SMP / MTs Kelas VIIl




. Ggmbar 4.26. [

Menu pada ikon-ikon toolbar — [ — EEEE | EEEE
table aem H

Jenis border(a), jenis garis(b), — : 4
warna garis(c), warna | Buredarddl T
background(d) O i HH

Sumber: Dokumen penulis r_-r: r:- ﬂi— LLL
a). c). d).

Gambar 4.27.

O e ke |1 Alfania Dita Jalan Anggrek | 22 Juni 1992
Sumber: Dokumen penulis | 2 Adi Nugroho Jalan Melati 18 Juni 1994
3 Aisya Puri Jalan Mawar 25 Mei 1995

4 Hakim Ananda Jalan Anggrek 15 Oktober 1991

10. Table Autoformat

Adalah tabel yang sudah disiapkan dengan format khusus. Untuk membuatnya
klik pada tabel yang sudah jadi atau posisikan kursor pada tabel, lalu aktifkan menu
Table — Autoformat. Yang perlu kamu perhatikan di sini adalah ada jenis tabel yang
khusus untuk memformat data angka dan ada tabel yang untuk memformat data
teks.

Gambar 4.28. [NINEE | Alamat | Tanggal Lahir

Contoh tabel dengan Alfania Dita Jalan Anggrek |22 Juni 1992
autoformat - - ;
Sumber: Dokumen \ Adi Nugroho Jalan Melati 18 Juni 1994
penuiis [CRII Aisya Puri Jalan Mawar 25 Mei 1995
\ Hakim Ananda Jalan Anggrek 15 Oktober 1991

1. Perhitungan dalam tabel

Padatabel terkadang diperlukan perhitungan-perhitungan seperti penjumlahan,
mencari nilai rata-rata. Pada bab ini hanya akan kita bahas perhitungan sederhana
yang biasanya digunakan dalam pembuatan surat. Untuk perhitungan yang yang
lebih rumit akan di bahas secara rinci pada pengolah angka Openoffice.org Calc.

Untuk membuat formula (rumus) perhitungan dalam tabel, posisikan kursor
pada sel yang akan diisi. Klik menu Table — Formula. Baris formula akan ditampilkan.
Ketik rumus pada kotak teks yang tersedia.

100
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| Ketik formula di sini |

foxv O
NO NAMA BARANG | JUMLAH HARGA TOTAL
SATUAN
1 | Stereoform 5 6000 30000
2 | Kertas lipat Asturo 2 7000 14000
3 |CDRW 25 2000 50000
4 | Photo Paper 1 35000| =<C5>*<D5>
5 | Konektor RJ45 5 10000
6 | Paku payung 1 1500
7 | Kertas Krep 2 1500
8 |lIsi Cutter Kenko 1 4500
JUMLAH =Sum<EZ2:E9>

Perhatikan tabel di atas, untuk mengisi rumus Total pada Stereoform posisikan
kursor pada sel total milik stereoform (yang berisi angka 30000). Aktifkan menu
Table — Formula atau ketik tanda = (sama dengan, penulisan formula selalu di awali
dengan =). Formula bar akan ditampilkan. Klik mouse sel jumlah stereoform (angka
5) sehingga ditampilkan <C2> pada formula bar. Ketik tanda * (sebagai operator
perkalian). Klik mouse pada sel harga satuan stereoform (angka 6000) sehingga
ditampilkan <D2>. Formulanya menjadi =<C2>*<D2>. Tekan tombol Enter, maka
formula berubah menjadi nilai hasil 30000.

Untuk menghitung jumlah, posisikan kursor pada sel nilai jumlah. Ketik =
(sama dengan) atau aktifkan menu Table — Formula. Klik pada ikon fungsi f pada
Formula Bar, pilih Sum (fungsi untuk menghitung jumlah). Blok semua sel yang akan
dijumlahkan pada kolom TOTAL, sehingga pada Formula Bar tertulis =Sum<E2:E9>.
Tekan tombol Enter akan ditampilkan nilai 188000. Selamat mencoba!

Gambar 4.29.
Formula Bar

Sumber: Dokumen
penulis

Gambar 4.30.
Contoh mengisi
formula pada
tabel

Sumber: Dokumen
penulis
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raktikum

PEMASUKAN
NO JENIS JUMLAH SATUAN TOTAL
1 Anggaran dari Sekolah 250000
PENGELUARAN
1 CD RW untuk hadiah 25 2000 50000
2 Paku payung 1 1500 1500
3 Konektor RJ 45 1 10000 10000
4 Paper Photo Sticker 1 35000 35000
5 Permen Chupa Cup untuk souvenir 5 5800 29000
6 CD Pocket Bantex 1 17000 17000
7 Kertas lipat Asturo 2 7000 14000
8 Tinta printer isi ulang 1 25000 25000
9 Kertas krep 2 1500 3000
10 |Transport 4 2000 8000
JUMLAH PENGELUARAN 192500
SALDO 57500
(Lima puluh tujuh ribu lima ratus rupiah)

A. Praktikum menyiapkan tabel

1. Buatlah tabel dengan jumlah kolom 5 dan jumlah baris 18.

2. Gabunglah sel-sel yang harus digabung (lihat soal) dengan bantuan ikon Merge Cell.

3. Tambahkan border dan background pada tabel.

B. Praktikum mengisi tabel

1. Ketikkan isi masing-masing sel, kecuali sel-sel Total pada Pengeluaran karena kamu harus

mengisinya dengan formula sehingga kesalahan perhitungan dapat dihindarkan.

2. Formatlah teks dengan bantuan ikon-ikon toolbar formatting.

3. Aturlah perataan isi sel dalam tabel dengan bantuan ikon-ikon pada toolbar formatting.

C. Praktikum membuat formula

1. Buatlah formula pada sel Total dengan ketentuan Jumlah * Satuan.
2. Buatlah formula pada sel JUMLAH PENGELUARAN menggunakan fungsi SUM.
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3. Buatlah formula pada sel SALDO dengan ketentuan TOTAL PEMASUKAN -
JUMLAH PENGELUARAN.

4. Cocokkan hasil perhitunganmu dengan angka yang sudah tertera pada soal di
atas.

D. Praktikum menyimpan dan mencetak

1. Simpanlah dengan nama TABEL_NAMA_KELAS.
2. Cetak hasil pekerjaanmu dengan perintah File — Print.

B. Menyajikan Data dengan Grafik

Grafik atau dalam istilah komputer sering disebut dengan Chart adalah merupakan
visualisasi dari data yang tersimpan dalam tabel. Hati-hati tertukar dengan istilah
graphics karena berbeda. Dalam istilah di dunia IT graphics berarti gambar atau hal-hal
yang berhubungan dengan desain.

Grafik biasanya digunakan untuk menganalisa suatu perkembangan, lebih cepat
dan lebih mudah membacanya dibandingkan jika harus menganalisis data yang tersimpan
dalam tabel. Grafik umumnya dilambangkan dengan gambar-gambar seperti garis atau
kurva, batang, piramid, lingkaran (sering diistilahkan dengan donat/doughnut atau pie
karena bentuknya yang menarik seperti makanan). Ketinggian garis, batang atau besar
kecilnya potongan juring dalam lingkaran menyatakan perbandingan yang dapat dengan
cepat ditangkap bedanya.

GRAFIK PENGUNJUNG PERPUSTAKAAN
APRIL 2009
300

250 —

200
B | aki-laki

150 -
| Perempuan

JUMLAH SISWA

Gambar 4.31.
Contoh grafik
Sumber: Dok. Penulis

Al VI IX

KELAS
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1. Menyiapkan data

Langkah pertama adalah menyiapkan data. Data yang akan ditampilkan dalam
bentuk grafik dibuat lebih dahulu. Data harus dalam bentuk tabel, dapat dibuat
dahulu tabelnya lengkap atau setidaknya data sudah siap dan dapat diketikkan pada
datasheet yang sudah disiapkan ketika perintah membuat tabel dijalankan. Berikut
ini adalah contoh tabel yang sudah disiapkan.

Gagbar 2N Kelas Laki-laki Perempuan
ata grafik
Pengunjung V” 125 215
Perpustakaan | V||| 205 235
Sumber: Dokumen | |X 210 240
penulis

2. Membuat Grafik
a. Insert — Object - Chart
Blok tabel yang akan ditampilkan grafiknya. Aktifkan menu Insert — Object
— Chart maka akan ditampilkan langkah pertama pembuatan grafik. Memilih jenis
grafik.

b. Chart Type
Adalah fasilitas untuk memilih jenis grafik. Pilih salah satu di bawah Choose
a chart type. Ketika satu jenis grafik terpilih, misalnya Column maka di sebelah
kanan ada beberapa variasi jenis yang tersedia. Tinggal kamu memilihnya salah
satu.
Tersedia juga jenis tampilan tiga dimensi (3-D). Klik pada pilihan 3D Look
maka di bawahnya akan muncul beberapa pilihan, pilih sesuai seleramu. Lalu

Next
& Chart Wizard =
Steps (( Choose a chart type D
Col
1 Chart Type; ll_L—' =
2.Data Range @ pie
ks Area
3.Data Series | Line Risese
4.Chart Elements e ¥ (Scatter)
= v
|% stock —
4il Column and Line e
_C-;-ar_nb_ar 4.33. ] —
Memilih jenis grafik Cylinder
Cone
Sumber: Dokumen o
penulis Help | <Back ][ Next=>) || Einish |[ cancel

c. Data Range
Data range adalah data dalam tabel yang nantinya akan dijadikan sebagai
grafik. Apabila data sudah dibuat di awal maka data range tidak perlu diisi lagi.
Tetapi jika belum dibuat dapat ditambahkan dengan mengaktitkan menu View —
Chart Data Table. Kemudian isikan datanya.

1\04 . Teknologi Informasi dan Komunikasi NN
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ChartWizard

Steps Choose a data range

Data range
|Table1.Aal:c4

1.Chart Type

() Data series in rows

Data series in columns
4, Chart Elements @ =

W First row as label

4 First column as label

Gambar 4.34.
Menentukan data
range

Sumber: Dokumen
Help ‘ ‘ << Back || Next == | | Finish | | Cancel | .
penulis

Ada dua pilihan data series, yaitu Data Series in Row yang artinya data baris
pertama pada tabel dijadikan label pada sumbu X grafik, yang kedua Data Series
in Column yang artinya kolom pertama pada pada tabel dijadikan sumbu X pada
grafik. First row as label artinya baris pertama pada tabel dijadikan sebagai label
pada sumbu X grafik. First column as label artinya kolom pertama pada tabel
dijadikan sebagai label pada sumbu X grafik. Klik Next.

d. Data Series

Ada dua jenis data series pada contoh ini, yaitu Series untuk laki-laki dan
perempuan. Jika tidak ingin ditampilkan dapat dihapus dengan cara klik tombol
Remove. Sebaliknya jika akan menambahkan series baru klik tombol Add. Ketik
nama seriesnya pada Range for Name. Klik Next.

2 Chart Wizard i3l

Steps Customize data ranges for individual data series

Data series Data ranges

Laki-laki Name Tablel B1:B1
Perempuan Y-Values Table1.B2:B4

1.Chart Type

4.Chart Elements
Range for Name

|Table1.B1:B1 |

Add A | Categories
[ Remove | [w| [TablelA2ad ‘
R i

Gambar 4.35.
Memilih Series

Sumber: Dokumen
Help | | << Back H Next >> | ‘ Finish | ‘ Cancel | .
penulis

e. Chart Element

Langkah terakhir adalah melengkapi elemen grafik. Ketikkan judul grafik
pada kotak Title. Isi sub judul ketikkan pada Subtitle. Ketik label pada Sumbu X
pada X axis. Ketik label pada sumbu Y pada Y axis. Pada grafik dengan mode
3-Dimensi mempunyai sumbu Z, ketikkan labelnya pada Z axis.

Untuk menampilkan keterangan pada diagram, ceklis pada Display legend.
Posisi keterangan pada diagram ini dapat kamu atur dengan meng-klik Left (kiri),
Right (kanan), Top (atas) dan Bottom (bawah).

Selanjutnya adalah menambahkan grid. Untuk menambahkan garis
mendatar klik X axis pada Display Grid dan Y axis untuk garis tegak. Klik Finish.

Y 1.inologi Informasi dan Komunikasi &5
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Gambar 4.36.
Melengkapi
komponen grafik

Sumber: Dokumen
Penulis

Gambar 4.37.
Hasil akhir
pembuatan grafik

Sumber Dokumen
penulis

Gambar 4.38.
Menu dan Toolbar
grafik

Sumber: Dokumen
penulis

E R
Steps Choose titles, legend, and grid settings
i W Display legend
1.Chart Type Title FFIK PENGUNJUNG PERPUSTAKAANl play leg
i ) Left
2.Dats Range Subtitle  [APRIL 2008 | O L
. @ Right
3.Data Series X axis |KELA5 |
() Top
4,Chart Elements Y axis |JUMLAH SISWA |
() Bottom
Z axis
Display grids
[] X axis M Y axis Z axis
T e | |

Tabel sudah selesai. Hasilnya akan ditampilkan seperti
berikut.

GRAFIK PENGUNJUNG PERPUSTAKAAN
APRIL 2009

B | aki-laki
] Perempuan

JUMLAH SISWA

Pada saat ini grafik sudah dapat ditampilkan di halaman naskah, caranya
klik mouse di luar obyek grafik, maka kita akan kembali halaman naskah.

Penempatan grafik di dalam naskah dapat diatur, dengan menggeser grafik
ke tempat posisinya dengan cara klik drag sepeti layaknya sebuah gambar.

3. Memodifikasi Grafik

Untuk memodifikasi grafik kembali seperti mengganti warna, type grafik atau
menambahkan series, kamu tidak dapat melakukannya di dalam naskah melainkan
harus mengaktifkan kembali software pembuat grafik dengan cara dobel klik mouse
pada obyek grafik.

Berikut adalah tampilan menu dan toolbar untuk mengubah grafik.

File Edit Wiew Insert Format Tools Window Help

B-S08 N Qs

@)
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a. Mengubah Jenis Grafik

Aktifkan menu Format — Chart Type atau klik ikon Chart Type. Jendela Chart
Type akan ditampilkan seperti berikut dan kamu dapat memilih.

(@ Chart Iype 3
[ Column
|; Bar fer—
B Pie =
b Area
|2 Line Normal
[ XY (Scatter)
i i eere—
1B Net W 30 Look  [Simple i
|1 stock
: Shape
lgail Column and Line EL
Box
Cylinder
Cone
Pyramid
oK | | Cancel | | Help |
o — GRAFIK PENGUNJUNG PERPUSTAKAAN
Er Chart Wall APRIL 2009
200
Q
'°° & B Lakidaki i
- I ol M Perempuan vy
o | ' v
b S s X
50 [
2 L
Chart Area d ﬂ"«s v
v X o

b. Warna Grafik
1). Format - Chart Wall

Jika ingin menambahkan warna pada dinding grafik agar lebih menarik

dapat ditambahkan dengan perintah Format — Chart Wall.

Pilih jenis warna

pada tab Area dan Transparancy untuk mengatur tebal tipisnya warna, jenis

garis pada tab Border. OK.

@ Chartwal =

|Borders |Area| Transparency |

Fill

[color B
[ Orange 4 [+
5 Violet

I Bordeaux

[ Pale yellow

= e

=] Pale green
I Dark violet

|
G

ok || cancel || pelp || Beset |

Gambar 4.39.
Menu untuk
mengubah Chart
Type

Sumber: Dokumen
penulis

Gambar 4.40.
Contoh grafik yang
sudah diubah
jenisnya

Sumber: Dokumen
penulis

Gambar 4.41.
Mengatur Chart Wall

Sumber: Dokumen
penulis

Teknologi Informasi dan Komunikasi
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2). Format - Chart Area

Jika ingin menambahkan warna pada latar grafik agar lebih menarik dapat
ditambahkan dengan perintah Format — Chart Area. Pilih jenis warna pada tab
Area dan Transparancy untuk mengatur tebal tipisnya warna, jenis garis pada
tab Border. OK.

2 Chart Area =

[Borders | Area | Transparency |

Fill

[color 2]

[ Blue gray
B Red 1

Il Red 2

Bl Red 3

B Red 4

B Red 5

Bl Red &

Il Red 7

Il Red 8

Il Magenta 1
Bl Magenta 2

Gambar 4.42. B Magenta 3 ]
Mengatur Chart
Area

Sumber: Dokumen
penulis

oK H Cancel H Help H Reset

3). Format - Chart Floor
Jika ingin menambahkan warna lantai grafik pada grafik dengan mode
3-Dimensi agar lebih menarik dapat ditambahkan dengan perintah Format —
Chart Floor. Pilih jenis warna pada tab Area dan Transparancy untuk mengatur
tebal tipisnya warna, jenis garis pada tab Border. OK.

( | Borders |Area| Transparency | E

Fill

[color 18]

[ Gray 20% [=]
[1 Gray 10%

[18Blue gray

B Red H
Bl Red 2

Il Red 3

B Red 4

B Red 5

Bl Red 6

Ml Red 7

Il Red 8

Bl Magenta 1 E\

Gambar 4.43.
Menambahkan Chart Floor

Sumber: Dokumen penulis

oK || Cancel H Help H Reset

4). Format — Object Properties

Jika ingin menambahkan properti seperti warna, border, character, font
effect, data label dan layout pada obyek grafik, klik pada obyek yang ingin
ditambahkan propertinya. Aktifkan menu Format — Object Properties. Pilih
tab yang sesuai dengan properti yang akan diubah. OK.

" Untuk SMP / MTs Kelas VIl
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Pata’series

[Borders |Area | Transparency | Characters | Font Effects | Data Labels | Layout |

Fill

|Cu|or E |
I chart 2 [«]
[ chart 3
B Chart 4
Ml Chart 5
[ chart 6
Ml Chart 7
[ chart 8
Ml Chart ¢
[ Chart 10
I chart 11
Bl Chart 12
=]
Gambar 4.44.
Memformat obyek
grafik
Sumber: Dokumen
oK H Cancel || Help || Reset | penulls
c. Keterangan Grafik
1). Insert - Titles
Jika kamu lupa memberikan judul pada grafik, aktifkan menu Insert —
Titles. Isikan pada Title untuk judul, Sub Title untuk sub judul, X axis untuk
menambahkan label pada sumbu X, dan Y axis untuk menambahkan label
pada sumbu Y.
Title [ERAFIK PENGUNJUNG PERPUSTAKAA|
S [ | Gambar 4.45.
Xaxis  [KELAS | Menyisipkan judul
¥ axis [JuMLAH SISwA | grafik
Z axis | | Sumber: Dokumen
penulis
2). Insert - Axis
Untuk menampilkan atau menyembunyikan sumbu X, sumbu Y atau
sumbu Z. Aktitkan menu Insert — Axis. Klik pada option-option X axis, Y axis
dan Z axis. OK.
Axes 3
—— [ oK ‘
oY axis Gambar 4.46
; Menampilkan
Eemm— keterangan sumbu
Sidian X, Y dan Z
A1 Y axis Sumber: Dokumen
: i penulis
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3). Insert - Grid

Garis-garis horisontal dan vertikal di belakang diagram digunakan
sebagai garis bantu untuk melihat nilai pada sumbu X atau sumbu Y pada
grafik. Untuk menambahkannya aktitkan menu Insert — Grid.

Datafabels

[ Number farmat... | F———
L ] Cancel
[] Show walue as percentage
| Percentage format... |
[] Show category
Gambar 4.47. | L) Showlegendkey
Menampilkan grid S —— o
Sumber: Dokumen penulls Flrmeen m

4). Insert — Legend

Untuk menampilkan atau menyembunyikan keterangan grafik Aktifkan
menu Insert — Legend. Show Legend untuk mengaktifkan. Untuk mengatur
posisinya pada grafik dapat memilih Left (kiri), Right (kanan), Top (atas) atau
Bottom (bawah). OK.

Gambar 4.48.
Menyisipkan legend A Bettomn
Sumber: Dokumen penulis = lr

5). Insert — Data Labels

Untuk menampilkan atau menyembunyikan label grafik (nilai) Aktifkan
menu Insert — Data Labels. Show value as number artinya menampilkan nilai
dalam bentuk angka. Show value as percentage menampilkan nilai dalam
bentuk perentase. Show category menampilkan kategori. Show legend key,
menampilkan kategori legend. OK.

'@ Data Labels =
& Show value as number
[ Number format... | o ;
1 J Cancel
[] Show value as percentage
:

N F-er-teritage format...
[ Show category
Gambar 4.49. [ | Show legend key
Menampilkan data label
Sumber: Dokumen penulis

”

Separator [Space o

Placement Above 1%
L
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Praktikum

JUMLAH

PUTRI

KATEGORI

PUTRA

MARET 2009

o ,.—"'. e ,//aﬁ

0 20 40 60 80 100120

110

JUMLAH

GRAFIK PENGUNJUNG STAND IT-CORNER

B KELAS VI
H KELAS VI
O KELAS IX
HE cuRU

A. Praktikum membuat data

1. Buatlah data grafik dalam bentuk tabel seperti di bawah ini.

2. Blok seluruh bagian tabel.

KATEGORI PUTRA PUTRI JUMLAH
KELAS VI 50 25 75
KELAS VI 45 60 105
KELAS IX 75 35 110
GURU 15 10 25

B. Praktikum membuat grafik

1. Aktifkan perintah membuat grafik Insert — Chart.

o &> oD

Tentukan Data Series.

Pilihlah jenis grafik sesuai dengan soal.

Pilih Data Range.

Lengkapi keterangan grafik dengan Chart Element.

Teknologi Informasi dan Komunikasi
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C. Praktikum memperindah grafik

1. Tambahkan Chart Area.

2. Ubah Chart Wall.
3. Ubah Chart Floor.

4. Tambahkan Data Label.

D. Praktikum menyimpan dan mencetak

1. Simpanlah dokumen dengan nama GRAFIK _Nama_Kelas.

2. Cetaklah dokumen.

Teknologi Informasi dan Komunikasi
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&angkuman cesses

. Dokumen laporan memerlukan tabel untuk menyajikan data karena lebih sistematis dan mudah
dipahami.

2. Tabel terdiri atas baris dan kolom. Perpotongan antara keduanya disebut dengan sel.

3. Mengisi tabel dapat dilakukan dengan mengetikkan teks ke dalam sel-sel pada tabel. Memformat
teks dalam tabel dapat dibantu dengan ikon-ikon pada toolbar formatting. Sedangkan perhitungan
dalam tabel dapat dilakukan menggunakan menu Table — Formula.

4. Grafik merupakan salah satu cara penyajian data dalam bentuk visual. Membaca grafik lebih
mudah dan lebih cepat dibandingkan dengan membaca angka-angka pada tabel. Grafik biasanya
digunakan untuk menganalisis perkembangan suatu kegiatan.

5. Membuat grafik dapat dilakukan dengan menu Insert — Object - Chart. Membuat grafik harus
disiapkan datanya lebih dahulu dalam bentuk tabel. Ada empat langkah penting dalam pembuatan
tabel yaitu memilih jenis grafik, menentukan data range, menentukan data series dan melengkapi
komponen-komponen tabel seperti judul grafik, judul sumbu (axis) dan keterangan (legend).

6. Grafik yang sudah jadi dapat dimodifikasi baik jenisnya maupun propertinya.

Y 1.inologi Informasi dan Komunikasi &3
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y =
~Glosarium

Autoformat | Tabel dengan format yang telah disediakan oleh Openoffice writer
Axis Sumbu pada grafik (sumbu x, sumbu y dan sumbu z untuk grafik 3 dimensi)
Background |Warna latar belakang
Border Bingkai
Chart Grafik
Chart area |Area di belakang grafik
Chart floor |Bagian bawah grafik pada grafik dengan jenis 3 dimensi
Chart type |Jenis grafik
Chart wall Dinding grafik pada grafik dengan jenis 3 dimensi
column Kolom pada tabel

Column width

Lebar kolom pada tabel

1N

Datarange |Data pada tabel yang akan disajikan dalam bentuk grafik
Data series |Satu kelompok data sejenis
Formula Rumus pada tabel
Grid Garis-garis vertikal dan horisontal pada tabel
heading Judul kolom pada tabel
Legend Keterangan satu seri data pada grafik
Merge cell |[Menggabung sel dalam tabel
Row Baris pada tabel
Row height |Tinggi baris pada tabel

Teknologi Informasi dan Komunikasi N
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ISTILAH KETERANGAN

Split cell Membagi sel pada tabel
Sub title Judul grafik baris ke dua
Table
properties Perlengkapan pada pembuatan tabel

Text direction

Arah teks dalam sel-sel pada tabel

Title

Judul grafik baris pertama

Visual

Tampilan berupa gambar

Teknologi Informasi dan Komunikasi
Untuk SMP / MTs Kelas VIIl
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Evaluasi 2

A.Pilihlah jawaban yang paling tepat.

1.

1 1“6‘\\ \ Teknologi Informasi dan Komunikasi

Perintah untuk membuat tabel terdapat
pada menu ....

a. Format

b. Insert

c. Table

d. Tools

Berikut ini adalah tabel dengan jumlah baris,
kolom dan sel ....

5 kolom 4 baris 20 sel
4 kolom 5 baris 20 sel
5 kolom 4 baris 5 sel
4 kolom 5 baris 4 sel

oo oo

Mengubah lebar kolom pada tabel dapat
dilakukan dengan perintah Tabel - .... —
Column width

a. autofit

b. autoformat

c. format

d. insert

Ikon Optimize adalah fasilitas pada toolbar

Table yang fungsinya untuk ....

a. Mengubah lebar kolom sesuai banyaknya
huruf

b. Mengubah tinggi baris sesuai dengan
tinggi huruf

c. Mengubah lebar kolom dan tinggi baris
sesuai dengan isi sel

d. Mengubah banyaknya kolom sesuai

Untuk SMP / MTs Kelas VIII

kebutuhan

5. Formula yang digunakan untuk menghitung

jumlah pada tabel adalah ....
a. max

b. average

c. count

d. sum

Sebelum membuat grafik yang harus
disiapkan adalah data dalam tampilan ....
a. sel

b. kolom

c. baris

d. tabel

Ada empat langkah pembuatan grafik,
langkah yang pertama adalah ....

a. memilih jenis grafik

b. menentukan data range

c. menentukan data series

d. membuat judul grafik

Grafik berikut ini termasuk grafik dengan
type column dengan shape ....

. w0
1
D

box
b. cylinder
C. cone
d. pyramid

Tebal tipisnya warna pada chart area dapat
diatur menggunakan fasilitas ....

a. border

b. background



c. transparancy
d. color

10. Keterangan berupa angka pada grafik seperti di bawah ini disebut dengan ....

36 = ?

. 2

=
a. rata kanan
b. rata Kiri
c. rata kanan dan rata Kiri
d. rata tengah

B.Lengkapi pernyataan berikut ini.
1. Komponen sebuah tabel terdiriatas ... . dan . . ..
2. Perpotongan antara kolom dengan baris pada tabel disebut dengan . . ..
3. lkon . ... berfungsi untuk menyisipkan baris pada tabel.
4. Langkah-langkah membuat grafik terdapat pada menu Insert — Object - . . ..
5

Garis-garis horisontal dan vertikal di belakang grafik disebut dengan . . . .

C.Jawablah pertanyaan di bawah ini dengan tepat.
1. Jelaskan fungsi tabel.
2. Apakah keuntungan menggunakan tabel.
3. Jelaskan langkah-langkah menghapus kolom pada tabel.
4. Jelaskan keuntungan menyajikan data dengan grafik.
5

Sebutkan jenis grafik yang tersedia pada OpenOffice Writer.

| Teknologi Informasi dan Komunikasi
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Evaluasi 3

SEMESTER |

A.Pilihlah satu jawaban yang paling benar.

1.

Sebuah poster selalu membutuhkan gambar 5
untuk menambah kesan artistik. Gambar
dapat disisipkan ke dalam dokumen dengan
perintah Insert - .... — From File.

a. Picture

b. Image

c. Object

d. Gallery

Fasilitas yang digunakan untuk membuat
teks artisitik berikut ini adalah ....

a. Text

b. Fontwork

c. Dropcaps

d. Gallery

Berikut ini adalah gambar yang dibuat
menggunakan shape ....

a. DOV
C. :
d. .

Teks pada fontwork )
diubah menjadi FontWﬂ!‘k
ikon pada toolbar fontwork bernama ....
a. Fontwork gallery

b. Fontwork shape

c. Fontwork same letter height

d. Fontwork alignment

dapat

118\

Teknologi Informasi dan Komunikasi
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menggunakan 8.

lkon border di bawah ini bernama .... ......

o=

?

a. Set all four border

b. Set left and right border only

c. Set top and bottom border only
d. Set left border only

Cara cepat membuat tabel adalah dengan
klik ikon bernama ....

e. Insert Table

f. Format Table

g. Table

h. Toolbar Table

Berikut ini adalah contoh grafik jenis column
dengan bentuk ....

.~

a. cylinder
b. cone
c. pyramid
d. box

Operator untuk membuat formula perkalian
pada tabel menggunakan tanda ....

a. x

b. *

c. . (titik)

d. /



10.

11.

12.

13.

Pada pembuatan grafik data series in row

artinya ....

a. kolom pertama pada tabel digunakan
sebagai label pada sumbu x

b. baris pertama pada tabel data digunakan
sebagai label pada sumbu x

c. kolom pertama pada tabel digunakan
sebagai label pada sumbu y

d. baris pertama pada tabel data digunakan
sebagai label pada sumbu y

Pada pembuatan tabel repeat heading

artinya ....

a. Judul pada tabel diulang pada saat tabel
terputus halaman

b. Judul kolom diulang pada saat tabel
terputus halaman

c. Menyisipkan baris judul pada tabel

d. Menyisipkan judul tabel

OpenOffice Writer merupakan program
pengolah kata bagian dari kelompok ....

a. OpenOffice.org

b. OpenOffice Base

c. OpenOffice Calc

d. OpenOffice Impress

Untuk melakukan pembatalan editing pada
penulisan yang salah pada OpenOffice.
org Writer, maka kita dapat menggunakan
perintah ....

a. cancel

b. next

c. redo

d. undo

Untuk memformat teks berubah menjadi

miring, maka perintah yang digunakan
adalah menekan tombol Ctrl + ....

a. A

b. B

c. |

d U

14.

15.

16.

17.

18.

Untuk meletakan teks paragraph berada di
posisi tengah lembar kertas kerja, maka kita
dapat menggunakan menu toolbar formatting
bernama ....

a. align center

b. align left

align right

d. justify

o

Dibawah ini adalah istilah perintah fungsi dari
mouse untuk menekan tombol kiri sebanyak
satu ....

a. klik

b. klik ganda

c. klik kanan

d. drag

Fungsi dari menu Tab Drop Caps di kotak

dialog paragraf adalah ....

a. Mengubah karakter pertama teks menjadi
besar

b. Mengubah karakter pertama teks menjadi
kecil

c. Mengubah semua karakter teks menjadi
besar

d. Mengubah semua karakter teks menjadi
kecil

Untuk melakukan pemformatan pada lembar
kerja dokumen di OpenOffice.org Writer, kita
dapat menggunakan dari submenu ....

a. Format

b. Install

c. Page

d. Edit

Fungsi yang mengatur jarak antara sisi
kanan paragraf dengan batas margin kanan
adalah indentasi dari ....

a. Before text

b. After text

c. Firsttext

d. Last text

Teknologi Informasi dan Komunikasi
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19. Elemen yang letaknya berada dibawah 20. Fungsi tombol kombinasi untuk menyimpan

dari lembar halaman dokumen dinamakan dokumen adalah menggunakan ....
dengan .... a. Ctrl+F

a. Footnote b. Ctrl+ 0O

b. Footer c. Ctrl+P

c. Header d. Ctrl+S

d. Bookmark

B.Lengkapi pernyataan berikut ini.

1.

© ® N o 0o bk~ 0D

Teks atau gambar yang terdapat di bagian bawah di setiap halaman dalam dokumen disebut
dengan. ...

. ... adalah cara penyisipan gambar diantara teks dalam dokumen.

Menghapus gambar dalam dokumen dapat dilakukan dengan tombol . . . . pada keyboard
Ketumpulan sudut pada gambar yang dibuat dengan ikon rectangle disebut dengan . . . .
Titik-titik tempat berhenti pada pengetikan dikenal dengan istilah . . . .

Table — . ... — Column Width adalah perintah untuk mengubah lebar kolom.
Untuk membagi sel pada tabel dapat menggunakan ikon bernama . ... pada toolbar table.
Menambahkan garis bingkai pada table dapat menggunakan ikon . ... pada toolbar table.

Judul pada grafik dapat disisipkan dengan menu Insert - . . ..

10. Warna latar belakang grafik dapat ditambahkan dengan perintah . ... - .. ..

C.Jawablah pertanyaan di bawah ini dengan tepat.

1.

Sebutkan langkah-langkah untuk menggunakan gambar pada Gallery menjadi background
halaman.

2. Jelaskan perbedaan header dengan footer.

Sebutkan langkah-langkah membuat nomor halaman pada dokumen.

4. Jelaskan langkah-langkah membuat nomor halaman yang berbeda untuk halaman ganijil dan

© N o o

9.

genap.
Jelaskan perbedaan teks pada Text dan Fontwork.
Apakah artinya repeat heading pada pembuatan tabel?
Apakah fungsi merge cell pada tabel?

Jelaskan langkah-langkah memindahkan menambahkan legend pada grafik sehingga posisinya
ada di bagian bawah grafik.

Jelaskan cara mengganti jenis grafik.

10. Jelaskan cara menambahkan data label dalam tampilan persentase.
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PERANGKAT LUNAK
PENGOLAH ANGKA

o TTm— aatini perangkat lunak pengolah angka sudah
banyak tersedia baik dariyang didapatdengan
bayar dan juga gratis. Ada beberapa macam

software atau perangkat lunak pengolah angka

Eile Edit VWiew Insert Format Tools Data Window Help

- SMNAE NGB LO0 4 9-¢

[Nlmbus Sans L

F - aA4A EEEEHE -
(A [ e Z =]
H

sJalalclalalsls ! _ . . di antaranya adalah Microsoft Office Excel (versi
AEEERER MERGE CELLE 97,2000,2003,2007), Lotus 1-2-3, Borland Quattro,
4 4] 5[ 6] 7 8] 9(10 Fitrhia Lukluiyati . . .
5 [11 15|1314151617 Sulthan Al Ghoz: Visicalc, Boeing Calc 3D, Lotus Improv, Javelin
|6 [18[19[20]21]22[23[24 | | . .
P Software, Lotus Jazz for Mac, Lucid 3D, Gnumeric
n e Lw““ dan OpenOffice.org Calc. Semua itu mempunyai
2 i L] ﬂ ”]‘] s fungsi yang sama yaitu mengolah angka.

: — Kapan kita perlu menggunakan perangkat

lunak pengolah angka? Yaitu ketika kamu dihadapkan
pada persoalan hitung menghitung, di situlah awal
mulanya kamu memerlukan perangkat ini.
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Peta Konsep

. 1220

PERANGKAT LUNAK
PENGOLAH ANGKA

-
Pengenalan

P—
m Sekilas spreadsheet
m Mengenal Program

spreadsheet

Menu, Toolbar dan Ikon pada
OpenOffice.org Spreadsheet

N

—
m Menu pada

OpenOffice.org Calc
m Toolbar dan Ikon

pada OpenOffice.org
Calc

Penggunaan Menu
dan Ikon

Membuat dokumen
baru

Mengedit dokumen
Membatalkan dan
mengulang perintah
Menyimpan
dokumen
Memformat karakter
Mengatur perataan
paragraf
Memformat angka

komputer yang khusus melakukan pengolahan perhitungan. Program ini berisi sejumlah sel

Perangkat lunak pengolah angka atau dikenal dengan spreadsheet adalah program aplikasi

yang terdiri dari kolom dan baris. Setiap sel dapat berisi teks atau angka. Sel tersebut dapat
juga berisi rumus suatu perhitungan matematika.

Fasilitas-fasilitas yang disediakan dalam perangkat lunak pengolah angka ini memungkinkan
kamu dapat dengan cepat dan mudah bekerja untuk mengevaluasi, merevisi data perhitungan dan
perbandingan harga serta untuk membuat laporan dalam bentuk tabel dan diagram grafik.

Sel, Kolom, Baris, Spreadsheet, Grafik, worksheeet
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A. Mengenal Perangkat Lunak Pengolah

Angka

Ada beberapa aplikasi perkantoran Open Source dan salah satunya adalah

OpenOffice.org, selain ada KOffice, dll. (StarOffice tidak Open Source). Dalam
OpenOffice.org ada program khusus pengolah angka yaitu OpenOffice.org Calc.

1. Sekilas tentang Program Pengolah Angka

OpenOffice.org calc adalah perangkat lunak pengolah angka, layaknya Excel

pada MS.Office dan di buat sebagai alternatif Excel. Aplikasi ini berjalan di Linux dan
dapat juga berjalan pada Windows serta bersifat Open Source sehingga aplikasi ini
dapat di gunakan dengan gratis. Untuk mendapatkanya dapat dengan cara download
dari situs OpenOffice.org, yaitu: www.openoffice.org atau dengan mendapatkan
filenya dari CD suatu majalah yang membahas tentang komputer.

a. Definisi

OpenOffice.org adalah kumpulan perangkat lunak aplikasi yang dapat
dioperasikan dalam berbagai sistem operasi komputer. OpenOffice.org mendukung
standar ISO 26300 Open Document Format (ODF) untuk pertukaran data sebagai
standar format file. OpenOffice.org mampu mengenali bermacam-macam format
dokumen, termasuk format Microsoft Office. OpenOffice.org awalnya diturunkan
dari StarOffice, sebuah kumpulan perangkat lunak yang dikembangkan oleh
StarDivision yang dibeli oleh Sun Microsystems.

OpenOffice.org Calc adalah bagian dari OpenOffice.org yang merupakan
salah satu jenis program pengolah angka yang bersifat open source.

. Fungsi

OpenOffice.org Calc adalah program yang bekerja mengkhususkan
pada bidang perhitungan. Ketika kamu membuka OpenOffice.org Calc, maka akan
tampil sebuah jendela spreadsheet baru yang terdiri dari beberapa sheet kosong.
Sebuah spreadsheet bisa memiliki banyak sheet yang digunakan untuk menyusun
berbagai macam jenis informasi yang berhubungan pada satu file spreadsheet.

. Contoh program pengolah angka

Ada beberapa program atau perangkat lunak pengolah angka yang sering
digunakan dewasa ini. Di antaranya adalah seperti berikut ini:

Untuk mendapatkan
tips OpenOffice.
org kunjungi www.
openofficetips.com

Teknologi Informasi dan Komunikasi &23 o
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1). OpenOffice.org Calc

Gambar 5.1 File Edit View Insert Format Tools Data Window Help 7
OpenOffice.org spreadsheet 8- 2HQE R YR LADO 46 ¢ er 24 i
) ) B mbsssenst [0 A4 A EIEEESH &b » %8 E)E[H-E-%-
Sumber: Dok. Penulis — S e x =] w
A 5 c 5 £ F s ) 7 z e
T
:
5
5
s
7
5
5
i
i
i
i
1
s
s
W7
s
i
20
E
%
A
Eh
P
|76 A\ sheet1 (SrEsm 7eREs 7 1[X
sheet1/3  [Default oo [ [so [ [ [ ‘sum=0
2). Microsoft Excel
El e B %]
Gambar 5.2 & o v rer o 1 o e HEQ Typea slimioci, _s;
MREERG) 8RR )8 = b el o0 o B Z U EE B F O A
MS. Excel 'Ak = B £ c D I E G H 1 J K L M N [9] :
Sumber: Dok. Penulis
ik <> ¥\ Sheet1 { Sheet2 / Sheet3. 1<l m mm

3). StarOffice Calc

Gambar 5-3 le:///home/bilbrey Webstats.xls &}
Star Office

Sumber: Dok. Penulis

d. Aplikasi yang bisa dibuat dengan program pengolah angka
Banyak sekali aplikasi perkantoran yang dapat dibuat dengan program
pengolah angka khususnya OpenOffice.org spreadsheet yaitu: perhitungan gaji
karyawan, absensi, daftar inventaris barang dan banyak lagi lainnya.

@ Teknologi Informasi dan Komunikasi N
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2. Mengenal OpenOffice.org Calc

Saat kamu mulai bekerja dengan OpenOffice.org Calc, maka akan tampil
sebuah halaman kerja yang terdiri dari beberapa bagian, yaitu: baris menu, toolbar
standar, toolbar formatting, baris formula, halaman spreadsheet, dan baris status.

a. Menjalankan openoffice.org Calc

A crafis »

) internet »
[©) Peralatan Sistem  »
[§5l Perkantoran Office. » (=] Evoltion Mail and Calendar
[«}) Permainan » OpenOffice.org Presentation

[ suara & video » §7) Openoffice.org Spreadsheet

Perform calculation, analyze information
and manage lists in spreadshests.

fr openofiice.org word processor,

(3 TambahyHapus...

Gambar 5.4
Memulai
OpenOffice.org Calc
= Sumber: Dok. Penulis

Untuk menjalankan OpenOffice.org spreadsheet, kamu dapat melakukan
dengan cara sebagai berikut:

1. Melalui Menu Aplications > Office - Spreadsheet.
2. Pilih menu bar File > New - Spreadsheet.
3. Tekan tombol New dan pilih Spreadsheet.

b. Identifikasi lembar kerja

Selanjutnya akan muncul window OpenOffice.org Calc, seperti terlihat pada

gambar berikut ini.

File Edit View Insert Format Tools Data Window Help X
$- 8P B IR YR AOE 46 f FiLi.E0 BLE
M st HE D A4A BEESEE b » 5 [ - -

B I MmE =]
A | B | & | D E F E H [ T« | [lirs
1 |
2

w

IS

ol

&

N

@

©

10
11
12
13
14
15
16
17
18

19 Gambar 5.5

20

21 Identifikasi layar

Z OpenOffice.org Calc

786 i\ She et1 ShEs ToRERE 7| [] ] o Sumber: Dok. Penulis

Sheet1/3 Default 100% sTD Sum=0

<1
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Halaman spreadsheet terdiri dari beberapa tab-tab sheet, yang setiap sheet
terlihat seperti tabel besar yang terdiri dari baris (penomoran dengan numerik) dan
kolom (penomoran dengan abjad kapital).

1).Baris Judul

Gambar 5.6 |, Untitfad 1> Openoffice.org Calc
Baris judul ‘
Sumber: Dok. Penulis

Baris Judul terdapat pada bagian paling atas dalam jendela program.
Bagian ini memuat keterangan tentang perangkat lunak yang sedang kita
gunakan dan nama file yang sedang aktif. Nama perangkat lunak yang terbaca
adalah OpenOffice.org Calc, sedangkan nama default file yang terbuka adalah
Untitled1. Di ujung sebelah kanan Baris Judul terdapat tiga tombol pengaturan
jendela, yaitu tombol minimized, maximized/restored, dan closed.

Tombol Minimized . tombol ini berfungsi untuk memperkecil
tampilan lembar kerja lalu menyembunyi-
kannya.

uEF] Tombol Maximized/Restore : tombol ini berfungsi untuk memperbesar
dan memperkecil tampilan lembar kerja.

@ Tombol Closed : tombol ini berfungsi untuk menutup tampilan
lembar kerja.

Gambar 5.7 2).Menu Pulldown
Menu pulldown

Sumber: Dok. Penulis ‘ File Edit View Insert Format Tools Data Window Help

Menu Pulldown untuk menampilkan perintah pada menu File, Edit, View,
Insert, Format, Tools, Data, Window, dan Help.

c. Baris, kolom, sel dan range
Pada lembar kerja OpenOffice.org Calc, ada beberapa yang perlu diketahui
karena sering digunakan dalam bekerja dengan aplikasi ini. Dalam lembar kerja
terdapat baris, kolom, sel dan range.

Adapun penjelasannya sebagai berikut:
A

1). Baris dalam spreadsheet terdapat di pojok kiri dan tersusun
vertikal, dimulai dari baris nomor 1 (satu) sampai dengan baris
65536.

Ctrl + End + |
untuk menuju
baris terakhir.

Gambar 5.8
Baris dalam lembar
kerja spreadsheet

Sumber: Dok. Penulis

000 [~ | T | L0 P |l [ R e

—
]

=
—
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2).Kolom dalam spreadsheet terdapat di pojok atas dan tersusun horizontal,

dimulai dari kolom A sampai dengan kolom IV.

A B C D

1
Gambar 5.9

Kolom dalam lembar kerja spreadsheet
Sumber: Dok. Penulis

Ctrl + End + — untuk

3).Sel adalah titik perpaduan antara baris dan kolom atau dengan kata lain sel menuju kolom terakhir.
adalah kumpulan dari baris dan kolom. Contoh sel A1, berarti kolom A baris 1.  Ctrl + Home untuk

A B

1
2
i

Gambar 5.10
Sel dalam lembar kerja spreadsheet

Sumber: Dok. Penulis

menuju kolom dan
baris pertama.

4).Range adalah kumpulan dari sel-sel. Contoh: A1;B5 berarti range yang terdiri

dari kumpulan sel A1 sampai dengan B5.

Gambar 5.1
Range dalam lembar kerja spreadsheet
Sumber: Dok. Penulis

d. Operasi dasar bekerja dengan sheet

Operasi dasar dalam bekerja menggunakan sheet, dapat kita lakukan dengan
cara meng-klik kanan pada sheet tersebut lalu memiih jenis operasi yang kita
kehendaki, dari menambahkan sheet sampai dengan menghapus dan memin-

dahkan sheet.

18 Insert Sheet...

20 Delete Sheet, .,

21 Bename Sheet...
22 Move/Copy Sheet...
23 Select All Sheets
24

25 o6 Cut

A Co o
[H s Sheetl _{'ETE’E‘L‘FZJXD'HEET}_;_‘HTF
Gambar 5.12
Operasi dasar sheet
Sumber: Dok. Penulis
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e. Keluar dari program OpenOffice.org Calc

Bl oo Untuk keluar dari program OpenOffice.org Calc, kamu
& gpen.. fie bisa mengklik tanda silang X pada pojok kanan atas program

OpenOffice.org Calc tersebut. Atau dapat juga melalui cara
culis menggunakan pilihan exit yang ada dalam menu file.

... Ctri+shift+s

[ Export...
Export as PDF...
Send

[£] Properties...
Digital Signatures...
Templates

Gambar 5.1 3 Preview in Web Browser
Keluar dari OpenOffice.org | page preview

=, Print... Ctrl+p
spreadSheet {2 Printer Settings..,
Sumber: Dok. Penulis & et cultq

A. Praktikum mengaktifkan OpenOffice. org Calc

Bukalah program OpenOffice.org Calc dari Linux.
Lakukan maximize program.
Lakukan restore program.

Lakukan move program.

o M DN~

Lakukan close program.

B. Praktikum operasi sheet
1. Bukalah program OpenOffice.org Spreadsheet dari Linux.
2. Ubahlah nama Sheet
a. Sheet1 dengan Lembar1.
b. Sheet2 dengan Lembar2.
c. Sheet3 dengan Lembar3.

(1)) Cembarl fLembarZ % Lembar3 /]

Gambar 5.14
Sheet yang sudah dirubah namanya
Sumber: Dok. Penulis
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3. Lakukanlah penyimpanan dengan nama file: Latihan 1.

Caranya:

1).Klik File.

2).Pilih Save.

3).Name: ketik Latihan1.
4).Klik Save.

Narme: [Latihanl ]

Save in folder: |";.- arianto - |

= Browse for other folders

B. Menu, Toolbar dan lkon pada
OpenOffice.org Calc

(<) [@arania
Places ~ | Name -~  Modified =
&£} arianto =) .config Kamis
@ Desktop "& fontconfig Yesterday
| = Add | | = Remo) -I [OpenDocument Spreadsheet (.ods) = l
[> File type
Edit filter settings Gambar 5.15
[] Save with password Dlalog
penyimpanan

[ € cancel l [ ® Save ] dokumen
Sumber: Dok. Penulis

Kamu harus mengetahui terlebih dahulu lingkungan kerja pada OpenOffice.org
spreadsheet agar semua pekerjaanmu dapat diselesaihan dengan baik karena di sanalah
perintah dan fasilitas OpenOffice.org Calc berada.

1. Menu pada OpenOffice.org Calc
a. Fungsi Menu

Menu berisi kumpulan perintah yang dikelompokkan dalam susunan menu
dan sub menu. Sub menu yang aktif ditandai dengan warna yang jelas dan dapat
digunakan untuk memproses sel yang terpilih. Sedangkan sub menu yang tidak
aktif berwarna abu-abu dan tidak dapat diakses (di-klik), kecuali setelah melalui
perlakuan lain lebih dahulu. Misalnya sub menu Merge Cell pada menu Format
hanya akan menjadi aktif setelah memilih sel yang akan digabung dengan cara
mem-blok sel yang akan digabung.

Y 1.inologi Informasi dan Komunikasi
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a. Macam-macam Menu

Menu ini sama pada menu-menu OpenOffice lainnya yang akan
menghubungkan pada fasilitas OpenOffice.org Calc.

Gambar 5.16
Menu bar

Sumber: Dok. Penulis

File Edit View Insert Format Tools Data Window Help

Ada cara cepat untuk menggunakan menu ini jadi kamu tidak harus mengklik
menu tapi dengan cara menekan beberapa tombol pada keyboard.

Misalnya untuk membuka dokumen baru kalau dari menu dengan cara:
Melalui Menu bar

Klik File > New - Spreadsheet

New b sxt Document
[ Open... ctrl+0 & dsheet Ctrl+N
Gambar 5.17 Recent Documents || Presentation
Menu membuka :
ammn | wizards e
— Datapase

Melalui tombol

Perhatikan gambar menu di atas pada nama menu terdapat huruf yang
bergaris bawah menunjukkan menu tersebut dapat dibuka dengan menekan
tombol Alt berbarengan dengan huruf yang bergaris bawah.

Untuk membuka dokumen baru dengan cara:
Tekan Alt + FNS.
Artinya sambil menekan tombol Alt + tekan FNS.

(FNS: File New Spreadsheet).

Langkah ini dapat dipersingkat dengan menekan tombol CTRL+N yang
diberi tahu di sebelah kanan nama menu.

Gambar 5.18
Cara cepat membuka
dokumen baru @ SPFE'E'['E heet
Sumber: Dok. Penulis -
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Berikut ini adalah menu penting dan fungsinya pada OpenOffice.org Calc:

Tabel 5.1. Menu dalam OpenOffice.org Calc

MENU FILE

File

Untuk operasi file seperti membuat file baru,
membuka, menutup, menyimpan, mencetak file
dan keluar dari program.

Edit

Mengedit isi sel seperti menyalin, memotong,
menempel, menghapus, mencari, mengganti dan
memilih data dalam lembar kerja

View

Mengatur tampilan layar, menampilkan atau
menyembunyikan toolbar, status Bar, Formula
Bar, Baris atau Kolom Judul dan sebagainya.

Insert

Untuk pergantian halaman, menyisipkan baris
atau kolom, Sheet (lembar kerja), karakter khusus,
header, footer, footnote, gambar, video, suara dan
sebagainya

Format

Memformat angka, karakter, border, kolom, baris
pada lembar kerja

Tools

Berisi peralatan untuk mengecek ejaan,
penterjemahan, koreksi otomatis, proteksi

Data

Perintah untuk pengolahan database seperti
pengurutan data, filter data, pembuatan subtotal
dan melakukan validitas data.

Window

Mengatur tampilan window OpenOffice.org Calc

Help

Menampilkan program bantuan

Ada beberapa sub menu yang diberi tanda ceklis, artinya sub menu tersebut
sedang aktif digunakan. Contohnya pada menu yang mengatur tampilan toolbar
(View » Formula Bar) Untuk me- nonaktifkannya dengan cara klik mouse sekali

lagi pada sub menu tersebut hingga hilang tanda ceklisnya.

Untuk mengaktifkan menu cukup dipilih dengan klik mouse pada menu yang
ditunjuk, lalu pilih sub menu di bawahnya. Apabila pada sub menu terdapat tanda

» maka artinya dalam sub menu tersebut masih ada sub menu lagi.

2. Toolbar dan lkon pada OpenOffice.org Calc

Definisi toolbar dan ikon

Toolbar adalah ikon-ikon yang mempunyai perintah yang sejenis dikumpulkan
dalan sebuah baris ikon. Pada saat mengetik, gunanya adalah untuk melakukan
perintah yang sering kita gunakan sehingga untuk membuka menu memerlukan
waktu yang relatif lama dapat dipersingkat dan lebih cepat. Untuk itu telah disediakan

tombol sebagai jalan pintas untuk melakukannya yang disebut dengan ikon.

Teknologi Informasi dan Komunikasi
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Toolbar yang tersedia pada OpenOffice.org spreadsheet cukup banyak, ada
24 macam, di antaranya yang sering digunakan adalah:

Contohnya ikon-ikon yang mempunyai fungsi untuk memformat isi sel
dikelompokkan dalam Toolbar Formatting.

Toolbar Formatting D % s% = - Bl - % 3

Sumber: Dok. Penulis |

Gambar 5.19 [omRusa (v -4 4 A
$0p 0—1

Menampilkan toolbar yang belum tersedia
Untuk menampilkan Toolbar di atas dapat dilakukan dengan perintah.

1. Klik menu View.
2. Pilinh Toolbar.
3. Pilih Nama Toolbar.

I 2>-seting:

View Insert Format Tools D Align
Drawin
+« MNormal E . gob' tp rti
. rawin ect Pro ies
Page Break Preview 9 20 e
Fontwork
Toolbars 3 Form Controls
Formula Bar Form Design
+ Status Bar Form Navigation
Gambar 5.20 |+ Input Method Status Form Object
Mengaktifkan toolbar :
s I?vber Dok Penulis Column & Row Headers ¥ Formatting
u : . uli
Value Highlighting Ctrl+F8 JsE

Toolbar yang aktif ditandai dengan tanda ceklis, apabila ingin
menonaktifkannya tinggal diklik sekali lagi sehingga tanda ceklisnya hilang.

Untuk fungsi dan penggunaan toolbar akan dibahas pada sub bab berikutnya
yang berhubungan dengan materi.

Untuk SMP / MTs Kelas VIII
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A. Praktikum Membuka OpenOffice dengan berbagai cara

1. Bukalah OpenOffice.org Writer.
2. Buka lagi OpenOffice.org Calc dari OpenOffice.org Writer.
3. Buka lagi OpenOffice.org Calc dengan toolbar.

B. Praktikum Mengaktifkan Toolbar
1. Aktifkan atau nonaktif toolbar standar.

d-afeEHuaa vE L
=R - R Ral

& -
Gambar 5.21
Toolbar Standar
Sumber: Dok. Penulis
2. Aktifkan atau nonaktif toolbar Formatting.
Formatting T x
(Dejavui Sans Mo - & 4 A \
bowrm@ H-E-% -
Gambar 5.22
Toolbar Formatting

Sumber: Dok. Penulis

3. Aktifkan atau nonaktif toolbar Drawing.
Drawing X
[l 2 (4= @

Gambar 5.23
Toolbar Drawing

Sumber: Dok. Penulis
4. Aktifkan atau nonaktif toolbar formula bar.

[*] fo Z = |

‘ | A2 =
Gambar 5.24

Formula Bar
Sumber: Dok. Penulis

5. Aktifkan atau nonaktif toolbar fontwork.
Fontwork X
= v AN
et o

Gambar 5.25

Toolbar Fontwork
Sumber: Dok. Penulis
]
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C. Praktikum menggunakan shortcut pada keyboard

Isilah Tabel di bawah ini dengan mencari cara cepat pada tombol keyboard
dan fungsinya.

NO | MENU | CARACEPAT | FUNGSI
1 File+Save Ctrl+S Untuk  menyimpan
dokumen
2 |File + Print
3 |Edit+ Undo
4 | Edit + Paste
5 |Edit + Select All
6 |Edit+ Find &
Replace
7 |File + Open
8 |Edit + Cut
9 |Edit + Copy
10 [Format+Cells

D. Praktikum tipe data

Isilah Tabel di bawah ini dengan menyebutkan kategori apa yang digunakan

dalam memformat data.

NO ‘ CONTOH ‘ FORMATTING
FORMATTING CATEGORY
1 |Rp150,000,00
2 |8 September 2009
3 [10%
4 15 Tahun
5 [150,000,00

. Teknologi Informasi dan Komunikasi
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C. Menggunakan Menu dan lkon pada
OpenOffice.org Calc

Penggunaan menu dan ikon ini akan selalu bermanfaat ketika kamu akan membuat
dokumen atau memperbaiki dokumen yang sudah dibuat.
1. Penggunaan Menu dan lkon untuk Membuat Dokumen Baru
Pembuatan dokumen baru pada OpenOffice.org Calc dapat dilakukan dengan
beberapa cara:
1). Melalui toolbar New

Setelah kamu selesai mengerjakan sebuah dokumen pada OpenOffice.org
Calc dan akan membuat file berikutnya, caranya adalah sebagai berikut:

Gambar 5.26
lkon New

Sumber: Dok. Penulis

NO | NAMA | IKON | FUNGSI
‘ 1 New ‘ Untuk membuka

dokumen kosong
2).Melalui OpenOffice.org yang sedang Aktif

Ketika kamu sedang bekerja dengan OpenOffice.org Writer atau lainnya
selain Calc dan akan bekerja juga dengan OpenOffice.org Calc tidak perlu menutup
program atau melalui taskbar tetapi langsung saja dari menu File yang ada pada
program tersebut.

File Edit View Insert Format Table Tools Window Hi

] New » Text Document Ctrl+N
& open... Ctrl+0 | s/ Spreadsheet
Recent Documents v Presentation Gambar 5.27 .
4 Menu pembuka OpenOffice.org
Wizards ] & Drawing Spreadsheet
[@ Database Sumber: Dok. Penulis
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3). Penggunaan Menu dan Ikon untuk Mengedit Dokumen (cut, copy, paste)

Dalam pembuatan dokumen kamu akan membutuhkan perintah untuk
membantu perbaikan dokumen yang salah, menu dan ikon yang sering digunakan
dalam memperbaiki dokumen di antaranya cut, copy dan paste.

Berikut fungsi penggunaaan ikon dalam proses perbaikan dokumen yang
biasanya sering digunakan.
Tabel 5.2. lkon pengeditan

NAMA
NO IKON IKON FUNGSI

1 CuT Untuk memotong
dokumen

2 COPY Menggandakan atau
memperbanyak

3 PASTE Melaksanakan
perintah penempelan

Selain ikon kamu dapat juga menggunakan menu yang terkumpul dalam
menu edit.

Edit View Insert Format Tools

@3 Undo: Input Ctri+Z

@ Repeat: Input
44 cut ctrl+X
Gambar 5.28 ] Copy Ctri4C
Me;:r?;e”;itg: [l easte Ctrl+V
Sumber- Dok. Paste Special... Ctrl+Shift+Vv
Penulis Select All Ctrl+A

4).Penggunaan Menu dan Ikon untuk Membatalkan dan Mengulang Perintah

Selain perbaikan (pengeditan) suatu saat kamu akan membatalkan apa
yang sudah dikerjakan atau akan mengembalikan ke posisinya semula, kamu
dapat melakukannya dengan bantuan menu atau ikon undo dan redo.

Tabel 5.3. ikon pembatalan perintah

NAMA

NO IKON IKON FUNGSI
1 UNDO membatalkan perintah
o - ke sebelumnya
2 RESTORE : Melanjutkan perintah ke
sesudahnya

Undo dan redo dapat dilakukan berulang beberapa kali.

136
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5).Penggunaan Menu dan Ikon untuk Memformat Karakter (font, size, color, bold,
italics, underline, dll).

Ada juga ikon yang berguna untuk Format teks, pada menu terkumpul di
menu Format sedangkan pada toolbar dikelompokkan di toolbar formatting.

Untuk mengaktifkan menu perubahan karakter lakukanlah langkah-langkah
sebagai berikut:

Menampilkan Menu bar

1. Klik 2x pada sel yang terdapat teks yang akan diatur.

2. Klik Format - Character. Format Tools Data Window Help
Default Formatting Ctrl+Shift+Space

Cells... Ctri+1
Row

Column

Sheet

Merge Cells

Page...
Print Ranges v

;EE_ Character...
# paragraph

3. Aturlah font typeface dan size.
e Font digunakan untuk mengatur jenis huruf.
e Typeface digunakan untuk mengatur tampilan huruf.
e Size digunakan untuk mengatur besar huruf.

[Font | Font Efferts | Font Position

Font Typeface Size
[Dejavu sans] | [Book ] [10
Kochi Gothic ExtraLight 10
Kechi Mincho Book 10,5
Condensed Oblique 11
Bold 12
Bold Oblique 13
14
18
Language
Indonesian =

fest,

The same font will be used on both your printer and your screen.

[ ok ][ cancel |[ Help || Reset |

Gambar 5.29
Menu mengaktifkan
pengaturan
character

Sumber: Dok. Penulis

Gambar 5.30
Dialog perubah
character

Sumber: Dok. Penulis
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Gambar 5.31
Toolbar formatting

Sumber: Dok. Penulis

Menampilkan Tool bar

[Deia\ru Sans |"] [

1w [~ A 4 A

% % O - -8 -

Tabel 5.4. Ikon formatting pengatur character

Toolbar yang digunakan adalah toolbar formatting.

SRR

NAMA
NO IKON IKON FUNGSI
1 font name , mengubah jenis
[ DejaVu Sans | '] huruf
2 size mengatur ukuran
(10 |~] huruf
3 Bold menebalkan huruf
B
4 Italic membuat miring
4
5 |Underlline A membuat garis
= bawah
6 |font color % mengarut font

Tabel 5.5. Ikon formatting pengatur perataan

6). Penggunaan Menu dan lkon untuk Mengatur Perataan

NAMA
NO IKON IKON FUNGSI

Align Left mengatur rata
tengah

centered mengatur rata
tengah

Align Right mengatur perataan
teks

. Teknologi Informasi dan Komunikasi
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7).Penggunaan Menu dan lkon untuk Memformat Angka (currecy, %, dll).

Penampilan teks dalam memformat angka diperlukan untuk membedakan
antara teks dan angka serta mempercepat pembacaan data.

: — =

[Numbers| Font | Font Effects | Alignment | Borders | Background | Cell Protertion |

Category Format Language
i 3 standard
i -1234
e 123412
o s 1934
Currency -1.234,12
Date -1.234,12
Time
S :
Options
Decimal places O Negative numbers red
Leading zeroes e (] Thousands separator
Format code
[Standard ] |i‘ |£‘ |§_‘
Gambar 5.32
Dialog format cells
[ oK ” Cancel ][ Help H Reset l

Sumber: Dok. Penulis

‘ ac[h ” Yo ” $4Eh I.:u?n' I.:uﬂlu ‘ I‘I 'Ic';oaol:;)':;:r.r?\zt Cells
- Sumber: Dok. Penulis
Tabel 5.6. Ikon formatting pengatur character
NAMA
NO IKON IKON FUNGSI CONTOH
1 |Currency Menambahkan |Rp.123,456,00
| Lambang Rupiah
: didepan angka
2 |Percent = Menambahkan |12345600,00%
Yo Lambang persen
o (%) dibelakang
angka
3 |[Standart T Mengembalikan |123456
%%
i ke angka dasar
4 |Add Decimal o= | Menambahkan |123456,00
Place 000 angka nol (0)
— |dibelakang
angka
5 |[Delete [0 Menghapus 123456,0
Decimal | o angka nol (0)
Place dibelakang
angka
6 |Decrease Menggeser teks | mengarut font
Indent atau angka ke
Kiri
7 |Increase Menggeser teks |membuat garis
Indent atau angka ke bawah
kanan

Teknologi Informasi dan Komunikasi &9 o
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8). Penggunaan Menu dan Ikon untuk Menyimpan Dokumen
Setelah kamu melakukan proses pengerjaan OpenOffice.org Calc yang
penting dilakukan adalah mendokumentasikan pekerjaan tersebut dengan
menyimpannya. Tujuannya agar kamu dapat membuka kembali dokumen yang
telah dibuat tanpa harus mengetik ulang.

FUNGSI

1 Save Untuk menyimpan

dokumen

raktikum

A. Praktikum Mengedit Tabel

Ketiklah data berikut ini:

A B [EERiED E F
1
2
~3 |No Nama Nilai _
El | IPA IPS MTK KOMP |
~ 5 | 1Farid Arkan 85 75 98 75
6 2 Ariefuddin Faiz 74 70 80 70
7 3Fatih Nashrullah 86 70 75 65
_8 | 4Mustika Rahmawati = 94 80 80 71
_ 9 | 5Hanifa dofiyanti | 75| 90| 85 94
10 6
] 7
Bz 8
13| 9
“1a | 10
L '
[ F N Sheetl fShest? FShect3 /7 |[4]
Gambar 5.34
Mengetik data

Sumber: Dok. Penulis

—

. Gunakan Cut untuk memindahkan barisan nama:
a. Barisan no 2 Ariefuddin Faiz dipindah ke nomor 8.
b. Barisan no 4 Mustika Rahmawati dipindah ke nomor 10.
2. Gunakan Copy untuk menggandakan barisan nama:
a. Barisan no 1 Farid Arkan disalin ke nomor 2.
b. Barisan no 3 Fatih Nashrullah disalin ke nomor 4.
c. Barisan no 5 Hanifa Dofiyanti disalin ke nomor 6 dan 7.

d. Barisan no 8 Farid Arkan disalin ke no 9.

Langkah pengerjaan:

Gunakanlah ikon cut, copy dan paste pada toolbar standard.

1\46 . Teknologi Informasi dan Komunikasi NN
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Hasilnya akan seperti berikut ini:

A B | € | b E | F |
3 |No Nama Nilai . _
4 | IPA IPS MTK KOMP
5 1 Farid Arkan 85 75 98 75
6 2 Farid Arkan 85 /5 98 i
7 3 Fatih Nashrullah 86 70 75 65
8 4 Fatih Nashrullah 86 70 75 65
9 5 Hanifa dofiyanti 75 90 85 94
10 6 Hanifa dofiyanti 75 90 85 94
11 | 7 Hanifa dofiyanti 75 90 85 94
12 8 Ariefuddin Faiz 74 70 80 70
13 9 Ariefuddin Faiz 74 70 80 70
14 | 10 Mustika Rahmawati 94 80 80 i |
Gambar 5.35
Hasil pengaturan data
Sumber: Dok. Penulis
. Praktikum Pengaturan Text
1. Ketiklah tabel seperti di bawah ini.
A | B | g | D |
1 +
2 |DAFTAR HARGA BARANG
3 |TOKO SEJAHTERA
4
5 |[NO NAMA BARANG HARGA BELI :HARGAJUAL
6 1 Sabun Mandi 2500 3000
7 2/Sikat gigi 1500 2000
a8 3 Pasta Gigi 4500 5000
9 4 Ember 25000 25500
10 5 Gayung 5500 6000
11
Gambar 5.36
Daftar harga yang diatur Text
Sumber: Dok. Penulis
2. Buatlah pengaturan teks seperti ini.
A | B | C | D

1

2 DAFTAR HARGA BARANG

3 TOKO SEJAHTERA

4

5 MO | NAMA BARANG | HARGA BELI HARGA JUAL
7] 1 |Sabun Mandi Rp2.500,00 Rp3.000,00
7 2 |Sikat gigi Rpl.500,00 Rp2.000,00
8 3 |Pasta Gigi Rp4.500,00 Rp5.000,00
9 4  |Ember Rp25.000,00 Rp25.500,00
10 5 [Gayung Rp5.500,00 Rp6.000,00
o Gambar 5.34

Daftar harga yang belum diatur Text
Sumber: Dok. Penulis

3. Simpanlah file tersebut.
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&angkuman

. OpenOffice.org Calc adalah program untuk mengolah angka yang dapat digunakan untuk
membuat laporan berupa angka-angka dan dapat melakukan perhitungan secara otomatis
dengan menerapkan rumus.

. OpenOffice.org Calc terdiri dari beberapa sheet yang diibaratkan buku, sheet adalah
lembarannya.

. OpenOffice.org Calc adalah salah satu software Open Source. Saat ini dapat digunakan dalam
sistem operasi Linux maupun Windows.

. Banyak terdapat software pengolah angka, di antaranya Microsoft Office Excel, Lotus 123,
Borland Quattro.

5. Dalam worksheet atau lembar kerja OpenOffice.org Calc terdiri atas kolom dan baris.

6. OpenOffice.org Calc terdiri dari 65536 baris dan kolom sampai dengan kolom |V.

7. OpenOffice.org Calc dapat atau sering digunakan untuk: mengevaluasi, merevisi data perhitungan

serta untuk membuat laporan dalam bentuk tabel dapat juga dilengkapi dengan diagram grafik.

" Untuk SMP / MTs Kelas VIl
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J
~Glosarium

PeLrs:glk(at Kode atau program yang berjalan di dalam komputer
Menu Perintah berupa tulisan yang tersusun berdasarkan fungsinya
Tabel Kumpulan baris dan kolom yang tersusun berdasarkan data
Ikon Gambar kecil yang menunjukkan kegunaan atau fungsinya
Edit Ubah, mengubah atau memperbaiki dokumen yang telah ada
Menyisipkan |Meletakkan sesuatu di antara keduanya
Dokumen Hasil pengetikan yang tersimpan
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

144

Yang dimaksud dengan Sheet adalah ....
a. Buku kerja

b. Lembar kerja

c. File

d. Dokumen

Yang dimaksud dengan Ikon adalah ....

a. Kumpulan perintah yang sejenis

b. Perintah langsung atau cara cepat
menggunakan perintah

c. Perintah tidak langsung untuk

menggunakan perintah
d. Pengaturan menu perintah

Ikon menyimpan dan membuka file terdapat

pada toolbar ....
a. Standard

b. Formatting
c. Drawing

d. Fontwork

Untuk memformat agar didepan angka
terdapat tanda rupiah (Rp.) menggunakan
perintah ....

a. Format - Cells

b. File - New

c. Insert - Row

d. Edit - Copy

Yang dimaksud dengan Sel pada OpenOffice.
org Spreadsheet adalah ....

a. Kumpulan baris dam kolom

b. Perpotongan baris dan kolom

c. Kumpulan toolbar

d. Perpotongan sel-sel aktif

Teknologi Informasi dan Komunikasi
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6.

10.

lain

Untuk memindahkan data ke sel
menggunakan perintah ....

a. Copy

b. Paste

c. Cut

d. Delete

Ikon Marge and center cells digunakan untuk
mengatur teks agar ....

a. di tengah sel

b. di tengah range

c. di kiri Range

d. di kanan Range

Untuk mengaktifkan toolbar dilakukan dengan
cara ...

a. Format - Toolbar

b. Insert - Toolbar

c. View - Toolbar

d. Edit - Toolbar

Untuk membatalkan
dengan cara ....

a. Edit - Paste

b. Edit - Cut

c. Edit- Undo

d. Edit - Redo

perintah  dilakukan

Pekerjaan yang tepat dalam menggunakan
OpenOffice.org Calc adalah ....

a. Membuat surat

b. Membuat Proposal

c. Membuat Laporan Keuangan

d. Membuat Puisi



B.Lengkapi pernyataan berikut ini.

1.

Untuk menambah baris dengan cara . . . .

. Agar data dapat dihitung maka format data harus bertipe . . . .
. Line, Rectangle, ellips terdapat pada toolbar . . . .

2
3
4.
5

Untuk membuka dokumen baru dari menu dengan cara . . . .

. Menebalkan data adalah fungsi dari ikon . . . .

C.Jawablah pertanyaan berikut ini dengan singkat dan tepat.

1.

Sebutkan ikon yang terdapat pada toolbar standard.

. Sebutkan cara mengaktifkan toolbar drawing.
. Sebutkan macam-macam program pengolah angka yang kamu ketahui.

2
3
4.
5

Sebutkan kegunaan OpenOffice.org Calc.

. Sebutkan perbedaan sel dan range.

Teknologi Informasi dan Komunikasi
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Bekerja dengan
OpenOffice.org Calc

OpenOffice.Org Calc

B ] B = [-vaen
A B c |
1 0002365 2365
2 |0001254 1254
3 |003B589 36589
4 |0Z3R544 236544
5 |0215468 215460
6 0223651 223651 Microsoft Excel
z 2 B i G D
| 1 0002365 <> Y|
2 0001254
3 [D03Es39 Mumber Stored as Text
ihQSEE‘M | Convert to Number
%Eg;gég? Help on this errar
L Ignore Error
| 8 |
=l
10 Errar Checking Sptions. ..
11 Show Formula Auditing Toolbar
12
B EEEEBNE

uatu ketika mungkin kita menyalin data

ke dokumen spreadsheet di mana suatu

data dalam cell yang dimaksudkan sebagai
bilangan (number) masuk sebagai teks (text).
Kasus lainnya data-data bilangan tersebut awalnya
memang diformat sebagai text dan saat ini kita
menginginkannya benar-benar sebagai number.
Alasannya, apabila suatu penulisan bilanganterformat
sebagai teks, ketika diubah format number-nya maka
tidak terjadi perubahan sesuai yang diinginkan,
karena format number tersebut akan berlaku hanya
jika format asalnya adalah number.

Dalam Microsoft Excel, ketika suatu cell diisi
angka-angka namun formatnya berubah menjadi text,
maka pada cell tersebut muncul semacam peringatan
yang ditandai dengan kotak kuning di dalamnya ada
tanda seru ("!") pada bagian sebelah kanan dan
tanda berwarna hijau di bagian kiri atas karakternya.
Untuk melakukan konversi, caranya adalah dengan
menyeleksi semua cell yang dimaksud, klik pada
tanda peringatan yang berada di sebelah kanannya
dan pilihlah Convert to Number.
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Ada cara yang dapat diterapkan di Microsoft Excel dan juga di OpenOffice.org
Clc. Sebagai contoh, dimisalkan cell-cell yang akan dikonversi berada dalam satu
kolom, yaitu di kolom A. Kita membutuhkan kolom lain sebagai pembantu, misalnya
kolom B. Pada cell B1, masukkan formula: =VALUE(A1).

Fungsi VALUE ini akan mengkonversi text yang berada di cell A1 menjadi number.
Selanjutnya, copy-paste-kan cell B1 ke cell-cell di bawahnya (B2 dan seterusnya).
Jika sudah yakin proses konversi berhasil, seleksi cell-cell di kolom B dan copy. Untuk
memindahkan isinya ke kolom A, seleksi cell-cell di kolom A, klik kanan dan pilih
Paste Special. Untuk pengguna Microsoft Excel, pilih opsi value pada dialog box yang
muncul, sedangkan untuk pengguna OpenOffice.org Calc, buang tanda centang pada
opsi Formula pada dialog box yang muncul. Sedangkan untuk kolom B dapat dihapus
isinya karena sudah tidak dibutuhkan.

(Sumber: Artikel “konversi text ke number dalam cell microsoft excel dan
openofficeorg-calc’Dikutip dari http://www.maseko.com dengan beberapa perubahan)
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Peta Konsep

MEMBUAT DOKUMEN

SEDERHANA
Memasukkan) (Format Kolom Format Format gﬂ%\gnfggtga
Data & Baris Sel Halaman Dokumen
C Data Type (a Columns & "' Numbers CPaper Size "u save
= Input Data Rows = Font = Margin m Save As
= Fill Series m Merge Cell m Alignment m Orientation m Password
a Sort List = Insert Columns m Cell Protectionf | m Percentation m Page Preview
& Rows m Header & m Print
m Delete Columns Footer
& Rows
m Border

ada OpenOffice.Org Calc terdapat beberapa jenis data yaitu teks, angka, tanggal dan waktu.

Untuk memasukkan data pada suatu sel, kita bisa melakukannya dengan cara memilih sel-

nya terlebih dahulu kemudian ketikkan datanya dan tekan enter atau tab pada keyboard.
OpenOffice.Org Calc akan langsung mengidentifikasi jenis data yang dimasukkan dalam suatu sel
sehingga data akan secara otomatis dikenali.

Ketika memilih sel di mana data akan dimasukkan dapat dilakukan dengan beberapa cara.
Cara pertama menggunakan mouse dan yang kedua menggunakan tanda anak panah pada
keyboard. Terserah mana yang menjadipilihan kamu, jika kamu menganggap menggunakan mouse
lebih mudah, maka silakan gunakan mouse untuk memilih sel. Sebaliknya, jika kamu lebih suka
menggunakan tanda anak panah untuk menggeser-geser dan memilih sel, juga tidak ada salahnya.
Semua itu tergantung keinginan kamu sendiri.

Adapun jika data yang dimasukkan dalam suatu sel terdapat kesalahan, kamu bisa
menghapusnya dengan mengguanakan tombol backspace atau delete. Tombol backspace digunakan
untuk menghapus satu karakter di sebelah kiri kursor, sedangkan tombol delete digunakan untuk
menghapus satu karakter di sebelah kanan kursor. Nah, kemudian bagaimana jika ingin membatalkan
perintah memasukkan data dalam sebuah sel? Caranya sangat mudah yaitu tinggal menekan tombol
Esc pada keyboard.

Kata Kunci

Columns, Numbers, Save As, Border, Header, Password, Margin, Header, Footer, Orientation,
Alignment, Page Preview, Rows, Font, Footer, Type, Save, Print
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A. Memasukkan Data

s
¢ | No. | Nama Lengkap | ID Pegawai | Tanggal | Jam Masuk | Jam Keluar
7 |1 /|Arianto Nur W \ 101|) ((03131/09 5:45:00 AM|  04:35:00 PM| \
s | 2| |Arief Setiadi 102 | | 03/31/09||| 06:50:00 AM|  04:40:00 PM
E 3| |Bayu Pratama 103| | | 03/31/09 06:25:00 AM 04:37:00 PM
10 4| |Imam Darwantomo 104 | | 03/31/09 06:46:00 AM 04:47:00 PM
Gambar 6.1 |t 5| |LusiEndangS 105/ | | 03/31/09|| | 06:22:00 AM|  04:44:00 PM
Penulisan Berbagai Jenis |=| 6| [Nanang Kuswana 106 | | 03/31/09||| 06:55:00 AM|  04:55:00 PM
Data dalam Sel |= 7| |saruri NF 107| | | 03/31/09||| 06:35:00 AM|  04:50:00 PM
Sumber: Dokumentasi Penulis | w| 8\ |Siswanto 108 || 03/31/09| \06:59:00 AM|  04:54:00 PM /
—

Untuk memasukkan data ke dalam lembar kerja, dapat kamu lakukan dengan
menggunakan mouse atau tombol panah pada keyboard untuk berpindah antar sel. Ada
beberapa hal yang perlu diperhatikan pada saat memasukkan data pada lembar kerja
yaitu posisi data yang dimasukkan akan berubah secara otomatis pada saat memasukkan
data seperti teks akan berada pada posisi rata kiri dan data angka akan berada pada
posisi rata kanan. Data yang diketikkan pada lembar kerja akan tertulis apabila kamu
menekan tombol enter, tab atau tombol anak panah pada keyboard. Bisa juga dengan
mengganti posisi kursor ke sel yang lain dengan mouse.

Kemudian, data yang telah ditulis pada suatu sel dapat terhapus apabila pada
sel tersebut kamu mengetikkan sasuatu. Jika terjadi kesalahan pada saat pengetikan
maka kamu dapat memilih perintah Undo pada menu Edit. Cara lainnya adalah dengan
menekan tombol Backspace dan Delete untuk menghapus isi sel. Jika kamu ingin
mengganti atau mengedit isi sel dapat dilakukan dengan mengklik dua kali pada sel
yang akan diubah atau dengan menekan tombol F2 pada keyboard.

1. Jenis-jenis Data

Seperti yang telah dikemukakan pada pengantar bab ini, bahwa dalam aplikasi
spreadsheet biasanya terdapat beberapa jenis data yaitu teks, angka, tanggal dan
waktu.

A B I | D | E F

I
: Daftar Absensi Harian
: Karyawan PT. Mitra Karya Jaya
: Kemang Pratama — Bekasi

Format Format Format Format
Data Text Data Data Date Data Time
Numbers
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Berikut adalah penjelasan dari masing-masing jenis data tersebut.

. Teks (String)

Jenis data teks jika dimasukkan ke dalam sel, maka formatnya akan otomatis
rata kiri. Data jenis teks merupakan suatu data yang terdiri atas karakter atau bisa
berupa gabungan dari huruf dan simbol serta angka. Biasanya data jenis teks ini
ditampilkan dalam beberapa bentuk huruf (font), ukuran (size), warna (color), dan
berbagai format teks yang lainnya.

Untuk mengatur format tampilan teks dapat dilakukan melalui menu maupun
menggunakan toolbar Formatting. Beberapa ikon pada toolbar Formatting dapat
digunakan untuk mengatur format teks.

b. Angka (numerik)

Jenis data angka jika dimasukkan ke dalam sel, maka formatnya akan
otomatis rata kiri. Data jenis angka merupakan suatu data yang terdiri atas
karakter berupa angka, simbol mata uang, dan simbol-simbol lainnya yang bisa
dipergunakan dalam perhitungan.

. Tanggal (date)

Jenis data tanggal jika dimasukkan ke dalam sel, maka format default yang
ditampilkan adalah mm/dd/yy di mana "mm” adalah bulan (Mounth), dan "dd’
adalah tanggal (Date), serta "yy” adalah tahun (Year). Format ini dapat diubah
sesuai dengan kebutuhan.

. Waktu (time)

Jenis data waktu jika dimasukkan ke dalam sel, maka format default yang akan
ditampilkan berupa hh:mm:ss di mana "hh” adalah jam (Hours), dan ’7mm” adalah
menit (Minutes), serta "ss” adalah detik (Seconds). Untuk berbagai keperluan,
maka format data waktu ini juga dapat diubah sesuai dengan kebutuhan.

Sebagai catatan, format pemasukkan data tanggal dan waktu mungkin akan
berbeda untuk setiap komputer, tergantung pada Regional Setting dan pengaturan
yang ada pada komputer saat instalasi.

. Rumus (formula)

Selain dari empat jenis data di atas, ada satu tambahan jenis data yaitu
formula atau rumus. Jenis data ini digunakan untuk mempermudah operasi
perhitungan dalam lembar kerja. Penulisan rumus biasanya harus diawali dengan
tanda sama dengan (=), sedangkan dalam operasi perhitungannya menggunakan
beberapa operator, yaitu:

., Gambar 6.2
- Toolbar Formatting

Sumber: Dokumentasi Per
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1. Operator Aritmatika (hitung)

2. Operator Logika
3. Operator Teks

2. Memasukkan Data

Agar kamu lebih memahami teori jenis-jenis data di atas, kamu dapat
mempraktikkan langsung di komputermu beberapa jenis data ke dalam lembar kerja
OpenOffice Calc mulai dari data teks, angka, kemudian tanggal dan waktu seperti
contoh yang akan saya tunjukkan di bawah ini.

a. Data Teks

Bentuk dari data teks ini berupa karakter, dalam hal ini bisa berupa huruf
yang tidak dapat dipergunakan dalam operasi perhitungan. Dalam hal penggunaan
rumus, data teks bisa ditempatkan sebagai karakter atau string dengan format
penulisan harus disertakan tanda kutip dua. Contohnya data berupa nama-nama
orang, alamat, dan berbagai data lainnya seperti dalam gambar berikut ini:

A B C

: 1 |Arianto Nur W Jati Asih, Bekasi
Gambar 6.3 |° 2 |Bayu Pratama Margonda, Depok
Contoh Jenis Data Teks . 3 imam Darwantomo [Pondok Kopi, Jaktim
(Nama Lengkap dan
Alamat) |« 4 |Lusi Endang S Kranggan, Pondok Gede
Sumber: Dokumentasi ) :
Penulis 5  SaruriNF Cinere, Depok

b. Data Angka

Semua jenis data angka pasti bisa digunakan dalam operasi perhitungan
matematika. Oleh karena itu, pastikan tidak ada campuran berupa karakter lain
selain data angka (numbers) seperti tanda kutip, titik koma atau tanda baca
lainnya.

Ketika menuliskan rumus berdasarkan data angka, maka tidak perlu
tambahan karakter berupa tanda kutip dua seperti yang dilakukan pada data teks.
Contoh untuk data angka dapat berupa nomor induk siswa, nomor urut ujian, nomor
telepon, dan berbagai jenis data angka lainnya seperti pada gambar berikut ini:
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1 |Arianto Nur W 81020401 88
Bayu Pratama 81090402 86

Imam Darwantomo| 81090403 84
Lusi Endang S 81090404 90
Saruri NF 81090405 92

O MWD

c. Data Tanggal

Format data default yang dimasukkan dalam sel sebagai data tanggal adalah
Bulan-Tanggal-Tahun. Dalam aplikasinya di kehidupan kerja, kita bisa menemukan
banyak contoh bentuk formulir dan laporan yang menyertakan data tanggal di
dalamnya. Ada yang menuliskannya dengan angka, ada juga yang berupa nama
bulan dan campuran angka dan teks seperti yang ada pada contoh di bawah ini:

) I 3 I
Kartu Peminjaman Buku
Perpustakaan Sekolah

2
_
4

1 |TIK SMP Kelas 8 03/15/09 Mar 22, 200
2 |Fisika SMP Kelas 8 03/16/09 Mar 23, 200
3 |Biologi SMP Keias 8 03/17/09 Mar 24, 200
4 |Agama SMP Kelas 8 03/18/09 Mar 25, 200!
5 |Sejarah SMP Kelas 8 03/19/09 Mar 26, 200

d. Data Waktu

Format waktu akan tertulis berupa Jam:Menit:Detik jika dalam penulisan
tidak ada perubahan formatnya. Ini artinya data yang muncul adalah data yang
bersifat general tanpa melalui proses formatting. Contoh yang bisa kamu tulis
adalah data berupa jadwal pelajaran, waktu kehadiran dan pulang karyawan,
jadwal penerbangan pesawat, dan data waktu lainnya.

T T T

Absensi Kehadiran Karyawan

> /Nama : Saruri NF
s Senin, 30 Maret 2009 06:30:00 AM 04:40:00 PM
Selasa, 31 Maret 2009 | 06:35:00 AM 04:45:00 PM
Rabu, 01 April 2009 06:40:00 AM 04:50:00 PM
Kamis, 02 April 2009 06:45:00 AM 04:55:00 PM

gl OWIN| =

Iimalad 2 Aweil 2NN0 nNEe-EN-NN AR NE-NN-NN DA
Ui at, uo Aprin 2uug UOIOUIUU AV UDIUUIUU T Ivi

Gambar 6.4
Contoh Jenis
Data Angka (No.
UAS dan Nilai)
Sumber:
Dokumentasi
Penulis

Gambar 6.5
Contoh Jenis
Data Tanggal (Tgl.
Pinjam & Kembali)

Sumber:
Dokumentasi Penulis

Gambar 6.6
Contoh Jenis Data
Waktu (Jam Masuk
& Keluar)

Sumber: Dokumentasi
Penulis
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3. Menggunakan Fill Series

Fasilitas ini sering digunakan para pengguna aplikasi spreadsheet karena
kemudahannya. Fill Series digunakan untuk membuat daftar urutan otomatis seperti
penomoran otomatis, penamaan hari otomatis, penamaan bulan otomatis dan segala
urutan yang otomatis lainnya. Adapun langkah penggunaan Fill Series adalah sebagai
berikut:

Gambar 6.7
Menyeleksi Range
Yang Akan Diberi
Data Urut

Sumber:
Dokumentasi Penulis

Gambar 6.8
Kotak Dialog Fill
Series

Sumber: Dokumentasi

Penulis

Untuk mempercepat
Auto Fill, kamu harus
mengisi sel pada hari

pertama (Sunday),
kemudian lakukan
Double Click agar
nama hari yang
lain tampil secara
otomatis.

Gambar 6.9
Hasil Urutan data dengan

Fill Series |

Sumber: Dokumentasi

Penulis | :

1). Blok range sel yang akan diisi data urut (Misalnya
berupa data nama-nama hari secara otomatis).

1 2). Pilih menu Edit - Fill > Series.
2 3). Kemudian akan muncul kotak dialog Fill
Series.
3
4
5
6
7
El
E FilSenes =
Direction Series type Time unit
@ Down O Linear ) [L}
Right ) Growth Weekday
O Up O Date Month [ |
Left | @ AutoFill ‘ Year —_—
Increment 1 l

4

m Pada bagian Direction, pilih Down.

m Di bagian Series Type, pilih Auto Fill.
m Di bagian Start Value, ketikkan Sunday.

).Klik OK.

Kemudian hasilnya adalah sebagai berikut:

1 Sunday
2 Monday
3 Tuesday

4 Wednesday

1 5 Thursday
6 Friday
7 Saturday
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4. Menggunakan Sort Lists

Fasilitas ini hampir mirip penggunaanya dengan Auto Fill atau Fill Series.
Fasilitas ini sangat berguna jika kamu ingin mengurutkan data terutama pada data yang
tidak berdasarkan abjad atau numerik. Berikut ini langkah untuk mengurutkan data
pada sel melalui daftar pengurutan otomatis:

Proses Drag | | S

Ke Bawah

{
. 3 1 3 Rabu
i
1
|

1 [Senin /

N>
w
D
5
7]
22

F-

Kamis

(3]

¢ 5 Hasil Proses Jum'at

i 6 Auto Fill

(-2

Sabtu

7  Minggu

1). Masukkan sebuah daftar hari atau daftar lain pada sebuah Sel.

2). Selanjutnya, pilih sel tersebut dan geser kotak hitam kecil yang ada di ujung kanan
bawahnya.

3). Daftar hari berikutnya akan muncul secara otomatis pada daerah yang dipilih.

Jika kamu ingin membuat urutan daftar sendiri, caranya adalah sebagai berikut:

1). Menggunakan menu Drop Down, pilih menu Tools = Options.
2).Pada kolom sebelah kiri, pilih OpenOffice.org Calc - Sort Lists.
3).Klik tombol New pada kolom paling kanan.

4).Kemudian pada bagian Entries yang ada di sampingnya, tulis daftar (misalnya
nama-nama hari) secara berurutan.

5).Klik tombol Add untuk menambahkan daftar yang baru dibuat pada bagian Lists
di samping Entries.

6). Klik OK untuk mengakhiri.

“Options - Openorfice.ofg Cale - Soft bists. e

B OpenOffice.org A : ;

e o Lists Entries

General Sun,Mon, Tue, Wed, Thu, Fri,Sat Senin [ REe

Mermory Sunday,Monday, Tuesday, Wedngbd | Selasa =

‘P"ew Jan,Feb,Mar,Apr.May,junjulAugFe; | Rabu

(ait January, February,March, April, May, ). Kamis Add

Zafhs SUpC oMY ——adge\ d: | Jumat

e Klissan lyar, Sivan, Tammuz,Av, IS 20tU

iy Senin,Selasa,Rabu,Karmis Jum'at, 53

Appearance

Accessibllity

Java
Load/Save
Language Settings
B OpenOffice.org Calc

General

Calculate

Sort Lists L

fange E

Grid Copy list from

ke py list i [gSheet1.9E410 ] [ Copy ]
OpenOffice.org Base —

Ll — -
Chas L q oK 1 S 1 Lelo ) If e 1
Internet =] S ] G ol == J L i ]
S

Gambar 6.10
Sort Lists
Mengurutkan Data
Otomatis

Sumber:
Dokumentasi Penulis

Gambar 6.11
Membuat Daftar
Urutan Secara
Manual

Sumber: Dokumentasi
Penulis
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1.

2. Simpan data tersebut untuk bahan praktikum di komputer.

Praktikum

A. Praktikum mengumpulkan data

Carilah Biodata teman-teman di kelasmu yang meliputi:

e Nama Lengkap.
e Tempat Lahir.
e Tanggal Lahir.

e Alamat Rumah.

e No. Telepon.

e Jam ketika kamu mendapat biodata temanmu.

B. Praktikum memasukkan data

1.

Buka Program OpenOffice.org Calc di komputer masing-masing.

2. Buatlah data sederhana dalam bentuk tabel seperti di bawah ini:

No

Nama Lengkap

Alamat
Rumah

Nomor
Telepon

Jam
Mendapat
Biodata

10

1.

Lengkapi tabel tersebut dengan biodata teman-temanmu yang sudah kamu peroleh di atas.

2. Simpan hasil pekerjaanmu dengan nama: “Lat_Bab_6_Biodata_Nama_Kelas.ods”.
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B. Memformat Kolom dan Baris

Tampilan dari aplikasi Spreadsheet pada dasarnya berupa susunan kolom dan
baris sehingga akan otomatis membentuk tabel (Table). Jadi kamu tidak perlu merasa
kesusahan dalam hal pembuatan tabel, mungkin yang perlu diperhatikan adalah bingkai
yang mengelilingi data dalam tabel yaitu dengan menebalkan border atau mewarnainya
sehingga kamu bisa membedakan mana yang bingkai (Border) dan mana yang garis
bantu (Gridlines).

Setelah kamu tahu bahwa tampilan yang terdiri dari kolom dan baris disebut dengan
tabel, kamu perlu tahu kegunaan dari tabel tersebut. Biasanya tabel digunakan untuk
menampilkan dan mengelola data-data serta mempermudah pengelompokkan data
yang sama dalam bentuk kolom. Selanjutnya, di dalam tabel ini terdapat perpotongan
atau titik temu antara kolom dan baris. Inilah yang disebut dengan sel (Cells). Dengan
kata lain, tabel itu terdiri dari susunan banyak sel. Kalau kita gambarkan bagian-bagian
tabel, akan nampak seperti pada gambar berikut ini:

»

oy I 1
- NO.|Nama Siswa | Jenis Kelamin | Usia |
. 1 |Aan L Bl | A
7| 2 |Agus L 14
> 3 |And L 15— | R
s | 4 |Aziz L 14
w| 5 |Azizah P 13— | |
w| 6 |Bud L 14
7 |Bunga p 15<t=——=| 8§
| 8 |Cintya PN\ 14 L]
.

1. Mengatur Lebar Kolom
Untuk mengatur lebar kolom dapat dilakukan dengan langkah sebagai
berikut:
1). Pilih kolom yang akan diatur.
2).Klik menu Format -> Columns -> Width.

width  [2,27cm 2 oK |
i Default value [ Cancel l
T

Gambar 6.12
Bagian-bagian
Tabel

Sumber:
Dokumentasi Penulis

Gambar 6.13
Mengatur Lebar
Kolom

Sumber:
Dokumentasi Penulis
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3). Tentukan ukuran kolom pada kotak Column Width.

Jika tanda cheklist aktif pada bagian Default value, maka nilai lebar kolom menjadi
ukuran default yaitu 2,27 cm.

4). Klik OK.
2. Mengatur Tinggi Baris
Untuk mengatur tinggi baris dapat dilakukan dengan langkah sebagai berikut:

1). Pilih baris yang akan diatur.
2). Klik menu Format > Rows > Height.

Height [0.43cm [£] [ oK ]
Mengatur Tinggi Baris
Sumber: Dokumentasi Penulis

3). Tentukan ukuran baris pada kotak Row Height.

Jika tanda cheklist aktif pada bagian Default value, maka nilai tinggi baris
menjadi ukuran default yaitu 0,43 cm.

4). Klik OK
Selain menggunakan cara di atas, untuk melebarkan kolom dan meninggikan
baris bisa dengan menggunakan pengaturan secara manual yaitu dengan
mouse. Langkah pengaturan ukuran lebar kolom dan tinggi baris secara manual
adalah sebagai berikut:

1. Sorot kolom atau baris yang akan diubah ukurannya.

2. Tempatkan pointer pada tepian kolom atau baris sehingga membentuk tanda
panah. Untuk kolom, tanda panahnya berupa tanda panah ke kiri dan kanan.
Sedangkan untuk baris, tanda panahnya berupa tanda panah ke atas dan

bawah.
|ﬁl:A65536 v| ﬁ Z m R AM - [ |
<ps

it

2

3

Gambar 6.15 | /%m

Mengatur Lebar Kolom dan | Vi
Tinggi Baris dengan Mouse | \_y
Sumber: Dokumentasi Penulis ; 3

3. Kemudian tekan dan geser (drag) pointer sesuai ukuran (lebar/tinggi) yang
dibutuhkan.

4. Kemudian tekan dan geser (drag) pointer sesuai ukuran (lebar/tinggi) yang
dibutuhkan.
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3. Menggabungkan Sel

Ketika bekerja dengan OpenOffice Calc, terkadang ada saatnya kita harus
menggabungkan beberapa sel menjadi satu. Istilah penggabungan sel tersebut sering
disebut dengan Merge Cells. Penggabungan itu dapat dilakukan secara horisontal
(sel pada baris tertentu), vertikal (sel pada kolom tertentu), maupun gabungan
keduanya. Akibat penggabungan itu akan menghilangkan batas kolom dan baris dari
sel tersebut dan sebagai gantinya, sel-sel tersebut akan berupa suatu sel dengan
ukuran yang lebih panjang atau lebih lebar.

Langkah-langkah untuk menggabungkan sel adalah sebagai berikut:

1). Blok beberapa sel yang akan digabung, misalnya sel B2 sampai D2.

P - - - -
1 N

H D
3 \ /
2).Klik menu Format > Merge Cells > Merge and Center Cells.

Format Tools Data Window Help

Default Formatting Ctrl+5hift+Space b = & a .
ld - A M

cells... Ctri+1
Row H b
Column
Sheet
Merge Cells ~ Merge and Center Cells
p 2rge Cells
Sine [ split Cells

Secara otomatis sel yang diblok yaitu B2 sampai D2 akan berubah menjadi
satu sel tanpa garis pembatas antar kolom.

1

5 —H ¢

L |

3

4

Gambar 6.16
Memilih Sel yang
akan digabung

Sumber:
Dokumentasi Penulis

Gambar 6.17
Perintah Merge
Cells

Sumber: Dokumentasi
Penulis

Gambar 6.18
Hasil
Penggabungan
Cells

Sumber: Dokum entasi
Penulis
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4. Menyisipkan Kolom dan Baris

Dalam memasukkan data ke lembar kerja memungkinkan terjadinya kekurangan
data yang dimasukkan. Untuk itu perlu ditambahkan kolom atau baris pada lembar
kerja dengan langkah sebabagai berikut:

1). Pilih kolom atau baris yang akan disisipkan datanya. Misalnya akan menyisipkan
Kolom C atau baris ke 4 seperti pada gambar berikut.

1 |Beras : 1 |Beras 5500

2 |Gula Pasir 6500 2 Gula Pasir 6500

Gambar 6.19 3 |Minyak Goreng 8500 = 3 |Minyak Goreng 8500

Menyeleksi Kolom C (kiri) 4 |Terigu 3500 | [#] 4 [Terigu 3500

dan Baris ke 4 (kanan) [& 5 [Telor 7500 ||: 5 [Telor 7500
Sumber: Dokumentasi Penulis

2).Klik menu Insert pada Menu Bar, kemudian pilih:
a. Columns, jika akan menyisipkan kolom.
b. Rows, jika akan menyisipkan baris.

3).Jika yang disisipkan adalah kolom, maka akan muncul di sebelah kiri kolom yang
terseleksi. Sedangkan jika yang disisipkan adalah baris, maka akan muncul di
sebelah atas baris yang terseleksi.

A B < D

| _—-

Gambar 6.20
Hasil Menyisipkan . 41 |Beras 5500
Kolom atau :

Baris(ditandai warna © 2 |Gula Pasir 6500
orange) * 3 |Minyak Goreng 8500

Sumber: Dokumenta§i s
Pendlls 4 Terigu 3500
5 [Telor 7500

5. Menghapus Kolom dan Baris

Tidak menutup kemungkinan ketika memasukkan data ke lembar kerja terjadi
penumpukan data atau data yang rangkap. Oleh karena itu kita perlu menghapusnya
dengan langkah sebagai berikut:

Untuk menghapus

lebih dari satu
kolom/baris, pilihlah
beberapa kolom
atau baris yang ingin
dihapus. Kemudian
klik kanan dan pilih
Delete Columns/
Rows.

1).Klik kanan kolom atau baris yang akan dihapus.
2).Pada pull down menu, Klik:
a. Delete Columns, jika akan menghapus kolom.
b. Delete Rows, jika akan menghapus baris.

3).Jika benar, maka kolom atau baris yang terseleksi akan terhapus otomatis.
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7. Menyembunyikan Kolom dan Baris

Biasanya ketika kita menulis data ke area lembar kerja terdapat banyak
kolom dan baris yang melebihi tampilan di monitor sehingga bagian yang tertutup
monitor tidak terlihat sedangkan kita masih bekerja di bagian data yang paling kanan
dengan membandingkan data yang pertama yang berada pada sebelah kiri. Hal ini
menyebabkan kita harus terus menggeser-geser scroll bar bolak-balik dan berulang-
ulang. Cara ini sangat tidak efektif, oleh karena itu perlu cara yang lebih baik yaitu
dengan menyembunyikan kolom atau baris yang datanya kurang diperlukan atau
jarang dan tidak pernah dibuka lagi, misalnya kolom yang ada di tengah-tengah.
Berikut ini penjelasan langkah-langkah untuk menyembunyikan kolom dan baris
pada area lembar kerja OpenOffice.Org Calc.

a. Menyembunyikan Kolom

Langkah untuk menyembunyikan kolom adalah sebagai berikut:

1). Pilih satu atau lebih kolom yang akan disembunyikan, misalnya kolom C.

Laporan Penjualan Barang

Koperasi Sekolah 2008

Januari Rp4,500,000.0p Rp10,000,000.00 | Rp9,750,000.00
Februari Rp5,000,000.0p Rp10,250,000.00 Rp10,100,000.00
Maret Rp5,500,000.0p Rp10,500,000.00 Rp10,450,000.00
April Rp6,000,000.0p Rp10,750,000.00 Rp10,800,000.00
Mei Rp#6,500,000.0p; Rp11,000,000.00, Rp11,150,000.00
Juni Rp7,000,000.0p Rp11,250,000.00 Rp11,500,000.00
Juli Rp7,500,000.0p Rp11,500,000.00 Rp11,850,000.00
Agustus Rp8,000,000.0p Rp11,750,000.00 Rp12,200,000.00
September Rp8,500,000.0p Rp12,000,000.00 Rp12,550,000.00
Oktober Rp9,000,000.0p Rp12,250,000.00 Rp12,900,000.00
Nopember Rp9,500,000.0p Rp12,500,000.00 Rp13,250,000.00
Desember | Rp10,000,000.08 Rp12,750,000.00/Rp13,600,000.00]

2).Klik menu Format > Column -> Hide.

3).Kemudian data yang terseleksi akan disembunyikan sehingga yang nampak
akan langsung kolom D setelah kolom B.

A / B D\

1 Laporan Penju

: Koperasi Sekolah 2008

+ Januari Rp4,500,000.00] Rp9,750,000.00
= Februari Rp5,000,000.00| Rp10,100,000.00
s Maret Rp5,500,000.00| Rp10,450,000.00
» April Rp6,000,000.00| Rp10,800,000.00
s Mei Rp6,500,000.00| Rp11,150,000.00
s Juni Rp7,000,000.00| Rp11,500,000.00
v Juli Rp7,500,000.00| Rp11,850,000.00
u Agustus Rp8,000,000.00| Rp12,200,000.00
2 September Rp8,500,000.00| Rp12,550,000.00
= QOktcber Rp9,000,000.00| Rp12,900,000.00
11 Nopember Rp9,500,000.00| Rp13,250,000.00
s Desember | Rp10,000,000.00| Rp13,600,000.00

Gambar 6.21
Menyeleksi
Kolom C
Sumber:

Dokumentasi
Penulis

Gambar 6.22
Menyembunyikan
Kolom C

Sumber: Dokumentasi
Penulis
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b. Menyembunyikan Baris

Langkah untuk menyembunyikan baris adalah sebagai berikut:

1). Pilih salah satu atau lebih baris yang akan disembunyikan. Misalnya baris ke 6

sampai 10.

Gambar 6.23
Seleksi Baris Ke 6 sampai 10

Sumber: Dokumentasi Penulis

+ Laporan Penjualan Barang

: Koperasi Sekolah 2008

« Januari Rp4,500,000.00| Rp9,750,000.00

s_Februari Rp5,000,.000 00! Rpd0, 100000 00
Maret Rp5,500,000.00| Rp10,450,000.00
April Rp6,000,000.00| Rp10,800,000.00
Mei Rp6,500,000.00| Rp11,150,000.00
Juni Rp7,000,000.00| Rp11,500,000.00
Juli Rp7,500,000.00| Rp11,850,000.00

- AQUStUS Rps,000,000.00] Rp12,200,000.00

= September Rp8,500,000.00| Rp12,550,000.00

13 Oktober Rp9,000,000.00| Rp12,900,000.00

1 Nopember Rp9,500,000.00| Rp13,250,000.00

= Desember | Rp10,000,000.00| Rp13,600,000.00

2).Klik menu Format - Row —> Hide.

3). Kemudian data pada baris ke 6 sampai 10 akan disembunyikan.

Gambar 6.24
Menyembunyikan Baris Ke 6
sampai 10

Sumber: Dokumentasi Penulis

A

B

1 Laporan Penjualan Barang
2 Koperasi Sekolah 2008

i _

o]

+ Januari Rp4,500,000.00] Rp9,750,000.00
“Februari Rp5,000,000.00| Rp10,100,000.00
g;}\gustus Rp8,000,000.00| Rp12,200,000.00
September | Rp8,500,000.00| Rp12,550,000.00

= Oktober Rp9,000,000.00| Rp12,900,000.00
« Nopember | Rp9,500,000.00| Rp13,250,000.00
= Desember | Rp10,000,000.00| Rp13,600,000.00

7. Mengatur Border Tabel (Batas Sel)

Pada dasarnya lembar kerja terdiri dari garis-garis yang disebut Gridlines yang
membentuk kolom dan baris, namun garis-garis tersebut hanyalah garis standard
yang kadang kala tidak sesuai dengan kebutuhan kita. Selain itu, garis gridline
tersebut tidak ikut tercetak saat mencetak lembar kerja. Oleh karena itu, kita dapat
memberikan garis sebagai batasan tepi sel sendiri di tabel data sehingga lebih sesuai
dengan kebutuhan dan nantinya, garis tepi ini akan ikut tercetak pada saat kita

melakukan pencetakan dokumen lembar kerja.

-
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Memberi batas sel atau border dapat
dilakukan dengan cara mengklik sel yang akan
diberi batas, kemudian klik tombol borders pada
toolbar formatting (Gambar 6.25) dan memilih
jenis batas sel yang ingin diberikan pada sel

tersebut.

Sebagai contoh, kita memiliki tabel data tanpa batas sel tapi masih ada garis
gridlines-nya seperti pada Gambar 6.26. Langkah-langkah untuk memberikan garis

e Borders =7
| | [
] £ O O
= H m H

Laporan Penjualan Barang
Koperasi Sekolah 2008

P et aTar

Januari Rp4,500,000.00

Februari Rp5,000,000.00
Maret Rp5,500,000.00
April Rp6,000,000.00
Mei Rp6,500,000.00
Juni Rp7,000,000.00
Juli Rp7,500,000.00
Agustus Rp8,000,000.00
September Rp8,500,000.00
Oktober Rp9,000,000.00
Nopember Rp9,500,000.00
Desember  Rp10,000,000.00

tepi pada tabel adalah sebagai berikut:

1). Pilihlah data dari sel A3 sampai sel D15.
2).Klik menu Format > Cells [CTRL+1].
3). Kemudian pilih Tab Borders pada kotak dialog Format Cells.

e

Rp10,000,000.00
Rp10,250,000.00
Rp10,500,000.00
Rp10,750,000.00
Rp11,000,000.00
Rp11,250,000.00
Rp11,500,000.00
Rp11,750,000.00
Rp12,000,000.00
Rp12,250,000.00
Rp12,500,000.00
Rp12,750,000.00

T telalale

Rp8,750,000.00
Rp10,100,000.00
Rp10,450,000.00
Rp10,800,000.00
Rp11,150,000.00
Rp11,500,000.00
Rp11,850,000.00
Rp12,200,000.00
Rp12,550,000.00
Rp12,900,000.00
Rp13,250,000.00
Rp13,600,000.00

EormatiCells

[Numbers | Fant | Font Effects | Alignment [Borders| Background | Cell Protection |

E

Sk
Si

=idlen
hadow style

Eroe=eds

Line arrangerment Line Spacing to contents
Default Style Left _l .Opt
TOEEBD None = ‘ *
0.05 pt Right 1opt |5
User-defined 0.50 pt a
Top 14t |3
Bottorm 1.4pt E

Synchronize

Position

Ooooo

Distance

[5.0pt :

[ 0K H Cancel H Help ][ Reset l

Gambar 6.25
Tombol Borders
pada Toolbar
Formatting

Sumber: Dokumentasi
Penulis

Gambar 6.26
Tabel data tanpa
batas sel

Sumber: Dokumentasi
Penulis

Gambar 6.27
Kotak dialog
Format Cells >
Borders

Sumber: Dokumentasi
Penulis
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1). Atur jenis border, style dan warnanya agar berbeda dengan garis gridlines.

Misalnya:

m Jenis Bordernya “Set Outer Border or All Inner Lines”.

m Stylenya “1.00 pt’.

m Dan warnanya “Blue”.

2).Klik OK dan hasilnya akan tampak seperti gambar berikut ini.

+ Laporan Penjualan Barang
= Koperasi Sekolah 2008
+ Januari Rp4,500,000.00| Rp10,000,000.00| Rp9,750,000.00
s |Februari Rp5,000,000.00[ Rp10,250,000.00| Rp10,100,000.00
« Maret Rp5,500,000.00| Rp10,500,000.00| Rp10,450,000.00
> |April Rp6,000,000.00[ Rp10,750,000.00| Rp10,800,000.00
= |Mei Rp6,500,000.00] Rp11,000,000.00| Rp11,150,000.00
= Juni Rp7,000,000.00[ Rp11,250,000.00| Rp11,500,000.00
w Juli Rp7,500,000.00] Rp11,500,000.00| Rp11,850,000.00
2 \Agustus Rp8,000,000.00| Rp11,750,000.00| Rp12,200,000.00
» |September Rp8,500,000.00| Rp12,000,000.00| Rp12,550,000.00
Gambar 6.28 | * [Oktober Rp9,000,000.00] Rp12,250,000.00] Rp12,900,000.00
1 INopember Rp9,500,000.00] Rp12,500,000.00| Rp13,250,000.00
Tabel Data dengan Batas Sel |15 2 =—-0 05 500°000.00 Ro72.750,000.00] Rp13.600.000 00
Sumber: Dokumentasi Penulis |

raktikum

A. Praktikum membuat tabel

1. Aktifkanlah program OpenOffice.org Calc di komputermu

2. Pada lembar kerja tuliskan data sehingga nampak seperti tabel berikut ini:

A B < D E

DAFTAR BUKU KOMPUTER

5 Panduan Merakit Komputer

45000

2 Belajar Desain Grafis dengan Inkscape 35000

3 Image Editing dengan The Gimp 55000

4  Membangun Server Linux untuk Jaringan 40000

5 Mengenal Sistem Operasi Linux 25000

10 6 Internet dan Berbagai Aplikasinya 35000
u 7 Aplikasi Perkantoran dengan OpenOiffice. Org 60000
2 8 Panduan Praktis Bermain Games Linux 45000
13 9 Linux, Sistem Operasi Masa Depan 40000
1 10 Panduan Praktis Membuat Website dengan Joomla 55000

Gambar 6.29
Tabel Data Bahan Praktikum Satu

Sumber: Dokumentasi Penulis

Teknologi Informasi dan Komunikasi
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B. Praktikum mengubah ukuran kolom dan baris

1. Gabungkan Judul Tabel “DAFTAR BUKU KOMPUTER” yang ada pada sel B2 sampai pada
sel D2 dan buat agar rata tengah. Berilah batas sel (border) pada judul tersebut dengan
warna biru dan tebalnya 1,00 pt.

2. Ubahlah lebar kolom yang terdapat pada kolom B agar tidak terlalu lebar dari isinya. Berikan
ukuran 8,80 cm.

3. Ubahlah lebar Baris yang berisi tulisan “NO., JUDUL, dan HARGA” agar terlihat lebih lebar.
Berikan ukuran 0,90 cm.

4. Selanjutnya berikan batas sel (Border) pada sel B4 sampai D14 dengan tebal 1,00 pt dan
warna biru. Jika benar, maka hasilnya akan tampak seperti pada tabel berikut ini:

2 | DAFTAR BUKU KOMPUTER |
5 1 |Panduan Merakit Komputer 45000
s 2 |Belajar Desain Grafis dengan Inkscape 35000
’ 3 |Image Editing dengan The Gimp 55000
s 4 IMembangun Server Linux untuk Jaringan 40000
s 5 |Mengenal Sistem Operasi Linux 25000
10 6 |Internet dan Berbagai Aplikasinya 35000
u 7 |Aplikasi Perkantoran dengan OpenOffice. Org 60000
] 8 |Panduan Praktis Bermain Games Linux 45000
13 9 |Linux, Sistem Operasi Masa Depan 40000
1 10 |Panduan Praktis Membuat VWebsite dengan Joomla 55000

Gambar 6.30
Tabel Data Bahan Praktikum Dua

Sumber: Dokumentasi Penulis

5. Simpan hasil praktikum kamu dengan nama: “Lab_Bab_6_Format_Tabel_Nama_Kelas.
ods”.

Untuk SMP / MTs Kelas VIl
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C. Memformat Sel dengan Tipe Data yang

Sesuai

Data yang dimasukkan dalam spreadsheet dapat berupa tulisan tentang suatu
masalah atau kejadian lengkap yang disajikan dalam bentuk laporan dengan berbagai
jenis format data. Data tersebut dikelompokkan menjadi sebuah informasi yang lebih
bermakna sehingga nantinya dapat digunakan untuk mengambil keputusan yang
tepat.

1. Format Data Angka (Numbers)

Data angka (numbers) ditampilkan dalam bentuk susunan karakter yang
berbentuk angka dan biasanya dapat dipergunakan dalam operasi perhitungan.
Misalnya terdapat angka “2009”, maka angka tersebut dapat ditampilkan dengan
format yang berbeda-beda. Bisa jadi akan berubah menjadi Rp 2009.00, $2009,
2009.00, dan berbagai format angka lainnya. Semua angka tersebut bernilai
sama akan tetapi dalam penggunaanya berbeda-beda. Ada yang digunakan
untuk menyatakan satuan, jumlah, uang, dan lain-lain.

Untuk mengedit dan memilih format data dari suatu sel yang berisi data
angka dapat digunakan perintah dari menu Format - Cells kemudian pilih Tab
Numbers. Selanjutnya akan terlihat beberapa kategori format beserta pilihan

bahasa yang digunakan.
[ G B[ T

Numbers| Font | Font Effects | Alignment | Borders | Background | Cell Protection |
Category Format Language
User-defined -1234
Number -1234.12
Percent -1,234
Currency -1,234.12
Date -1,234,12
Time
Scientific ‘ 1.234.57 |
Cptions
Decimial places 2 % & Héééi“\‘\f‘&“ﬁu}ﬁgﬁ“\’% Ted
Leading zeroes a M Thousands separator
Gambar 6.31 B o
Kotak Dialog Format | [z ##000imeo1# ##0.00 (][] %
Cells > Numbers N— o
Sumber: Dokumentasi
Penulis I oK ” Cancsl][ Help H Reset ]

a. Format User-Defined
Format User-defined ini biasa disebut dengan format data General, yaitu
sebuah format yang apa adanya tanpa ada perubahan pada sel sejak penulisan.
Contohnya: 2009.
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b. Format Number

Format data angka hampir mirip dengan format desimal. Ketika kamu
memasukkan data berupa angka ke sel, maka itulah yang tertulis. Sistem bisa
mengenali bahwa itu adalah angka. Format data angka dapat ditulis dengan
tambahan desimal, bisa berupa angka negatif, atau bisa juga ditulis tanpa tanda
pemisah ribuan dengan ratusan. Contohnya: -2008, 2009.99.

c. Format Percent

Format data Percent digunakan untuk menampilkan angka persen dari
suatu nilai di mana angka dalam sel tersebut dikalikan dengan 100 dan ditandai
dengan simbol (%). Dalam penulisan persen, kita dapat menyertakan tanda
desimal. Contohnya: angka 0,90 akan menjadi 90 %.

d. Format Currency

Format data Currency digunakan untuk menyatakan bahwa angka tersebut
berformat sebagai mata uang. Secara default nilai currency dalam suatu sel adalah
dollar ($), tetapi dapat diubah menjadi mata uang negara lain dengan cara memilih
jenis mata uang pada bagian format Symbol. Contohnya: $2009, Rp 2.500,00.

e. Format Date

Seperti yang telah dijelaskan pada awal bab 6, format data date digunakan
untuk menyatakan tanggal dengan bentuk penulisan "mm/dd/yy” atau Bulan/
Tanggal/Tahun. Namun format tersebut dapat diganti ke format yang lainnya sesuai
dengan kebutuhan. Contohnya: 02-April-2009, May 31. 2009.

f. Format Time

Format data Time digunakan untuk menyatakan format waktu (jam) dengan
bentuk penulisan "hh:mm:ss” atau Jam:Menit:Detik. Format waktu ini juga dapat
diubah sesuai dengan kebutuhan. Contohnya: 02:10 AM, 05:15:10 AM, 20:30
PM.

g. Format Scientific

Format data Scientific digunakan untuk menyingkat angka yang terlalu besar
atau terlalu kecil dengan notasi ilmiah. Contohnya: 125.000.000 menjadi 1.25E +
08, artinya: 1.25 x 108.

Y 1.inologi Informasi dan Komunikasi &]
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h. Format Fraction

Format data Fraction digunakan untuk meletakkan angka pada posisi
tertentu, misal digit ke 1, digit ke 2, digit ke 3 dan seterusnya. Bisa juga digunakan
untuk membagi angka pada suatu sel dengan pembagi tertentu seperti per-dua,
per-tiga, per-empat, per-lima, dan seterusnya. Hasilnya, angka pada posisi tertentu
atau angka dalam bentuk tampilan diikuti dengan pembaginya. Contohnya: 1, 2,
3, ¥4, Va, dan seterusnya.

Format Bolean Value

Format data Bolean Value digunakan untuk menampilkan informasi Benar
atau Salah (True and False) dari suatu sel.

Format Text

Di dalam tipe data angka juga terdapat format text, yaitu format yang
digunakan untuk mengubah angka menjadi teks biasa. Meskipun tampilannya
angka, tatapi tidak dapat digunakan dalam proses perhitungan karena data sudah
berubah menjadi teks. Contohnya: 5, 10, dan seterusnya. Dalam hal ini jika 5
dikalikan 10 tidak menghasilkan angka 50 melainkan menghasilkan teks yaitu
5%10.

2. Format Data Teks (Font)

Gambar 6.32

Kotak Dialog

Format Cells >

Sumber: Dokumentasi

Font

Penulis

Dalam lembar kerja terdapat format data Teks yang dalam praktiknya bisa

diterapkan format yang meliputi jenis font, ukuran font, bahasa dan tampilannya
(tebal, miring dan garis bawah). Di bagian bawah kotak dialog format teks terdapat
tampilan teks yang sedang diedit.

Format Cells =

|[Numbers |[Font | Font Effects | Alignment | Borders | Background | Cell Protection |

Western text font
Font Typeface Size Language

[Aria\ Black "l INcrmaI |'l [20 |'] [ Indonesian
CTL font

Font Typeface Size Language

[DEJaVu Sans i'] iBooK i'] [12 i'] [ [None]

The same font will be used on both your printer and your screen,

[ QK ” Cancel H Help H Reset l

Selain dapat diubah jenis huruf dan ukurannya, font atau huruf dapat diberikan

efek seperti Underline, Double Underline, Strikethrough, Font color, Relief, dan
Underline Color.

168N
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EormatiCells

Underlining

[Numbers | Font [Font Effects| Alignment | Borders | Backaround | Cell Protection |

Color

[Wave (Bald)

O EM :]

Strikethrough Relief

@ Inclvidual words
Font color < Outline
Gambar 6.33
L Kotak Dialog
peoajar Ypenbinies.Urg Format Cells >

Font Effects

I oK H Cancel H Help H Reset ]

Sumber: Dokumentasi

Penulis

Selain menggunakan menu format, kita bisa menggunakan beberapa fungsi

yang terdapat pada toolbar formatting.

[Nimbus Sans L | '] l 10

-] & 4 A

A EEEEE & * = o [H-E -

» Gambar 6.34
= Toolbar Formatting

Di dalam toolbar formatting terdapat beberapa ikon yang mempunyai fungsi Sumber: Dokumentasi
yang berbeda-beda. Lihatlah dalam tabel berikut ini!

Tabel 6.1 Ikon dan Fungsi dalam Toolbar Formatting

NAMA
IKON

1 EaE Style and
L Formatting

NO IKON

FUNGSI

Digunakan untuk
menentukan style dan
format dalam penulisan
data pada lembar kerja

[Nimbus Sans L | *l

2 Font Name

Digunakan untuk
menentukan jenis huruf
yang digunakan dalam
penulisan

3 Font Size

(10 |~

Digunakan untuk
mengganti besar kecilnya
ukuran huruf

4 Typeface
A 4 A

Digunakan untuk
mengubah tampilan
karakter dalam suatu sel
apakah akan ditampilkan
dalam bentuk Tebal,
miring atau garis bawah

S | Character

Position

Digunakan untuk
mengubah posisi suatu
karakter dalam sel
apakah akan rata Kiri,
rata tengah, rata kanan
atau justify. Ada juga
ikon untuk merge cells
untuk menggabungkan
beberapa cells atau lebih
menjadi satu.

Penulis

Teknologi Informasi dan Komunikasi
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3. Format Alignment

Format Alignment digunakan untuk mengatur perataan tampilan data pada
suatu sel. Perataan teks atau angka dalam sel sebenarnya secara otomatis sudah
dilakukan oleh OpenOffice Calc, di mana data teks diatur rata kiri sedangkan data
angka dan tanggal diatur rata kanan. Walaupun sudah diatur sedemikian rupa oleh
system, tetapi Anda masih dapat mengatur perataan teks sendiri. Yaitu dengan
bantuan tombol Align Left, Center, Align Right atau Justify yang terdapat pada toolbar
formatting. Selain dengan toolbar formatting, Anda masih dapat mengatur perataan
teks menggunakan menu Format.

Untuk memformat perataan teks dengan menu format ini, lakukanlah langkah-
langkah berikut:
1).Pilih sel yang akan diubah formatnya.
2).Pilih Menu Format > Cells.
3).Pilih Tab Alignment.

C) Format Gells =]
|Numbers ‘ Fonl\ Font Effects |Alignment\ Borders| Background ‘ Cell Protection ‘
Text alignment
Horizontal Indent Vertical
|Justified +] foet [Z] [Midde
Text orientation
o Degrees [ Vertically stacked
AN o[
N
. & y | Reference edge
T e =] =]
Properties
M Wrap text automatically
¥ Hyphenation active
Gambar 6.35 Shrink to fit cell size
Format Ce”s 9 Alignment Text direction Use superordinate object settings = ]
Sumber: Dokumentasi Penulis ok ] [Cancel | [ e ] [(Reset |

Dari Tab Alignment yang kamu pilih, terdapat beberapa bagian yang digunakan
untuk mengatur perataan teks pada sebuah sel, antara lain:

1). Text Alignment > Horizontal, menentukan perataan data secara horizontal, di
mana secara standar akan tertulis di dalam kotak dialognya adalah Default, tapi
Anda bisa mengubah dengan memilih list yang ada, yaitu Left (rata kiri), Centerl
(rata tengah), Right (rata kanan), Justified (rata kiri dan kanan) dan Filled (data
teks atau angka akan diulang penulisannya sehingga memenuhi lebar sel).

2). Text Alignment - Vertical, menentukan perataan teks data secara vertical.

a. Top, data dalam sel akan diletakkan di atas atau rata atas tehadap tinggi
baris.
b. Middle, data akan diletakkan rata tengah terhadap tinggi baris.

c. Bottom, data akan diletakkan di bawah atau rata bawah terhadap tinggi baris.

Teknologi Informasi dan Komunikasi N
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3). Text Orientation, menentukan arah penulisan teks, secara default teks
ditulis secara mendatar atau horizontal dengan pembacaan teks dari Kiri
ke kanan, akan tetapi Anda dapat mengubah arah penulisan menjadi
vertical (Vertically Stacked) atau miring berdasarkan sudut kecuraman
tertentu dengan menuliskan sudut kecuraman pada kolom degrees atau
dengan menggerakkan penunjuk arah teks. atau dengan mengatur posisi

teks yang telah dimiringkan tersebut (Reference Edge).

4). Properties, mengatur data pada sel.

a. Warp Text Automatically, melipat teks ke baris baru atau data akan ditampilkan
ke bawah jika lebar sel tidak mencukupi untuk menampung panjang teks yang
tulis.

b. Hyphenation Active, menambahkan garis pemisah pada kata yang terpotong
di dalam sel.

c. Shrink to fit cell size, menyesuikan ukuran huruf suatu teks yang cukup panjang
terhadap lebar kolom.

4. Proteksi Sel

Untuk menjaga agar data tidak diubah oleh pihak lain, OpenOfficee Calc
menyediakan fasilitas protection yang digunakan untuk mengunci sel agar tidak
dapat diubah dan menyembunyikan formula yang telah dibuat agar tidak terlihat.
Untuk mengatur format protection, dapat dilakukan dengan langkah-langkah sebagai
berikut:

1). Pilih sel yang akan diubah formatnya.

2).Pilih menu Format -> Cells.
3).Pilih Tab Cell Protection.

E) Format Cells =Y

[Numbers | Font | Font Effects | Alignment | Borders | Background |Cell Protection|

Protection

[ Hide all Cell protection is only effective after the current
 Eehedicd sheet has been protected
¥ Protecte:

Select 'Protect Document' from the Tools' menu,

™ Hide formula N g N
and specify ‘Sheet’,

Print
™ Fide when printing; The cells selected will be emitted when printing

I OK H Cancel H Help H Reset l Penu”S

4).Pada format Cell Protection terdapat dua pilihan yaitu Hide All dan Print. Pada
bagian Hide All terdapat dua opsi yaitu Protected (mengunci sel dari perubahan
data) dan Hide formula (menyembunyikan formula pada suatu sel). Sedangkan
pada bagian Print, terdapat opsi Hide when printing (karakter pada suatu sel
tidak dicetak karena tersembunyi).

Gambar 6.36
Format Cells > Cell
Protection

Sumber: Dokumentasi
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Praktikum

A. Praktikum mengatur format sel

1.

Aktifkan komputermu.

2. Bukalah aplikasi OpenOffice.Org Calc.

3. Kemudian tulislah data berikut ini:

a. Sel A1: Latihan Format Data.
b. Sel A3: Format.
c. Sel B3: Angka berikut ini.

4. Selanjutnya lengkapi data tersebut agar nampak seperti pada gambar berikut ini.

5. Isilah tanda titik-titik tersebut dengan menggunakan perintah Format — Cells — Numbers

dengan mengacu pada angka: 1725,7654.

Simpan latihan tersebut dengan nama: “Lat_Bab_6_Format_Data_Angka_Nama_Kelas.
ods”.

A E

1 Latihan Format Data

+ User-Defined 1725.7654
s Number |
s Currency |
r Percent |
s Date |
s Time |
w Scientific |
u Fraction L
12 Bolean Value |
s Text

14

Gambar 6.37
Latihan Praktikum Format Data Angka

Sumber: Dokumentasi Penulis
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B. Praktikum mengatur perataan isi sel

1. Aktifkan komputermu dan bukalah program OpenOffice.org Calc
2. Buatlah data seperti nampak pada gambar di bawah ini:

A E C

1 Latihan Format Data

2

- TEKNOLOGI INFORMASI [KOMUNIKASI |

4

Gambar 6.38
Latihan Praktikum Format Data Teks

Sumber: Dokumentasi Penulis

3. Edit data tersebut agar berubah formatnya seperti pada gambar di bawah ini:

A E (e

1 Latihan Format Data

T 7]
E >
K =
N 2 =]
L &
o N
G
|

Gambar 6.39

Hasil Praktikum Format Data Teks
Sumber: Dokumentasi Penulis

4. Simpan dengan nama: “Lat_Bab_6_Format_Data_Teks_Nama_Kelas.ods”.

D. Format Halaman

Agar dapat mencetak dokumen lembar kerja dengan baik, kamu perlu melakukan
pengaturan halaman, margin, header dan footer serta bagian-bagian lembar kerja
yang akan dicetak. Berikut ini adalah tampilan dari kotak dialog format halaman pada
OpenOffice Calc:
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Gambar 6.40
Format Pengaturan
Halaman (Format >
Page)

Sumber: Dokumentasi
Penulis

1.

Gambar 6.41
Format
PengaturanUkuran
Kertas

Sumber: Dokumentasi
Penulis

(@ PEOEISHY e D erauit =

[Organizer |Page | Barders | Background | Header | Footer | Sheet |

Paper format

Format

Width 14.00"

&

T
Orientation O Portrait Text direction ILeﬁ-tu—right (horizontal) = ]

@ Landscape Paper tray [[Frﬂm printer settings] = ]

Margins Layout settings
Left 0.93" E Page layout [Right and left = ]
Right Format 123 .. :]
Top Table alignment Harizontal
Bottomn 0.87" B ‘ B
i
[ OK ” Cancel H Help H Reset l

Mengatur Ukuran / Jenis Kertas

Pengaturan hasil pencetakan tidak terlepas dari pengaturan ukuran kertas,
karena setiap pencetakan tidak selalu menggunakan ukuran yang sama. Penggunaan
ukuran kertas dapat berubah-ubah sesuai kebutuhan. Untuk mengubah ukuran
kertas dapat dilakukan dengan langkah-langkah berikut ini:

a. Pilih Menu Format - Page

b. Pada kotak dialog “Page Style:default” seperti pada Gambar 6.40, pilih menu
drop down pada bagian Paper Format: Format.

c. Beberapa jenis format jenis kertas yang sering digunakan antara lain: Letter,

Legal, A4, B5, dan lain-lain.

Organizer |Page | Borders | Background

Paper format

Format ELegal i| >
. B4 (JIS) 4]
L BS (JIS) .
, B6 (IS)
Height Letter ]
Orientation 92l
Tabloid B

™ CATTIsTaE=

d. Klik OK jika sudah memilih jenis ukuran/jenis kertasnya.
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2. Mengatur Margin

Untuk menghasilkan cetakan yang baik, kamu harus memperhatikan pengaturan
margin yaitu jarak antara tepi halaman kertas dengan tepi bidang lembar kerja. Margin
dapat mementukan apakah bidang yang ingin dicetak dapat dimuat pada sebuah
halaman atau tidak. Jika margin yang diatur melebihi batas halaman, maka lembar
kerja yang tercetak akan terputus.

Untuk mengatur margin, dapat dilakukan dengan langkah sebagai berikut:

a. Pilih Menu Format -> Page.

b. Pada kotak dialog “Page Style:default’ seperti pada Gambar 6.40, pilih tab
“‘Page”.

c. Di bagian bawah terdapat Options “Margins”. Isikan batas-batas penulisan
halaman lembar kerja tersebut. Misal diisi dengan ketentuan

1).Left: 0.93 inch

) . Margins
2). Right: 0.89 inch Left E
3).Top: 0.87 inch AlghE oes &
4). Bottom: 0.87 inch - e —
Top 0.87" B
d. Klik OK jika sudah selesai.
Bottom 0.87" B

. Orientasi Halaman

Orientation merupakan bagian yang digunakan untuk mengatur tata letak kertas.
Pilihan yang digunakan adalah tegak (portrait) dan menyamping (landscape).

[Organizer |Page | Borders | Background | Header | Footer | Sheet |

[Elop e
Faper Tormat

Format B5 (JIS) =
Width 10.12" B

Height 7.17"

Orientation ) Portrait Jext direction [Leﬂ:—to—right (horizontal) : ]
@ Landscape Paper tray [Autﬂ Select H ]

. Persentasi Ukuran Halaman

J

Pengaturan persentasi ukuran halaman dapat ditemukan pada Tab Sheet
yang berada pada kotak Format - Page paling ujung. Persentasi ukuran halaman
dapat menentukan skala pencetakan. Terdapat dua opsi pada bagian pengaturan
persentasi ukuran halaman yaitu Scaling Mode dan Scaling Factor. Scaling Mode akan
memadatkan isi hasil pencetakan menjadi sejumlah halaman yang ditentukan. Kemudian
Scaling Factor, jika kotak tersebut diisi dengan 100, maka artinya normal, sedangkan jika
lebih tinggi lagi berarti diperbesar dan apabila kurang dari 100 berarti diperkecil.

Gambar 6.42
Format Pengaturan
Margin Halaman

Sumber: Dokumentasi
Penulis

Gambar 6.43
Format Pengaturan
Orientasi Halaman
(portrait)

Sumber: Dokumentasi
Penulis
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Gambar 6.44
Format Pengaturan
Orientasi Halaman
(portrait)

Sumber: Dokumentasi
Penulis

Gambar 6.45
Format Pengaturan
Header

Sumber: Dokumentasi
Penulis

Page Style: Defaut

\Organlzer \ Page \ Borders \ Background |Header\ Footer |Sheet |

Page order
@ Top to bottom, then right

O Left to right, then down

— a N
[ First page number 1 =

Print
[ Column and row headers [ Charts
Grid Drawing objects
@ Notes & Formulas
Objects/graphics Zero values

Scal
AﬁTﬂg mode
[Reducs/en\arge printout = ] Scaling factor E

[ OK H Cancel H Help H Reset ]

5. Menambahkan Header dan Footer

Untuk membuat tampilan pencetakan lebih menarik, akan lebih baik apabila
dibuat suatu baris tambahan di bagian atas dan bawah dari halaman yang disebut
header dan footer. Tampilan header dan footer juga dapat dilihat sebagai judul yang
muncul pada setiap halaman atau beberapa halaman tertentu. Selain itu, header dan
footer biasanya digunakan untuk memberi nomor halaman atau memberi identitas
pada hasil cetakan.

Untuk membuat header dapat dilakukan dengan cara sebagai berikut:

1). Pilih menu Format -> Page.
2).Pada kotak dialog “Page Style:default’ pilih tab “Header".
3).Pada Option Header, Checklist Header On agar fasilitas Header aktif.

=

= Heager [m

Same content left/right

Left margin 0.00" =

Right margin 0 oo %
a 0.00

Spacing 0.10 =

Height 0.20" B

AutoFit height

More... | [ Edit... ]

[ OK H Cancel ][ Help H Reset ]
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4).Masukkan ketentuan batas-batas header seperti Left Margin, Right Margin, Spacing
dan Height sesuai kebutuhan

5).Jika ingin menambahkan Header secara manual, klik tombol “Edit’, sehingga
muncul kotak dialog seperti di bawah ini:

& HESAER(Page Sty ENDETatIE) =
Left area Center area Right area [T]
| |
Header [Custornized L] Gambar 6.46
- Menambahkan
s Header (Right Area)
RotS ‘ ‘ secara manual
Use the buttons to change the font or insert field commands such as date, time, etc.
Sumber: Dokumentasi
Penulis
6). Masukkan keterangan header, misal kata: File Latihan Calc 6 pada salah satu
posisi Left Area, Center Area atau Right Area.
7).Kalau sudah, klik OK.
Sedangkan untuk membuat Footer, dapat dilakukan dengan langkah-langkah
sebagai berikut:
1). Pilih menu Format -> Page.
2).Pada kotak dialog “Page Style:default’ pilih tab “Footer’.
3).Pada Option Footer, Checklist Footer On agar fasilitas Footer aktif.
@ Page style DEfatlt =
[Organizer | Page | Borders | Background | Header [Footer| Sheet|
FD;EEruuter on:
™ Same content left/right
Left margin 0.00" B
Right margin
S ECNE
Height 020 [3]
[ AutoFit height
Gambar 6.47
More.. |[  Ede. ] Format Pengaturan
Footer
Sumber: Dokumentasi
[ OK ” Cancel ” Help H Reset l Penu”S

4).Masukkan ketentuan batas-batas footer seperti Left Margin, Right Margin, Spacing
dan Height sesuai kebutuhan.

5).Jika ingin menambahkan Footer secara manual, klik tombol “Edit”, sehingga muncul
kotak dialog seperti di bawah ini:
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Gambar 6.48
Menambahkan
Footer (Left Area)
secara manual

Sumber:
Dokumentasi Penulis

SPraktikum

A. Praktikum membuat Tabel

Left area

EOotErPagerStyIE e atl L)

Center area

Right area

OK

Eooter

Custorn footer

Note

aaaaaaaa

[Custum\zed

¢

[a])(=]

Use the buttons to change the font or insert field commands such as date, time, etc.

=]

Help

6). Masukkan keterangan footer, misal kata: TIK Kelas 8 — SMT 2 pada Left Area,
dan kata: Halaman 1 pada Right Area.

7).Kalau sudah, klik OK.

1. Aktifkan program OpenOffice.org Calc.
2. Buatlah data dalam tabel dengan isi sebagai berikut:

DAFTAR NILAI PELAJARAN TIK

1 Aan 67 78 83 74 71
2 |Abdul 71 80 85 78 74
3 |Acika i 82 87 82 78
4  |Adinda 79 84 89 86 82
5  |Afifah 83 86 91 90 86
6 |Akbar 83 38 93 90 36
7 |Amanda 87 90 88 94 90
8  |Andi 91 92 92 98 94
9  |Annisa 86 94 9% 93 89
10 |Aziz 90 9% 100 97 93

3. Simpan dengan nama: “Lat_Bab_6_Format_Halaman_Nama_Kelas.ods”:

Untuk SMP / MTs Kelas VIII
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B. Praktikum memformat tabel

1. Melanjutkan Praktikum nomor satu, formatlah halaman file latihan di atas
2. Buat agar halaman mengikuti ketentuan di bawah ini:

m Ukuran Kertas (A4,
m Orientasi : Landscape.
m Margins
1). Kiri :4 cm.
2).Kanan :3cm.
3).Atas :3cm.
4).Bawah :3cm.
3. Berikan Header dengan tulisan
m Kiri Atas : "File Data Nilai Siswa”.
m Kanan Atas : "Tanggal Sekarang”.

4. Berikan Footer dengan tulisan:
m Kiri Bawah : "Arsip Nilai TIK”.

m Kanan Bawah : "Halaman, misal: 1”.

5. Simpan ulang pekerjaanmu dengan nama yang sama pada praktikum nomor satu.

E. Menyimpan Lembar Kerja

Setelah lembar kerja selesai dibuat, selanjutnya buku kerja dapat
disimpan ke media penyimpanan seperti hard disk, flashdisk, disket,
dan media lainnya. Untuk menyimpan file lembar kerja dapat dilakukan
dengan perintah Save dan perintah Save As.

1. Menyimpan dengan Save

Perintah Save digunakan untuk menyimpan perubahan pada
isi file yang sebelumnya sudah pernah disimpan. Selain itu, perintah
ini biasa digunakan untuk menyimpan data yang baru dibuat
pertamas kali. Langkah-langkah untuk menyimpan dengan perintah
Save adalah:

Y 1.inologi Informasi dan Komunikasi
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a. Klik Menu File > Save (CTRL+S).
File Edit View Insert Fol
] New >
2 Open... Ctrl+0O
Recent Documents »
Wizards »
X Close
Gambar8.49 ) gaye Ctrl+S
Menyimpan dengan Save = -
Sumber: Dokumentasi Penulis Save As... Ctrl+Shift+5
Save All
b. Kemudian muncul kotak dialog Save.
c. Tentukan folder di mana akan menyimpan file, misalnya di folder “Latihan”.
d. Masukkan nama file penyimpanannya, misalnya: “Latihan Calc 5.
e. Tentukan ekstensi penyimpanan file. Misalnya: .ods.
f. Klik tombol Save.
Name: [Latihan Calc 5 ) )
er: [ Lo al
o oo RN e
< Places AliNeme A ~ Modified =]
e j s Yomordey a£ 747
& Desktop | Latihan Calc 3.ods Yesterday at 07:48
(= Pictures _ Latihan Calc 4.0ds Yesterday at 07:48
& Videos j
Add [m ODF Spreadsheet (.ods)
[ type
Gambar 6.50 el e MO = i
Kotak Dialog Save L = I
Sumber: Dokumentasi CEE e s :
Penulis e

. Menyimpan dengan Save As

Selain menggunakan perintah Save, kamu bisa juga menggunakan perintah
Save As yaitu perintah untuk menyimpan lembar kerja yang memungkinkan kamu
untuk mengubah nama file sebelumnya dengan nama yang baru. Dan tidak menutup
kemungkinan terjadinya perubahan pada isi file lembar kerja. Langkah-langkahnya
adalalah sebagai berikut:

Untuk menyimpan
lembar kerja yang
pertama kali dibuat, bisa
langsung menekan ikon

a. Klik Menu File > Save As.

b. Kemudian muncul kotak dialog Save.

bergambar disket
pada Toolbar Standard.
Atau bisa juga dengan
Shortcut: CTRL + S.

. Tentukan letak folder di mana kamu akan menyimpan file, misalnya di folder:
“‘Latihan”.
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Untuk SMP / MTs Kelas VIII

g



d. Masukkan nama file penyimpanan yang baru,
misalnya: “Latihan 5 Bab 6.

e. Pastikan kamu memilih Ekstensi penyimpanannya.

Misalnya: .ods.

f. Klik tombol OK.

Pada saat menyimpan dokumen lembar kerja, ada kalanya kita perlu memberikan
pengaman file agar setelah kita selesai mengguanakan file tersebut tidak bisa dibuka
oleh orang lain. Apalagi jika data dala lembar kerja bersifat rahasia yang tidak boleh
diketahui oleh orang lain. Langkah untuk memberikan password sangat mudah, ketika
kamu menjalankan perintah untuk menyimpan (Save atau Save As) akan muncul
kotak dialog Save. Nah, di bagian bawah kotak dialog tersebut akan muncul tulisan
“Save With Password”. Kamu tinggal memberikan tanda checklist pada kotak kecil

di sampingnya.

File Edit View Insert Fol

Name:

Save in folder: ‘ Latihan

~ Browse for other folders

E][Eé saruri H Documents ”Latihan]

Places

“ Name

~ Modified

[ New b
2 Open... Ctrl+0
Recent Documents »
Wizards »
X Close
[Z] Save Ctrl+S
Save As... Ctrl+Shift+S
Save All
Save EHEE
|Latihan 5 Bab 6 J
=)

= Downloads
(= Latihan
& Desktop
= Pictures

[ Latihan Calc 1.ods
[/ Latihan Calc 2.0ds
' U Latihan Calc 3.ods
[ Latihan Calc 4.ods

Yesterday at 07:47
Yesterday at 07:47
Yesterday at 07:48
Yesterday at 07:48

~ File type

Tl e

ODF Spreadsheet (.ods)

ODF Spreadsheet

ODF Spreadsheet Template
OpenOffice.org 1.0 Spreadsheet
OpenOffice.org 1.0 Spreadsheet Template

Edit filter settings
Save with password

3. Menyimpan dengan Password

~ File type

ODF Spreadsheet

e | FEE i
UUr opreadasneec

- ;R
Iempiate

dshee
OpenOffice.org 1.0 Spreadsheet

OpenOffice.org 1.0 Spreadsheet Template

¢

Edit. filter Isetting'-s

Save with passgorc;
\ /

Gambar 6.51
Menyimpan dengan
Save As

Sumber: Dokumentasi
Penulis

Gambar 6.52
Menyimpan dengan
Save As

Sumber: Dokumentasi
Penulis

Gambar 6.53
Menyimpan dengan
Password

Sumber: Dokumentasi
Penulis
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Jika sudah memberi tanda checklist, klik tombol Save dan akan muncul kotak
dialog memberi password sebagai berikut:

Gambar 6.54 Password [nxun ]
Kotak Dialog Input
Pagswsrd T — ] e
Sumber: Dokumentasi (Minimum 5 characters)
Penulis =

Password yang kamu masukkan akan otomatis terlihat dengan tanda bintang-
bintang dengan ketentuan minimal 5 karakter. Password bisa berupa campuran
karakter huruf dan angka serta tanda baca sehingga kuat. Contohnya: R4h4s1a! <
artinya “rahasia!”.

SPraktikum

Praktikum menyimpan file

1. Aktifkanlah komputer, kemudian buka program OpenOffice Calc

2. Buka kembali file latihan pada praktikum sebelumnya yang bernama: ”Lat_Bab_6_Format_
Halaman_Nama_Kelas.ods”

3. Ubah nama file latihan tersebut dengan perintah File > Save As
4. Pada kotak dialog Save, lakukan ketentuan berikut ini:
a. Tulis nama file yang baru: ”Lat_Bab_6_Save_with_password_Nama_Kelas.ods”
b. Pilih ekstensi penyimpanan: ”.xIs”
c. Centang opsi: Save With Password di bagian bawahnya
d. Klik tombol Save
5. Jika muncul kotak dialog password, masukkan passdwordnya: ”L4t1h4n”

6. Simpan dengan nama: ”"Lat_Bab_6_Format_Halaman_Nama_Kelas.ods”:
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F. Mencetak Lembar Kerja

Setelah selesai menyimpan lembar kerja, selanjutnya sampai pada tahap
pencetakan. Pada saat akan mencetak lebar kerja, ada baiknya terlebih dahulu
melihat bentuk hasil pencetakan lembar kerja di layar monitor. Hal ini akan sangat
membantu untuk memeriksa hasil cetakkan sebelum dicetak ke printer.

1. Menggunakan Fasilitas Page Preview

Jika akan mencetak, sebelumnya lakukan pemeriksaan terhadap isi lembar kerja
dengan fasilitas Page Preview agar hasil cetakan sesuai dengan yang diinginkan.
Berikut ini merupakan langkah-langkah untuk menampilkan hasil cetakan di layar
monitor:

a. Pilih menu File > Page Preview, atau dengan menekan tombol pada toolbar
standard.

b. Selanjutnya, akan ditampilkan jendela preview yang menampilkan lebar kerja
secara keseluruhan yang akan dicetak.

File Edit View Insert Format Tools Data Window Help X

B |« v & @L @ Fermat Page  Close Preview

Sheetl =

DAFTAR NILAI PELAJARAN TIK

1 Aan 67 78 83 74 Fl
2 Abdul 71 80 85 78
3 Acika 75 82 87 82
4 Adinda 79 84 89 86
5 Afifah 83 86 91 90
6 Akbar 83 88 93 90
7 Amanda 87 90 88 94
8 Andi 91 92 92 98
9 Annisa 86 94 95 93
10 Aziz 90 96 100 97

4] [
h /maé&WEE n

|Page 1 | Default [117% |

Pada jendela Preview, terdapat beberapa tombol yang dapat digunakan. Berikut
ini keterangan tombol-tombol yang terdapat pada jendela preview:

Gambar 6.55
Kotak Dialog Page
Preview

Sumber: Dokumentasi
Penulis
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Gambar 6.56

Kotak Dialog Printer
Settings

Sumber: Dokumentasi
Penulis

Gambar 6.57
Kotak Dialog Print

Sumber: Dokumentasi
Penulis

Tabel 6.2 Tombol-tombol pada Page Preview

NO |

TOMBOL

FUNGSI

1 Next Menampilkan Halaan Berikutnya

2 Previous Menampilkan Halaman Sebelumnya

3 First Page Menampilkan Halaman Pertama

4 Last Page Menampilkan Halaman Terakhir

5 Zoom In Memperbesar tampilan

6 Zoom Out Memperkecil tampilan

7 Full Screen Menampilkan secara keseluruhan

8 Format Page Mengatur halaman, ukuran kertas, header/
footer, dan lain-lain

9 Close Preview Menutup jendela Preview

2. Mencetak Dokumen Ke Printer

Untuk mencetak ke printer, sebelumnya printer harus sudah terinstall dan
dalam keadaan aktif. Untuk mengecek printer yang sudah terinstal di komputer
dapat dilakukan dengan perintah File > Printer Settings, maka akan muncul kotak
dialog printer setting sebagai berikut:

2 Printer Setup =

E ] Properties. ..

Printer

Name fHPU_P1006

Status

Type
Location

Default printer
CUPS:HPLJ_P1006
saruri-ubuntume

Comment HP Laserjet P100

o ] |

Berikut langkah-langkah untuk mencetak dokumen ke printer:

Cancel Help l

a. Pilih Menu File > Print atau dengan menekan ikon printer H pada toolbar
standard.

b. Selanjutnya akan tampil kotak dialog Print.

<@ PHAE =
Printer
Mame [HPU_P1008 ] Properties...
Status Default printer
Type CUPS:HPL] P1006
Location saruri-ubuntume
Comment HP Laserjet P100
[ Print to file
Print Copies
O All sheets Number of coples %
@ Selected sheets 2,
(O Selected cells ﬁﬁ | etz
Print range
O All pages
© Pages
Options... i oK i [ Cancel J I Help

184N
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c. Aturlah pencetakan lembar kerja yang meliputi:

m Printer: mengetahui pilihan, status dan lokasi printer.

e Name, tentukan nama printer yang sudah terinstall di komputer.

e Properties, mengatur fasilitas yang ada pada printer.

e Print To File, pilih opsi ini jika kamu akan mencetak dokumen dalam bentuk

file yang lain.
m Print:

e All Sheets, mencetak seluruh sheets.

e Selected Sheets, mencetak hanya pada sheet yang terseleksi.

e Selected Cells,mencetak sel tertentu dalam sheet.

m Copies: menentukan jumlah salinan lembar kerja yang akan dicetak.

e Number of copies, menentukan jumlah cetakan.

e Collates, mencetak semua halaman terlebih dahulu baru kemudian mencetak

salinannya.

m Print Range: Menentukan letak halaman yang akan dicetak.

e All Pages, mencetak semua halaman pada lembar kerja.

e Pages, mencetak dari halaman tertentu.

d. Jika sudah selesai tekan OK.

raktikkum

Praktikum mencetak file

1. Aktifkanlah komputer, kemudian aktifkan program OpenOffice.org Calc.

2. Bukalah file pada latihan sebelumnya yang bernama: ”Lat_Bab_6_Format_Halaman_Nama_

Kelas.ods”
3. Cetaklah dokumen tersebut ke printer dengan cara:
4. Pada kotak dialog Save, lakukan ketentuan berikut ini:
Tekan CTRL + P pada keyboard.
Sheets yang dicetak: "Selected Sheets”.
Tentukan halaman: "All Pages”

Masukkan jumlah cetakkan "Number of Copies”: 5.

®© a0 T o

Centang tanda "Collates”.
5. Klik OK.

Teknologi Informasi dan Komunikasi
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&angkuman

. Pada OpenOffice. org Calc terdapat beberapa jenis data yaitu teks, angka, tanggal dan waktu.

. Untuk memasukkan data pada suatu sel, kita bisa melakukannya dengan cara memilih sel-nya

terlebih dahulu kemudian ketikkan datanya dan tekan enter atau tab pada keyboard. OpenOffice.
org Calc akan langsung mengidentifikasi jenis data yang dimasukkan dalam suatu sel sehingga
data akan secara otomatis dikenali.

. Datayang telah ditulis pada suatu sel dapat terhapus apabila pada sel tersebut kamu mengetikkan

sasuatu. Jika terjadi kesalahan pada saat pengetikan maka kamu dapat memilih perintah Undo
pada menu Edit. Cara lainnya adalah dengan menekan tombol Backspace dan Delete untuk
menghapus isi sel. Jika kamu ingin mengganti atau mengedit isi sel dapat dilakukan dengan
mengklik dua kali pada sel yang akan diubah atau dengan menekan tombol F2 pada keyboard.

. Jenis data teks jika dimasukkan ke dalam sel, maka formatnya akan otomatis rata kiri. Data jenis

teks merupakan suatu data yang terdiri atas karakter atau bisa berupa gabungan dari huruf dan
simbol serta angka. Biasanya data jenis teks ini ditampilkan dalam beberapa bentuk huruf (font),
ukuran (size), warna (color), dan berbagai format teks yang lainnya.

. Jenis data angka jika dimasukkan ke dalam sel, maka formatnya akan otomatis rata kiri. Data

jenis angka merupakan suatu data yang terdiri atas karakter berupa angka, simbol mata uang,
dan simbol-simbol lainnya yang bisa dipergunakan dalam perhitungan.

. Jenis data tanggal jika dimasukkan ke dalam sel, maka format default yang ditampilkan adalah

mm/dd/yy di mana "mm” adalah bulan (Mounth), dan "dd’ adalah tanggal (Date), serta "yy’
adalah tahun (Year). Format ini dapat diubah sesuai dengan kebutuhan.

. Jenis data waktu jika dimasukkan ke dalam sel, maka format default yang akan ditampilkan

berupa hh:mm:ss di mana "hh” adalah jam (Hours), dan "mm” adalah menit (Minutes), serta
”’ss” adalah detik (Seconds). Untuk berbagai keperluan, maka format data waktu ini juga dapat
diubah sesuai dengan kebutuhan.

8. Jenis data formula digunakan untuk mempermudah operasi perhitungan dalam lembar kerja.

9. Fill Series digunakan untuk membuat daftar urutan otomatis seperti penomoran otomatis,

penamaan hari otomatis, penamaan bulan otomatis dan segala urutan yang otomatis lainnya.

10.Fasilitas Sort Lists sangat berguna jika kamu ingin mengurutkan data terutama pada data yang

11.

tidak berdasarkan abjad atau numerik.

Tampilan dari aplikasi Spreadsheet pada dasarnya berupa susunan kolom dan baris sehingga
akan otomatis membentuk tabel (Table). Jadi kamu tidak perlu merasa kesusahan dalam hal
pembuatan tabel, mungkin yang perlu diperhatikan adalah bingkai yang mengelilingi data dalam
tabel yaitu dengan menebalkan border atau mewarnainya sehingga kamu bisa membedakan
mana yang bingkai (Border) dan mana yang garis bantu (Gridlines).

12.Ketika bekerja dengan OpenOffice.org Calc, terkadang ada saatnya kita harus menggabungkan
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Cells. Penggabungan itu dapat dilakukan secara horisontal (sel pada baris tertentu), vertikal (sel
) pada kolom tertentu), maupun gabungan keduanya.

13.Biasanya ketika kita menulis data ke area lembar kerja terdapat banyak kolom dan baris yang
melebihi tampilan di monitor sehingga bagian yang tertutup monitor tidak terlihat sedangkan kita
masih bekerja di bagian data yang paling kanan dengan membandingkan data yang pertama
yang berada pada sebelah kiri. Hal ini menyebabkan kita harus terus menggeser-geser scroll
bar bolak-balik dan berulang-ulang. Cara ini sangat tidak efektif, oleh karena itu perlu cara yang
lebih baik yaitu dengan menyembunyikan kolom atau baris yang datanya kurang diperlukan atau
jarang dan tidak pernah dibuka lagi, misalnya kolom yang ada di tengah-tengah.

14.Pada dasarnya lembar kerja terdiri dari garis-garis yang disebut Gridlines yang membentuk
kolom dan baris, namun garis-garis tersebut hanyalah garis standard yang kadang kala tidak
sesuai dengan kebutuhan kita. Selain itu, garis gridline tersebut tidak ikut tercetak saat mencetak
lembar kerja. Oleh karena itu, kita dapat memberikan garis sebagai batasan tepi sel sendiri di
tabel data sehingga lebih sesuai dengan kebutuhan dan nantinya, garis tepi ini akan ikut tercetak
pada saat kita melakukan pencetakan dokumen lembar kerja.

15.Data yang dimasukkan dalam lembar kerja dapat terdiri dari berbagai tipe dan format. Data tersebut
berupa teks, angka, waktu, dan tanggal, serta formula. Masing-masing tipe data tersebut tentu
ditampilkan dengan format yang berbeda-beda. Misalnya, data teks ditampilkan dengan format
tebal, miring dan bergaris bawah. Sedangkan data angka seperti data uang ditampilkan dengan
simbol mata uang di depannya. Agar tampilan data sesuai dengan kebutuhan dan keinginan,
maka kita perlu memformatnya agar sesuai dengan tipe data.

16.Dalam lembar kerja terdapat format data teks yang dalam praktiknya bisa diterapkan format
yang meliputi jenis font, ukuran font, bahasa dan tampilannya (tebal, miring dan garis bawah). Di
bagian bawah kotak dialog format teks terdapat tampilan teks yang sedang diedit.

17.Format Alignment digunakan untuk mengatur perataan tampilan data pada suatu sel. Perataan
teks atau angka dalam sel sebenarnya secara otomatis sudah dilakukan oleh OpenOffice.org
Calc, di mana data teks diatur rata kiri sedangkan data angka dan tanggal diatur rata kanan.
Walaupun sudah diatur sedemikian rupa oleh sistem, tetapi Anda masih dapat mengatur perataan
teks sendiri. Yaitu dengan bantuan tombol Align Left, Center, Align Right atau Justify yang terdapat
pada toolbar formatting. Selain dengan toolbar formatting, Anda masih dapat mengatur perataan
teks menggunakan menu Format.

18.Untuk menjaga agar data tidak diubah oleh pihak lain, OpenOffice.org Calc menyediakan fasilitas
protection yang digunakan untuk mengunci sel agar tidak dapat diubah dan menyembunyikan
formula yang telah dibuat agar tidak terlihat.

19.Agar dapat mencetak dokumen lembar kerja dengan baik, kamu perlu melakukan pengaturan
halaman, margin, header dan footer serta bagian-bagian lembar kerja yang akan dicetak.

20.Untuk membuat tampilan pencetakan lebih menarik, akan lebih baik apabila dibuat suatu baris
tambahan di bagian atas dan bawah dari halaman yang disebut header dan footer. Tampilan
header dan footer juga dapat dilihat sebagai judul yang muncul pada setiap halaman atau
beberapa halaman tertentu. Selain itu, header dan footer biasanya digunakan untuk memberi
nomor halaman atau memberi identitas pada hasil cetakan.
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Delete Tombol untuk menghapus satu karakter sebelah kanan pointer
Backspace |Tombol untuk menghapus satu karakter sebelah kiri pointer
Undo Untuk membatalkan perintah sebelumnya
Esc Membatalkan perintah memasukkan data pada sel
Save Menyimpan data pada lembar kerja (file baru dan juga file yang diubah isinya
pada dokumen yang sama)
Save As Menyimpan dokumen dengan mengganti nama filenya
Strin Jenis tipe data berupa karakter yang tidak dapa digunakan dalam operasi
9 perhitungan
Data jenis angka merupakan suatu data yang terdiri atas karakter berupa angka,
Numerik simbol mata uang, dan simbol-simbol lainnya yang bisa dipergunakan dalam
perhitungan.
Jenis data yang dapat di input dalam sel dengan format default mm/dd/yy di mana
Date "mm” adalah bulan (Mounth), dan "dd” adalah tanggal (Date), serta "yy” adalah
tahun (Year). Format ini dapat diubah sesuai dengan kebutuhan.
Jenis data di input ke dalam sel dengan format default yang akan ditampilkan
Time berupa hh:mm:ss di mana "hh” adalah jam (Hours), dan "mm” adalah menit
(Minutes), serta "ss” adalah detik (Seconds).
Dr?\;)eaawn Menu yang dapat dimunculkan dari menu Bar.
Pull Down |Menu yang dapat dimunculkan dengan cara klik kanan pada objek di dalam
Menu dokumen
. Mengurutkan data terutama pada data yang tidak berdasarkan abjad atau
Sort Lists .
numerik.
. Mengurutkan data secara otomatis, biasanya berupa nomor, nama bulan, tanggal,
Auto Fill L
tahun, dan lain-lain
Border Bingkai atau garis tepi yang terdapat pada tiap-tiap sel
i Garis bantu yang digunakan untuk membantu pengguna spreadsheet dalam
Grid Lines : .
membedakan dan membatasi kolom atau baris.
Titik pertemuan antara kolom dan baris. Misalnya, kolom B bertemu di baris ke 5,
Cells
maka nama cells-nya adalah B5.
Tabel Susunan dari baris dan kolom, sering disebut juga dengan sekelompok cells yang

disusun banyak baik secara horisontal maupun vertikal.
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Merge Cells |Penggabungan antara dua cell atau lebih dalam lembar kerja

Spilt Cells  |Memisahkan sebuah sel menjadi dua atau lebih sel.

Jenis format data angka yang digunakan untuk menandai bahwa data tersebut

Currency adalah mata uang. Biasanya ada simbol mata uang pada data tersebut.

Alignment | Fasilitas untuk mengatur perataan sel dalam lembar kerja

Font Size Digunakan untuk mengganti besar kecilnya ukuran huruf

Font Name |Digunakan untuk menentukan jenis huruf yang digunakan dalam penulisan

Style and Digunakan untuk menentukan style dan format dalam penulisan data pada lembar
Formatting |kerja

Digunakan untuk mengubah tampilan karakter dalam suatu sel apakah akan
ditampilkan dalam bentuk Tebal, miring atau garis bawah

Typeface

Margin Menentukan batas kanan kiri atau atas dan bawah dari format halaman
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

1 90\

Jenis tipe data yang dalam penulisannya 6. Fasilitas

secara otomatis terletak pada posisi sebelah
kanan dan datanya dapat digunakan dalam
operasi perhitungan adalah ....

a. Teks

b. Angka

c. Font

d. General

Ikon pada bagian toolbar formatting yang
digunakan untuk mengatur jenis huruf
bernama....

a. Style and Formatting

b. Font Name

c. Font Size

d. Typeface

Jenis format data yang digunakan untuk
menampilkan angka dalam bentuk mata uang

disebut....
a. Percent
b. Currency
¢. Number
d. Scientific

Berikut ini beberapa jenis data yang termasuk
dalam jenis data teks adalah....

a. Nomor Induk Siswa

b. Nomor Telepon

c. Nama Siswa

d. Nomor Absen

Fasilitas dalam OpenOffice Calc yang
digunakan untuk menggabungkan sel
disebut....

a. Split Cells

b. Merge Cells

c. Table
d. Page Preview

Teknologi Informasi dan Komunikasi
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pada OpenOffice Calc yang
digunakan untuk mengunciselagartidak dapat
diubah dan menyembunyikan formula yang
telah dibuat agar tidak terlihat adalah....

a. Alignment

b. Gridline

c. Cell Protection

d. Background

. Perintah yang digunakan untuk menyem-

bunyikan baris atau kolom dalam lembar kerja
dapat digunakan perintah ....

a. Show

b. Auto Fill

c. Hide

d. Width

Ukuran lebar dan tinggi default dari sebuah
sel dalam lembar kerja adalah....

a. 2,77 cmdan 0,43 cm

b. 2,66 cm dan 0,45 cm

c. 2,55 cm dan 0,50 cm

d. 2,44 cmm dan 0,53 cm

Perintah berupa shortcut yang digunakan
untuk menyimpan dokumen lembar kerja dan
memungkinkan untuk mengubah namanya
(save as) adalah....
a. CTRL + Shift+ O
b. CTRL + Shift + P
c. CTRL + Shift + S
d. CTRL + Shift + N

Perintah Sort Lists pada OpenOffice Calc
dapat dilakukan dari menu....

a. File

b. Edit

c. Tools

d. View



B.Lengkapi pernyataan berikut ini.

1. Untuk memperbaiki kesalahan pada saat mengetik di lembar kerja dapat digunakan
perintah . . ..

2. Untuk menghapus karakter pada suatu sel dari sebelah kiri digunakan tombol . . . .
3. Sedangkah untuk menghapus karakter suatu sel dari sebelah kanan pointer digunakan . . . .

4. Dalam sebuah spreadsheet terdapat banyak sel. Ukuran lebar default dari suatu sel adalah
..... dan ukuran tinggi default suatu sel adalah . . . .

5. Format default dari tipe data tanggal adalah . . . .

C.Jawablah pertanyaan berikut ini dengan singkat dan tepat.
1. Sebutkan dan jelaskan beberapa macam jenis data dalam Spreadsheet yang kamu ketahui!
2. Sebutkan dan jelaskan minimal 5 ikon yang terdapat pada toolbar formatting!

3. Pada saat menyimpan dokumen lembar kerja, terdapat 2 cara yaitu dengan Save dan Save
As. Sekaligus kita dapat menambahkan password.

a. Jelaskan perbedaan antara Save dengan Save As!

b. Bagaimana cara memberi password saat menyimpan dokumen?
4. Jelaskan dan berikan contoh penggunaan fasilitas:

a. Fill Series.

b. Sort Lists.

c. Merge Cells.

5. Jelaskan langkah-langkah untuk menampilkan garis bantu atau gridlines pada openoffice.org
calc!
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Bekerja Dengan

Formula

0Z Somdiyouedy

ernahka h kamu ke supermarket, ketika
Pakan membeli kebutuhanmu sehari-hari?

Coba perhatikan, setelah kamu memilih
barang-barang yang akan dibeli kemudian kamu
menyerahkannya ke kasir, kan? Apa yang dilakukan
kasir? Dia akan melakukan perhitungan terhadap
barang-barang yang akan kamu beli. Kalau ternyata
kasir itu melakukan perhitungan dengan kalkulator,
berapa lama yang dibutuhkan untuk menghitung
barang belanjaan yang kita beli? Pastilah lama
sekali.

Seorang bendahara OSIS di sekolahmu
diharuskan untuk membuat Rencana Anggaran
Pendapatan Belanja OSIS (RAPBO), atau membuat
laporan keuangan dari kegiatan yang akan dan telah
kamu lakukan. Pekerjaan ini membutuhkan proses
hitung menghitung dan jika kamu membuatnya
hanya dengan mesin ketik pasti membutuhkan alat
bantu lain untuk menghitungnya yaitu kalkulator.
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Peta Konsep

FORMULA

Statistika

—

m Fungsi Rumus
Statistika

m Penerapan Rumus

Statistika

p
Matematika

Text

m Fungsi Rumus
Matematika

m Penerapan Rumus

Statistika

m Fungsi Rumus Text
m Penerapan Rumus Text
m Kombinasi fungsi

Logika

I

m Logika tunggal
m Logika ganda
m Kombinasi Fungsi

penOffice.org Calc pada Linux sama persis dengan Microsoft Office Excel pada windows.
Program ini memiliki fasilitas untuk melakukan proses perhitungan. Apapun perhitungannya
dapat dikerjakan dengan mudah dan cepat tanpa harus menggunakan kalkulator. Masih
banyak profesi lain yang bekerja menggunakan proses perhitungan, cobalah kamu cari profesi

apakah itu?

N AR
N4 \
/ \/

Perhitungan, Formula, %nd‘féi, operator, eksekusi, format, data, absolut, relatif, alamat, fungsi,

tabel
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A. Membuat Formula

Formula adalah penggunaan rumus pada perhitungan tertentu, atau dapat juga
diartikan perhitungan yang menggunakan nilai dari sel yang lain pada spreadsheet.
Sebelum menghitung, kamu harus mengetahui rumus apa yang cocok pada suatu
masalah atau kondisi. Setelah mengetahui rumus yang digunakan yang harus kamu
ketahui adalah bagaimana cara memperoleh data tersebut kemudian diolah dan dihitung
sesuai rumusnya untuk mendapatkan hasil yang diinginkan.

1. Cara Menggunakan Formula

Misalnya pada suatu tabel terdapat data penjualan barang, (hama barang, harga
satuan dan banyak barang) sedangkan kolom yang harus kamu isi adalah jumlah
harga. Rumus apa yang dapat menghasilkan jumlah harga? Ya benar (harga satuan
dikali banyak barang). Setelah kamu mengetahui rumus yang digunakan kamu harus
tahu di mana letak data harga satuan dan letak data harga banyak barang? Untuk
menjawab pertanyaan ini yuk kita perhatikan tabel berikut ini.

o)
File Edit VMiew Insert Format Tools Data Window Help

8- 208 BNRATE LADO A0 BLi.Eé0®

- F& [Nimbus Sans L M -1a 4A EEEEE b =N [H -
fo B = |
A ] B I C [ D | £ | 3 G |~
!
2 DATA PENJUALAN BARANG TOKO SEJAHTERA
3
) No. Nema Bararg | Hara Saiuan | Jumlah Barang |_Jumiah Harga
& 1 Buku Tulis 2500 12 =
6 2 Pulpen 1500 10
7 3 Pensil 1000 10
8 4 Penghapus 500 20
9 5 Spidol 1500 15

10

11
)i «|i» )]\ Sheetl (Sheetz {Sheeta 7 |[<] ] I
[Sheet1/3 [Default [1a0% s = [ | Sum=0

Data harga satuan terletak pada kolom D mulai baris 5 sampai dengan baris
9 atau disebut sel D5 : D9, data jumlah barang terletak pada kolom E mulai baris 5
sampai dengan baris 9 atau disebut sel E5 : E9. Bagaimana menerapkan ke dalam
rumus tersebut untuk mengisi jumlah harga? Yang pertama kali harus kamu lakukan
adalah mengisi jumlah harga buku tulis dengan rumus D5*ES5.

‘J |=D5*E5 —

E | F

SEJAHTERA

1lah Barang
1Q-D5*E5

Gambar 7.1
Tabel formula
penjualan

Sumber: Dok. Penulis

Gambar 7.2
Menulis rumus

. Sumber: Dok. Penulis
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Untuk menulis rumus
kamu dapat dengan

klik ikon fi =

196

Penggunaan rumus formula pada OpenOffice.org Calc diawali dengan tanda =,
meletakkan hasil penjumlahan pada kolom Jumlah Harga, mulai dari sel F5 sampai
sel F9. Maka urutan pengerjaannya adalah sebagai berikut:

1). Letakkan kursor pada sel F5 atau klik sel F5.

2).Ketik =

3). Ketik rumus untuk menghitung jumlah harga buku tulis yaitu D5*ES5.
Atau dapat juga dengan cara:

1).Klik sel D5.

2).Ketik *

3).Klik Sel E5.

4). Tekan tombol Enter.

Begitu pula untuk mencari jumlah harga pulpen sampai dengan spidol, caranya
sama hanya saja sel yang digunakan berbeda, untuk pulpen rumus yang digunakan
adalah =D6*E®6, pensil rumusnya =D7*E7, penghapus rumusnya =D8*E8 dan spidol
rumusnya D9*E9.

. Operator yang digunakan untuk membuat Formula

Penggunaan operator pada penerapan formula atau rumus sama seperti
pada operator matematika, mengapa? Karena formula memang disediakan
untuk melakukan aktivitas perhitungan secara matematis. Namun demikian ada
sedikit tanda atau lambang operator yang berbeda misalnya perkalian biasanya
dilambangkan dengan tanda X kalau di komputer ditandai dengan lambang *.

Memasukkan data berbentuk rumus matematika ke dalam suatu sel, dilakukan
dengan menggunakan operator hitung sebagai berikut:

+ (plus) : penjumlahan.
- (minus)  : pengurangan.
* (asterik) : perkalian.

/ (slash) : pembagian.

A (carret)  : pangkat.

Untuk rumus atau formula dalam tanda kurung () akan dieksekusi atau dihitung
terlebih dahulu oleh komputer.

. Menyalin Formula ke sel lain

Salah satu tujuan bekerja dengan OpenOffice.org Calc adalah untuk
mempercepat pekerjaan. Mungkin kamu juga telah merasakan ketika sedang
mengerjakan tugas komputer, ketika mendapatkan data yang begitu banyak dengan
rumus formula yang kompleks untuk dihitung satu per satu, pastilah membutuhkan
waktu lama untuk menyelesaikannya.

_ Teknologi Informasi dan Komunikasi
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Sebelum kamu mencoba untuk menyalin rumus formula ada beberapa hal yang
harus kamu perhatikan pada setiap datanya yaitu:

a. Data tidak boleh berformat teks

Data yang berisi teks tidak dapat dilakukan perhitungan misalnya terdapat
data nilai siswa yang berisi nomor, nama siswa, Nilai Matematika, Nilai IPS dan
Nilai IPA. Ketika menulis Nilai Matematika diketik 70 (tujuh puluh), kemudian ketika
mengetik nilai IPS ditulis 70 (tujuh huruf O besar) sekilas sama seperti angka tujuh
puluh tetapi nilai IPS adalah berformat teks karena terdapat huruf O, dan Nilai
IPA ditulis “70 (tanda petik dua tujuh puluh) ini juga menjadi format teks karena
terdapat tanda petik.

Perhatikan pada tabel di atas sepertinya pengisian angka tersebut 70
(tujuh puluh) tetapi yang benar pengisiannya hanya satu yaitu pada sel C5 nilai
matematika, sehingga ketika dijumlah =C5+D5+E5 seharusnya bernilai 210 tetapi
menjadi Err:529.

B g D E F

3 NILA
s MATEMATIKA | IPS IPA JUMLAH

5 70 f 0 Yy 7 Err529

Untuk memperbaikinya yang kamu lakukan adalah klik sel yang salah
kemudian ketik angkanya, yaitu klik pada sel D5 kemudian ketik angka 70 (tujuh
puluh), selanjutnya klik pula sel E5 ketik angka 70 (tujuh puluh).

. Sel berisi rumus atau formula bukan berisi angka

Yang dimaksud dengan sel berisi rumus adalah sel yang di dalamnya
mengandung rumus perhitungan yang menghasilkan dan menampilkan angka
di atas sel tersebut, sedangkan sel yang berisi angka adalah sel yang tidak
mengandung rumus tetapi menampilkan angka di atas sel tersebut. Perhatikanlah
tabel berikut ini.

Gambar 7.3
Memasukkan data
Numeric yang salah
Sumber: Dok. Penulis

1. Sel berisi rumus
disebut sebagai
sel relative atau
data formula.

2. Sel berisi angka
disebut sebagai
sel data bersifat
numeric.
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F10 ~| fw ¥ = [=Cl0+D10+EL0

A B [ 7 B | |
1 NILAI BIDANG STUDI TEKNOLOGI INFORMASI DAN KOMUNIKASI
2
3 PENILAIAN
a NAMA QISWA | Jumlz
uas | Aumien
F10 " E = 22 —
Al B T -
|| NILAI BIDANG STUDI TEKNOLOGI INFORMASI DAN KOMUNIKASI 95 270
2 8.5 240
| 3] PENILAIAN 97 20820
— K. NAMASISWA T rysus | urs [ uns | 2ot 95 25,50
I Py 9.5 24.50)
Gambar 7.4 7 1 |Abdioutera Rahanursvah 98 ¥ 9.5 7.20
Membedakan hasil data 8 | 2 |Abiyoso Harmadhani 8.7 7 85 7.20)
formula dan angka 9 | 3 |Aditya Nuzul Ramadhan 6 7 97 :
Sumber: Dok. Penulis i ¢ "q"“ Atlymmﬁmsa Balgs 4 L 2 -
1 5 |Afifa Tri Ananda 6 9 95

Lihatlah hasil dari kedua tabel jelas berbeda, pada sel berisi rumus hasilnya
tidak sama dengan sel yang berisi angka.

c. Menyalin Formula Beralamat Relatif

Saat kamu menyalin rumus formula, keadaan alamat sel yang digunakan
oleh rumus tersebut berbeda, maka secara otomatis alamat sel tersebut juga

berubah otomatis.

Yang harus kamu lakukan untuk menyalin sel relatif adalah sebagai

berikut:
ten =
C D E L
“{ Tueas uTs UAS Jumian
6
7 9.8 7.9 9.5 27.20
8 8.7 7 8.5
5 5 7 9.7
10 7 9 9.5
11 6 9 9.5
12 6 8.5 9
Gambar 7.5 [ 6 8 7
menyalin formula || 6 2 e
. 15 6 9 8
Sumber: Dok. Penulis |, 5 8 7.5
)7\ Sheetl (Sheet? 7ohestd 7 | [] |

kanan bawah sel F16.

1),
2).

3).
4).

5).

Klik pada sel F7.

Masukkan satu sel relatif sehingga
menghasilkan nilai yang benar, yaitu pada
data pertama, pada tabel contoh terletak di
sel F7, dan berisi formula =C7+D7+E7.
Tekan Enter.

Letakkan mouse kembali pada sel tersebut
yaitu F7.

Arahkan posisi mouse di ujung sebelah

6). Geser drag / geser mouse ke bawah hingga sel F16.

7).Klik di tempat kosong untuk menghilangkan blok, maka hasilnya terlihat

1. Tekan Ctrl=C pada
sel berisi rumus.

2. Blok sel yang masih
kosong dan akan

diisi rumus.

3. Tekan Ctrl+V.

Teknologi Informasi dan Komunikasi
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d. Menyalin Formula Beralamat Absolut

Ketika kamu menyalin sel formula ada sel yang ternyata di dalamnya terdapat
alamat yang tidak boleh berubah, artinya bukan hanya nilai selnya yang sama
tetapi juga alamat selnya harus sama atau tetap.

Sel Absolut adalah sel yang alamat kolom dan barisnya tetap, dengan diberi
tanda $, misalnya sel H20, maka sel absolutnya $H$20, artinya jika sel ini disalin
ke kolom atau baris, maka alamat tersebut tetap tidak berubah yaitu $H$20, tetapi
jika sel yang disalin adalah H20, maka jika disalin ke kolom akan berubah menjadi
120, J20, K20, .... atau ke baris maka menjadi H21, H22, H23,....

Yang harus kamu lakukan untuk menyalin sel absolut adalah sebagai
berikut:
1).Klik pada sel C3.

2).Masukkan satu rumus bersifat absolut sehingga menghasilkan nilai yang benar,
yaitu pada data pertama, pada tabel contoh terletak di sel C3, dan berisi formula
=C2*$B$3.

3). Tekan Enter.

4).Letakkan mouse kembali pada sel tersebut yaitu C3.

5). Arahkan posisi mouse di ujung sebelah kanan bawah sel G3.
6). Tekan Ctrl + C.

7).Blok sel dari C3 sampai G3.

8). Tekan Ctrl + V.

Fov o) fe X [z
A B I c [ D E F G [ =
%
2 KELIPATAN 1 2 3 4 5
3 10 =C2*$B$3 ]

700 Y Sheet1 fSReetz 7Sheeta 7 | [<]

1. Sel absolut dapat
diartikan sebagai
sel yang dikunci
perubahan kolom
dan barisnya agar
tidak dapat disalin.

2. Tanda kolom
dikunci dengan
ditandai $
misalnya $A.

3. Tanda baris
dikunci dengan
ditandai $
misalnya $1.

4. Jika $A$1:B2
menunjukkan sel A
saja yang dikunci
disebut semi
absolut.

Gambar 7.6
Tabel formula absolut

Sumber: Dok. Penulis

1. Untuk perintah
Ctrl + C dapat
menggunakan ikon
Copy.

2. Untuk perintah
Ctrl + V dapat
menggunakan ikon
Paste.
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raktikum

A. Praktikum formula penjualan

Pada sebuah toko komputer seorang karyawan melaporkan hasil penjualannya dalam
satu hari, ia melaporkan sebagai berikut:

B | (o

D | E

1 [TOKO MULTIMEDIA KOMPUTINDO

LAPORAN HARIAN PENJUALAN
PER TANGGAL : 17 MARET 2008

NO.

JENIS BARANG

JUMLAH

HARGA

STOK

TERJUAL

SATUAN DISKON

TERJUAL

SISA
BARANG

s

100
100

nnnnn
uuuuu

Keyboard

100

mouse pad

100

hub ushb

60

kabel usb

20|

kabel power

40

olw|slw|slo|o

CDR

200

o

Kesing cd

300

N
o

W e | N[d o) -+

CD RW

150

1ES
o

16

i
[=

Card reader

20|

-
3]

WAL {Sheet? { oheetd

LT

Gambar

7.7

Tabel formula penjualan
Sumber: Dok. Penulis

Buatlah rumus formula untuk menerapkan rumus berikut ini:

Harga diskon = harga satuan x 15%.

Harga Terjual = jumlah terjual x harga satuan.
Sisa Barang = jumlah stok — jumlah terjual.

B. Praktikum formula harga fotokopi

[T

Seorang pegawai fotokopi berfikir bagaimana cara melayani pelanggannya dengan cepat,
salah satunya adalah dengan membuat daftar harga fotokopi. Yang dilakukan pegawai tersebut
adalah membuat tabel seperti berikut ini.

A

c | b | E

[ F [ ¢ [ H

DAFTAR HARGA FOTOKOPI

JUMLAH LEBAR

[

Untuk SMP / MTs Kelas VIII
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Tabel Daftar fotocopi

Sumber: Dok. Penulis

2
3
4 1 2 3 4 5 6 7 8 10|
5 [XEROX = 200
6 |CANON =150
7 |MINOLTA =100
s |SHARP =60
9
10
4] ()( FOTOKOP | { SReetz J Sheetd ][] ] D |
Gambar 7.8




Untuk menghitung harga dari tiap lembarnya yang kamu lakukan adalah dengan memasukkan
formula pada Jumlah Lebar 1. pada setiap merek fotokopi. Rumus tersebut adalah:

1. Pada harga XEROX

Pada harga CANON

Pada harga SHARP

o > oD

letakkan di sel B5 dan isikan =200*B4.
letakkan di sel B5 dan isikan =150*B4.

Pada harga MINOLTA letakkan di sel B5 dan isikan =100*B4.

letakkan di sel B5 dan isikan =60*B4.

Untuk lembar 2 sampai lembar 10 silakan disalin ke samping kanan.

. Praktikum formula untuk menghitung perkalian

Untuk melatihmu pada proses menyalin sel formula, kali ini kita akan membuat Tabel
perkalian yang mungkin saja dapat membantu adikmu saat menghafal perkalian. Yang harus
kamu lakukan adalah membuat tabel seperti berikut ini:

B_ | D |

E

[ F [ e [ w [T v T 53 T w [ v

-

MENGHITUNG PERKALIAN

N

w

4 5 6 7

B

(4]

-]

~

-]

10

D0~ U 4| K| =
Lol R [ S T N A DV E

11

12

=k
o
-
=

13

Buatlah rumus pada:

—

Tabel menghitung perkalian
Sumber: Dok. Penulis

. Sel C4 sampai dengan C13 rumus tersebut tidak dapat disalin ke bawah karena terdapat

angka yang dimasukkan berbeda-beda.

Sel C4 ketik rumus
Sel C5 ketik rumus
Sel C6 ketik rumus
Sel C7 ketik rumus
Sel C8 ketik rumus
Sel C9 ketik rumus
Sel C10 ketik rumus
Sel C11 ketik rumus
10. Sel C12 ketik rumus
11. Sel C13 ketik rumus

© ©®© N o g bk~ w D

=1*C3 salinlah sel C4 hingga ke L4.

=2*C3 salinlah sel C5 hingga ke L5.

=3*C3 salinlah sel C6 hingga ke L6.

=4*C3 salinlah sel C7 hingga ke L7.

=5*C3 salinlah sel C8 hingga ke L8.

=6*C3 salinlah sel C9 hingga ke L9.

=7*C3 salinlah sel C10 hingga ke L10.

=8*C3 salinlah sel C11 hingga ke L11.

=9*C3 salinlah sel C12 hingga ke L12.

=10*C3 salinlah sel C13 hingga ke L13 sehingga menghasilkan

angka 1,2,3,....10 seperti pada gambar.

Teknologi Informasi dan Komunikasi
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Gambar 7.10

Tabel penjualan toko

sejahtera
Sumber: Dok. Penulis

Menggunakan fungsi Statistika

Pada awal perkembangannya statistika digunakan untuk melakukan pendataan
dan analisa kependudukan. Saat ini statistika berkembang, merambah ke banyak
bidang. Definisi statistika selain menangani kependudukan juga ilmu tentang bagaimana
merencanakan, mengumpulkan, mengolah, menganalisa, dan mempresentasikan
data.

Statistika mempunyai peran untuk mengubah informasi yang berupa data-data
menjadi sebuah pengetahuan. Salah satu definisi menyebutkan bahwa statistika
adalah metode ilmiah untuk menyusun, meringkas, menyajikan dan menganalisa data,
sehingga dapat ditarik suatu kesimpulan yang benar dan dapat dibuat keputusan yang
masuk akal berdasarkan data tersebut.

Dari pengertian statistika yang sesungguhnya di atas, kita akan mengambil salah
satu definisinya, statistika adalah ilmu mengumpulkan dan mengelola data saja yang
akan kita gunakan sebagai bahan pembelajaran dalam menggunakan OpenOffice.org
Calc.

Pernah mendengar istilah statistika, tetapi yang dimaksud Fungsi Statistika adalah
cara perhitungan untuk mengetahui Jumlah, rata-rata, banyak data, nilai tertinggi, dan
nilai terendah dari suatu data yang sedang diamati. Untuk menerapkannya kita akan
menggunakan fungsi yang disebut fungsi Statistika pada OpenOffice.org Calc.

Perhatikan tabel berikut ini:

A B [ c \ D \ E [ F
1
z ~ DATA PENJUALAN BARANG TOKO SEJAHTERA
3
4 No. Nama Barang Herga Satuan | Jumlah Barang | Jumlah Harga
5 1 Buku Tulis 2500 12
6 2 Pulpen 1500 10,
7 3 Pensil 1000 10,
8 4 \Penghapus 500 20
9 5 Spidol 1500 15,
10
|ﬁ1|ﬁj@ Sheetl {Sheetz {Sheet3 [ || <]
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Menerapkan formula fungsi statistika.

1. Fungsi SUM(range)

Digunakan untuk menjumlah seluruh data dalam satu baris atau satu kolom.

Contoh:
Cara mengerjakannya:

1. Klik pada sel F10.

2. Ketik = - | = ‘ =
i
3. Ketik sum( | = LAN BARANG TOKO SEJAHTERA
3
4. Kilik kiri pada sel F5 jangan ¢ | HargaSatvan | JumlahBarang | Jumlah Harga
3 & 2500 12 30000
dilepas. 5 1500 10) 15000
. 7 1000 10 10000
5. Geser mouse ke bawah hingga sel || s 500 20 10000
9 1500 15 22500
Fg) 10 =sum(F5:F9)

6. =Sum(F5:F9).
7. Enter.

8. Fungsi AVERAGE(range)

Digunakan untuk menghitung rata-rata pada suatu data dalam satu kolom atau

satu baris.
Cara mengerjakannya:
1. Klik pada sel F11.
Ketik =
Ketik average(

Klik kiri pada sel F5 jangan dilepas.

o b~ 0N

Geser mouse ke bawah
sel F9).

6. Sum(F5:F9)
7. =Average(F5:F9).

hingga

8. Enter.
9. Fungsi Max(range)

Digunakan untuk mencari nilai tertinggi pada suatu data dalam satu baris atau

kolom.

Cara mengerjakannya:

D

[ E

[ F

LAN BARANG TOKO SEJAHTERA

1

IEN

IER
4 Harga Satuan Jumlah Barang | Jumlah Harga
5 2500 12 30000
8 1500 10 15000
7 1000 10 10000
8 500 20 10000
] 1500 15 22500

_ 87500
=average(F5:F9)

Gambar 7.11
Penerapan rumus
SUM

Sumber: Dok. Penulis

Gambar 7.12
Penerapan rumus
AVERAGE

Sumber: Dok. Penulis
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Gambar 7.13
Penerapan rumus
MAX

Sumber: Dok. Penulis

Gambar 7.14
Penerapan rumus MIN

Sumber: Dok. Penulis

Gambar 7.15
Penerapan rumus
COUNT

Sumber: Dok. Penulis

4. Fungsi Min(range)

D [ E I F

> |LAN BARANG TOKO SEJAHTERA

i

4 | HargaSatuan | JumlahBarang | Jumlah Harga

5 2500 12 30000

6 1500 10 15000

7 1000 10 10000

8 500 20 10000

a 1500 15 22500

10 87500
[ 5 | 17500

12 :max(FE:FQ)]'

13

[ 1.Klik pada sel F12.

2.Ketik =
3. Ketik max(
4. Klik kiri pada sel F5 jangan dilepas.

5.Geser mouse ke bawah hingga sel F9).
6.=Max(F5:F9).
7.Enter.

Digunakan untuk mencari nilai terendah pada suatu data dalam satu baris

atau kolom.

Cara mengerjakannya:

D I E | F [
; 1
2 |LAN BARANG TOKO SEJAHTERA 2
3
4 | HargaSatuan | JumlahBarang | Jumlah Harga 3
5 2500 12 30000
] 1500 10 15000 4
7 1000 10 10000 .
5 500 20 10000 5
] 1500 15 22500
10 87500
11 1?500_ 6
12 30000
13 =min(F5:F9) 7
5
Digunakan untuk menghitung
sample.
Contoh:
Cara mengerjakannya:
D E i 1
4 | Harga Satuan | JumlahBarang | Jumlah Harga
5 2500 12 30000 2
6 1500 10 15000
7 1000 10 10000 3
8 500 20| 10000
B 1500 15 22500] 4
10 87500
11 17500 5
12 30000
13 | 10000 6
14 =court(F5:F9)
7

204N
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. Klik pada sel F13
. Ketik =
. ketik min(

Klik kiri pada sel F5 jangan dilepas.

. Geser mouse ke bawah hingga sel F9).
. =Min(F5:F9).

. Enter.

. Count(range)

banyaknya data yang digunakan sebagai

. Klik pada sel F14

. Ketik =

. Ketik count(

. Klik kiri pada sel F5 jangan dilepas

. Geser mouse ke bawah hingga sel F9)

. =Count(F5:F9).

. Enter.



C. Menggunakan Fungsi Matematika

Banyak sekali fungsi matematika yang dapat kamu gunakan pada OpenOffice.
org Calc, untuk mengetahui apa saja yang termasuk fungsi matematik aktifkan function

dengan mengklik toolbar function pilih mathemati

1. EXP

Fungsi ini adalah untuk mencari nilai eksponen,

kebalikan dari fungsi EXP adalah LN.

Format Umum:

=EXP(number)
fo £ = oG
A ] B [
+ nilai  eksponen
2 1 2l
2. ROUND

cal.

Lategory

Mathemnatical

Function

ABS
ACOS
ACOSH
ACOT
ACOTH
ASIN
ASINH
ATAN
ATANZ
ATANH
CEILING
COMEBIN
COMBIMA
CONVERT

1w [o]

Gambar 7.16

Function

Mathematical
Sumber: Dok. Penulis

Fungsi ini akan membulatkan sebuah nilai atau bilangan ke dalam beberapa

desimal.
Format Umum:
=Round(number; count)

Keterangan:

Number : Bilangan yang akan di bulatkan. Maksimal count yang di berikan
adalah 2, jika lebih dari 2, maka pembulatan desimal tetap 2 di belakang koma.

Buatlah tabel seperti ini:

A [

+ |Pembulatan

hasil

Round(n;1)

Round(n;2) | Gambar 7.17

Tabel penggunaan

: 1 Rumus
: |=28/3
+ |=29/3

round
Sumber: Dok. Penulis

Teknologi Informasi dan Komunikasi
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Isi kolom hasil dengan formula sebagai berikut:

A \ B | c [ D [
Gambar 7.18 1 |Pembulatan
Tabelhasil "
Penggunaan round 2 Bywmyg h@ﬁﬂ Round(n;1) Round(n;2)
Sumber: Dok. Penulis ; =28/3 933 93 933
+ |=29/3 9.67 9.7 9.67
Pada Sel B3 ketik =28/3
Pada Sel B4 ketik =29/3
Isi kolom round(n:1) dengan rumus formula
Pada sel C3 ketik =round(B3;1)
Pada sel C4 ketik =round(B4;1)
Isi kolom round(n:2) dengan rumus formula
Pada sel D3 ketik =round(B3;2)
Pada sel D4 ketik =round(B4;2)
3. SQRT
A & C Fungsinya untuk mencari akar bilangan.
1 nilai | akar
- 1 Format Umum:
£ 4 Buatlah tabel seperti ini:
4 9
5 16
6 25
7 36
8 49
Gambar 7.19 g 64
Tabel penerapan
SQrRT | 1° 81
Sumber: Dok. Penulis 11 100
[ 2 Isi kolom akar dengan rumus formula:
1 nilai | akar
2 1 1 =SQRT(C2)
> ; § Salinlah rumus tersebut di baris berikutnya.
4
5 16 4
6 25 5
7 36 6
8 49 7
9 64 8
10 81 9
il 100 10
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4. MOD

Fungsinya untuk mengetahui sisa nilai atau bilangan dalam bentuk desimal.

Format Umum:

=mod(number ; count)

Buka lagi tabel round di atas lalu tambahkan kolom mod di sampingnya.
Isilah kolom mod dengan rumus formula seperti ini:

=m0d(B3,1) A [ 8 ] c D E
1 |Pembulatan

2 [Rumus|hasil|Round(n;1) |Round(n;2)| mod ?abmlbar 7.20
3 E28/3 19.33 9.3 933 MaOeD penerapan

+ |=29/3 |9.67 9.7 9.67 Sumber: Dok. Penulis

5. PRODUCT

Fungsi ini akan mengalikan bilangan secara cepat.
Format Umum:

=PRODUCT(Number1;number2,...)

Al

B | ¢ [ o [ e | °F
+| Perkalian Cepat

i X 1 2 3 4 5 6 Gambar 7.21
- 22 Tabel pengujian
Buatlah tabel seperti | | product
di Samping ini. 7 4 Sumber: Dok. Penulis

B [ ¢ [ o [ E ] F
+ | Perkalian Cepat
A[xT1T2[3]2]5 6
Tabel ini mengalikan angka 1 |~ 212 4 6| 8 |10 12| Gambar 722

Tabel hasil pengujian

hingga 6 dengan 2 dan 4. T 414 | 8 12116 |20 24 product

Sumber: Dok. Penulis

Al

Masukkan rumus pada sel C3 dengan:
=PRODUCT($B$3;C3)lalu salin ke kanan.
=PRODUCT($B$4;C3)lalu salin ke kanan.

Y 1.inologi Informasi dan Komunikasi &]
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raktikum

Praktikum menggunakan fungsi matematik

Buatlah tabel seperti berikut ini:

Al B [ C \ D E F G
1
| 2 | FUNGSI MATEMATIKA
| 3 |
N FUNGS| MATEMATIKA
=0 NILA EXP ROUND MOD PRODUCT SQRT
| 5 |
7 | 1.61
2.3 |
o | 2.25
10 | 3.24
11 | 4,56
12 |
Gambar 7.23

Tabel Pengujian fungsi matematika
Sumber: Dok. Penulis

Isilah tabel tersebut dengan menggunakan fungsi mathematical seperti berikut ini:

1. =EXP(B7).

2. =ROUND(B7;1).

3. =MOD(B7;1).

4. =PRODUCT(B7;C7;D7;E7).
5. =SQRT(B7).

D. Menggunakan Fungsi Teks

Salah satu fungsi yang terdapat pada OpenOffice.org Calc adalah Fungsi Teks,
banyak fungsi yang terdapat pada fungsi teks, tentu tidak cukup waktu untuk mempelajari
semua, tetapi kita akan membahas fungsi teks terhadap kebiasaan seorang operator
dan fungsi yang sering dipergunakan.

Untuk mengetahui apa saja yang termasuk dalam kategori fungsi teks, caranya
adalah sebagai berikut:

Cara cepat pilih fungsi

fix). 1- Klik Insert.
2. Pilih Function.
3. Pilih Category: Text.
4. Terdapat banyak pilihan fungsi teks di dalamnya.

__ 208N
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Untuk memahami penggunaan fungsi teks, kita akan menggunakan beberapa

fungsi yang nantinya dapat digunakan bersamaan dengan fungsi yang lainnya.
@

Functions | Structure |

category
Text

Function

ARABIC
ASC
BAHTTEXT
BASE
CHAR
CLEAN
CODE
CONCATENATE
DECIMAL
DOLLAR
EXACT
FIND
FIXED

JIs
LEFT

[ Array

<

=

Gambar 7.24
Function text

Sumber: Dok. Penulis

Fnction Wizard’ i3]

Function result |123.46

PRODUCT

Multiplies the arguments

Number 1{required)

Number 1, number 2, ... are 1 to 30 arguments to be multiplied and a

resuit returned.
[~ |[ps =l H

1| s
| — ]
R O —
N o — -]
Formula Result [123.45
|=PRODUCT(DE)

[meime | [ ]

1. UPPER

Penggunaan rumus upper diperlukan pada kondisi tertentu, misalnya pada
seorang administrator mendapatkan sebuah data, tetapi huruf pada data tidak sama,
ada yang kecil, ada yang besar, sedangkan pencetakan dilakukan harus berhuruf
besar. Ada beberapa cara penggunaanya tergantung kebutuhan dan kebiasaan

masing-masing pengguna.

Cara 1:

Rumus diketik langsung membaca terhadap teks pada sel tersebut.

Tabel 7.1 Function upper

FUNGSI

Mengubah teks
menjadi huruf
besar semua

Cara 1

FORMAT
RUMUS

=UPPER(teks) |=UPPER(“linux”) |LINUX

| CONTOH | HASIL

Tabel 7.1
Function upper

Sumber: Dok. Penulis

Buatlah tabel seperti berikut ini:

A

I D E

[ £
DAFTAR HADIR SISWA /SISWI

SMP 01 KAYUJATI
JAKARTA

v
=
[o]

NAMA

KELAS TANDA TANGAN

4c 1

3d 2

5b 3

1a 4

2b 5

6¢c 5

& 7 Gambar 7.25

4c 8

Tabel penggunaan

wh upper

—
o
— w 3] ~ [+ 3] ~ w n -

0

6¢c 10

Sumber: Dok. Penulis

[W][4](» WM 1 ¢ Shieets 7
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Isilah kolom nama dengan:
=UPPER(“adi saputera”)
=UPPER(“amelia herlati siahaan”)

=UPPER(“andika rachman”)
=UPPER(“anggia fahriza”)
=UPPER(“anggita roy ryansyah”)
=UPPER(“annisa wuri ayuningtyas”)
=UPPER(“aulia ashri burfurqoni”)
=UPPER(“azrin kuriniawan”)
=UPPER(“deka agit meiwan bulsara”)
UPPER(“deni maulana”)

Cara 2:

Mengganti langsung teks menggunakan menu Change case.

Tabel 7.2 Change Case

FORMAT
FUNGSI RUMUS CONTOH HASIL
Mengubah teks |Cara 2 Klik pada sel berisi teks [LINUX
menjadi huruf sel aktif pada teks Linux
besar semua 1. Klik Format 1. Klik Format

2. Pilih Change Case |2. Pilih Change Case
3. Pilih UPPERCASE | 3. Pilih UPPERCASE

Tabel 7.1
Change Case
Sumber: Dok. Penulis

Buatlah tabel seperti berikut ini.

A B [ I | E [ F =
1 DATA SISWA BARU
2 SMP PALAPA SAKTI
d o =
“No NAMA 1] Rl - B o Alamat Rumah KELAS
2 i lahir
s | 1 Isinda P IMadura | 20/08/1999I Jati Pasar / 54 1
7 | 2 |adam rafliansyah L |Jakarta | 22/03/2001|Rawamangun Tegalan no. 18 rt 007/03 1
Gambar 7.25 @ | 3 |ganteng perkasa L akarta | 10/11/2001{JI. Metro Jaya | No. 44 Pulomas 1
Tabel data siswa | < [ 4 |dini syafitrah P |akarta | 06/04/2002}1. Sirap No. 1 Rt 003/001 Kayu Putih 1
Sumber: Dok. Penulis | 10 | 5 |elien elsa sabrina P lakarta | 03/01/20014JI. Kusen | No. 7 Rt 006/02 Kp Ambon 1
11
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Ubahlah kolom nama menjadi huruf besar semua, dengan cara:

1).Blok kolom nama dari sel B6 sampai B10.

2).Klik Format.

3).Pilih Change case.

4).Pilih UPPERCASE.

Cara 3:

--ngmat-.l Tools Data Window Help

Default Formatting Ctrl+Shift+Space

B0Q- i

cells...

Row
Column
Sheet
Merge Cells

ctri+1

=Bl El

Page...
Print Ranges

| I
TA SISW

-

> PALAF

L ;ﬁlamj;}elﬁase

N

» | Uppercase

[] Styles and Formatfﬁg

Menggunakan menu function.

Tabel 7.3 Change Case
FORMAT RUMUS/

FUNGSI

Mengubah teks
menjadi huruf
besar semua

CARA
Cara 3
Klik pada sel tujuan
1. Klik insert
2. Pilih Function
3. Pilih category: Text
4. Pilih Function: UPPER
5. Next
6. Isi kotak shrink: alamat
teks
7. Klik Ok

CONTOH

Klik pada sel
berisi teks

linux misalnya di
sel C5

Lalu ikuti cara 4

Fdad

Lowercase

HASIL
LINUX

Gambar 7.26
Penggunaan
changecase

Sumber: Dok. Penulis

Tabel 7.3
Function UPPER

Sumber: Dok. Penulis

Untuk SMP / MTs Kelas VIII
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Tabel 7.4
Penggunaan UPPER

Sumber: Dok. Penulis

Gambar 7.27
Function Wizard
Text Upper
Sumber: Dok. Penulis

Buat table seperti berikut ini:

Al 5 B D e

1 DAFTAR HADIR SISWA /SISWI

2 SMP 01 KAYUJATI

3 JAKARTA

a4

s Inol NARIA NAMAS WELAS LNDA TANGH

5 | NAMA NAMA2 KELAS KNDA TANG#H

1 |adi saputra 4c 1

T 2 |ame|ia herlati siahaan 3d 2

Bila |andika rachman 5b 3

8 4 !anggia fahriza 1a 4

Uit |anggita roy ryansyah 2b 5

L] |anni5a wuri ayuningtyas 6c 6

=y |au|ia ashri burfurqoni 3d 7

13 |g  |azrin kuriniawan 4c 8

14 19 |deka agit meiwan bulsara 5b k]

15 |10 [deni maulana 6c 10
MR 2/

Klik pada sel tujuan atau letakkan pada sel C6:

1).Klik Insert.

2).Pilih Function.

3).Pilih Category: Text.

4).Pilih Function:

5). Next.

UPPER.

6). Isi kotak text / alamat teks yaitu B6:B15

7).Klik Ok.

Atau klik tombol fungsi seperti berikut ini

Functions | Structure

Category
[Text

Function

LOWER [+]
MID
PROPER
REPLACE
REPT

RIGHT
ROMAN
ROT13
SEARCH
SUBSTITUTE
T

TEXT

TRIM
UPPER

VALUE

R ——

Function Wizard

UPPER

Function result [Erm511

Converts text to uppercase,

text(required)

The text in which lower case letters are to be converted to capitals.

O | —) -]

Formula Result [Erm511

[=UPPER(])

| g

Ll Array |

<< Back ‘ ‘ Next ==

Teknologi Informasi dan Komunikasi
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2. LOWER

Penggunaan rumus lower
mempunyai beberapa cara yang sama seperti upper.

pada OpenOffice.org

Cara 1:

Calc

Rumus diketik langsung membaca terhadap teks pada sel

tersebut.

Tabel 1.5 Rumus lower

FORMAT
FUNGSI CONTOH HASIL
RUMUS
Mengubah teks Cara 1 =lower(“MANDRIVA”) |LINUX Tabel 7.5
menjadi huruf =lower(teks) Rumus lower
kecil semua Sumber: Dok. Penulis
Contoh dalam tabel.
Buatlah tabel seperti berikut ini:
A B | & [ D E
1 DAFTAR HADIR SISWA /SISWI
2 SMP 01 KAYUJATI
B JAKARTA

s |NO NAMA KELAS TANDA TANGAN

L 4c | I

7o 3d 2

o s 5 | Gambar 7.28

Penerapan lower pada
o la 1a 4
i - tabel
B 2b 5 Sumber: Dok. Penulis

Isilah kolom nama dengan:
=lower(*ADI SAPUTERA”")
=lower("AMELIA HERLATI")
=lower(*ANDIKA RACHMAN”)
=lower("ANGGIA FAHRIZA")
=lower("ANGGITA RYANSYAH”")

Teknologi Informasi dan Komunikasi
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Tabel 7.5
Rumus change case

Sumber: Dok. Penulis

Gambar 7.29
Tabel penggunaan
Change case

Sumber: Dok. Penulis

Gambar 7.30
Menu Change case

Sumber: Dok. Penulis

Cara 2:

Mengganti langsung teks menggunakan menu Change case.

Tabel 7.6 Rumus change case

FUNGSI

Mengubah teks
menjadi huruf kecil
semua

FORMAT

RUMUS
Cara 2
Sel aktif pada teks
1. Klik Format
2. Pilih Change Case
3. Pilih lowercase

CONTOH

Klik pada sel berisi teks
MANDRIVA

1. Klik Format

2. Pilih Change Case
3. Pilih lowercase

HASIL

mandriva

Contoh dalam tabel.

Buatlah tabel seperti berikut ini.

A B == D E E [ 6]

1 DATA SISWA BARU
o CQAMD DAI ADACAVKT
= MIVIE FRALAT A JAIZV
3
il . — . .~ | Tempat | Tanggal e - : -

No. NAMA (Wi SN == Aiamat Ruman kis
5 lahir lahir
5 | 1 |sinda P |MADURA | 20/08/1999\J1. Jati Pasar / 54 1
7 | 2 |adam rafliansyah L [JAKARTA 22/03/2001(Rawamangun Tegalan no. 18 rt 007/03 | 1
e | 3 |ganteng perkasa L [JAKARTA 10/11/2001J1. Metro Jaya | No. 44 Pulomas 1
s | 4 |dini syafitrah P [JAKARTA | 06/04/2002|J1. Sirap No. 1 Rt 003/001 Kayu Puth | 1
w | 5 |elien elsa sabrina | P |[JAKARTA | 03/01/2001}J1. Kusen | No. 7 Rt 006/02 Kp Ambon | 1

Ubahlah kolom nama menjadi huruf besar semua, dengan cara:

1
2
3
4

Klik Format.

).
).
). Pilih Change case.
).

Pilin lowercase.

_Fg_r_m_at_!quls Data Window Help

Default Formatting Ctrl+Shift+Space

Blok kolom nama dari sel D6 sampai D10.

oa- 4

Cells... Ctrl+1

Column v

Sheet T —

Merge Cells v

- I

Page... L

Print Ranges r A SISW;
* PALAPI
1’1&; Paragraph..

Change Case + | Uppercase
] Styles and Formatting F11 | Lowercase

204N
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Untuk SMP / MTs Kelas VIII




Cara 3:

Menggunakan menu function

Tabel 7.7 Rumus lower

FORMAT
FUNGSI RUMUS/CARA CONTOH

Mengubah teks Cara 3 Klik pada sel berisi |mandriva
menjadi huruf kecil |Klik pada sel tujuan teks MANDRIVA
semua 1. Klik insert misalnya di sel C5

2. Pilih Function

3. Pilih category: Text  |Lalu ikuti cara 4

4. Pilih Function: lower

5. Next

6. Isi kotak text: alamat

teks
7. Klik Ok Tabel 7.7

Rumus lower
Sumber: Dok. Penulis

Buatlah tabel seperti berikut ini

Klik pada sel C6

1).Klik Insert.

2).Pilih Function.
3).Pilih Category: Text.
4).Pilih Function: lower.

5). Next.

6).Isi kotak text: B6 atau blok sel B6:B15.

7).Klik Ok.

Copy ke baris berikutnya.
A B | E [ o [ e F]

L DAFTAR HADIR SISWA /SISWI
2 SMP 01 KAYUJATI
3 JAKARTA
4
5 |NO NAMA NAMA2 KELAS aNDA TANGH
5§ |1 |ADISAPUTRA 4c 1
7 |2 [AMELIA HERLATI SIAHAAN ad 2
8 |3 [ANDIKA RACHMAN 5b 3
S |4 [ANGGIA FAHRIZA 1a 4
10 15 (ANGGITA ROY RYANSYAH 2b 5
11 |5 |[ANNISA WURIAYUNINGTYAS 6c 5
12 17 |[AULIA ASHRIBURFURQONI ad 7
13 | |AZRIN KURINIAWAN 4c B Gambar 7.31
14 g (DEKA AGIT MEIWAN BULSARA Sb f<] Penerapan lower
15 110 [DENIMAULANA 6c 10 Sumber: Dok. Penulis
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Atau kamu dapat menggunakan tombol function ini
3. PROPER

Penggunaan rumus proper pada OpenOffice.org Calc mempunyai 2 cara.

Cara 1:

Rumus diketik langsung membaca terhadap teks pada sel tersebut.

Tabel 7.8 Rumus proper

FORMAT
FUNGSI ‘ RUMUS CONTOH ‘HASIL

Mengubah huruf |Cara 1 =proper(“distro linux Distro
besar pada huruf |=proper(teks) |ubuntu”) Linux
Tabel 7.7 |y ortama dari Ubuntu
Rumus proper fi kata dari
Sumber: Dok. Penulis setiap kata dar
suatu teks

Buatlah tabel seperti berikut ini.

A B | & | D E 7]

1 DAFTAR HADIR SISWA /SISWI
2 SMP 01 KAYUJATI
3 JAKARTA

s [NO NAMA KELAS TANDA TANGAN
4c 1
3d 2
5b 3
1a 4
2b 5

o
=y

Gambar 7.32
Tabel penerapan proper
Sumber: Dok. Penulis

©
o S w N

Ll o
MRy erE | 3 -

Isilah kolom nama dengan:
=proper(“adi saputera”)
=proper(“amelia herlati siahaan”)
=proper(“andika rachman”)
=proper(“anggia fahriza”)

=proper(“anggita roy ryansyah”)

21 6 _ Teknologi Informasi dan Komunikasi NN
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Cara 2:

Menggunakan menu function.
Tabel 7.9 Rumus proper

FORMAT

FUNGSI RUMUS/CARA CONTOH
Mengubah huruf Cara 3 Klik pada sel
besar pada huruf |Klik pada sel tujuan berisi teks
pertama dari setiap | 1. Klik insert MANDRIVA
kata dari suatu teks|2. Pilih Function misalnya di sel

3. Pilih category: Text C5

4. Pilih Function: proper

5. Next Lalu ikuti cara 4

6. Isi kotak text: alamat
teks

7. Klik Ok

Distro Linux
Ubuntu

Buatlah tabel seperti berikut ini.

A ] B [ E [ o I T
1 DAFTAR HADIR SISWA /SISWI
2 SMP 01 KAYUJATI
3 JAKARTA
4
5 |NO NAMA NAMA2 KELAS WNDA TANGA
5 |1 |ADISAPUTRA 4c 1
7 |2 |AMELIA HERLATI SIAHAAN 3d 2
g 13 |ANDIKA RACHMAN 5b ]
¢ l4 |ANGGIA FAHRIZA 1a 4
10 5 |JANGGITA ROY RYANSYAH 2b 5
11 1 |ANNISA WURI AYUNINGTYAS 6c 6
12 17 |JAULIA ASHRIBURFURQONI 3d 7
13 | |AZRIN KURINIAWAN 4c 8
14 g |DEKA AGIT MEIWAN BULSARA 5b k]
15 110 |DENIMAULANA 6c 10

Klik pada sel tujuan:
1. Klik Insert.
. Pilih Function.

. Pilih Category: Text.

2

3

4. Pilih Function: proper.

5. Next.

6. Isi kotak text: B6 atau blok sel B6:B15.
7. Klik Ok.

Salinlah ke baris berikutnya..

Tabel 7.9
Rumus proper
Sumber: Dok. Penulis

Gambar 7.33
Tabel penerapan
proper

Sumber: Dok. Penulis

Teknologi Informasi dan Komunikasi @] o
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atau dengan menggunakan tombol function ini

i Fanction Wizard =
Functi.,ns| Structure PROPER Function result [Err:511
Lategory Capitalizes the first letter in all words,
[Text Sl
RUnsieD text(required)
LOWER T?’;f text in which the beginning of werds are to be replaced by capital
MID etters.
PROPER |
REPLACE text £l |3
REPT
RIGHT
ROMAN
ROT13
SEARCH
SUBSTITUTE
T | Result |Erri511
E Formula
Gambar 7.34 TEXT S oA =
. TRIM [=PROPER()
function proper UPPER |
VALUE - =
Sumber: Dok. Penulis =
[ Array [ Help | [ cencel | [ =<<Back |[ next | oK |

4. LEFT

Penggunaan rumus left pada OpenOffice.org Calc mempunyai 2 cara
Cara 1:

Rumus diketik langsung membaca terhadap teks pada sel tersebut
"Tabel 7.10 Rumus left
FORMAT

FUNGSI RUMUS CONTOH |[HASIL

Membaca Cara 1 =left(“ubuntu”;2) ubu
sejumlah karakter |=left(text;number)

dari sebelah kiri

pada suatu teks

Tabel 7.9
Rumus left
Sumber: Dok. Penulis

Buatlah tabel seperti berikut ini

A B 5 | D E

HARGA PRODUK MAKANAN SEHAT

HARGA
| NO' | KODE AMATREOUIE DISTRIBUTOR | KONSUMEN
5
3 1 Calsium Powder Rp143.000 Rp163.000]
7 2 Vitality Capsul Rp176.000 Rp196.000)
Gambar 7.35 8 3 Cellulose Tablets Rp151.000 Rp171.000]
tabel penerapan left |~ 4 Protein Powder Rp209.000 Rp229.000)
Sumber: Dok. Penulis 10 5 Bio-Energi Rp318.000 Rp338.000]
11

Isilah kolom KODE dengan:

1. =left(“Calsium Powder”;3)
2 =left(“Vitality Capsul”;3)

3 =left(“Cellulose Tablets”;3)
4, =left(“Protein Powder”;3)
5 =left(“Bio-Energi”;3)

% Teknologi Informasi dan Komunikasi N
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Cara 2:

Menggunakan menu function.
Tabel 7.11 Rumus left

FUNGSI

Membaca
sejumlah
karakter dari
sebelah Kiri
pada suatu
teks

FORMAT
RUMUS/CARA | CONTOH
Cara 3 Klik pada sel berisi DIS
Klik pada sel tujuan teks
1. Klik insert DISTRO misalnya di
2. Pilih Function sel C5

3. Pilih category: Text 1. Klik insert
4. Pilih Function: left 2. Pilih Function

5. Next 3. Pilih category: Text
6. Isi kotak shrink: alamat 4. Pilih Function: left
teks 5. Next
7. Isi number: Jumlah 6. Isi kotak shrink:
karakter alamat teks Tabel 7.10
8. Klik Ok 7. Isi number: Jumlah Rumus left
karakter: 3 Sumber: Dok. Penulis
8. Klik Ok

Buatlah tabel seperti berikut ini.

[5] E

c I
1 HARGA PRODUK MAKANAN SEHAT

2

3 HARGA

b5 | RRER R DISTRIBUTOR | KONSUMEN

)

6 1 Calsium Powder Rp143.000 Rp163.000|

7 2 Vitality Capsul Rp176.000 Rp196.000

8 3 Cellulose Tablets Rp151.000 Rp171.000|

9 4 Protein Powder Rp209.000 Rp229.000 _Cl_;abmlbar 7.36 left
s 5 Bio-Energi Rp318.000,  Rpassooo| 'aPelpenerapan le
1 Sumber: Dok. Penulis

Klik pada sel tujuan:

1).Klik Insert.

2). Pilih Function.

3).Pilih Category: Text.
4).Pilih Function: left.

5). Next.

6). Isi kotak text: C5.

7).1si number misalnya dengan 3.

8).Klik Ok.

Salin sel B5 ke baris berikutnya.

I 1.inologi Informasi dan Komunikasi @9
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Tabel 7.11
Rumus mid

Sumber: Dok. Penulis

Gambar 7.37
Tabel penerapan mid
Sumber: Dok. Penulis

5. MID

Penggunaan rumus MID pada OpenOffice.org Calc mempunyai 2 cara.
Cara 1:
Rumus diketik langsung membaca terhadap teks pada sel tersebut

Tabel 7.12 Rumus mid

FORMAT
FUNGSI ‘ RUMUS ‘ CONTOH ‘HASIL
Membaca Cara 1 =mid(“ubuntu”;2;3) |bun
sejumlah =mid(text;start;number)

karakter dari
tengah pada
suatu teks

Buatlah tabel seperti berikut ini.

Isilah kolom kode diskon dengan:

A B c [ D [ E F
1 HARGA PRODUK MAKANAN SEHAT
2
3 KCDE HARGA
4 NO DISKON |PRODUK WEMR PECDLE DISTRIBUTOR KONSUMEN
5
6 1 Cal Calsium Powder Rp143.000 Rp163.000]
7 2) Vit Vitality Capsul Rp176.000 Rp196.000f
8 3| Cel Cellulose Tablets Rp151.000 Rp171.000]
] 4 Pro Protein Powder Rp209.000 Rp229.000]
10 5| Bio Bio-Energi Rp318.000 Rp338.000]
11
12

=mid(“Calsium Powder”;5;2)
=mid(“Vitality Capsul”;5;2)
=mid(“Cellulose Tablets”;5;2)
=mid(“Protein Powder”;5;2)

=mid(“Bio-Energi”;5;2)

Untuk SMP / MTs Kelas VIII
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Cara 2

Menggunakan menu function
Tabel 7.13 Rumus mid

FORMAT

FUNGSI RUMUS/CARA CONTOH
Membaca Cara 3 Klik pada sel berisi STR
sejumlah Klik pada sel tujuan teks
karakter dari 1. Klik insert DISTRO misalnya di
sebelah Kiri 2. Pilih Function sel C5
pada suatu 3. Pilih category: Text 1. Klik insert
teks 4. Pilih Function: mid 2. Pilih Function
5. Next 3. Pilih category: Text
6. Isi kotak text: alamat teks |4. Pilih Function: mid
7. Isi kotak start: mulai dari  |5. Next
karakter ke berapa 6. Isi kotak shrink:
8. Isi number: Jumlah alamat teks
karakter yang dibaca 7. Isi start dengan: 3
9. Klik Ok 8. Isi number: Jumlah
karakter: 3
7. Klik Ok
Buatlah tabel seperti berikut ini
1 _— . ‘ - ‘ HARGA PRCJD[LK MAKANAN SEHﬁl\T - ;
2 KODE HARGA
4 e DISKON |PRODUK NAMA PRODUK DISTRIBUTOR KONSUMEN
Z 1 Cal Calsium Powder Fp143.000 Rp163.000
7 2] Vit Vitality Capsul Rp176.000 Rp196.000]
g 3 Cel Cellulose Tablets Rp151.000 Rp171.000)
9 4 Pro Protein Powder Rp208.000 Rp229.000)
10 5) Bio Bio-Energi Rp318.000 Rp338.000)

Klik pada sel tujuan yaitu B6:

1).Klik Insert.

2).Pilih Function.
3).Pilih Category: Text.
4).Pilih Function: mid.

5). Next.

6). Isi kotak text: D6.

7).lsi kotak Start:5.
8).Isi Kotak Number:2.
9).Klik Ok.

Tabel 7.12
Rumus mid

Sumber: Dok. Penulis

Gambar 7.38
Mengisi kolom distro
dengan function
Sumber: Dok. Penulis
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6. RIGHT

Penggunaan rumus right pada OpenOffice.org Calc mempunyai 2 cara.

Cara 1:

Rumus diketik langsung membaca terhadap teks pada sel tersebut.

Tabel 7.14 Rumus right

FORMAT
FUNGSI RUMUS CONTOH |HASIL
Membaca Cara 1 =right(“ubuntu”;3) [ntu
sejumlah =right(text;number)

Tabel 7.13 karakter
Rumusright | garj sebelah
Sumber: Dok. Penulis kanan pada
suatu teks

Buatlah tabel seperti berikut ini.

A ] B [ & I 5] I E [ F G
1 HARGA PRODUK MAKANAN SEHAT
2
3 KODE HARGA
4 NO PROMO | DISKON PRODUK NAMA.FRODLK DISTRIBUTOR | KONSUMEN
5
6 | 1 iu Cal Calsium Powder Rp143.000 Rp163.000,
7| 2 li Vit Vitality Capsul Rp176.000 Rp196.000,
Gambar 7.39 s [ 3 ul Cel Cellulose Tablets Rp151.000| Rp171.000
Tabel penerapan right 9| 4 ei Pro Protein Powder Rp209.000  Rp229.000
Sumber: Dok. Penulis 10| 5 En Bio Bio-Energi Rp318.000 Rp338.000,
11
1z

Isilah kolom nama dengan:
=Right(“Calsium Powder”;4)
=Right(“Vitality Capsul”;4)
=Right(“Cellulose Tablets";4)
=Right(“Protein Powder”;4)
=Roght(“Bio-Energi”;4)
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Cara 2:

Menggunakan menu function.

Tabel 7.15 Rumus right

RUMUS/CARA

sebelah kanan
pada suatu
teks

Membaca Cara 3
sejumlah Klik pada sel tujuan
karakter dari | 1. Klik insert

2. Pilih Function

3. Pilih category: Text

4. Pilih Function: right

5. Next

6. Isi kotak shrink: alamat
teks

7. Isi Kotak Start: mulai dari
huruf ke berapa

8. Isi number: Jumlah
karakter yang dibaca

9. Klik Ok

1
2
3
4
5
6

7

8

CONTOH

Klik pada sel berisi teks

DISTRO misalnya di sel C5

. Klik insert

. Pilih Function

. Pilih category: Text

. Pilih Function: left

. Next

. Isi kotak shrink: alamat
teks

. Isi number: Jumlah
karakter: 3

. Klik Ok

DIS

Buatlah tabel seperti berikut ini.

A ] B \ g \ ) [ E ] F &

1 HARGA PRODUK MAKAMNAN SEHAT
2
2 KODE HARGA
4 . PROMO | DISKON |PRODUK NAMAFROBUK DISTRIBUTOR | KONSUMEN
5
6 | 1 iu Cal Calsium Powder Rp143.000 Rp163.000,
7|2 li Vit Vitality Capsul Rp176.000 Rp196.000
s | 3 ul Cel Cellulose Tablets Rp151.000 Rp171.000
a | 4 ei Pro Protein Powder Rp209.000 Rp229.000
0|5 En Bio Bio-Energi Rp318.000 Rp338.000
11
12

Isi Kode promo dengan cara:

Klik pada sel B6:

1).Klik insert 5). Next

2).Pilih Function
3).Pilih category: Text
4).Pilih Function: right

6).Isi kotak text: E6
7).lsi kotak number:4
8).Klik Ok

Tabel 7.14
Rumus right
Sumber: Dok. Penulis

Gambar 7.40
Tabel penerapan
right

Sumber: Dok. Penulis
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SPraktikum

Praktikum menggunakan fungsi teks

Buatlah tabel seperti berikut ini:

2
2 |No. | TEKS ASAL | UPPER | LOWER | PROPER | LEFT | RIGHT | MID
41 1 [KOMPUTER
5 | 2 [MONITOR
6 | 3 |KEYBOARD
7 | 4 |PRINTER
g | 5 |SCANNER
Gambar 7.41
Tabel penerapan rumus fungsi text
Sumber: Dok. Penulis
KETERANGAN:
Gunakan rumus-rumus sebagai berikut:
=UPPER(text)
=LOWER(text)
=PROPER(text)

=LEFT (text;jumlah huruf)
=RIGHT(text;jumlah huruf)
=MID(text;mulai huruf ke;jumlah huruf)

E.

Menggunakan fungsi logika

Untuk mengetahui apa saja yang termasuk dalam fungsi logika kamu dapat
melihatnya pada fungsi siap pakai (function wizard) pada sebuah toolbar function f(x),
caranya:

1).KIlik Insert.

2).Pilih Function.

3). Pilih Category: logical atau langsung klik toolbar function ini.

Dari function wizard kita bisa lihat ada beberapa fungsi yang termasuk fungsi
logika, yaitu AND, FALSE, IF, NOT, OR, dan TRUE. Semua fungsi tersebut bisa
digunakan berdiri sendiri atau secara bersamaan, tergantung data dan hasil yang akan
digunakan.
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1.

Finction Wizard

Function result

Functions ‘ Structure

AND

: ~
|Logical > AND( Logical value 1; Logical value 2; ... )

Function

AND
FALSE
IF
NOT
OR
TRUE

Returns TRUE if all arguments are TRUE.

Result |Err:520

= A

Formula

[ Array Help ‘ | Cancel

IF

Pada kehidupan sehari-hari kita sering dihadapkan pada dua buah pilihan yang
harus kita ambil sebagai keputusan, tetapilihat dahulu kondisi yang ada saat ini barulah
tahu apa yang akan kita ambil sebagai keputusan. Untuk memahami penggunaan
fungsi IF, ikuti ilustrasi berikut ini: Misalnya akan memutuskan membawa payung, kita
lihat kondisi apakah hari hujan atau cerah.

Untuk lebih jelasnya mari kita pelajari tabel berikut ini:

1). Keputusan pertama
Untuk membawa payung jika kondisi hari hujan, jika kondisi hari cerah
keputusannya memakai topi.
2).Keputusan kedua
Untuk berhenti jika kondisi lampu lalu lintas merah, jika lampu hijau
keputusannya berjalan.
3). Keputusan ketiga

Untuk barang yang ditawar jika harga barang mahal, jika harga barang murah
keputusannya dibeli.

Mengisi rumus formula fungsi IF.
Tabel 7.16 Rumus logika If

FORMULA
UMUM CONTOH ARTINYA

=IF(tes logika =IF(C4>=7;"LULUS”;”"GAGAL”) |Jika sel C4

; Kondisi jika berisi nilai lebih

benar ;Kondisi sama dengan 7

jika salah) maka hasilnya
ditulis LULUS,
selain itu
GAGAL

Gambar 7.42
Function logical
Sumber: Dok. Penulis

Tabel 7.15
Rumus logika If
Sumber: Dok. Penulis

Teknologi Informasi dan Komunikasi
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Fungsi IF hanya mengenal 1 tes logika dari 2 kondisi, karena yang akan diambil
sebagai keputusannya hanyalah satu. Bagaimana cara berfikir untuk membaca
fungsi IF Prinsipnya adalah YA atau TIDAK, BETUL atau SALAH. Fahami bagan

berikut ini.

Gambar 7.43
Bagan fungsi if
Sumber: Dok. Penulis

=IF(tes logika ;Kondisi 1 ; Kondisi 2)

Dari bagan di atas definisi fungsi IF dapat juga diartikan sebagai: suatu
fungsi percabangan yang akan melaksanakan suatu perintah berdasarkan data
yang masuk, bila data yang masuk benar maka yang dijalankan perintahnya adalah
kondisi 1, bila data yang masuk salah maka yang dilaksanakan perintahnya adalah

.

kondisi 2.

Bawa Payung

Penerapan Rumus IF dapat kamu lihat pada tabel berikut ini:

feo E = [SIF(C3>=6,"LULUS"REMEDIAL')
A [ B [ c D
1 DAFTAR NILAI ULANGAN
: | NO NAMA NILAI | KETERANGAN
3 1|Siti Nurjanah 7.5 |LULUS
s 2|Olivia Adnan 6.8 |LULUS
Gambar 7.44 3/Agus Santoso 58 |REMEDIAL
tabel penerapan if .
Sumber: Dok. Penulis 4 Adam IQDI"QMM 8.2 LULUS
7 5Toni Sianturi 5.2 |REMEDIAL

Pada kolom keterangan, syarat siswa LULUS ULANGAN adalah jika nilai
yang didapat adalah lebih atau minimal sama dengan 6, jika kurang dari 6 siswa
harus remedial. Yang dimaksud data masuk adalah pada kolom nilai, misalnya Siti
Nurjanah, mendapat nilai 7.5 berarti tes logika benar karena syaratnya nilai lebih
atau sama dengan 6, maka yang ditulis pada kolom keterangan adalah LULUS,
sedangkan Toni Sianturi mendapatkan nilai 5.2 maka tes logika salah atau kurang

dari 6, maka yang ditulis pada kolom keterangan adalah REMEDIAL.
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2. IF GANDA

Yang dimaksud dengan IF GANDA adalah jika kita akan mengambil sebuah
keputusan, tetapi mempunyai kondisi lebih dari dua kondisi keadaan yang
mempengaruhinya atau mempunyai lebih dari satu tes logika, karena fungsi IF
hanya mengenal satu tes logika dan dua kondisi, jika lebih dari dua kondisi harus
menggunakan fungsi IF tambahan di dalamnya, Fungsi IF GANDA karena di dalam
fungsi IF terdapat fungsi IF lagi, Agar lebih jelas memahami penulisan rumus lihatlah
bagan berikut ini.

[Fungsi IFStandar dengan 2 kondisi
=IF(tes logika A;kondisi 1; kondisi 2)

[Fungsi Ifpada kondisi 3i
IF(tes logika B;kondisi 2;kondisi 3)

IFungsi IF ini diletakkan sebagai kondisi 2

>—>

[Fungsi IF GANDA setelah penggabungan dua fungsi IF
=IF (tes logika A;kondisi 1;IF(tes logika B;kondisi 2;kondisi 3))

Jika kondisi lebih dari 3, maka kamu harus menambah fungsi IF lagi pada
kondisi 3, dan seterusnya.

[Fungsi IFStandar dengan 2 kondisi
EIF(tes logika Askondisi 1; kondisi 2)

[Fungsi Ifpada kondisi 3i

[F(tes logika B;kondisi 2ikondisi 3)

Fungsi IF ini diletakkan sebagai kondisi 2
i

i Fungsi Ifpada kondisi 3i
| p-[F(tes logika Bikondisi 3:kondisi 4)
IFungsi IF ini diletakkan sebagai kondisi 3

IFungsi IF GANDA setelah penggabungan dua fungsi IF
~IF(tes logika A;kondisi 1;IF (tes logika B;kondisi 2;1F(tes logika C;kondisi 3;kondisi 4)))

Mungkin kamu masih bingung untuk menerapkan rumus di atas, sekarang
pikirkanlah jika kamu akan mengambil sebuah keputusan penting, tetapi terdapat
3 pilihan, misalnya kamu akan memutuskan untuk melanjutkan sekolah ke SMA,
terdapat 3 pilihan yaitu SMANegeri, SMASWASTA, dan SMK. Dengan memperhatikan
3 pilihan tersebut, sebagai penentunya adalah melihat kondisi Nilai, jika nilainya lebih
dari sama dengan 9 keputusannya masuk SMA NEGER!I, jika lebih dari sama dengan
8 keputusannya masuk SMA SWASTA, selain itu masuk SMK.

Dari cerita di atas kamu bisa membuat sebuah rumus formula IF sebagai
berikut:

[FIF(Nilai<9;”SMA NEGERI”;IF (Nilai<8;”SMA SWASTA”;”SMK”)) |

Gambar 7.45
Bagan fungsi if ganda
Sumber: Dok. Penulis

Gambar 7.46

Bagan fungsi if ganda
lebih dari tiga

Sumber: Dok. Penulis
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Kalau kita masukkan dalam sebuah tabel akan menjadi seperti ini.

2 NO NAMA NILAI KEPUTUSAN
Gambar 7.47 : 1 Burhan 9
Struktur if pada | s 2 Baskoro 8
function
Sumber: Dok. Penulis . 3 Basani 7
= [H
B = ==
@ D4
& 8
& "SMA NEGERI™
B = IF
B = ==
Gambar 7.48 @ D4
Tabel penggunaan if ganda & B
Sumber: Dok. Penulis ® "SMA SWASTA"
@ "SME"

=IF(D4>=9;"SMANEGERI";IF(D4>=8;"SMA SWASTA”;"SMK"))

Untuk mengisi kolom keputusan maka rumusnya adalah sebagai berikut:

Klik pada sel E4, ketik rumus berikut:

Salin rumus tersebut ke dalam baris berikutnya sehingga tabel menghasilkan

keputusan seperti ini.

C D

E

Gambar 7.49
Hasil keputusan

Sumber: Dok. Penulis

NO NAMA NILAI KEPUTUSAN
1 Burhan 9 SMA NEGERI
2 Baskoro 8 SMA SWASTA
3 Basani 7 SMK
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. AND

Fungsi AND mempunyai lebih dari satu tes logika atau pengujian, prinsipnya
adalah jika semua tes logika atau pengujian itu mempunyai nilai benar atau memenuhi
syarat, maka menghasilkan nilai BENAR (True), tetapi jika salah satu atau semua nilai
salah pengujian tidak memenuhi syarat, maka menghasilkan nilai SALAH (false).

Jika menggunakan function seperti ini Function AND menyediakan 30 tes logika
atau argumen yang bisa digunakan.

Format Umum penulisan rumus AND:

& = ——
Functions | Structure | AND Function result [Erm511

Category Returns TRUE if all arguments are TRUE

Eunctien fedizeiuel B e ian]

AND Lecevalen dines ymine e 1 to 30 conditions to be tested and
PRTSE 2oh returns aither TAUE or FALSE.

elI:Il
P — ]
ues:.
P | — 1

. R Gaml?ar 7.50
B 7 Function and
Sumber: Dok. Penulis
[ Array Help ] [ cancel | | <<Back [ next
Simaklah tabel berikut ini:
=AND (tes logika 1, tes logika 2,... tes logika n)
fw E = [-AND(AI>—4iB3>=4C3>=4)

I B [ E [ D

Uji Kebenaran FUNGSI AND
Nilai 1 Nilai2  |Nilai 3 |Nilai >=4

—

~

3 7 5 6 TRUE

Gambar 7.51
: 4 B 3 FALSE Tabel penerapan and
5 3 2 1 F AL S E Sumber: Dok. Penulis

Dari Tabel ini rumus yang digunakan adalah sebagai berikut:

= |[=AND(A3>=4;B3>=4;C3>=4)

Rumus tersebut mengharuskan semua nilai berisi lebih atau sama dengan 4,
maka pada baris pertama dengan nilai 7,5,6 semuanya memenuhi sayarat maka
menghasilkan nilai true, pada baris kedua nilai 4,5,3 mempunyai satu nilai salah yaitu
3 maka menghasilkan nilai false, begitu pula pada baris ketiga dengan nilai 3,2,1
semua nilai salah maka menghasilkan nilai salah.

Untuk SMP / MTs Kelas VIII
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Gambar 7.52
Tabel penerapan IF
dan AND

Sumber: Dok. Penulis

4. Penerapan Fungsi IF DAN AND
Format Umum Fungsi IF dan AND adalah:

=IF (AND(tes logika 1; tes logika 2; ...);
Kondisi 1 jika benar ; kondisi 2 jika salah)

Fungsi AND tidak akan berarti apa-apa kalau tidak diterapkan dengan fungsi
yang lain karena hanya akan menghasilkan nilai TRUE dan FALSE, dari tabel di
atas tambahkan satu kolom Penerapan di sebelahnya dan gabungkan fungsi AND
dengan IF, bagaimana caranya yuk kita lihat tabel berikut ini:

feo X = |=IFIAND(A3>=4:B3>=4:C3>=4);"LULUS":"GAGAL")

A [ B [ < [ b [ E \

Uji Kebenaran FUNGSI AND

Nilai 1 |Nilaj 2| Nilai 3| Nilai >=4 | Penerapan
7 5 6 TRUE LULUS
e 5 3 FALSE GAGAL
3 2 1 FALSE GAGAL

Untuk mengisi penerapan mempunyai ketentuan sebagai berikut: jika semua
nilai lebih atau sama dengan 4 maka mempunyai pernyataannya LULUS sedangkan
jika salah satu atau semua nilai kurang dari 4 pernyataannya GAGAL. Maka rumus
yang digunakan adalah sebagai berikut:

1). Letakkan kursor pada sel E3.
2).lsi sel tersebut dengan

— ! =IF(ANDIA3==4,B3==4,C3==4);"LULUS","GAGAL")

. OR

Fungsi OR juga mempunyai lebih dari satu tes logika atau penguijian,
prinsipnya kebalikan dari prinsip AND yaitu jika semua tes logika atau pengujian itu
mempunyai nilai SALAH, maka menghasilkan nilai SALAH (False), tapi jika salah
satu atau semua nilai BENAR, maka menghasilkan nilai BENAR (True).

Format Umum penulisan rumus OR.

=0OR(tes logika 1, tes logika 2,;... tes logika n)

Jika menggunakan function:

Function OR menyediakan 30 tes logika atau argumen yang bisa

digunakan.
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Functions | Structure OR Function result [Erm511

Lategory Returns TRUE if an argument is TRUE.

‘Lug\ca\ 4 ‘

Elnetion Logical value 1(required)

AND Logical value 1, logical value 2,... are 1 to 30 conditions to be tested and

FALSE which return sither TRUE or FALSE.

IF

o B ) [—

TRUE < &
Logealvaties [ ][
N ) — 1]

Formula Result |Err511

=CRI)
| :

[ Array | Help || Cancel | ‘ << Back ‘|77_‘-:nr v | oK J

Perhatikan tabel kebenaran dengan fungsi OR berikut ini:

D3 v fio X = [-OR(A3>=4;B3>=4;C3>=4)

A [ ] I T [
Uji Kebenaran FUNGS| OR

D

| Nilai 1 [Nilai 2 |Nilai 3| Nilai >=4
s 7 5 6 TRUE
: 4 5 3 TRUE
s 3 2 1 FALSE

Dari tabel ini rumus yang digunakan adalah:

1). Letakkan kursor pada sel D3.

2).1si sel tersebut dengan

— !=DRI{A3:—=4:BE:—=4:C3:—=4J

Rumus tersebut mengharuskan semua nilai berisi lebih atau sama dengan 4,
maka pada baris pertama dengan nilai 7, 5, 6 semuanya memenuhi syarat maka
menghasilkan nilai true, pada baris kedua nilai 4, 5, 3 mempunyai satu nilai salah
yaitu 3 maka menghasilkan nilai true, karena nilai 4 atau 5 benar lebih sama dengan
4, pada baris ketiga dengan nilai 3,2,1 semua nilai salah maka menghasilkan nilai
salah, karena tidak ada yang mewakili satupun nilai kebenaran.

. Penerapan Fungsi IF DAN OR
Format Umum Fungsi IF dan AND adalah:

=IF(OR(tes logika 1; tes logika 2; ...);
Kondisi 1 jika benar ; kondisi 2 jika salah)

Fungsi OR tidak akan berarti apa-apa kalau tidak diterapkan dengan fungsi
yang lain karena hanya akan menghasilkan nilai TRUE dan FALSE, dari tabel tersebut
tambahkan satu kolom Penerapan di sebelahnya dan gabungkan fungsi OR dengan
IF, bagaimana caranya yuk kita lihat tabel berikut ini:

Gambar 7.53
Function OR
Sumber: Dok. Penulis

Gambar 7.54
Tabel penerapan OR

Sumber: Dok. Penulis
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Teknologi Informasi dan Komunikasi &1 o



2 [ fw X

[=IF(OR(A3>=4;B3>=4;C3>=4);"LULUS";"GAGAL")

A [ B [ c [ ) [ E
» \Uji Kebenaran FUNGSI OR
= INilai 1|Nilai 2|Nilai 3| Nilai >=4 | Penerapan
Gambar 7.55 || 3 7 5 6 TRUE LULUS
Tabel penerapan IF
danoR || ¢| 4 5 3 TRUE LULUS
Sumber: Dok. Penulis : 3 2 .I F ALSE G AG AL I

Gambar 7.56
Function Wizard
logical Not
Sumber: Dok. Penulis

Untuk mengisi penerapan mempunyai ketentuan sebagai berikut: jika salah
satu atau semua nilai lebih dari sama dengan 4 maka mempunyai pernyataan
LULUS sedangkan jika semua nilai tidak ada yang lebih dari 4 pernyataan GAGAL.
Maka rumus yang digunakan adalah sebagai berikut:

1). Letakkan kursor pada sel B3.

2).Isi sel tersebut dengan

I =IF(OR(A3==4;B3>=4,C3>=4);"LULUS";"GAGAL")

. NOT

Fungsi NOT hanya mempunyai satu tes logika, fungsinya untuk membaca
kebalikan dari tes logika atau pengujian yang dilakukan, prinsipnya jika tes logika
atau pengujian itu mempunyai nilai SALAH (FALSE), maka menghasilkan nilai
BENAR (TRUE) dan jika tes logika atau pengujian itu mempunyai nilai BENAR
(TRUE), maka menghasilkan nilai SALAH (FALSE)

Functions| Structure | NOT Function resul It [Err511
Lategery Reverses the value of the argument.
Logical B
S—— Logical value(required)
AND An expression that can be either TRUE or FALSE
FALSE
IF "
o togicatvatue (£ |[5]
OR
TRUE
Formula Result [Erri511
[=NoT( i
0 enay [ ][ ol ] [semmk [ i

Format Umum penulisan rumus NOT:
=NOT (Tes Logika)

Jika menggunakan function:

Function NOT hanya memiliki satu tes logika atau argumen.

2320\
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SPraktikum

Praktikum menggunakan fungsi logika
Buatlah tabel seperti berikut ini:

A |

B

[ c |

6]

1 PENERIMAAN SISWA BARU
2
3 |No. Nama Rata'Nilai STATUS
4 1 |Mustika Rahma 8.20
5 | 2 |lmam Pratiknyo 8.60
6 | 3 |Fatih Nashrullah 9.20
7 | 4 |Farid Arkan 9.00
8 5 |Affan lzuddin 8.49
g | 6 |Zaid Yunan 8.51
10 | 7 [Yulianti 7.81
11 | 8 |OskarLaksono 8.25
12 | 9 |Ariefuddin Faiz 9.50
13 | 10 |Ayyas lzuddin 8.90
Gambar 7.57
Tabel penerimaan siswa baru
Sumber: Dok. Penulis
KETERANGAN:

Isilah kolom STATUS dengan:

=IF(C4<=8.5;"DITOLAK";"DITERIMA")

Isilah kolom DISKON dengan
=IF(C4>=9;"DISK";"0")
Isilah kolom SOVENIR dengan
=IF(C4<=8.5;"STIKER”;"JAM”)

Buatlah tabel seperti berikut ini:

A

[ G

]

ENIS ANGKUTAN

IENIS

ULINID

~ Jika

Bogor

DAFTAR J
NO | NO.POLIS!I | DAERAH
1 |B1473 LH
2 |AB 5002 MU
3 |D2514 HS
4 [B6517 AX
5 |F5123 MU
Gambar 7.58
Tabel rute mobil
Sumber: Dok. Penulis
B : Jakarta
: Bandung
AB : Cirebon

~ Jika huruf ke 3 adalah
2 : Sedan

Lainnya: Motor

~ Jika 2 huruf terakhir
adalah

MU : Umum

Lainnya : Pribadi
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1

2
3
4.

. Formula adalah penggunaan rumus pada perhitungan tertentu.

. Untuk menggunakan formula selalu diawali dengan tanda “=".

. Formula dapat disalin ke sel lain yang memiliki rumus perhitungan yang sama.

Fungsi statistic dapat digunakan untuk mencari nilai rata-rata, nilai tertinggi, nilai terendah,

jumlah data dengan harapan dapat digunakan untuk menyusun, meringkas, menyajikan dan
menganalisa data.

. Fungsi logika dapat membantu menganalisa data untuk mendapatkan sebuah keputusan dari

beberapa data yang disediakan.

Teknologi Informasi dan Komunikasi .
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- Glosarium

ISTILAH KETERANGAN

Formula susunan atau bentuk tetap; rumus
Kalkulator 1 alat hitung; 2 juru hitung
. bidang pekerjaan yang dilandasi pendidikan keahlian (keterampilan, kejuruan,
Profesi
dsb) tertentu
Data keterangan atau bahan nyata yang dapat dijadikan dasar kajian (analisis atau
kesimpulan);
1 ringkasan (hukum, patokan, dsb di ilmu kimia, matematika, dsb) yang
Rumus .
dilambangkan oleh huruf, angka, atau tanda
formula susunan atau bentuk tetap; rumus
daftar berisi ikhtisar sejumlah (besar) data informasi, biasanya berupa kata-
tabel kata dan bilangan yang tersusun secara bersistem, urut ke bawah di lajur
dan deret tertentu dengan garis pembatas sehingga dapat dengan mudah
disimak
Relative tidak mutlak; nisbi
Absolute tidak terbatas; mutlak
tanda yang dikenakan oleh pengusaha (pabrik, produsen, dsb) pada barang
merek yang dihasilkan sebagai tanda pengenal; cap (tanda) yang menjadi pengenal
untuk menyatakan nama
Merencanakan |[rancangan; buram (rangka sesuatu yang akan dikerjakan):

mengumpulkan

membawa sesuatu dan menyatukan dengan yang lain agar berkumpul

Mengolah

1 orang yang mengolah data; 2 alat (mesin, komputer) yang mengolah data;

Menganalisa

Melakukan pemecahan persoalan yang dimulai dengan dugaan akan
kebenarannya

mempresentasikan

menyajikan; mengemukakan

data yang berupa angka yang dikumpulkan, ditabulasi, digolong-golongkan

Statistika sehingga dapat memberi informasi yang berarti mengenai suatu masalah
atau gejala
informasi 1 penerangan; 2 pemberitahuan; kabar atau berita tentang sesuatu
menyajikan Mempersembahkan, menyediakan
logika 1 pengetahuan tentang kaidah berpikir; 2 jalan pikiran yang masuk akal:

keterangan saksi tidak ada -- nya;

Teknologi Informasi dan Komunikasi
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1. Penggunaan rumus formula dapat d. COUNT

dilakukan pada data yang bersifat .... 6. Fungsi IF digunakan untuk ....

a. Number a. Membandingkan nilai benar dan salah
b. D.ate b. Menentukan kodisi yang akan dijalankan
c. Time c. Membaca kondisi

d. Text

d. Menghitung
2. Untuk melakukan perhitungan diawalidengan 7 g mus dari =SQRT(B5), jika sel B5 diisi

tanda ... dengan 36 hasilnya adalah ....
a. + a.5
b. - b. 6
c. = c.7
d. d. 8
3. Yang dimaksud alamat absolut adalah .... 8. Pembaca rumus teks =MID(“Open Office”;6;3)
a. sel yang dapat dihitung akan menghasilkan ....
b. sel yang tidak dapat dihitung a. Open
c. sel yang tidak berubah alamat selnya jika b. Ope
disalin ke sel lain c. Off
d. Sel yang dapat berubah alamat selnya d. lce
at.au menyesuaikan diri jika disalin ke sel g pj45 fungsi logika ganda =IF(B4>=9;"LULU
lain S”;IF(B4>=8;"REMEDIAL”;IF(B4>=7;"GAGA
4. Sebutlan syarat sebuah sel formula agar L”;”"MENGULANG”))) jika nilai B4 adalah 8.7
dapat disalin ke sel yang lain! maka keterangan yang dihasilkan adalah ....
a. Sel berisi teks a. LULUS
b. Sel berisi angka b. GAGAL
c. Sel berisi hasil c. REMEDIAL
d. Sel berisi rumus d. MENGULANG
5. Fungsi yang bertujuan menghitung ratra-rata 10.Logika OR hanya akan salah jika ....
adalah .... a. Semua benar
a. SUM b. Semua salah
b. ROUND c. Salah satu benar
c. AVERAGE d. Salah satu salah
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B.Lengkapi pernyataan berikut ini.

1.

2
3
4.
5

Fungsi . . . . berguna mengubah teks dari kecil ke besar.

. Untuk memeasukkan formula perhitungan elalu diawali dengan . . . .

. Fungsi Average untuk menghitung nilai . . . .

IF, AND, OR, NOT adalah termasuk kelompok fungsi . . . .

. Sedangkan yang termasuk kelompok fungsi teks adalah . . . .

C.Jawablah pertanyaan berikut ini dengan tepat.

1.

Sebutkan macam-macam fungsi statistika.

. Sebutkan operator matematika yang digunakan oleh OpenOffice.org Calc.
. Pada teks Internet_sekolah agar menghasilkan teks net_sek menggunakan rumus apa?

2
3
4.
5

Jika ditulis rumus =62 menghasilkan nilai berapa?

. Sebutkan syarat agar rumus dapat disalin ke sel lain.

Teknologi Informasi dan Komunikasi
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Mengelola Data

dengan OpenOffice.org

Calc

[r— GRAFIK PENGUNJUNG PERPUSTAKAAN

APRIL 2009
=y
=

X

GRAFIK PENGUNJUNG STAND IT-CORNER

eorang administrasi sering kali dihadapkan
S dengan pekerjaan mencaridata. Kelihatannya
mudah tapi ketika proses pencarian berapa
banyak data yang harus kitabacadan dimana sumber
data itu berada? Kalau data itu sedikit sangatlah
mudah untuk mencarinya tetapi seorang administrasi

sebuah kantor sangatlah banyak datanya, dan dari
tahun ke tahun selalu bertambah.

Menurutmu apa yang dibutuhkan seorang
administrasi dalam memecahkan masalah ini,
yaitu sebuah sistem informasi berbasis data atau
pengelolaan data yang memungkinkan seorang
administrasi dapat mencari data dengan cepat?

Database merupakan basis data yang berisi
beberapa kumpulan data yang bernilai informasi
tentang suatu obyek, tujuan atau topik tertentu.
Misalnya data barang suatu supermarket, buku
telepon, katalog buku, data siswa, data penduduk
dan sebagainya.

Y 1.knologi Informasi dan Komunikasi
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Peta Konsep

MENGELOLA DATA

Mengurutkan Data Saring data Grafik

P

m Autofilter
m Standar Filter
m Advanced Filter

m Ascending
m Descending
m criteria

m Menyiapkan Data
m Membuat Grafik
m Mengedit Grafik

data yang telah diproses sedemikian rupa sehingga meningkatkan pengetahuan seseorag

yang menggunakan data tersebut. Menurut Davis (1999), informasi adalah data yang telah
diolah menjadi sebuah bentuk yang berarti bagi penerimanya dan bermanfaat dalam pengambilan
keputusan saat ini atau saat mendatang. Menurut Shannon dan Weaver, mendefinisikan informasi
adalah dengan adanya informasi yang semula tidak pasti menjadi pasti.

DATA disebut juga sebagai bahan mentah infomasi. Melalui suatu proses transformasi,
data dibuat menjadi lebih bermakna. atau data merupakan fakta atau objek dalam suatu peristiwa
yang masih belum diolah atau dapat dikatakan data asli dalam bentuk lembaran-lembaran kertas.
Contohnya: Nama, Alamat, Suhu, Warna, Jumlah, dan sebagainya.

Banyak pendapat tentang apa itu arti informasi. McFadden, dkk. (1999) informasi sebagai

Database merupakan proses penyimpanan beragam informasi untuk diolah sedemikian rupa,
sehingga dapat dipergunakan kembali dengan mudah dan cepat. Fungsi dari program pengolah
data adalah membantu proses penyimpanan dan pengolahan data dengan lebih cepat dan efisien
sehingga data dapat diproses menjadi informasi.

Data, administrasi, proses, system, database, basis, mengolah, mengurut, menyaring, bimbingan,
ini, bimbingan

/i
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Saat ini sudah banyak sekali pemanfaatan sistem informasi di seluruh aktivitas
kegiatan sehari-hari pada sebuah kantor, swalayan, bahkan tempat parkir kendaraan,
karena memanfaatkan informasi berbasis data ini sangat mudah dan tidak perlu biaya
mahal. Contoh sederhananya dengan menggunakan OpenOffice.org Calc kamu dapat
mengelola data-data menjadi informasi. Yang memanfaatkannya pun beragam, mulai
dari pengusaha hingga pelajar. Bagaimana pelajar bisa memanfaatkan Informasi?
Dengan mengumpulkan data nilai kamu kemudian diolah sedemikian rupa maka akan
menghasilkan informasi terhadap dirimu sendiri, misalnya nilai pada pelajaran tertentu
memenuhi target nilai atau harus ditingkatkan dengan cara les privat.

Mengelola data pada OpenOffice.org Calc dapat kamu lakukan dengan berbagai
cara, tergantung kebutuhan dan pemanfaatannya. Penyajian pengolahan data
haruslah tepat agar data dapat bermanfaat dan menjadi informatif. Misalnya seorang
guru membutuhkan data siswa dan data nilai, seorang pedagang membutuhkan data
harga barang dan penjualan, jangan sampai guru mendapatkan informasi data harga
barang dan pedagang mendapatkan data siswa karena pasti data itu tidak akan menjadi
informasi yang bermanfaat.

A. Mengurutkan Data

Salah satu pengolahan data yang sering dilakukan pada OpenOffice.org Calc
adalah mengurutkan data. Data diurut agar mudah melakukan pencarian, berdasarkan
urutan abjad maupun angka.

ASCENDING

Yaitu proses mengurutkan data dari data yang terendah ke data yang tertinggi.
Misalnya data dari A sampai dengan Z, atau data dari 1 sampai dengan 9.

Mengurutkan data.

Cara cepat
mengurutkan data
adalah menggunakan
ikon Ascending dan
ikon Descending pada
Toolbar Standard.
Hati-hati perintah ini
hanya berlaku untuk
satu kolom
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raktikum

Buatlah tabel seperti berikut ini:

L l DAFTAR Il\IILAI —
2| No. [NAMA KELAS | NILAI

3 1 |Sinta Mulia 8A 65

a [ 3 JAnjas Maulana 7B 83

5 2 |Fatih Nawawi oC 95

5 4 [Zaid Ahmad 8A 75

7 5 [Kamelia 7e 85

Gambar 8.1

Daftar nilai yang belum urut

Sumber. Dokumen penulis

1. Urutkan data berdasarkan NAMA.
2. Urutkan data berdasarkan KELAS.
3. Urutkan data berdasarkan NILAI.

Untuk mengerjakannya langkah yang dilakukan
adalah:

A. Praktikum mengurutkan data berdasarkan nama
A B [ C D E
: DAFTAR NILAI
: | No. [NAMA KELAS | NILAI

:
:
:
| Gambar 8.2

Data yang diseleksi

Sumber. Dokumen penulis

Egurt Criteria| Options |

S0t X

Sort by
@ Ascending

[Column B 2

() Descending

v

Then by
@ Ascending

|- undefined - 0

) Descending

- undefined -

| oK H Cancel H Help H Reset

Gambar 8.3
Pengaturan sort

Sumber. Dokumen penulis
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1. Lakukan pemilihan data dengan cara blok tabel
pada seluruh data dari A3 sampai D7.

2. Klik menu data — Pilih Sort.
3. Pada sort By pilih Column B.
4. Pilih Accending.
5. Klik OK.
A B [ C D E
1 DAFTAR NILAI
2 | No. [NAMA KELAS | NILAI
a [ 3 JAnjas Maulana 7B 83
a 2 |Fatih Nawawi aC 95
3 5 |[Kamelia 7C 85
s| 1 [Sinta Mulia 8A 65 I
Gambar 8.4

Tabel hasil pengaturan sort berdasarkan nama

Sumber. Dokumen penulis



B. Praktikum mengurutkan data berdasarkan kelas

Cobalah urutkan data berdasarkan KELAS sehingga menghasilkan tabel seperti ini:

A

B

[ c [ D

E

Lakukan pemilihan data dengan cara blok tabel

3. Pilih Accending.
4. Klik OK.

KESALAHAN PENGURUTAN DATA

Hasil pengurutan data tidak akan sesai dengan yang kamu harapkan apabila dengan proses
pemilihan datanya salah. Perhatikan contoh berikut:

Gambar 8.6
Kolom nilai yang sudah urut

Sumber. Dokumen penulis

Gambar 8.7
Kesalahan memilih data

Sumber. Dokumen penulis

T B ] C T e 8 I L s

1 DAFTAR NILAI 1 DAFTAR NILAI

2| No. [NAMA KELAS 2| No. NAMA KELAS | NILAI

3 ] ] 8A 3| 3 |Anjas Maulana | 8A 65

a Anias Maulana |:> +| 2 [Fatih Nawawi 78 83

5 Fatih Nawawi s| 4 [Kamelia 9C 95

B 4 |Kameli s| 1 [(Sinta Mulia 8A 75

ENCCTH o | |
7 “gog @o! 7C 85 I 7| 5 |Zaid Ahmad 7C 85

pada seluruh data dari A3 sampai D7. i DAFTAR NILAI
2| No. [NAMA KELAS | NILAI
1. Klik menu data — Pilih Sort. |3 [Anjas Maulana 7B 83
2. Pada sort By pilih Volumn C. a| 5 |Zaid Ahmad 7C 85
3. Pilih Accending. 1 BinE Muig A | B8
. 6 4 [Kamelia 8A 75
4. Klik OK. |2 |Fatih Nawawi 9C 95
: Gambar 8.5
Kolom kelas yang urut
Sumber. Dokumen penulis
C. Praktikum mengurutkan data berdasarkan nilai
Cobalah urutkan data berdasarkan NILAI A E l c D E
. . —_— 1 DAFTAR NILAI
sehingga menghasilkan tabel seperti ini:
- z | No. [NAMA KELAS | NILAI
Lakukan pemilihan data dengan cara blok tabel - -
. . 3 1 |Sinta Mulia 8A 65
pada seluruh data dari A3 sampai D7. B . Kamelia A -5
1. Klik menu data — Pilih Sort. s| 3 |Anjas Maulana 7B 83
2. Pada sort By pilih Volumn D. °| 5 |Zaid Ahmad 7C 85
7 2 |Fatih Nawawi 9C 95

Jika yang kamu pilih hanya sebagian misalnya pada nomor dan nama saja, setelah kamu
melakukan sorting ascending maka hasilnya kelas dan nilai tidak akan ikut berubah pada

nama yang memiliki nilai tersebut.
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DESCENDING

Descending, yaitu proses mengu
yang terendah. Misalnya data dari Z sa

rutkan data dari data yang tertinggi hingga data
mpai dengan A, atau data dari 9 sampai dengan

1 atau proses pengurutan data secara menurun yang akan mengurutkan data dari yang
nilainya paling besar sampai data yang nilainya paling kecil.

Buatlah tabel seperti berikut ini:

1. Urutkan data berdasarkan JENIS.
2. Urutkan data berdasarkan STATUS.
3. Urutkan data berdasarkan HARGA.

L DAFTAR RI|ENTAL VC‘D

2 | No. |JENIS STATUS | HARGA
s 1 |VCD Film Dewasa | Rp2.000
a| 2 [VCD Lagu Umum Rp1.500
s 3 |DVD Film anak Rp3.000
s | 4 [DVD Lagu anak Rp3.500
7| 5 |Dokumenter Umum Rp1.000

Gambar 8.8

Data rental VCD

Sumber. Dokumen penulis

Untuk mengerjakannya langkah yang dilakukan
adalah:

1. Lakukan pemilihan data dengan cara blok tab

pada seluruh data dari A3 sampai D7.
Klik menu data — Pilih Sort.

Pada sort By pilih Column B.

Pilih Descending.

Klik OK.

o M 0D

D. Praktikum mengurutkan data secara descending

B | c [

E

DAFTAR RENTAL VCD
No. [JENIS STATUS | HARGA

;
2 VoD lagy |omum | Rpis00

g o pvorim e oo
8+ Pl | -
3 5 Dorurmener |

Gambar 8.9
Penandaan data

Sumber. Dokumen penulis

el
[@ s |

|Snrt Criteria| Options
Sort by

1 Ascending

|Column B

@ HEECEnding;

Then by

@ Ascending
|- undefined - B

() Descending

- undefined -

| oK H Cancel H Help H Reset
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Menu sort
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Mengurutkan dengan dua kriteria

Untuk mengurutkan data kamu bisa melakukan lebih dari satu kriteria. Kalau di atas

telah dipelajari mengurutkan data dengan satu kriteria yaitu pada NAMA saja, NILAI

saja. Atau HARGA saja, tapi kamu bisa juga dapat mengurutkan dengan dua kriteria,

misalnya mengurutkan Nilai dengan Kelas.

Praktikum mengurutkan data dengan dua kriteria

Buka sebuah tabel seperti berikut ini:

A ] B | D [ E [ F G
1
2 SMP 11 KAYU PUTIH
3 Ji. Kunci No, 28 Kei Kayu Puiih Kec Puiogadung Jak-Tim
@

=
s [No.| NAMA JK [Tempat| Tanggal lahir Alamat Bumah KELAS
6 | 1 |adnan rafliansyah L |Jakarta [22 Maret 2001 |JI. Rawamangun Tegalan no. 18 1
7 | 2 |bagasgagahprakoso | L |Bangka |10 November 2001  |JI. Metro Jaya | No. 44 2
8 | 3 |diniyah syafitrah P akarta s April 2002 WL, Sirap Me. 1 Rt 003/001 1
o | 4 |dewi meisye alifiah P |Madura |27 Mei 2000 Wl Waringin IV No. 15 Rt 007/08 3
10 | 5 |diwani ahmar P |Jakarta |1 Agustus 2000 I, Plapon 11l / 17 Rt 003/07 1
11 | ¢ |ellyarahmanti yusuf P |Bangka |31 Juli 2001 L. Pulo Nangka Barat I / 22 2
12| 7 alfandry L Jakarta 12 Juli 1598 i, Peimuda ! No. 35 Rt. 04/03 i
13 | 8 |al-zahra aishanamira| P |Madura [31 Oktober 1999 . Porselen II/6 Rt. 11/03 3
14 | 9 |analuffiana P akarta |15 Mei 1999 WL, Kusen 11I/3 Rt.002/02 2
15 | 10 |ade yunita P lJakarta |28 Juni 1996 L. Kusen III No. 29 2
Gambar 8.11 o L
Data siswa yang akan diurut 2
3
Sumber. Dokumen penulis

Pilih data yang termasuk pada pengurutan
data

1. Klik Data.
2. Pilih Sort sehingga menampilkan data
seperti ini.

3. Atur sort By pada KELAS.

4. Atur Then by pada NAMA.

5. Klik OK.

SMP 11 KAYU PUTIH

dJI. KunciNo, 28 Kel Kayu Putih Kec Pulogadung Jak-Tim

Gambar 8.12
Penandaan data

Sumber. Dokumen penulis

[ e

[sort Criteria| Options
Sort by
O A
[kELAS %]
@ Descending
Then by
® As
[NAMA B
O De!
Then by
[- undefined - ®

() Descending

[ ok |[cancel |[ Help |[ Reset

Gambar 8.13
Pengaturan sort

Sumber. Dokumen penulis
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B. Menyaring Data

Suatu saat kita akan mencari data tertentu untuk dilaporkan, tetapi data tersebut
sangatlah banyak dan tidak mudah untuk menemukannya secara manual. Bagaimana
OpenOffice.org memecahkan masalah ini? Dengan fasilitas Filter kamu dapat
menampilkan tabel berdasarkan kriteria tertentu.

Ada 3 cara penggunaan Filter:

|| AutoFilter

1. Autofilter
2. Standard Filter
3. Advanced Filter
Data | Window Help
Define Range...
Select Range...
Sort...
Gambar 8.14 I Eilter
Menu menyaring data | DataForm...
Sumber. Dokumen penulis Subtgta|5m

b 4 #handard Filter...
& Advanced Filter...

Pada sebuah kargo pengiriman barang, akan mengirim buku petunjuk telepon
atau yellowpage ke pelanggan telepon di seluruh DKI Jakarta, untuk itu manajer kargo
membagi ke dalam lima wilayah, yaitu Jakarta Timur, Jakarta barat, Jakarta Pusat,
jakarta Utara dan Jakarta Selatan. Ternyata data yang didapat hanya satu dan semua
alamat dan wilayah tidak berurutan.

Dari kasus di atas seorang administrasi berinisiatif untuk melakukan penyaringan
data atau filter berdasarkan wilayah, berikut ini tabel pelanggan telepon yang akan
mendapatkan buku yellow pages.

Al B | C [ D E F G
1
2 [DATA PELANGGAN TELEPONy
3
: No. Nama Pelanggan Alamat Wilayah kode area | No Pelanggan
] 1 [Hafidz Atamim WL, Cililitan kecil Rt 00402 no.15 Jakarta Timur 021 8090408
7 2 |Bahrul Uum . Kembang Rt 01/02 Jakarta Barat 021 6874229
8 3 |Miftahul Janah WI. Kucing RT 05/02 Jakarta Selatan 021 7232311
9 4 [Mahdi Jamil WJI. Kemangi Rt 11/ 12 no 15 Jakarta Selatan 021 7792552
10 5 |Nanang Kuswana I Walilkota Rt 05/11 no. 23 [Jakarta Pusat 021 3191223
11 6 |Ali Mansur WI. Kunci gang sempit Bt 09/06 no.28  [Jakarta Timur 021 8498129
Gambar 8.15 12 | 0 7 [Sumatin |Jl. Pasar Rebo Rt 03/04 No. 20 Jakara Selatan 021 7982134
Daftar pe|anggan 13 8  |Masagus lhsan I, Pesing Gang lkan Rt 004/01 Jakarta Utara 021 4412367|
14 9  |Wahyu Catur WI. Kerja Bakti Rt 15/03 no.22 Jakarta Timur 021 8088543
telepon |5 10 |Khatiiah L. Mangga Besar Rt 05/02 No. 77 Jakara Baral 021 6690611
Sumber. Dokumen 16 11 [Hengki lrawan WI. Pejaten barat Rt 18/8 no. 88 Jakarta Selatan 021 7077538
li 17 12 |lmam Darmawan WJl. Cacing gang kober RT 04/02 NO. 4 |Jakarta Utara 021 8016179
penutis ie i3 |Rnojfan Widnanic Wi, Swadaya Ri 01.09 ro 44 Jakara Pusal oz 3100522,
19 14 |Sarud Siswoyo WI. Raya Condet gang sampit Rt 06/03 [Jakarta Timur 021 8841922
20 15 [Siswanto ki, Grogol Rt 09/05 no. 66 Jakarta Barat 021 5672142
21 S
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1. Autofilter

Dari tabel di atas tampilkan alamat berdasarkani wilayah dengan
cara sebagai berikut:

Langkah pengerjaan:
1. Blok seluruh tabel
2. Klik Data

3. Pilih Filter

4. Pilih Autofilter

W] B | c | D | e [ £ [ &6 M

[DATA PELANGG AN TELEFON h

Gambar 8.16
Seleksi data filter

Sumber dokumen penulis

& Sehingga muncul anak panah ke bawah pada kolom wilayah

W B ] T | D E F [ 6 |H Gambar8.17
4 Tanda autofilter
2 DATA PELANGG AN TELEPON '
3 Sumber. Dokumen penulis
; Mo, * Mama Pelmgan ¥ Alamat * Wilayah ¥ koda a ¥ T\b@ﬂﬂﬂﬂ ‘
5] 1 |Hafidz Atamim L Cililitan kecil Rt 00402 no 15 Jakarta Timur 021 8020408
7 2 |Bahrul Um L Kembang Rt O1/02 Jakarta Barat 021 6874229
g 2 |Miftahul Janah L Kucing RT 0502 Jakarta Selatan | 021 723231
9 4 |Mahdli Jamil L Kemanpgi Rt 11/ 12 no 15 Jakarta Selatan | 021 TT92552
10 5 |Mapang Kuswana L Walikota Rt 0511 no. 23 Jakarta Pusat 021 3191223
ALk 6 |AliMansur L Kunci gang sampit Rt 08006 no. 28 Jakarta Timur 021 G498129
12 7 |Sumarini .| Pasar Bebo Rt 08/04 No. 20 Jakarta Selatan | 021 7982134
L] 8  |Masagus lean L Pesing Gang lkan Rt 00401 Jakarta Liam 021 4412357
14 9 |Wahyu Catur L Keja Bakti Rt 1503 no 22 Jakarta Timur 021 B088543
15 10 |Khatih I llangga Besar At 0502 Mo, 77 Jakarta Barat 021 BES061 1
16 11 |Hengki lrawan L Pejaten tamt Rt 18/8 no. 88 Jakarta Selatan | 021 TO77838
ik 12 (Imam Darmawan L Cacing gang kober RT 0402 NO. 4 |Jakarta LiaE 021 5016179
18 13 |Khdlifah Wichianto L Swadaya Rt 01.09no 44 Jakarta Pusat 021 3100522
19 14 [Sanri Sewoio 1| Baya Conckt gang sampit FOG03  |Jakarta Timur | 021 841922
20 15 |Siswanto L Grogol Rt o805 no. 85 Jakarta Barat 021 BE72142
21
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Gambar 8.18
Menu pilihan filter

Sumber. Dokumen penulis

Gambar 8.19
Menentukan pilihan
kaya kunci filter

Sumber. Dokumen penulis

Gambar 8.20
Hasil filter pilihan Jakarta
selatan

Sumber. Dokumen penulis

Gambar 8.21
ilter pilihan Jakarta barat

Sumber. Dokumen penulis

Gambar 8.22
Hasil filter top 10

Sumber. Dokumen penulis

1. Klik anak panah pada kolom wilayah dan tentukan wilayah mana

All
Top 10 yang akan ditampilkan.
Standard Filter... . .
- empty - 2. Tampilkan untuk wilayah JAKARTA TIMUR.
- not empty - Kli . .
. Klik nak panah Kolom Wilayah hin muncul men

LR 3 p.a'da ana pa' ah Kolo aya gga muncul menu
lakarta Pusat dan pilih Jakarta Timur.
lakarta Selatan
lakarta Timur
lakarta Utara
[No. [#] NamaPelanggan [+ Alamat [#] wiayah [*]kode arfh]No Pelanggll

1 |Hafidz Atamim 1. Gililitan kecil Rt 004/02 no.15 Jakarta Timur 021 809040
! 6 |Ali Mansur JI. Kunci gang sempit Bt 09/06 no.28 Jakarta Timur 021 840812
9 |wahyu catur JI. Kerja Bakti Rt 15/03 no.22 Jakarta Timur 021 808854

14 [Sarur Siswoyo JI. Raya Condet gang sampit Rt 06/03  [Jakarta Timur 021 884192

Tampilkan untuk wilayah JAKARTA SELATAN.

Klik pada anak panah kolom wilayah @ sehingga muncul menu dan pilih Jakarta
SELATAN.

MNo. [#] Mama Pelanggan + Alamat *| Wiayah *lkode al Mo Pelanggg

1 |Hafidz Atamim J1. Gililitan kecil Rt 004/02 no.15 Jakarta Timur 021 809040

6 |Ali Mansur JI. Kunci gang sempit Bt 09/06 no.28 Jakarta Timur 021 840812

I 9  |Wahyu Catur JI. Kerja Bakti Rt 15/03 no.22 Jakarta Timur 021 808854
14 [Sarur Siswoyo JI. Raya Condet gang sampit Rt 06/03  [Jakarta Timur 021 884192

Tampilkan untuk wilayah JAKARTA BARAT.

Klik pada anak panah pada kolom wilayah @ sehingga muncul menu dan pilih
Jakarta BARAT.

No. |* Nama Pelanggan & Alamat *|  Wiayah *|kode arﬁ]No Pelanggé}
2 |Bahrul Ulum JI. Kembang Rt 01/02 Jakarta Barat 021 6874229
10 [Khotijah JI. Mangga Besar Rt 05/02 No. 77 Jakarta Barat 021 6690611
15 |[Siswanto 1. Grogol Rt 09/05 no. 66 Jakarta Barat 021 5672142

2. Autofilter untuk Menampilkan 10 data teratas

Tujuannya adalah menampilkan 10 data dari tabel tersebut, pada tabel di atas
yang dapat menampilkannya hanya pada kolom NO.

Klik anak panah pada kolom No. lalu pilih Top 10.

to. [#] Hama ¥ Almat 3 Wikvah _ [#]koceara [ MM
5 [AllMamsu L Kunci gang s2mpt At 0906 n0.28 _ [Jakarta Timur 021 5496125
7 |Sumarini L. Pasar Bebo Rt GB/04 No. @0 [ Jakarta Selatan 021 7982134
8| Ibsan 1. Pesing Gang lian At 00401 | Jakarta Utam 021 4412357
9 [Wahyu Catur L. Kerja Bakti Rt 1508 no. 22 [Jakarta Timur 021 8085547
10 [Khatjah L. Iangga Besar Rt 05102 No. 77 | Jakarta Barat 021 BEE0611
11 |Hengki lrawan L. Pejaten bt Rt 18/8 no. 88 [ Jakarta Selatan 021 7077538
12 |imam Carmavan L Cacing gang kober RT 0402 NO. 4 [Jakarta Ltam 021 8016179
13 [Kholifah Wichianto L. Swadaya Rt 01.08 no 44 | Jakarta Pusat 021 3100522
14 |Sami Swoyo L. Baya Condet gang sampit At 0503 [Jakarta Timur 021 8841922
15 |Siseanto L. Grogal Rt cBI05 no. 65 | Jakarta Barat 021 5672142

Untuk mengembalikan autofilter ke posisi tabel semula caranya sama seperti akan
mengaktifkan autofilter yaitu:

1. Klik Data.
2. Pilih Filter.
3. Pilih Autofilter.

Teknologi Informasi dan Komunikasi N
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C. Menyajikan Data dalam Bentuk Grafik

Seorang pengambil keputusan ketika mempresentasikan data untuk menghasilkan
suatu keputusan dengan cepat dan tepat, maka data yang ditampilkan tidak berbentuk
tabel lagi, karena akan menyulitkan pembaca untuk mengetahui perubahan data tersebut

dengan cepat.

Agar data tersebut dapat dimengerti dengan cepat dan tepat, yang paling
memungkinkan adalah dengan menampilkan dalam bentuk grafik. Dengan grafik
seseorang bisa mengetahui bahwa nilai tertinggi ditunjukkan dengan gambar yang
paling besar, atau nilai terendah ditunjukkan oleh gambar yang lebih kecil.

1. Menyiapkan data

Data dalam grafik adalah penentu dari bentuk pergerakan grafik, data yang
disajikan merupakan kesan atau cara pandang sehingga bagaimana grafik dapat

disimpulkan oleh yang membacanya.

Bagaimanamenyiapkandata? Banyakcaranya, misalnyadenganmengumpulkan
data dari sensus penduduk, survei, studi banding, wawancara dan lain-lain. Setelah
data terkumpul kemudian data diolah dan menghasilkan sebuah tabel data. Judul
tabel data tergantung dari kumpulan isi data tersebut yang relevan.

Perhatikan sebuah data yang dimiliki sebuah lembaga kursus, berupa data nilai

siswa.

a | B c | bo ] E F |

1 |DATA SISWA

2 e OpenOiffice Rata —

3 Nama |[Writer | Calc |Inpres| rata

4 [ 1 [Fatih 70 75 95| 80

5 | 2 |Zaid 80 80 80| 80

6 | 3 |Affan 60 85 75| 73.33

7 | 4 [Hexa 80 70 80| 76.67

g | 5 |Lala 90 80 70| 80 Gambar 8.23
Data sumber

= Sumber: Dokumen penulis
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Gambar 8.24
Type chart

2. Membuat

grafik

Setelah menyiapkan data yang dibutuhkan untuk dijadikan sebagai grafik,
berikutnya lakukan langkah — langkah pembuatan grafik sebagai berikut:

1). Siapkan tempat untuk meletakkan grafik, misalnya di sheet?2.
2).Klik Insert.

3).Pilih Chart.

4). Setelah muncul kotak chart wizard pilih type grafik yang akan dibuat, klik Next.

Ghart Wizard'

=
teps | cChoose a chart type
Sl Colurmn
{Chart Type lus =
Ll |=- Bar |
Data Range & Pie
b Area
Data Series L‘
|2 Line Normal
Chart Elements XY (Scatt
\ﬁ (Scatter) [] 3D Look |[Simple
[2 Met
[+ stock Shape
lgiil Column and Line Bok
Cylinder
Caone
Pyramid
Back ‘ Next == | I Finish ] ‘ Cancel |

Sumber. Dikumen penulis _ Hep |

Gambar 8.25
t atau range seleksi data

Sumber. Dokumen penulis

Gambar 8.26
Memilih data yang akan
dibuat grafik

Sumber. Dokumen penulis

Gambar 8.27
Kotak pemilihan data

Sumber. Dokumen penulis

5). Setelah memilih type grafik, tentukan data yang akan kamu jadikan grafik dengan

mengklik shrink |

3.Data Series

4. Chart Elements

Chart Wizard x|
Steps Choose a data range
1.Chart Type Dardiangs
[$5heetl. $B43:3E%8 J
2.Data Range

() Data series in rows
@ Data series in columns
WA Eirst row as label

&4 First column as label

e
Hexa | a0l 70l  aolleliXew

80

6). Pada sumber data atau tabel tandai data
dengan memblok data tersebut seperti
gambar di samping ini.

<= Back H Next == ‘ { Einish ] | Cancel ‘
Al B [ € [ b [ E T F ]
1 |DATA SISWA
2 No OpenOiffice Rata —
3 Nama |Writer | Calc |Inpres| rala

7).Klik lagi toolbar shrink seperti pada gambar ini.

$TABEL.$B%3:$E$8

150 . Teknologi Informasi dan Komunikasi
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8).Setelah kembali dalam chart wizard akan terlihat nama data series yang akan
ditampilkan dalam grafik, kamu bisa menambah atau mengurangi data series

yang akan ditampilkan.

Enartvnzard

Customize data ranges for individual data series

Steps

1. Chart Type Data series Data ranges
Writer Name $Sheetl. $C$3

2. Data Range Calc Yalues $Sheetl. $CH4: $C$8
Inpres

L

4, Chart Elements
Range for Name

[$5heetl.§C43 |[&]
Add |r‘ Categories
v (e e 1o
| << Back H Next == | [ Einish ] | Cancel |

9). Tentukan judul grafik dan judul data yang digunakan, lalu klik Finish.

Cnarizard

Steps | Choosetitles, legend, and grid settings
f Display | d
1. Chart Type Ttle | | W Display legen
() Left
2, Data Range Subtitle [ ] O L
Right
3.Data Series X axis [ ] @ Rig
O Iop
4. Chart Elements ¥ axis [ ]
() Bottom
Zs [ |
Display grids

Choose titles, legend, and grid settings

[ litle [GRAFIK NILAI KOMPUTER | | & Displaylegend
Subtitle  [LPK NURUL FIKR| | O Left
X axis [SISWA | O Right
To
¥ axis (LAl | @ 1op
) Bottom
Z axis | |
Display grids
[] X axis Oo¥ [0 Z axis
Display grids ‘
[ X axis [ i s 0 Z axis
10).Setelah Finish maka grafik telah jadi dan hasilnya seperti berikut ini.
A [ B [ C |
—  GRAFIK NILAI KOMPUTER
| 3 | LPK NURUL FIKRI
L | B writer Bac Oinpres
5
s |
Ea
[ | 60
9

NILAI

- wﬂ Iiﬂll\

gambar 8.28
Kotak informasi data
yang dibuat grafik

sumber document penulis

Gambar 8.29
Menentukan judul
grafik

Sumber. Dokumen penulis

Gambar 8.30
13 Fatih Zad Affan Hexa Lala Hasil tamp”an graﬂk
14 SISWA batang
15 .
<]/ </~ |+ [\ _TABELY, GRAFIK /Sheeta 7/ |[<] I Sumber dokument penulis
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Chart.

Cara cepat mengganti
format grafik adalah
dengan dobel klik pada
bagian grafik yang
ingin diganti

Gambar 8.31
Tampilan editor grafik

Sumber: dokumen penulis

Gambar 8.32
Toolbar formatting

Sumber: Dokumen penulis

Tabel 8.1
Fungsi simbol dalam
pengaturan grafik

3. Mengedit grafik

Suatu saat kamu akan mengubah type grafik atau menyembunyikan dan
menampilkan salah satu dari judul grafik tersebut kamu tidak perlu membuatnya

dari awal.

Cara Mengedit Grafik adalah sebagai berikut:

1).Klik 2x pada grafik, sehingga masuk ke dalam editor grafik.

2). Tentukan bagian mana yang akan diubah dari tampilan grafik yang sudah dibuat
sebelumnya dengan mengklik toolbar formatting dalam editor grafik.

B ERAT TR OPENO T EEIOrGICaE:
File Edit View Insert Format Tools Window Help

oA BEE ¥BB s e,

EpxLew a8 a00 A=,
A [ B [ C [ D [ E

5]
ol
=

SYMBOL NAMA
e TOOLBAR TOOLBAR AUl
1 TitleOn/Off Menimbulkan atau
. menyembunyikan Judul
2 = Legend On/Off |Menimbulkan atau
menyembunyikan
- Keterangan warna
3 ul Axes Title On/  |Menimbulkan atau
het Off menyembunyikan judul
data
4 Show/Hide Axis |Menimbulkan atau
L Description(s) |menyembunyikan descripsi
data
5 Horizontal Grid |Menimbulkan atau
% On/Off menyembunyikan garis
bantu horizontal
6 Vertical Grid On/ |Menimbulkan atau
1l Off menyembunyikan garis
bantu vertikal

2520
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SYMBOL

NAMA

FUNGSI

TOOLBAR TOOLBAR
7 @ Chart Type Mengubah jenis grafik
i
8 @ AutoFormat Mengubah format grafik
9 Chart Data data grafik
10 Data In Rows Menampilkan data diambil
dari baris
11 Data In Columns |Menampilkan data diambil
dari kolom
12 Scale Text Mengubah ukuran teks
Al
13 Reorganize mengorganisasi ulang
I Chart grafik

raktikum

A. Praktikum membuat grafik batang (bar)

A [

[ c I D [

E

E [z

-

¥

Jumlah Penduduk menurut Provinsi

Tahun 1971 - 2005

- ;

4 | Provinsi 1971 1980 1990 2000 2005

5 |Aceh 2.008.595 2.611.271 3.416.156) 3.929.234| 4.031.58

s [Sum Utara 6.621.831 8.360.894| 10.256.027| 11.642.488 12.450.911) |

7 1Sum Barat 2.793.198  3.406.816  4.000.207, 4.248.515 4.566.12
Riay-- - - |- 1.641.545/ 2,168,535 - 3.303.976] 3.907.763 4.579.21

s tamhi 1.006.084] 1,445994 2020588 2.407.165 2.635.98
Sum Selatap  3.440.573]  4.629.801 6.313.074 6.210.800! 6.782.339

Gunakan tabel di atas untuk membuat grafik seperti berikut ini

Gambar 8.33
Data pertumbuhan penduduk

Sumber. Dokumen penulis

Teknologi Informasi dan Komunikasi
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11000000

9000000
8000000
7000000
6000000

NDUDUK

[ Aceh

W Sum Utara

= Sum Barat

5000000

WRiau

4000000

JUMLAH PE

3000000
2000000
1000000

WJambi
[ Sum Selatan

1971 1980 1990 2000 2005
TAHUN

Gambar 8.34
Hasil pembuatan grafik batang

Sumber. Dokumen penulis

B. Praktikum membuat grafik

lingkaran (pie)

Buatlah tabel seperti berikut ini:

C. Praktikum membuat grafik
lingkaran 3 D

Buatlah tabel seperti berikut ini:

B c D E F

1 Laju W Pen‘duduk per TaLun menun.lt‘Provinsi :
2 Annual Rate of Growth by Province
3

[ 4 |Sumber/Source : Sensus penduduk (1971,1980,1990,2000) dan Supas 2005
s [ Provinsi Periode / Period
6 | Province | 1971-1980 | 1980-1990 | 1990-2000 | 2000-2005
7 [Aceh 2.93 2.72 1.48 0.52)
8 [Sum Utara 2.6| 2.06 1.32 1.35
9 |sum Bant 2.21 1.62) 0.63 1.49
10 [Riau 3.11 422 4.35 4.08)
11 [Jambi 4.07 3.39 1.84) 1.84]
12 [Sum Selatan 3.37 3.15 2.39 1.78)
13 Bengkulu 4.39 438 2.97 1.26)
14 Lampung 5.77 2.67 1.17 1.38]
15 1okl 2.03 2.38 017 [E
16 |Ja Barat 2.26 2.57 2.07 1.75)

A I B I c I D [
1| Jumlah Penduduk menurut Kelompok
2 Umur, Jenis Kelamin 2005
3 Number of Population by Sex and Age Group
. |Sumber Source : SPAN (Sensus penduduk Acehdan Nias), SUPAS (Sensus Penduduk
° |Antar Sensus) 2005
° | Umur | Laki-laki | Wanita Total
7 Oold Male Female Total
0-4 844916 976208 1821124
o |15-24 844916 976208, 1821124
10 [25-39 1374207 1339222 2713429
11 40-59 885880 855228 1741108
12 50-74 181525 106856 288381
12 [75+ 2109 24843 26952

Gambar 8.34

Data yang akan dibuat grafik

Sumber. Dokumen penulis

Gunakan tabel di atas untuk membuat grafik

seperti berikut ini
JUMLAH PENDUDUK

Menurut Kelompok Umur

/)

Gambar 8.36
Grafik pie

Sumber. Dokumen penulis
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Gambar 8.35
Data sumber bahan pembuat grafik

Sumber. Dokumen penulis

Gunakan tabel di atas untuk membuat
grafik seperti berikut ini

PERTIIMBIIHAN PE
[T A

I
INDONESIA

1971 - 2005

nLintl
et

(O AU AN

[ Aceh
[l Sum Utara
[l Sum Barat
H Riau

[l Jambi
[H Sum Selatan

|

(

Gambar 8.37
Hasil pembuatan grafik

Sumber. Dokumen penulis




1. Sebuah pekerjaan dapat dikerjakan dengan cepat jika bekerjanya dengan menggunakan sistem.
Sistem yang digunakan dalam komputer adalah database.

2. Database dalam spreadsheet berupa pengurutan data, dan penyaringan data.

3. Untuk mengambil keputusan dapat juga dibantu dengan bantuan spreadsheet berupa gambar
grafik.

4. Grafikmenunjukkan perubahan, yang terjadi pada setiap data yang dapat menggambarkan sesuatu
kejadian meningkat atau menurun, baik atau buruk, maju atau mundur dan lain sebagainya.

Teknologi Informasi dan Komunikasi
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ISTILAH

KETERANGAN

Data Keterangan atau bahan nyata yang dapat dijadikan dasar kajian (analisis atau
kesimpulan);
Administrasi |Kegiatan kantor dan tata usaha
Proses Rangkaian tindakan, pembuatan, atau pengolahan yang menghasilkan produk
Perangkat unsur yg secara teratur saling berkaitan sehingga membentuk suatu
System .
totalitas
Informasi 1 Penerangan; 2 Pemberitahuan; kabar atau berita tentang sesuatu
Basis Dasar
1 Carik kartu, daftar, atau buku yang memuat nama benda atau informasi tertentu
Katalo yang ingin disampaikan, disusun secara berurutan, teratur, dan alfabetis: kartu
9 -- membantu memudahkan orang mencari buku di perpustakaan; 2 Map daftar
barang yang dilengkapi dengan nama, harga, mutu, dan cara pemesanannya;
Mengolah 1 Orang yang mengolah data; 2 Alat (mesin, komputer) yang mengolah data;

% Teknologi Informasi dan Komunikasi
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Evaluasi 2

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

Definisi informasi menurut McFadden adalah 6. Grafik batang disimbolkan dalam type chart

a. Data yang diolah sehingga dapat dijadikan
pengambil keputusan

b. Meningkatkan pengetahuan
menggunakan data

c. Datayang menyebabkaninformasi menjadi
pasti

d. Pemberitahuan kepada masyarakat

yang

Berikut ini yang termasuk pemanfaatan sistem

informasi ....

a. Mengetik dengan mesin tik

b. Penggunaan kalkulator

c. Jadwal kedatangan dan keberangkatan
pesawat

d. Pencatatan meteran listrik

Pengurutan data dari A sampai Z disebut

pengurutan ....
a. Ascending
b. Descending
c. sort

d. autofilter

Langkah untuk menyaring data adalah ....
a. Insert - picture

b. Data - Sort

c. Data - filter

d. Format - page

Penyaringan dengan menampilkan 10 data
pertama, dengan cara ....

a. all

b. Top 10

c. Standar filter

d. autofilter

a. pie
b. bar
c. line
d. area

. Legend pada graphic akan menampilkan ....

a. jenis grafik

b. keterangan judul
c. keterangan warna
d. garis bantu

. ||Tombol ini digunakan untuk ....

a. Memilih data

b. Memilih type graphic

c. Menentukan Judul

d. Menentukan keterangan

. Untuk menampilkan data dengan lebih dari

dua kriteria menggunakan ....
a. Advanced filter

b. Autofilter

c. Standard filter

d. All

.Pengurutan descending adalah mengurutkan

a. Dari yang terendah ke yang tertinggi
b. Dari yang tertinggi ke yang terendah
c. Secara acak

d. Tidak berurutan

Teknologi Informasi dan Komunikasi .
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B.Lengkapi pernyataan berikut ini.
1. Klik . ... lalupilih . ... adalah langkah untuk menyaring data.
2. Klik....lalu pilih....adalah langkah untuk mengurutkan data.
3. Pilih . ... untuk memilih jenis grafik.
4. Mengurutkan secara . . . . menghasilkan654 3 2 1.
5. Mengurutkan secara . . . . menghasilkan RSTUV W.

C.Jawablah pertanyaan berikut ini dengan singkat dan tepat.
1. Sebutkan tujuan menyaring data.
2. Sebutkan manfaat pembuatan grafik.
3. Grafik lingkaran ditunjukkan oleh type chart . . . .
4. Untuk mencari nama yang huruf depannya A dilakukan . . . .
5

. Agar data dapat terlihat 10 data teratas menggunakan . . . .
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Evaluasi 2

SEMESTER I

A.Berilah tanda silang (X) pada jawaban yang paling tepat.

1.

Jenis format data yang digunakan untuk g

membuat presentase adalah ....
a. Number

b. Currency

c. Date

d. Percent

. Fasilitas dalam Calc untuk memisahkan sel

adalah ....

a. Merge Cells
b. Split Cells
c. Margin

d. Preview

Perintah yang digunakan untuk menampilkan
kembali kolom yang disembunyikan adalah
a. Show
b. Hide

c. Auto Fill
d. Width

Ikon pada toolbar formating yang berfungsi
untuk mengatur ukuran huruf bernama ....
a. Font Style

b. Font Name

c. Font Size

d. Type Font

. Yang dimaksud dengan gridlines adalah ....

a. Tabel bantuan
b. b. Garis bantu
c. c. Baris bantu
d. d. Kolom bantu

. Cara cepat

. Fungsi Cell Protection adalah ....

a. Melindungi file

b. Memproteksi virus
c. Mengunci kolom
d. Mengunci sel

. Pengaturan halaman dan jenis kertas dapat

dilakukan melalui menu ....
a. File

b. Edit

c. Format

d. Help

untuk membuka file Calc,
menggunakan tombol pada keyboard adalah

a. CTRL+O
b. CTRL+ N
c. SHIFT+ 0O
d. SHIFT + N

. Untuk melihat versi OpenOffice.org Calc yang

digunakan, dapat dilakukan melalui ....
a. File

b. Edit

c. Format

d. Help

.Ikon untuk mewarnai tulisan terdapat pada

toolbar ....

a. standard

b. foramatting
c. drawing

d. Foramula Bar

Teknologi Informasi dan Komunikasi .
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. Openoffice pada linux sama dengan .... pada 15.Penggunaan Rumus berikut ini menghasilkan

windows. nilai 8.5 ....

a. Microsoft Word a. =MIN(9.5;8.5;8.7)

b. Microsoft Excel b. =MAX(9.5;8.5;8.7)

c. Microsoft Powerpoint c. =AVERAGE(9.5;8.5;8.7)

d. Microsoft Publisher d. =SUM(9.5;8.5;8.7)
12.Formula yang menghitung range terdapat 16.Proses pengurutan data dari yang tertinggi ke

pada rumus .... yang terendah disebut ....

a. =(A3+A4+A5) a. Descending

b. =Sum(A3:A5) b. Ascending

c. =Sum(A3+A4+A5) c. Decrease

d. =A3;A4;A5 d. Increase

Perhatikan table berikut ini untuk menjawab 17

.Mencari data dengan menyaring data
pertanyaan nomor 3, 4 dan 5

menggunakan fasilitas ....

a. Sort
. Nilai b. Filter
No. | Nama Siswa oa 1 1ps | MTK c. Subtotals
d. Validity
1 | Fatih Nasrullah | 9.5 | 8.6 |8.6 Perhatikan tabel dibawah ini:
2 Ariefuddin Faiz | 8.7 8.9 |94 No. (¥ MamaPelanggan |* Alamat ¥ Wiayah [¥]kode argh{o Pelan
3 Farld Al’kan 8 5 9 3 8 6 2 B,QDMM iLKembang Rt 01/02 Jﬂkﬂﬂag@@_ 02 6874229
i i i 10 Khotian |, Mangoa Besar Rt 0502N0. 77 JakartaBargt | 021 8630611
Rata — Rata 15 |Siswanlo 1, Grogol At 03/05 no. 66 Jakara Barat | 021 5672142
Nllal Pelajaran i ——————}
Nilai Tertinggi 18.Pada tabel diatas yang menjadi kunci Filter
Nilai Terendah data adalah ....
a. Nama Pelanggan
_ _ o b. Alamat
13.Pada Tabel diatas untuk menghasilkan nilai c. Wilayah

rata — rata menggunakan rumus ....

a. Sum

b. Average 19. Perhatikan grafik berikut ini

C. MaX A [ B [ C [
d. Min - GRAFIK NILAI KOMPUTER

LPK NURUL FiKRI

w

14.Jika diterapkan rumus nilai tertinggi pada
pelajaran IPS maka hasilnya adalah ....

IS

B yyriter B calc Ijlnpres

wu

(=]

a. 8.6 z &
8
b, 6.9 e 0 IFi
S -
d. 8.5 12 0
] Fatih Zaid Alfian Hexa La
14 SISWA

TABELY GRAFIK /Sheet3 13
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Grafik ini bertype 20.Pada Grafik tersebut menunjukkan bahwa

a. Pie nilai tertinggi ada pada pelajaran ..... dengan
b. Bar nama siswa ....

c. Area a. Writer, lala

d. Line b. Impres, Affan

c. Impress, Fatih
d. Calc, Zaid

B.Lengkapi pernyataan berikut ini.

N o a kb=

Lembar kerja spreadsheet terdiridari.... dan....

Baris akhir yang terdapat pada spreadsheet calc adalah . . . .
Kolom terakhir pada spreadsheet calc adalah . . . .

Membuat teks bergaris bawah, adalah fungsi dari ikon . . . .
Membuat teks bercetak miring, adalah fungsi dari ikon . . . .
Untuk mengambil keputusan dengan cepat dengan melihat . . . .

Fungsi yang menghasilkan kebalikan dari pernyataannya pada fungsi logika menggunakan
fungsi. . ..

8. Fungsi yang dapat merubah teks dari kecil ke besar menggunakan ...

9. Pembacaan teks “Open Source” sehingga menghasilkan teks “en Sou” menggunakan rumus

10.

Pembacaan teks “MENDIKNAS” sehingga menghasilkan teks “NAS” . . . .

C.Jawablah pertanyaan berikut ini dengan singkat dan tepat.

©® N o g b~ w0 DN~

Apakah format default dari data waktu

Sebutkan fasilitas yang digunakan untuk membuat penomoran otomatis

Perpotongan antara kolom dan baris sering disebut

Perpaduan atau gabungan dari sel disebut

Garis bantu pada worksheet, disebut

Sebutkan langkah menyaring data

Sebutkan langkan membuat grafik

Buatlah perhitungan berikut kedalam rumus

a. (5+6-2)/3

b. Jika harga pada B3>=5000 dan merk pada C3="sponsor” maka mendapatkan diskon 10%
dari harga selainitu 0. . ..

c. JikaMerk HP pada D4="NOKIA” atau kartu sim pada E4="MENTARI” mendapatkan souvenir
selain itu tidak . . . .

9. Sebutkan Program OpenOffice selain OpenOffice.calc . . . .

. Lembar kerja dalam OpenOffice disebut . . . .
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A

Absolute 194,

Administrasi 89,239

Aktivitas 196,240

Alignment 19, 59,170

And 20

Aplikasi 3,4,6,7,8,9,12,15,17,19,20,23,27,28,34
,35,41,42,112

Average 203

B

Basis 16,239

Border 48,49,60,61,65,66,81,90,92,97,98,105,1
06,112,131,186,188

C
Calc 2,131,135
Currency 139,189,

D

Data 15,23,58,89,90,91,98,101,102,103,106,10
8,111,112,131,

Database 2,255,

Disk 13,30,41,42,50,179

Drop caps 35,69,70,84,

E
Excel 142,147,
Exp 204

F

Fasilitas 9,26,42,49,70,84,90,91,93,102,154

Filter 71,131

Footer 28,33,38,43,72,84,85,173,

Format 2,3,4,9,14,19,20,48,50,52,55,58,60,62,
66,67,69,71,72,78,81,82,83,90,91,92,

Formula 100,101,102,186,206

Fraction 168,

Fungsi 3,7,8,9,10,11,12,13,14,15,16,19,22,28,
34,35,36,38,44,76,85,
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INDEXER

Ganda 10,13,17,65,227
Grafik 103, 104,142,245
Header 28,33,38,43,71,85

H
Hitung 4,14,21,69

I

If 227

Ikon 3,8,9,10,11,12,15,16,17,18,19,20,22,23,2
8,29,30,41,42,43,44,55,57,58,63,65,66,76,
77,80,84,

Informasi 7,12,27,47,48,49,241

Insert 9,13,38,48,50,51,63,64,72,84,208

K

Kalkulator 21,28,234

Keyboard 3,12,14,15,18,19,20,22,28,30,41,42,
44,54,82,149

L

Left 11,33,61,81,218,219
Linux 4,5,194,

Logika 152,224

Lower 224

M

Margin 33,36,38,44,173,
Max 7,204

Mengurutkan 94,

Merge cells 94,

Min 204

Mod 207

N
Not 224

(o)

Opencoffice.org 3,
Operator 101,151,
Or 224,



P

Page preview 10,183

Paragraf 9,13,14,19,22,28,35,36,55,60,61,63,5
7,69,70,82,85,

Password 28,42,43,181

Product 207

Program 2,3,4,5,6,7,8,12,13,17,19,20,22,28,30,
41,42,43,49,50,71,240

Proses 9,18,20,60,139

R

Rata-rata 100,
Relative 234
Right 11,33,61,81
Round 204
Rumus 114,151,

S

Save 9,10,13,19,28,41,42,43,50,66
Scientific 167

Sel 114,129,167,195

Shortkey 3,12

Slash 196,

Software 3,4,22,23,27,49,50,85,
Spreadsheet 186,

Sqrt 205

Standard 9,30,92,246

Statistic 202

Status 6,12,22,125,244,

Supermarket 193,239
System 123,170,240

-

Table 9,10,95,

Terendah 202,241,242

Tertinggi 234,244,249

Toolbar 3,6,8,9,10,11,12,13,17,18,19,20,29,41,
42,43,55,57,58,70,75,76,77,80,96,138,

Type 52,79,81,104,137,250

U
Upper 210,211

w
Windows 4,7,14,142,194
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Evaluasi Bab 1

A. Pilihan Ganda
1). d. Pengolah kata
2). a. Linux dan Windows
3). d. Office
4). c. Text Documents
5). b. Title Bar
6). b. Menyisipkan gambar
7). b.B
8). a. Menyimpan dokumen
9). a.Ctrl +C

10). a. Rata kanan

B. Melengkapi pernyataan

1). Toolbar Standard, toolbar formatting, dan toolbar drawing
2). OpenOffice.org

3). Menu maximize berfungsi untuk mengembalikkan ukuran atau memperbesar tampilan jendela
kerja pada program aplikasi OpenOffice.org Writer.

4). Scrollbar berfungsi untuk menggulung lembar kerja pada dokumen OpenOffice.org Writer.
5). View
6). Memasukkan gambar dengan cara meng-klik menu Insert >> Picture >> From File

7). Menu Bullets adalah daftaritem berbentuk simbol-simbol tertentu, sedangkan menu Numbering
adalah daftar item berbentuk huruf dan angka.

8). Kombinasi tombol pada keyboard berfungsi untuk menjalankan perintah-perintah tertentu
dengan cepat.

9). Berfungsi untuk meletakan hasil pemindahan paragraph atau teks dari perintah copy atau
cut.

10). Menu insert berfungsi salah satunya untuk menyisipkan gambar, simbol dan objek tertentu.
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C. Essay
1). Klik menu Application, Office dan kemudian OpenOffice.org Word Processor
2). Toolbar adalah kumpulan-kumpulan ikon yang memiliki perintah atau instruksi tertentu.
3). Document adalah suatu naskah yang akan diketik dan diolah pada aplikasi pengolah kata.

4). a. Menu Edit, berfungsi untuk proses perubahan naskah pada dokumen
b. Menu View, berfungsi untuk pengaturan tampilan lembar kerja.
c. Menu Insert, berfungsi untuk menyisipkan gambar dan simbol tertentu.
d. Menu Table, berfungsi untuk membuat dan mengedit tabel.
e. Menu Help, berisi fasilitas bantuan petunjuk penggunaan.

5). Ada 2 macam untuk menutup jendela dari program OpenOffice.org, yaitu:
a. Klik menu file, kemudian pilih Close
b. Klik menu file, kemudian pilih Exit

Evaluasi Bab 2
A. Pilihan Ganda
1). c. Mengganti dan menyimpan file baru
2). c. *.odt
3). a. File
4). b. OpenDocument Text
5). b. New
6). d. 7
7). c.Ctrl +S
8). a. Menyimpan dokumen
9). b.Ctrl + P
10). b. Before text
B. Melengkapi pernyataan

1). Tahapan pengolahan dokumen adalah
a. Klik menu File - New
b. Atur jenis dan format kertas dengan menu, Format >> Page
c. Ketik naskah
d. Simpan dengan menu File - Save As...
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2). Menggunakan menu Shortkey Ctrl + O atau ikon folder file

3). Fungsi Save As.... Adalah untuk mengganti nama dokumen yang baru di dalam komputer
kemudian disimpan kembali.

4). Dengan membuka menu Format - Page dan pilihlah menu Orientation.

5). Fungsi perintah Before Text adalah untuk mengatur jarak antara sisi kiri paragraf dengan
batas margin Kkiri.

6). Perbedaan Header dan Footer adalah area header berada di dalam margin bagian atas,
sedangkan area footer berada di bagian margin bawah.

7). Posisi kertas berbentuk datar disebut juga dengan Landscape.
8). Portrait adalah posisi kertas berbentuk tegak atau berdiri.
9). Ctrl + S, berfungsi untuk menyimpan dokumen yang sudah di ubah.

10). Untuk mencetak dokumen, kita dapat menggunakan menu ikon bergambar printer.

C. Essay

1). Langkah-langkah memformat halaman dokumen:
a. Buka dokumen yang akan diformat
b. Klik menu Format >> Page
c. Masukkan data nilai dan jenis kertas yang diinginkan
d. Kemudian klik tombol OK.

2). Menu-menu yang berada di dalam kotak dialog paragraph diantaranya adalah
a. Indents & Spacing, mengatur jarak dan posisi teks pada tiap kalimat atau paragraf
b. Alignment, pengaturan perataan teks
¢. Numbering, penomoran halaman
d. Border, membuat garis bingkai halaman.

3). File Recovery adalah file duplikat yang disimpan oleh program jika terjadi kerusakan pada
computer atau program OpenOffice.org Writer, namun file ini bersifat sementara.

4). a. Aktifkan menu Insert >> Header >> Default.
b. Aktifkan menu Insert >> Footer >> Default.

5). Jarak spasi pada teks adalah batas ukuran antara kalimat pertama atau paragraph dengan
yang berikutnya.
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Evaluasi Bab 3

A. Pilihan Ganda

1),
2).

3).

4).

5).
6).
7).
8).
9).

10).

a. Insert-Picture

c. bmp, jpg, gif

il

b. corner radius

a. Fontwork

b. Fontwork Gallery

c. Format

d. Menambahkan garis batas antar kolom
b. paragraf

d. watermark

B. Melengkapi Pernyataan

1),
2).

Keep ratio

Drop Caps

3). Arrange - Bring to Front

4),

5).

Outline

Header

C. Essay

1),
2).

Gambar, teks artistik, textbox, background dan bingkai.

Langkah-langkah membuat naskah dengan format kolom :

- Semua naskah diketik sampai selesai

Blok naskah

Aktifkan menu Format - Column

Pada column ketik jumlah kolom

Pilih garis pada Separator Line untuk menambahkan garis antar kolom
- Ok
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3). Bullets adalah pembuatan nomor urut menggunakan lambang, numbering adalah nomor
urut menggunakan angka atau abjad, sedangkan outline adalah pembuatan nomor urut
baik menggunakan lambang, angka maupun abjad secara bertingkat (di dalam nomor ada
nomor)

4). Send backward adalah perintah untuk memindahkan gambar di belakang satu gambar
lainnya. Sedangkan Send to back adalah perintah untuk memindahkan gambar ke bagian
paling belakang gambar lainnya.

5). Tabs digunakan untuk membuat naskah dengan tampilan seperti tabel.

Evaluasi Bab 4

A. Pilihan Ganda
1). c. Table
2). a. 5 kolom 4 baris 20 sel
3). a. autofit
4). a. mengubah lebar kolom sesuai banyaknya huruf
5). d. sum
6). d. tabel
7). a. memilih jenis grafik
8). c. cone
9). c. tranparancy

10). b. data label

B. Melengkapi Pernyataan
1). baris dan kolom
2). sel
3). Insert - Row
4). Chart

5). Grid
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C. Essay
1). Untuk mengelompokkan data berdasarkan jenisnya
2). Data lebih mudah dibaca dan dimengerti

3). Langkah-langkag menghapus kolom pada tabel :
- klik pada kolom yang akan dihapus
- aktifkan menu Table - Delete - Column

4). Lebih mudah dan lebih cepat untuk menganalisa data karena tampilannya dalam bentuk
gambar.

5). Jenis grafik yang ada pada Openoffice Writer antara lain :
- Column
- Bar
- Pie
- Area
- Line
XY (Scatter)
- Net
- Stack
- Column and Line

EVALUASI SEMESTER 1
A. Pilihan Ganda
1). a. picture
2). b. fontwork
3). c. Q
4). b. Fontwork Shape
5). a. set all four border

6). a. Insert Table

)

7). a. Cylinder
8). b.*
9). b. Baris pertama pada tabel digunakan sebagai label pada sumbu X

10). a. Judul tabel diulang pada saat tabel terputus halaman

- Teknologi Informasi dan Komunikasi
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11). a. OpenOffice.org

12).d. Undo

13).c. |

14). a. Align Center

15). a. Klik

16). a. Mengubah karakter pertama teks menjadi besar
17).c. Page

18). b. After Text

19). b. Footer

20).d. Ctrl + S

B. Melengkapi Pernyataan
1). Footer
2). Delete
3). Corner radius
4). Tab stop
5). Autofit
6). Split Cells
7). Border
8). Titles
9). Format - Chart Wall

10). Insert - Data Label - Show Value as percentage

C. Essay

1). Langkah-langkah menambahkan background dari gallery :
a. Klik ikon Gallery
b. Pilih gambar yang tersedia pada galerry
c. Klik tombol mouse kanan pada gambar yang di pilih
d. Klik Insert - Background
e. Pilih as Page untuk background halaman
f. Pilih as Paragraph untuk background paragraf
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2). Header diletakkan di bagian atas tiap halaman, sedangkan Footer diletakkan di bagian bawah
tiap halaman .

3). Langkah-langkah membuat nomor halaman :
a. Klik menu Format - Page
Aktifkan tab Footer
Ceklis pada Footer on
Posisikan kursor pada tempat dimana nomor halaman akan diletakkan.
Klik menu Insert - Fields - Page Number

© oo o

4). Langkah-langkah membuat nomor halaman :

Klik menu Format - Page

Aktifkan tab Footer

Ceklis pada Footer on

Hilangkan ceklis pada Same content left/right

e. Posisikan kursor pada tempat dimana nomor halaman akan diletakkan.pada halaman

ganijil

f. Klik menu Insert - Fields - Page Number

g. Posisikan kursor pada tempat dimana nomor halaman akan diletakkan.pada halaman
genap

h. Klik menu Insert - Fields - Page Number

oo oo

5). Teks pada Text adalah teks dalam bentuk paragraf biasa namun terletak dalam box sehingga
posisinya dapat dipindahkan ke mana saja. Sedangkan teks pada Fontwork lebih banyak
digunakan untuk judul, karena bentuknya artistik, lebih bersifat sebagai gambar.

6). Repeat heading digunakan untuk mengulang judul kolom apabila tabel terpotong sehingga
pindah halaman.

7). Menggabung dua sel atau lebih.
8). Aktifkan Insert - Legend. Ceklis pada Display - Legend, kemudian pilih Bottom, lalu klik OK
9). Aktifkan menu Format - Chart Type, lalu pilih jenis grafik.

10). Aktifkan menu Insert - Data Label, kemudian pilih Show Value as percentage

Evaluasi Bab 5
A. Pilihan Ganda
1). a. Lembar kerja
2). b. Perintah langsung atau cara cepat menggunakan perintah

3). a. Standart
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4). a. Format — Cell

5). b. Perpotongan baris dan kolom
6). c. Cut

7). b. Ditengah range

8). c. View toolbar

9). c. Edit— Undo

10). c. Membuat laporan keuangan

B. Melengkapi Pernyataan
1). Insert — Rows
2). Numerik (angka)
3). Toolbar Drawing
4). File — New

5). Bold

C. Essay

1). Beberapa ikon pada toolbar standart adalah: Open, New, Save, Print, Preview, Cut, Copy,
Paste, Undo, Redo, dan lain-lain

2). View — Toolbars — Drawing
3). OpenOffice.org Calc/Spreadsheet, Ms. Excel, Lotus, Borland Quattro, dll....

4). Salah satu fungsi atau kegunaan OpenOffice.org Spreadsheet adalah untuk melakukan
pengolahan data khususnya berupa numeric atau angka agar dapat melakukan proses
perhitungan, pembuatan tabel dan grafik serta pembuatan rumus-rumus fungsi logika dll...

5). Sel adalah perpaduan atau perpotongan antara kolom dan baris, sedangkan Range adalah
kumpulan dari Sel-Sel.
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Evaluasi Bab 6

A. Pilihan Ganda
1). b. angka
2). b. font name
3). b. currency
4). c. nama siswa
5). b. Merge cells
6). c. cells protection
7). c. Hide
8). a. 2,27cm dan 0,43cm
9). c. CTRL+Shift+S

10). c. Tools

B. Melengkapi Pernyataan
1). Undo
2). Delete
3). Backspace
4). 2,27cm dan 0,43cm

5). mm/dd/yy

C. Essay

1). Jenis data dalam spreadsheet:

a. Teks (string); perataan otomatis sebelah kiri, data ini berupa karakter atau gabungan
antara huruf dan angka namun bersifat sebagai teks (tidak bisa dihitung).

b. Angka (numeric); perataan otomatis sebelah kanan, data ini berupa angka atau number
yang dapat diolah dalam suatu perhitungan.

c. Tanggal (date); perataan otomatis sebelah kanan, format defaultnya adalah mm/dd/yy
yaitu month”bulan”, day”hari, year’tahun”.

d. Waktu (time); perataan otomatis sebelah kanan, format defaultnya adalah hh:mm:ss yaitu
hour’jam”, minute’menit”, seconds”detik”.

e. Rumus (formula); penulisan diawali dengan tanda sama dengan, jenis data ini digunakan
untuk mempermudah operasi perhitungan dalam lembar kerja.
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2). Beberapa ikon dalam toolbar formatting:
a. Font name ; untuk merubah jenis tulisan
b. Font size ; untuk merubah ukuran tulisan
c. Bold ; untuk menebalkan huruf
d. ltalic; untuk membuat huruf menjadi miring.
e. Underline ; untuk membuat huruf bergaris bawah
f. dan lain-lain

3). a. Perbedaan antara Save dan Save As, save adalah untuk menyimpan pertama kali file
dibuat sedangkan save as untuk menyimpan dengan perubahan, contoh menyimpan
dengan mengganti nama file atau disimpan pada folder penyimpanan yang baru.

b. Klik menu Save As — ketikkan nama file — tentukan tempat/folder penyimpanan- checklist
dipojok bawah "save with password” lalu OK. Nanti akan tampil window pengisian pass-
word dan Confirm passwordnya.

4). a. Fill Series digunakan untuk membuat daftar urutan otomatis seperti penomoran otomatis,
penamaan hari otomatis dll.
b. Sort Lists digunakan untuk mengurutkan data terutama pada data yang tidak berdasarkan
abjad atau numeric contoh dalam proses mengurutkan nama Hari, Nama Bulan, dll.
c. Merge Cells digunakan untuk menggabungkan beberapa sel/cells dalam sebuah range,
contoh menggabungkan sel dari A1 ke A10, maka akan menghasilkan range A1:10 yang
menjadi satu kesatuan.

5). Langkah menampilkan garis Bantu:
a. Klik menu Tools
b. pilih Options
c. Klik Openffice.org Calc
d. pilih View
e. Checklist Gridlines
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Evaluasi Bab 7

A. Pilihan Ganda.

1).
2).
3).
4).
5).
6).
7).

8).

a.

C.

b.

C.

number

. sel berisi rumus
. average

. menentukan kondisi yang akan dijalankan

6

off

9). c. remedial

10). b. semua salah

B. Melengkapi pernyataan.

1). UPPER

2). tanda ‘=’

3). Rata — rata

4). Fungsi Logika

5). lower, mid, proper, upper, dll

C. Essay

1)

2).
3).
4).

5).

. SUM, MAX, MIN, AVERAGE, COUNT, dll

+ ki = 3 X 3 /
=MID(TEXT, 6,7)
36

Sel harus berisi Rumus relative

. sel yang tidak berubah alamat selnya jika disalin ke sel lain

Teknologi Informasi dan Komunikasi
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Evaluasi Bab 8

A. Pilihan Ganda

1).
2).
3).
4).
5).
6).
7).

8).

b.

C.

a.

Meningkatkan pengetahuan yang menggunakan data

. adwal Kedatangan dan keberangkatan
. Ascending

. Data — filter

. Top 10

. Bar

Keterangan Warna

Memilih Data

9). a. Advanced Filter

10). b. Dari yang tertinggi ke yang terendah

B. Melengkapi pernyataan.

1). Data Filter

2). Data Sort

3). Chart

4). Descending

5). Ascending

C. Essay

1).
2).
3).
4).

5).

Untuk memilih data yang akan ditampilkan

Untuk membantu pengambilan keputusan

Pie

Menggunakan filter data

Top 10

27808
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EVALUASI SEMESTER 2

A. Pilihan Ganda

1). d.
2). b.

3). a.

8). a.
9). d.
10).b.
11). b.
12).b.
13).b.
14).c.
15).a.
16).a.
17).b.
18).c.
19).b.

20). c.

Percent
Split Cells

Show

. Font Size
. Garis bantu
. Mengunci sel

. Format

CTRL+O

Help

Formatting
Microsoft Excel
=Sum(A3:A5)
Average

9.3
MIN(9.5;8.5;8.7)
Descending
Filter

Wilayah

Bar

Impress, Fatih

B. Melengkapi pernyataan.

1). Baris dan Kolom

2). 65

3). IV

536

4). Underline

Teknologi Informasi dan Komunikasi
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5). ltalics

6). Grafik

7). NOT

8). UPPER

9). =MID(open Source;2;6)

10). =RIGHT(MENDIKNAS;3)

C. Essay
1). hhimm:ss
2). Bullets and Numbering
3). Sel/Cells
4). Range
5). Gridlines

6). Langkah menyaring data
a. blok table
b. klik Data
Pilih Filter
Pilih Autofilter
Pilih field kunci yang akan dicari

® oo

7). Langkah membuat grafik
Buat table sumber

blok table sumber

klik icon chart

pilih type grafik
masukkan data range

Isi Judul dan Isi Subjudul
g. finish

-0 o0 oTp

8). Buatlah perhitungan berikut kedalam rumus
a. =(5+6-2)/3
b. =IF(AND(B3>=5000,C3="Sponsor”); 10%*B3;0)
c. =IF(OR(D4="NOKIA”;E4="MENTARI”);"Souvenir”;"tidak”)

9). Program OpenOffice Selain OpenOffice.calc adalah
a. OpenOffice.Writer
b. OpenOffice.Impress
c. OpenOffice.Dbase

10). Worksheet
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Teknologi Informasi dan Komunikasi
untuk SMP / MTs kelas VIII

Buku ini disusun berdasarkan standar kompetensi dan kompetensi dasar pada
KTSP 2006. Ditulis oleh guru-guru yang mengajar pada bidang sesuai
jenjangnya.

Buku ini ditulis dengan tujuan meningkatkan kemampuan siswa dalam
menggunakan perangkat lunak pengolah kata dan pengolah angka sekaligus
memperkenalkan aplikasi berbasis Open Source.

Buku ini berisi bahasan tentang bagaimana mengoptimalkan penggunaan
aplikasi-aplikasi pengolah kata dan pengolah angka agar dapat menghasilkan
sesuatu yang lebih produktif.

Ditulis dengan bahasa sederhana sehingga mudah dipahami siswa dan tips-tips
yang membuat siswa dapat bekerja lebih cepat.

Buku teks pelajaran ini telah dinilai oleh Badan Standar Nasional Pendidikan
(BSNP) dan telah ditetapkan layak-pakai berdasarkan Peraturan Menteri
Pendidikan Nasional Republik Indonesia Nomor : Tahun
Tanggal tentang Penetapan Buku Teks Pelajaran yang Memenubhi
Syarat Kelayakan untuk Digunakan dalam Proses Pembelajaran.

HET (Harga Eceran tertinggi) Rp. 25.000,-
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